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Safety Instruction

Before using the product ...

For your safety and effective operation, please read the safety instructions
thoroughly before using the product.

» Safety Instructions should always be observed in order to prevent accident
or risk with the safe and proper use the product.

» Instructions are separated into “Warning” and “Caution”, and the meaning of
the terms is as follows;

&Warnin This symbol indicates the possibility of serious injury
g or death if some applicable instruction is violated

This symbol indicates the possibility of slight injury
ZQ Caution or damage to products if some applicable instruction
is violated

» The marks displayed on the product and in the user’s manual have the
following meanings.
A Be careful! Danger may be expected.
& Be careful! Electric shock may occur.

» The user's manual even after read shall be kept available and accessible to
any user of the product.



Safety Instruction

Safety Instructions when designing

7

/\Warning

» Please, install protection circuit on the exterior of PLC to protect

the whole control system from any error in exter nal power or PLC

module. Any abnormal output or operation may cause serious problem

in safety of the whole system.

- Install applicable protection unit on the exterior of PLC to protect
the system from physical damage such as emergent stop switch,
protection circuit, the upper/lowest limit switch, forward/reverse
operation interlock circuit, etc.

- If any system error (watch-dog timer error, module installation error,
etc.) is detected during CPU operation in PLC, the whole output is
designed to be turned off and stopped for system safety. However,
in case CPU error if caused on output device itself such as relay or
TR can not be detected, the output may be kept on, which may
cause serious problems. Thus, you are recommended to install an
addition circuit to monitor the output status.

Never connect the overload than rated to the output module nor
allow the output circuit to have a short circuit , Wwhich may cause a
fire.

Never let the external power of the output circuit be designed to
be On earlier than PLC power , which may cause abnormal output or
operation.

In case of data exchange between computer or other external
equipment and PLC through communication or any oper ation of
PLC (e.g. operation mode change), please install in  terlock in the

sequence program to protect the system from any err or. If not, it
may cause abnormal output or operation.
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Safety Instructions when designing
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/!\ Caution
» 1/O signal or communication line shall be wired at least 100mm
away from a high-voltage cable or power line. If not, it may cause
abnormal output or operation.
\

Safety Instructions when designing

a

/\ Caution

» Use PLC only in the environment specified in PLC ma  nual or
general standard of data sheet. If not, electric shock, fire, abnormal
operation of the product or flames may be caused.

» Before installing the module, be sure PLC power is off. If not,
electric shock or damage on the product may be caused.

» Be sure that each module of PLC is correctly secure d. If the
product is installed loosely or incorrectly, abnormal operation, error or
dropping may be caused.

» Be sure that I/O or extension connecter is correct |y secured. If
not, electric shock, fire or abnormal operation may be caused.

» If lots of vibration is expected in the installati on environment,
don’t let PLC directly vibrated.  Electric shock, fire or abnormal
operation may be caused.

» Don't let any metallic foreign materials inside th e product , which
may cause electric shock, fire or abnormal operation.
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Safety Instructions when wiring

7

/N\Warning

» Prior to wiring, be sure that power of PLC and exte  rnal power is
turned off. If not, electric shock or damage on the product may be
caused.

» Before PLC system is powered on, be sure that allt  he covers of
the terminal are securely closed. If not, electric shock may be caused

/\ Caution

» Let the wiring installed correctly after checking t he voltage rated
of each product and the arrangement of terminals. If not, fire,
electric shock or abnormal operation may be caused.

» Secure the screws of terminals tightly with specifi ed torque when
wiring. If the screws of terminals get loose, short circuit, fire or abnormal
operation may be caused.

» Surely use the ground wire of Class 3 for FG termin  als, which is
exclusively used for PLC . If the terminals not grounded correctly,
abnormal operation may be caused.

» Don't let any foreign materials such as wiring wast e inside the
module while wiring, which may cause fire, damage on the product
or abnormal operation.
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Safety Instructions for test-operation or repair
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/\Warning

» Don't touch the terminal when powered . Electric shock or abnormal
operation may occur.

» Prior to cleaning or tightening the terminal screw s, let all the
external power off including PLC power. If not, electric shock or
abnormal operation may occur.

» Don't let the battery recharged, disassembled, heat ed, short or
soldered . Heat, explosion or ignition may cause injuries or fire.

/\ Caution

» Don’'t remove PCB from the module case nor remodel t he module.
Fire, electric shock or abnormal operation may occur.

» Prior to installing or disassembling the module, le t all the external
power off including PLC power. If not, electric shock or abnormal
operation may occur.

» Keep any wireless installations or cell phone at |  east 30cm away
from PLC . If not, abnormal operation may be caused.

Safety Instructions for waste disposal

7

/\ Caution

» Product or battery waste shall be processed as indu strial waste.
The waste may discharge toxic materials or explode itself.
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About The User’'s Manual

Congratulations on purchasing PLC from IMO Precision Controls, Ltd.

Before use, be sure to read carefully and understand the PLC functions, performance, installation and

programming in order to use correctly. It is important to also provide the End User / Maintenance

Administrator with a copy of this The User’'s Manual.

The User’'s Manual describes the product functionality and provides basic instruction for installation, wiring

and programming. For additional information you may connect our website(http:/www.imopc.com/) and

download other manuals as PDF files.

Relevant User’'s Manual

User’'s Manual

: . No. of User
Title Description
Manual
It describes how to use XG5000 software especially about
XG5000 User's ) ) ) o o
online functions such as programming, printing, monitoring XG5000.pdf
Manual (XEC) ) .
and debugging by using XGB (IEC language)
XEC Series Instruction | It describes how to use the instructions for programming | XGB Programming
& Programming using XGB (IEC language) series. Instructions.pdf
XGB Hardware It describes how to use the specification of power/input
_ _ ) o XGB (IEC) User
User’s Manual (IEC /output/expansion modules, system configuration and built-in ya——-
anual.
language) High-speed counter for XGB main unit.
It describes how to use the specification of analogue
XGB Analogue . .
input/analogue output/temperature input module, system | XGB Analogue.pdf
User’'s Manual _ ) o ) )
configuration and built-in PID control for XGB main unit.
XGB Cnet I/F It describes how to use built-in communication function for
XGB Cnet.pdf
User’s Manual XGB main unit and external Cnet I/F module.
XGB Fast Ethernet I/F )
It describes how to use XGB FEnet I/F module. XGB FEnet pdf




© Table of Contents ©

Chapter L GENEIAl ........cccoiiiiieeeiii it et et e e e e e e et e e e e e e e e e e aeeaaens 1-1
N g = 1 oo 8 TSN o o o [ od £ RS S 1-1
1.2 Specification of ANAIOGUE MOUUIE..........ooiiiiiiiii e seeae s 1-2
Chapter 2 Analogue INnput Module ..........ciiiies oo 2-1
2.1 Setting Sequence before OPEIrAtION............oii it er e e e e e e e s ereeeeeeeeaaanns 2-1
P ] o L= 1ol Tor= £ o] oI PSR PP O PTPR 2-2
2.3 Name of part and fUNCHON ... et r e e e e e e e et eeeeeeeeeeaaanes 2-4
2.4 CharacteriStiC Of I/O CONVEISION ......ciiiiiiiiiieiiiie ettt 2-5
2.5 Conversion Characteristic according to INpUt RANGE .......eeveiiiiiiiiee e 2-6
AN ol ol U = o3 AP PP OPPPTPPPRPPR 2-9
2.7 Functions of Analogue INpUt MOAUIE ..........oo i e e e e e e 2-10
P28 S VAT oo PRSP PRPPPPN 2-13
2.9 Operation Parameter SEHING .....c...uueiiiiiieeei e e e e e e e er e e e e e e e s annereereeeeaeeaeaan 2-17
2.10 Special Module MonNitoring FUNCHONS  ......ocuiiiiiiiiies ettt ee e 2-20
2.11 REQISLEN U UBVICES  ...vriiiiiieeeei ittt e ettt e e e e e e e e s s ettt eeeeeeeeaaannnsteeeeaeeaeeessannnnnaeeeeeaeeanann 2-25
2.12 Configuration and Function of Internal MEMOIY .........ccccceiiiiiiiiiiiiie e 2-28
P S - g T o [N (o T | = o USRS 2-34
P S I (010 o] =T g To 1 oo [ PRSP SPPPPPN 2-40
Chapter 3 Analogue ONpUt MOAUIE ........cccciiiiiis e 3-1
3.1 Setting Sequence Defore OPEIatiON ... e 3-1
3.2 SPECIFICALION ...ttt ettt n e 3-2
3.3 Designations and FUNCLIONS .........uuiiiiiiiiiee ittt e e e e e e s et e e e e e e s e eeeeeeaeeeeeassnnenbeeeeeeeeeenaannes 3-4
3.4 CharacteriStiC Of /O CONVEISION  .....cocuiiiiiieiitie ettt e e 3-5
3.5 Characteristic of INPUI/OULPUL  .......eeiiiiiiiee e e e s e e e e e e e e e e e e senneb e eeeeeeeeeeaannns 3-6
R X ol o U = o3 AP P PP PPPPPPPPRPPR 3-7
3.7 Functions of Analogue OULPUt MOAUIE ...........euiiiiiiiie et e e e e e 3-8
I S AT o PR SRT PR 3-9
3.9 Operation Parameter SEHING .....c..euiiiiiiiieeei e r e e e e e s er e e e e e e e s annnreereeeeaeeaeaan 3-10
3.10 Special Module MoNItoriNg FUNCHON .......oiiiiiiiiiiiies et ee e 3-12
0 I B =0 111 (= g W 0 = Tt SRS 3-15
.12 INTEINAI MEIMOTY oottt et e bt e ettt e ettt ee e e s b et e e s sttt e e s e bbeeeesasbeeeessnnneeeennes 3-19
G S B = g ] o [N = (o T | = o PR 3-24

I I S I (010 o [=T= g T o 1 oo [PPSR PPPPPPN 3-27




Chapter 4 RTD INPUEt MOGUIE ......uueiiiiiii et it e e e e e 4-1

4.1 Setting Sequence Defore OPEIatiON .......c...oiiiiiiiiiiiiiie e ee e s ee e e 4-1
Y =T o= 11T USSR 4-2
4.3 Part Names and FUNCHIONS .......uiiiiiiiiiiieiee ettt ettt ne e b e en 4-4
4.4 Temperature Conversion CharaCteriStiC ..........oioieiiiiiriie e e eeeeeee s 4-5
N Oo] 1V =] = Te] o IS 0 1=T=T o PP PP TP PPPPPRR 4-6
G ol o U - Ty PO T 4-6
4.7 TeMPEIAtUIE DISPIAY .eeeiiiiieiiiee ittt ettt e st e e et e e e s bt e e e e sab b e ee s snbbeeeeeanbeeesennnbeeeenn 4-6
g I Tox= 111 o 0 o (o1 o USRS a4-7
4.9 Disconnection DeteCtion FUNCHON .........cooiiiiiiiiiiiie ettt 4-8
IO YT o SRR 4-9
v I T (=TT T 0T o 1o o PRSPPI 4-11
4.12 Operation Parameter SEHING . .....ooociiiiieie et e et r e e e e e e e s s e eeeee e e e e nnneeneeeeeas 4-12
4.13 Special MOduIe MONITOMING ..vviiiiiiiiie ittt e e s bbb e e st be e e s anbeeeeennaeeeens 4-15
I LT £ (= G o [ o LRSS 4-18
4.15 Configuration and Function of Internal MemOIY .......ccooiiiiiiiiiiie e 4-21
N L ez Lo 4] o] (TN o T | =T USSR 4-25
o A N (o 0 o] [0S g To o) £ o [ SO SPPRTOTPP 4-28
Chapter 5 Thermocouple Input Module............... oo 5-1
N 1=l 1= - | PP PT PP OPTPPPN 5-1
V] o T=Tol ] {Tor= 1 1 o] o PSR PPPOPTPR 5-3
IR I o U 0 Tox (T o PP OPU PP PPPPPPN 5-11
5.4 INStallation AN WiTNQ . ..eceei it e e et e e e st e e e e sab b e e e sasbeeeessnneeeennes 5-16
5.5 Operation Setting and MORNITOE ..........oiiiiiiiiiiie e ee e e e e e e e e e e e e e e e s annnnreereeeeaeeaeaan 5-18
5.6 Configuration and Function of Internal MemOrY ... 5-32
A == 1 ] o1 (SN = (o | = o PR 5-47
5.8 TroUDIESNOOLING ...eeiiiiiiiii e ettt e e et e e et e e e nreeeeane 5-52
Chapter 6 Analogue Combo MOdUIE..........ccccccies coeiiiiii e 6-1
6.1 Pre-operation SettiNng PrOCEUUIE ........ooiiii ittt e e e et e e e e e e e e s s nnetbeeeeeeeeeeeaannns 6-1
L] o =Tl Tor=1 o] o PSR PPPTPR 6-2
(SRS V.= o] g @ o0 ] o] g T=T o1 £ SRR 6-5
6.4 Conversion Characteristics by 1/O RANGE .........oiiiiiiiiiiiiiiiee st 6-6
SRS I o (= Toi ] To ] o T PP U PP OPUPPPPPPPPPNE 6-10

6.6 Functions of Analogue Combo MOUUIE .........c.uiiiiiiiiiii e 6-12




LS AT oo PRSP PPPPPPN 6-18

6.8 Operation Parameter SEHING .....c..uuiiiiiiiee e e e e e e er e e e e e e e s e ereeeeaeeaeean 6-22
6.9 Special Module MONItOr FUNCHION.........ociiiiiiiiii ettt e e e e e s ssneeeesnes 6-24
6.10 Auto-registration of U-Device (Special Module Variable) .........cccccoviiiiiiiiiiiiie e 6-28
6.11 Constitution and Function of Internal MEMOIY ............ocueiiiiiiiiieiiiiee e 6-33
Lo 2 = g T o [N = (o T | = o PP 6-40
LR T I (o101 o] =T g oo 1] oo [PPSR PRPPPPN 6-46
Chapter 7 PID Function (Built-in function)........ oo 7-1
A% R €= o= - T P TP PP UP T PPR PR 7-1
7.2 PID CONIIOI ettt ettt ettt e ettt e e ettt e e e bt e e s e ebbe e e e e eabe e e e e nbneee e s annneeeeaaneee 7-3
7.3 PID INSIUCHONS ...ttt ettt ettt et ettt e e e b se e e sh e e abe e e nane e s e e nneens 7-27
A 1 3 A U1 (o T (1 V1 o SRS 7-33
7.5 EXAMPIE PrOQIAMS ....oiiiiiiiiiiiiie ettt ettt e ettt e e ettt e e st ae e e s s bae e e e s bbe e e e satbaeeessnnneeeennes 7-42
AL =g o] FATAT L=V 1 o T o T o PR 7-54
APPENAIX .ot e e e App.1-3

Appendix 1 Standard ResSiStor Of PERTD ...ccooiiiiiiiiiiiieciiieeee ettt App.1-1
Appendix 2 Thermo Electromotive Force and Compensating Cable .........ccccccceiviiiiiiiceennenenn. App.2-1

Py o] o<1 gL D QST B 4 [=T0 ] o] o [ PP PRRPIIN App.3-1




Chapter 1 General

Chapter 1 General

Here is a description of all analogue modules and built-in PID function of XGB series.

1.1 Analogue Product List

No. of
Classification Name Range Resolution Characteristic
channel
1.Range selection by external switch and
0~ 10V 2.5 mv .
Voltage/Current parameter setting
XBF-ADO4A 4
input 0 ~ 20mA 2. External DC24V used
5.0 pA
4mA ~ 20mA
Voltage output XBF-DVO4A 4 0~ 10V 25 W 1. External DC24V used
0 ~ 20mA 2.Designates output in case of Error and CPU
Current output XBF-DCO4A 4 5.0 pA
p AmA ~ 20mA H STOP
- t XBE-RDO4A 4 PT100 . 1. External DC24V used
Inpu - 2. Filter function
XBF-RDO1A 1 JPT100
Thermocouple XBF- 1. External DC24V used
4 KIJITIR Notel) .
Input module TC04S 2. filter process, average process
4~20mA 1.Range selection by external switch and
0~20mA 50 uA parameter setting
Analogue combo XBF- 2 (input) 1~5vV 2.Filter function, averaging function
(voltage/current 1/0) AHO4A 2 (output) 0~5V 1.25 mv 3.Specifies output when error or CPU STOP
0~10V 25 W 4. Uses external DC24V

Notel) for more detail, refer to Ch.5.2.6 accuracy/resolution.
Note2) To use analogue combo module, the following version of basic unit is necessary

Basic unit Version
XGB S type V2.4
XGB H type V1.7

XGB IEC type V1.0




Chapter 1 General

1.2 Specification of Analogue Module

Here describes about specification of analogue module of XGB series.

1.2.1 Analogue input

Item XBF-ADO4A
Type Voltage Current
Analogue DC 4 ~ 20mA
input range ~ -
P ° Range (Input res?scia%ce'lciVMQ min.) DC 0 ~ 20mA
) ) (Input resistance: 250 Q)
Type 12 bit binary data
Unsigned 0 ~ 4000
value
Digital output Signed value -2000 ~ 2000
Range
Precise value 0 ~ 1000 400 ~ 2000/0 ~ 2000
Percentile
value 0 ~ 1000
Max. resolution 2.5mV(1/4000) 5/A(1/4000)
Accuracy +0.5% or less
Max. conversion speed 1.5ms/channel
Absolute max. input DC 15V DC +25mA

No. of output channel

4 channels

Insulation method

Photo-coupler insulation between input terminal and PLC power
(No insulation between channels)

Connection Terminal

11 point terminal block

1/0O points occupied

Fixed type: 64 points

Max. number of equipment

7 (when using XBM-DxxxS “S"type)
10 (when using XB(E)C-DxxxH “H"type)

. Inner (DC 5V) 120mA
Consumption
current
External (DC 24V) 62mA
Weight 649

Additional function

Filter-processing, average-processing (time, count)
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1.2.2 Analogue output

Item XBF-DVO4A XBF-DCO4A
Type Voltage Current
Analogue DC 4~ 20mA
output DC 0~ 10V m
Range (Load resistance: 2kQ or more) DC 0 ~ 20mA
) (Load resistance: 510Q or less)
Type 12 bit binary data
Unsigned value 0 ~ 4000 0~ 4000
Digital input Signed value -2000 ~ 2000 -2000 ~ 2000
Range
Precise value 0 ~ 1000 400 ~ 2000/0 ~ 2000
Percentile 0 ~ 1000 0 ~ 1000
value
Max. resolution 2.5mV(1/4000) 5/A(1/4000)
Accuracy +0.5% or less
Max. conversion speed 1ms/channel
Absolute max. output DC 15V DC +25mA
No. of output channel 4 channels

Insulation method

Photo-coupler insulation between output terminal and PLC power
(no insulation between channel)

Connection Terminal

11 point terminal block

I/O points occupied

64 points

Max. number of equipment

7 (when using XBM-DxxxS “S"type)
10 (when using XB(E)C-DxxxH “H"type)

. Inner (DC 5V) 110mA 110mA
Consumption
current
External (DC 24V) 70mA 120mA
Weight 649 709

Additional function

Designates output in case of error and CPU STOP
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1.2.3 RTD input

Item

XBF-RDO4A

No. of input channel

4 channels

Input sensor PT100 JIS C1604-1997
type JPT100 JIS C1604-1981 , KS C1603-1991
Input temp, PT100 200 ~ 600°C
range JPT100 200 ~ 600°C
PT100 -2000 ~ 6000
Digital output JPT100 -2000 ~ 6000
Scaling display 0 ~ 4000

Accuracy

Normal temp. (25C)

+0.3% or less

Full temp. (0~557C)

+0.5% or less

Conversion speed

40ms / channel

Insulation
method

Between channels

No insulation

terminal — PLC power

Insulation (Photo-Coupler)

Terminal block

15 point terminal

1/0O points occupied

64 points

Max. number of equipment

7 (when using XBM-DxxxS “S"type)
10 (when using XB(E)C-DxxxH “H"type)

Sensor wiring method

3line

Filter function

Digital filter (160 ~ 64000ms)

Additional
function Alarm function Disconnection detection
Consumption Inner DC5V 100mA
current External DC24V 100mA
Weight 639
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1.2.4 Thermocouple input

Items

Specification

Number of input channel

4 channels

Type of input sensor

Thermocouple K/ J/ T /R type
JIS C1602-1995

-200.0C ~ 1300.0C

K
Range of input J -200.0C ~ 1200.0C
temperature T -200.0C ~400.0C
R 0.0C ~ 1700.0C
Temp. display Displaying down to one decimal place — notel)

K, J, T type: 0.1C, R type: 0.5C

Digital output

Scaling display

Unsigned scaling (0 ~ 65535)

(user-defined scaling)

Signed scaling (-32768 ~ 32767)

Ambient temperature(25C)

Within £ 0.2% — note 2)

Insulation pressure

Accuracy Temp. coefficient
+100 ppm/C
(range of operating temp)
Conversion velocity 50ms / channel
Terminal — inner circuit Photo-coupler insulation
Insulation
Terminal — operating power DC/DC converter insulation
method
Between channels Photo-moss relay insulation
Insulation

400 V AC, 50/60 Hz, 1min,
leakage current 10mA or below

Insulation resistance

500 V DC, 10 MQ or above

Standard contact

point

Auto compensation

by RJC sensing (Thermistor)

compensation

Compensation amount

#1.0TC

Warming-up time

20 min or above

Terminal block

11 point terminal

I/O occupied points

64 points

Max. number of equipment

7 (when using XBM-DxxxS “S"type)
10 (when using XB(E)C-DxxxH “H"type)

Additional function

Filter process

Digital filter (200 ~ 64,000ms)

Time average (400~64,000ms)

Average process

Count average (2~64,000 times)

Moving average (2~100)

Alarm

Disconnection detection

Max./Min. display

Display Max./Min.

Scaling function

Signed scaling / Unsigned scaling

Consumption Inner DC5V 100mA
current External DC24V 100mA
Weight 639

Notel), Note2) For more detail specification, refer to 5.2.6 accuracy/resolution.

1-5
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1.2.5 Analogue combo

(1) Input performance specification

Max. resolution

Items Input performance specifications
No. of input channel 2 channels
Type Voltage Current
DC1~5V DC 4 ~ 20mA
Analogue DC 0~ 5V DC 0 ~ 20mA
input DC 0~ 10V (input resistor 250 Q)
Range
range (input resistor: 1 MQ or above)
Input range can be set through external voltage/current selector switch after
setting at user program or I/O parameter per input channel
Type 12bit binary data
Unsigned
0 ~ 4000
value
Signed value | -2000 ~ 2000
Digital
100 ~ 500 (DC 1 ~ 5V) 400 ~ 2000 (DC 4 ~ 20mA)
output Range Precise
0~ 500 (DC 0 ~ 5V) 0 ~ 2000 (DC 0 ~ 20mA)
value
0~ 1000 (DC 0 ~ 10V)
Percentile
0 ~ 1000
value
1/4000

1.25MW (DC 1~5V, 0~5V)
2.5MV (DC 0~10V)

5uh (DCA4~20mA, 0~20mA)

Precision +0.5% or less
Max. conversion speed 1ms/channel
Absolute max. input DC #15V DC +25mA

Filter function

Digital filter (4 ~ 64,000ms)

Additional Averaging

function function

Time averaging (4~16,000ms)

Cyclic averaging (2~64,000cycle)

Moving averaging (2~100samples)

Alarm function

Disconnection detection (DC 1~5V, DC4~20mA)
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(2) Output performance s

pecification

Items Output performance specification
No. of output channel 2 channels
Type Voltage Current
DC1~5V DC 4 ~ 20mA
Analogue DCO0~5V DC 0 ~ 20mA
output DC 0 ~ 10V (Load resistor 510 Q or less)
Range
range (Load resistor: 2kQ or above)
Input range can be set through external voltage/current selector switch after
setting at user program or |/O parameter per input channel
Type 12 bit binary data
Unsigned
0 ~ 4000
value
Signed value | -2000 ~ 2000
Digital
100 ~ 500 (DC 1 ~ 5V) 400 ~ 2000 (DC 4 ~ 20mA)
input Range | Precise
0~500 (DCO ~5V) 0~ 2000 (DC 0 ~ 20mA)
value
0~ 1000 (DC 0 ~ 10V)
Percentile
0~ 1000
value
1/4000

Max. resolution

1.25M (DC 1~5V, 0~5V)

2.5MV (DC 0~10V)

5uh (DCA4~20mA, 0~20A)

Precision 1+0.5% or less
Max. conversion speed 1ms/channel
Absolute max. output DC 15V DC 25mA

Additional function

Function setting channel output status

(Can select one among Previous, Minimum, median, maximum)

(3) /O common performance specification

Iltems

I/O common performance specification

Insulation method

Photo coupler insulation between

insulated between channels)

I/O terminal and PLC power (not

I/O terminal block

11 points terminal block

No. of /0O occupation point

Fixed type: 64 points

Max. number of equipment

7 (when using XBM-DxxxS “S” type)

10 (when using XB(E)C-DxxxH “H" type)

Consumption Internal (DC 5V) 120mA
current External (DC 24V) | 130mA
Weight 739
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Chapter 2 Analogue Input Module

2.1 Setting Sequence before operation

Before using the analogue input module, follow steps below.

XBF-ADO4A

Checking performance specification I—.

Wiring

Setting external voltage/current switch I—.

Reading analogue input data

——o

Setting parameter — e

Programming

e

Refer to trouble shooting when there is errorl

or analogue data is not normal.

Specification (2.2 performance specification)

®  Operating environment

® Input type and range

® Digital output range

Wiring

®  Wiring power (External DC24V)
®  Wiring analogue input

Setting switch
®  Setting voltage/current input type

Analogue input test

® XG5000 special module monitor test mode
Parameter
® XG5000 I/O parameter

Programming

® Programming for reading analogue
data
(1] device)
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2.2 Specifications

2.2.1 General specifications

General specifications are as follows.

No. Items Specification Related
standards
1 Operating 0~ 55 °C
temp.
p | Storage 25~ +70°C
temp.
Operating .
5195%RH (Non-condensin
3 | humidity ORH ( 9
4 Stor?ge 5195%RH (Non-condensing)
humidity
For discontinuous vibration -
Frequency Acceleration Amplitude Number
10 < f < 57Hz - 0.075mm
57 1550Hfz = 9.8m/s%(1G)
5 Vibration Each 10
For continuous vibration . : IEC61131-2
times in
Frequency Acceleration Amplitude . X’sz
directions
10 < f < 57Hz - 0.035mm
57 < f < )
1501z 4.9m/s“(0.5G)
« Max. impact acceleration : 147 m/s*(15G)
* Authorized time : 11ms
6 Shocks * Pulse wave : Sign half-wave pulse (Each 3 times in X,Y,Z IEC61131-2
directions)
.Square waye +1,500 V IMO standard
impulse noise
Electrostatic . . IEC61131-2
. . Volt : 4kV tact disch
discharging oltage : 4kV/(contact discharging) IEC61000-4-2
Radiated
) IEC61131-2,
7 Noise elegtromagnetlc 27 ~ 500 MHz, 10V/m IEC61000-4-3
field noise
P Digital/
T Fast Class m%\’(\;ﬁlre Analogue /0
ransient communication interface IEC61131-2
/ourst IEC61000-4-4
noise Voltage 2kV 1kV
8 Amplgnt No corrosive gas or dust
conditions
9 Ope.ratlng 2000m or less
height
10 Pollution 2 or less
degree
11 | Cooling type Natural air cooling
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2.2.2 Performance specifications

Performance specifications are as follows.

Iltems XBF-ADO4A
Type Voltage Current
Analogue input DC 4= 20mA
range ~ -
° Range (Input res?scia%ce'l(iVMQ min.) DC 0 ~ 20mA
) ) (Input resistance 250 Q)
Type 12 bit binary data
Signed value 0 ~ 4000
Digital output Ur\‘/zl'ﬁ’j;ed -2000 ~ 2000
Range Preci
recise 0 ~ 1000 400 ~ 2000/0 ~ 2000
value
Percentile
value 0 ~ 1000
Max. resolution 2.5mV(1/4000) 5/A(1/4000)
Accuracy +0.5% or less
Max. conversion speed 1.5ms/channel
Absolute max. output DC 15V DC +25mA

No. of output channel

4 channels

Insulation method

Photo-coupler insulation between input terminal and PLC power
(No insulation between channels)

Connection terminal

11 point terminal block

1/0O points occupied

Fixed type: 64 points

. Inner (DC 5V) 120mA
Consumption
current
External (DC 24V) 62mA
Weight 649

Additional function

Filter-processing, average-processing (time, count)

1) When A/D conversion module is released from the factory, Offset/Gain value is as adjusted for respective
analogue input ranges, which is unavailable for user to change.

2) Offset Value: Analogue input value where digital output value is 0 when digital output format is set to

Unsigned Value.

3) Gain Value: Analogue input value where digital output value is 16000 when digital output format is set to

Unsigned Value.
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2.3 Name of part and function

Respective designations of the parts are as described below.

HBF-ADD4A
RUN l @
g = } -
cH2 [ @
cH3 ([T
|
F-lem
C;ZE 3CH
+|: a7
-—|=]
Cf[ =] > — @
-=E=]
=]
@ =]
M= I=CH|
FHF—ROC J
L=
No. Description
RUN LED

= Displays the operation status of XBF-ADO4A
0 On: Operation normal

Flickering: Error occurs (page 12-30)

Off: Module error

Terminal block

0 = Analogue input terminal, whose respective channels can be connected with
external devices.

Voltage/Current selection switch

= Switch for voltage and current selection of analogue input
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2.4 Characteristic of I1/0O conversion

Characteristics of 1/0 conversion are the inclination connected in a straight line between Offset and
Gain values when converting analogue signal (voltage or current input) from PLC’s external device to
digital value. 1/O conversion characteristics of A/D conversion modules are as described below.

Analog input applicable
l—————————— _———
range
1011 2047 4047
1000 2000 4000
Jx Gain
value
750 1000 3000
Digital
output
500 0 200
value
250 -1000 1000
0 -2000 0
~—— Offset value
Analog inpu
9 Inp DCO~ 10V v Y 10V
value
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2.5 Conversion Characteristic according to Input Ra  nge

Voltage input range can be set through user program or special module package for respective
channels. Output formats of digital data are as specified below;

A. Unsigned Value
B. Signed Value
C. Precise Value
D. Percentile Value

2.5.1 Iftherangeis DC 0~ 10V

1011 1011 2047 4047
1000 1000 2000 4000
750 750 1000 3000
[0}
3
S| 500 500 0 2000
-
3
Q
2
3
o
S 250 250 -1000 1000
k=)
[a]
0 0 -2000 0

oV 25V 5V 75V 1oV
Analog input value (voltage)

Digital output value for voltage input characteristic is as specified below.
(Resolution (based on 1/4000): 2.5 mV)

Digital output Analogue input voltage (V)
range 0 2.5 5 7.5 10 10.11
Unsigned value
0 1000 2000 3000 4000 4047
(0~4047)
Signed value
g -2000 -1000 0 1000 2000 2047
(-2000 ~ 2047)
Precise value
0 250 500 750 1000 1011
(0~ 1011)
Percentile value
0 250 500 750 1000 1011
(0 ~1011)
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2.5.2 If the range is DC 0 ~ 20mA =

1011 2023
1000 2000
750 1500

()

=

©

>

a—

3

5 500 1000

o

©

=

2

o
250 500

0 0

2047
2000

1000

-1000

-2000

4047
4000

3000

2000

1000

OmA SmA 10mA

15mA

Analog input value (current)

= Digital output value for current input characteristic is as specified below.
(Resolution (based on 1/4000): 5 #A)

20mA

Digital output

Analogue input current (mA)

range 5 10 15 20 20.23
Unsigned value
1000 2000 3000 4000 4047
(0 ~ 4047)
Signed value
-2000 -1000 0 1000 2000 2047
(-2000 ~ 2047)
Precise value
500 1000 1500 2000 2023
(0 ~ 2023)
Percentile value
250 500 750 1000 1011
(0~1011)
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2.5.3 If range is DC4 ~ 20mA =

1011
1000

750

500

Digital output value

250

2023
2000

1600

1200

800

400
381

2047
2000

1000

-1000

-2000
-2048

4047
4000

3000

2000

1000

-48

4mA 8mA 12mA 16mA 20mA
Analog input value (voltage)
= Digital output value for current input characteristic is as specified below.
(Resolution (Based on 1/4000): 5 #A)
Digital Analogue input current (mA)
Output range 0 4 8 12 16 20 20.23
Unsigned value
SIONEAVale | 48 | o | 1000 | 2000 | 3000 | 4000 | 4047
(-48 ~ 4047)
Signed value
-2048 | -2000 | -1000 0 1000 2000 2047
(-2048 ~ 2047)
Precise value
381 400 800 1200 1600 2000 2023
(381 ~ 2023)
Percentile value
-12 0 250 500 750 1000 1011
(-12 ~1011)

Notes

defects.

1) If analogue input value exceeding digital output range is input, the digital output value will be kept to
be the max. or the min. value applicable to the output range specified. For example, if the digital
output range is set to unsigned value (0 ~ 4000) and the digital output value exceeding 4047 or
analogue value exceeding —0 is input, the digital output value will be fixed as 0~4047.

2) Voltage and current input shall not exceed +15 V and +25 mA respectively. Rising heat may cause
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2.6 Accuracy

Accuracy of digital output value does not changed even if input range is changed. Figure below
shows the range of the accuracy with analogue input range of 0 ~ 10 V and digital output type of
unsigned value selected.

Accuracy of XBF-ADO4A is +0.5%.

2000

Digital output value

ov 5V 10V

Analog input voltage

[ Accuracy ]

(1) Accuracy when using 5V input
4000 x 0.5% = 20
Therefore the range of the accuracy will become (2000-20) ~ (2000+20) = 1980 ~ 2020 when
using 5V input.

(2) Accuracy when using 10V input
4000 x 0.5% = 20
Therefore the range of the accuracy will become (4000-20) ~ (4000+20) = 3980 ~ 4020 when
using 10V input.
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2.7 Functions of Analogue Input Module

Functions of XBF-ADO4A conversion module are as described below.

Function Description

Channel Run/Stop (1) Specify Run/Stop of the channel to execute A/D conversion.

setting (2) If the unused channel is set to Stop, whole Run time can be reduced.
Input voltage/Current (1) Specify analogue input range to be used.

range setting (2) Select range in parameter setting after select Voltage/Current switch.
Output data format (1) Specify digital output type.

setting (2) 4 output data formats are provided in this module.

(1) Sampling processing
Sampling process will be performed if A/D conversion type is not specified.
A/D conversion (2) Filter processing
methods Used to delay the sudden change of input value.
(3) Average processing
Outputs average A/D conversion value based on frequency or time.

There are three A/D conversion methods, sampling processing, filter processing and average processing.

Sampling Processing

A/D Conversion Methods Filter Processing

Average Processing —ETime Average
Count Average
(1) Sampling processing

It collects analogue input sign through general A/D conversion processing at a specific interval so to
convert to digital. The time required for A/D conversion of analogue input sign till saved on the
memory depends on the number of channels used.

(Processing time) = (Number of channels used) X (C  onversion speed)

(Ex.) If the number of channels used is 3, its process time will be
3x15 ms =45 ms

Sampling is to calculate the sampling value of continuous analogue sign at a specific interval.
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(2) Filter processing
Filter process function is used to obtain stable digital output value by filtering (delaying) noise or

sudden change of input value. Filter constant can be specified for respective channels through user
program or 1/O parameters setting.

 Setting range: 1 ~ 99 (%)

FIn]=(1- a)xAln]+ axF[n-1]
F[n]: Present filter output value
A[n]: Present A/D converted value
F[n-1]: Previous filter output value
A: Filter constant (0.01 ~ 0.99: previous value added)

Q If filter setting value is not specified within 1 ~ 99, RUN LED blinks at an interval of 1 second. In
order to set RUN LED to On status, reset the filter setting value within 1 ~ 99 and then convert
PLC CPU from STOP to RUN. Be sure to use request flag of error clear (UXY.11.0) to clear the
error through modification during RUN.

* Analogue input range: DC 0 ~ 10 V, Digital output range: 0 ~ 4000
« If analogue input value changes 0 V - 10 V (0 - 4000), filter output value based on a value is
as specified below.

avalue Filter output value

Oscan | 1scan 2scan | 3scan el
1 0.01 0 3600 3960 3997 | 1% inclined toward previous value
20.66 0 1360 2257 2850 | 50% inclined toward previous value
0.99 0 40 80 119 | 99% inclined toward previous value

*1) 4000 output after about 4 scans
*2) 4000 output after about 18 scans
*3) 4000 output after about 950 scans(1.19 s for 1 channel Run)

4 If filter process function is not used, present A/D converted value will be output as it is. The filter
process function takes value-added data between ‘Present A/D converted value’ and ‘Previous
A/D converted value’. And the value-added data can be decided with filter constant. If output
data shakes too much, set a big filter constant value.

(3) Average processing

This process is used to execute A/D conversion of the channel designated for specified frequency or
for specified time and save the average of the accumulated sum on memory. Average processing
option and time/frequency value can be defined through user program or I/O parameters setting for
respective channels.

(a) What is the average process used for

This process is used for A/D conversion of abnormal analogue input signal such as noise to a
value near to normal analogue input signal.

(b) Average processing type
Average processing type is of time average and count average.

1) Time average processing
= Setting range: 4 ~ 16000 (ms)
= Average processing count within specified time is decided based on the number of channels
used.

Setting time
(Number of Channels used) x (Conversion Speed)

Average processing count =
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Ex.1) Channels used: 1, setting time: 16000 ms

Average processing count - 16000 ms - _ 10667 times
1x1.5ms
Ex.2) Channels used: 4, setting time: 4 ms
. 4 ms .
Average processing count = ——— = 1times
4x1.5ms

If setting value of time average is not specified within 4 ~ 16000, RUN LED blinks at an interval
of 1 second. In order to set RUN LED to On status, reset the setting value of time average within
4 ~ 16000 and then convert PLC CPU from STOP to RUN. Be sure to use request flag of error
clear (UXY.11.0) to clear the error through modification during RUN.

« Time average is processed after converted to average of the times inside the A/D conversion
module. In this case, a remainder may be produced when setting time is divided by (number of
channels used X conversion speed), which will be disregarded. Thus, the average processing
frequency will be the quotient of [(setting time) + (number of channels used x conversion
speed)].

Ex.) If the number of channels used is 5, and setting time is 151 ms

151 ms + (4 X 1.5 ms) = 26 times ...... Remainder of 2 - 26 times

2) Count average process
* Setting range: 2 ~ 64000 (times)
* The time required for average value to be saved on memory when frequency average used
depends on the number of channels used.

Process time = setting frequency X number of channels used X conversion speed

If setting value of count average is not specified within 2 ~ 64000, RUN LED blinks at
an interval of 1 second. In order to set RUN LED to On status, reset the setting value
of frequency average within 2 ~ 64000 and then convert PLC CPU from STOP to
RUN. Be sure to use request flag of error clear (UXY.11.0) to clear the error through
modification during RUN.

Ex.) If the number of channels used is 4, and average processing frequency is 50
50 X 4 X (1.5 ms) =300 ms
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2.8 Wiring

2.8.1 Precaution for wiring

(1) Don't let AC power line near to A/D conversion module’s external input sign line. With an enough
distance kept away between, it will be free from surge or inductive noise.

(2) Cable shall be selected in due consideration of ambient temperature and allowable current,
whose size is not less than the max. cable standard of AWG22 (0.3mm),

(3) Don't let the cable too close to hot device and material or in direct contact with oil for long, which
will cause damage or abnormal operation due to short-circuit.

(4) Check the polarity when wiring the terminal.

(5) Wiring with high-voltage line or power line may produce inductive hindrance causing abnormal
operation or defect.

2.8.2 Wiring examples
(1) Example of voltage wiring

- In case of voltage/current input, wiring is same. Adjust the voltage/current setting switch
according to the case.

HBF-AD04A
RUN

i

il

CHO+
CHoO-

o

CH1+
CH1-
CH2+
CH2-

CH3+
CH3-

o

o

[z}
I +x1 +x1 +T1 +I

' | BrEEEERHERH

DC24V+
DC24V-

"
I
i

h

§
5

%

DC power
(For analog
supply)

(a) Input resistance of current input circuit is 250 Q (typ.).

(b) Input resistance of voltage input circuit is 1 MQ (min.).

(c) Enable the necessary channel only.

(d) Analogue input module doesn’t support power for input device. Use the external power supplier.
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(2) Wiring example of 2-Wire sensor/transmitter (current input)
- In case of voltage/current input, wiring is same. Adjust the voltage/current setting switch
according to the case.

XBF-ADD4A
RUMN
+ 2~ Wire cHo—] =
pe=L Tansmi tter : Ve
I /J7 CHO ([T
CH1 (|
CHz ([T
cH3 [T
(;E 2-Wire ~—n CH!
D Transmi tter[ Hi 1 S EiEe
_ B CHO- +[ L]
/J? CH1+ CH1 [::|
+— | 2]
CHi- [
CH2+ || cHz o]
+ 2~ Wire ~—n CH—{ + | Ed
- .
DC—E Transmitter - o 0;3[ =]
o=y e e
- -= =]
: DC24v+ CH
DC:E 2= Wire /\,—'—\ﬁCHS DC24V- rezar] ]
L]
—[_ Transmi tter[ ] - A o]
L /J7 FHF =00,

%

DC power
(for analog
supply)

(a) Input resistance of current input circuit is 250 Q (typ.).

(b) Input resistance of voltage input circuit is 1 MQ (min.).

(c) Enable the necessary channel only.

(d) Analogue input module doesn’t support power for input device. Use the external power supplier.
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(3) Wiring example of 4-Wire sensor/transmitter (Voltage/Current input)

- In case of voltage/current input, wiring is same. Adjust the voltage/current setting switch
according to the case.

KBF-ADD4A
RUM
c:: 4-Wire CHO +
OC==] Transmitter : Woanl
CHo ([T
CH1 ([
cHz |
CHz ([
+ 4-Wire
DC,_F__ Transmitter oo o 2]
= CHO- [
CH1+ CHY o]
+— | [FE]
. o
CH2+ o2 o]
+ -
— 4-Wire CH2-
D T Transmitter] CH3+ c;?|.: E:El
T +— | =]
e | Lt
DC24v+ %
+ -
— 4-Wire DC24V- LL24Y
DC==] Transmitter iy =]
EHF —AOC

¢

(For analog
supply)

(a) Input resistance of current input circuit is 250 Q (typ.).

(b) Input resistance of voltage input circuit is 1 MQ (min.).

(c) Enable the necessary channel only.

(d) Analogue input module doesn’t support power for input device. Use the external power supplier.
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(4) Relationship between voltage input accuracy and wiring length

In voltage input, the wiring (cable) length between transmitter or sensor and module has an effect
on digital-converted values of the module as specified below;

Ri i

---------------------- Analogue input (Voltage)

Where,
Rc: Resistance value due to line resistance of cable
Rs: Internal resistance value of transmitter or sensor
Ri: Internal resistance value (1M2) of voltage input module
Vin: Voltage allowed to analogue input module

% Vi: Tolerance of converted value (%) due to source and cable length in voltage input

Vin= RIXVs
[Rs+(2x Rc) + Ri
%Vi :(1—\ﬁjx100%
Vs
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2.9 Operation Parameter Setting

A/D conversion module’s operation parameters can be specified through XG5000’s [I/O parameters].

(1) Settings
For the user’s convenience of A/D conversion module, XG5000 provides GUI (Graphical User
Interface) for parameters setting of A/D conversion module. Setting items available through [I/O
parameters] on the XG5000 project window are as described below in the table.

ltem Details

[/O parameter] | (1) Specify the following setting items necessary for the module
operation.
- Channel Enable/Disable setting
- Setting ranges of input voltage/current
- Output data format setting
- Filter processing Enable/Disable setting
- Filter constant setting
- Average processing Enable/Disable setting
- Average processing method setting
- Average value setting

(2) The data specified by user through S/W package will be saved on A/D
conversion module when [Special Module Parameters] are
downloaded. In other words, the point of time when [Special Module
Parameters] are saved on A/D conversion module has nothing to do
with PLC CPU'’s status RUN or STOP.

(2) 1/0 Parameter setting

(a) Run XG5000 to create a project.
(Refer to XG5000 program manual for details on how to create the project)

(b) Double-click [I/O parameters] on the project window.

[Praject window [“ertical Line] - x|

Itema |

=- @ ewF‘LC(XGB #BME)-Stap
------ 9 Variable/Comment
El Iﬂ Parameter
T Basic Parameters
el |0 Parameters
: - ‘H Internal Parameters
= - Scan Program
------ (27 MewFrogram

Ly Project

(c) On the ‘I/O parameters setting’ screen, find and click the slot of the base A/D conversion
module is installed on. 8-channel voltage type of A/D conversion module is installed on Base No.0,
Slot No.4 in this description.
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1/0 Parameter Setting 21|
Module list
E-@ Base 00 : Default Slot Module Comment Iput Filter Emergency Output Allocation
g 00 ¢ Default Dfmain]
: Default 1
: Default >
: Default 3
: Default i
¢ Default
 Default 5
: Default E
7
H——— 0
Delete &0t | [iglete Baze I Base Setling I Delete &ll | Details I Print w | (0]8 I Cancel |

(d) Click the arrow button on the screen above to display the screen where an applicable module
can be selected. Search for the applicable module to select.

21
Module list
= @ Base 00 Default Slat Module Comment Irput Filker Emergency Output Allocation
g U0+ Default Dimain]
; : Default 7
! Default 5
: Default
' Default g -
Defaul | A
| Default 5 [ Digital Module List
: Diefault B E@, Special Module List
7 E| @ Analag [nput Module
ﬁ Analog Output
B Commurication Module List
KT —
Delete Slot Delet _I Print ¥ QK Cancel

(e) After the module selected, click [Details].

21
Madule list

=@ Base 00 : Default Slat Module Comment Iripuit Filter Emergency Output Allocation
== 00 ! Default Ofmain]
: Default
: Default
: Default
: XBF-AD044 (Mol/Curre
: Default
: Default
: Default

POOMED ~ POOTEF

MmmImm—t

Kl ——

Delete Slot | Deleteﬂase| Basegertingl Delete Al | Details | Print v| o] I Cancel |

(f) A screen will be displayed for you to specify parameters for respective channels as shown below.
Click a desired item to display parameters to set for respective items.

urrent. 4-CH} ed |
*BF-AD048 ValtyCarrent, 4-CH3

Parameter CH O CH 1 CH 2 CH3
[T Channel status Disable Disable Disable Disahble
™ Inputranage O-1 0 0-10% 0-1 0 0-10v
Qutput type 0-~4000 0-~4000 0~4000 0-~4000
[C Filter pracess Disable Disable Disahle Disahle
Filter constant 1 1 1 1
T Awerage setting Disable Disable Disahle Disahle
™ fwerage processing Count-Auyr Sount-Awr Count-Avr Count-Avr
Average value 2 2 2 2

Cancel
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2.10 Special Module Monitoring Functions

Functions of Special Module Monitoring are as described below.

(1) Monitor/Test
Through applicable XG5000 menu of [Monitor] -> [Special Module Monitoring], A/D converted
value can be monitored and the operation of A/D conversion module can be tested.

(2) Monitoring the max./min. value
The max./min. value of the channel can be monitored during Run. However, the max./min. value
displayed here is based on the present value shown on the screen. Accordingly, when
[Monitoring/Test] screen is closed, the max./min. value will not be saved.

= The parameters specified for the test of A/D conversion module on the “Special Module
Monitoring” screen of [Special Module Monitoring] will be deleted the moment the “Special
Module Monitoring” screen is closed. In other words, the parameters of A/D conversion module
specified on the “Special Module Monitoring” screen will not be saved in [I/O parameters] located

Special Module Monitor 2l x|
XBF-aD044 (Volt/Current, 4-CH)
ltem Maihdin value Current value

CHO AID value oin 1]

CH1 AD value oin 0

CHZ2 AD value oin 0

CH3 AD value oin 0

Itermn Setting Value | Current ¥alue
Channel CHO
Channel status Disahble / Disahble \
Input range a~10v -1
Outputtype 0~4000 0~4000
Filter process Digable Digable » Not saved in [|/O
Filter constant 1 1
arameters
Average setting Disahle Disahle p ]
Average processing Count-Ar \ Count-Ar I
Average value 2 \ 2 /
N’
Feset max/min value {atop ManioG! Test |
Close

= Test function of [Special Module Monitoring] is provided for user to check the normal operation of
A/D conversion module even without sequence programming. If A/D conversion module is to be
used for other purposes than a test, use parameters setting function in [I/O parameters].
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2.10.1 How to use special module monitoring

Monitoring special module will be based on XBF-ADO4A.

(1) Start of [Special Module Monitoring]

Go through [OnLine] -> [Connect] and [Monitor] -> [Special Module Monitoring] to start. If the
status is not [OnLine], [Special Module Monitoring] menu will not be active.

Mnnitnri Debug Tools MWindow Hel
m Start/Stop Monitaring

Pausing Conditions,.,

@ BRE

[=T)
=l

Device Monitoring

Special Module Monitaring
Trend Monitaring
C

ustom Events
Data Traces

PE & EE

(2) How to use [Special Module Monitoring]

(a) With XG5000 connected to PLC CPU (on-line status), click [Monitor] -> [Special Module
Monitoring] to display ‘Special Module Select’ screen as in Fig. 5.1 showing base/slot
information in addition to special module type. The module installed on the present PLC system
will be displayed on the list dialog box.

Special Module List x|
Baze | Slat | Module
) Base 0 ﬂ Internal HSC Module (Open-Collector, 4-CH)
i Basze 0 ﬂ Internal &P Module (Open-Collectar, 2-CH)
0 Base 0 ﬂ_ Slat 1 XBF-AD0dA (Wolt/Current, 4-CH)
@ Base 0 ﬂ Slot 2 #BF-DW04a (Moltage, 4-CH)
<] | »
Wil Tritd, Monitar Close |

(b) Select Special module and click [Module information] to display the information as below.
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Jodule Infornation 2lx

“ﬂl Displays the informations of special module,

tem Informati
hodule Info HBF-ADD4A (VoltCurrent, 4-CH)
085 version Module 95 Wersion 1.0
0§ date 2006f 3 2
Module status Ma Errar. (0%

(c) Click [Monitor] on the “Special Module” screen in [Special Module List] to display [Special Module
Monitoring] screen as below, where 4 options are available such as [Reset max./min. value], [start
Monitoring], [Test] and [Close]. A/D conversion module’s output value and max./ min. value are
displayed on the monitoring screen at the top of the screen, and parameters items of respective
modules are displayed for individual setting on the test screen at the bottom of the screen.

Module Monitar 21|
XBF-AD044 (Valt/Current, 4-CH)
Itermn Maxihin value Currentvalue
CHO AD value
CH1 AD value
CH2 AD value
CH3 AD value
Item Setting Walue Current Value
Channel CHO
Channel status Disahle
Input range 0-1 0V
Output type 0~4000
Filter process Dizable
Filter constant 1
Average setting Disable
Average processing Count-Awr
Average value 2
Start Monitaring | Test |
Close |

(d) [Start Monitoring]: Click [Start Monitoring] to display A/D converted value of the presently operated
channel. Below screen is the monitoring screen displayed when the whole channels are in Stop
status. In the present value field at the screen bottom, presently specified parameters of A/D
conversion module are displayed
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odule Muonitar 21
XBF-AD044 (Maolt/Current, 4-CH}
ltem MaxMin value Currentvalue
CHOAD value oin 0
CH1 AD value ain 0
CH2 AD value ain 0
CH3 AD value oin 0
ltem Setting Value Current Value
Channel CHO
Channel status Disahle Digahle
Input range a~10v 0-~10W
Cutput type 0~4000 0~4000
Filter process Disahle Disahle
Filter constant 1 1
Average setting Disahle Disahle
Average processing Count-Avr Count-Aur
Average value 2 2
Reset max/min value | [{5t58 Manitanig: Tost |
Close

Execution screen of [Start Monitoring]

(e) [Test]: [Test] is used to change the presently specified parameters of A/D conversion module.
Click the setting value at the bottom field of the screen to change parameters. Below screen
will be displayed after [Test] is executed with channels O’s input voltage range changed to -
0~20 mA in the state of input not wired.

todule Monitor 2l

#BF-AD044 (Volt/Current, 4-CH)

Item Maxihin value Current value
CHO AD value oro 1]
CH1 AID value oro 1]
CH2 AID value o/ 0
CH3 AD value arn 1}
Item Setting Walue \ Current Value
Channel CHO
Channel status Disable Cisable
Input range 0 A j 0~10%
Qutput type 0~4000 04000
Filter process Enahle Enahle
Filter constant 1 1
Average setfing Disable Cisable
Average processing Count-Avr Count-Ayvr
Average value 2 2
BReset max/min value | Stop Monitoring | Test |

Cloge

Execution screen of [Test]

(f) [Reset max/min value]: The max/min value field at the upper screen shows the max. value and the
min. value of A/D converted value. Click [Reset max/min value] to initialize the max./min. value.
Below screen is after [Reset max/min value] button is clicked in the screen of Special Module
Monitor, where channel 0's A/D converted value can be checked as reset.
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2=
HBF-A0044 OVolt/Current, 4-CH)
Iterm hdzxidin value Current value
CHO AD value oo i]
CH1 AD value oo 1]
CH2 AD value oo i]
CH3 AD value oo i]
Item Setting Yalue Current Walue
Channel CHO
Channel status Disable Disable
Input range 0~20maA 0~10Y
Output type 0~4000 0~4000
Filter process Enahle Enahle
Filter constant 1 1
Average =setting Disable Dizable
Average processing Count-Avr Count-Avr
Average value 2 2
é’éf"iﬁ'é’i’é?ﬁﬁi'ﬁ"'(ﬁélLi'é"§| Stop Monitoring | Test |
Close |

Execution screen of [Reset max/min value]

(9) [Close]: [Close] is used to escape from the monitoring/test screen. When the monitoring/test

screen is closed, the max. value, the min. value and the present value will not be saved any
more.
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2.11 Register U devices

Register the variables for each module referring to the special module information that is set in the 1/O
parameter. The user can modify the variables and comments.

(1) Procedure

(a) Select the special module type in the [I/O Parameter Setting] window.

/0 Parameter Setting : x|

Module list

E@ Base 00 : Default I Slot ‘ M odule Comment Input Filter Emergency Dutput Allocation |

iz 00 Default Ofmain]
-5 111 RBF-ADD4A (Volt/Curre ' - - © PO0040 ~ POOOZF
By 02 ' . .

: D)ﬁgjl?wd'q e PO00g0 ~ POOTIF
-z 04 : Default
-z U5 ¢ Default
g U6 ¢ Detault
‘o U7 Default

CU| - U S Y R

|51 —
Delete Slot | [elete ﬁasel Base ﬁet‘lingl Delete All | Dietails Print | (0] I Cancel

(b) Double click ‘Variable/Comment’ from the project window.

| Project wiindou - x|
Iterns |
E@ Sd *

2 MewPLC(XGE-XBMS)-Stap
] ariable /Comment
=L Parameter

- Basic Parametars

H /0 Parameters

© ®m-H Internal Parameters

=[5 Scan Program

LI MewProgram

L Froject

(c) Select [Edit] — [Register U Device].
Editi Eind/Replace Miew 0O

L.
e
4 Cut Ctrl+x
Copy Ctrl+C
2
¥ Delete Cel

Select Al Ctel+&

Ingert Line Cirl+L
Delete Line  Cirl+D

Export to Eile, ..
| Reaister U Device |

W
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(d) Click ‘Yes'.

xesooo =

Autornatically register comments in the I Devices according to the special module sek in the IO parameter,
- The previous comment will be deleted,
' Continue?

fes Mo

(e) As shown below, the variables are registered.

V| Wiew Variable lf'_—"_h'\euu Device ] Ell’iew Flag ]
Yariable Type ¥ Device Comment =
1 Start_Condition BIT 0000
2 _O1_ERR BIT uo1.00.0 #nalog Input Module: Module Error
El _01_RDY BIT uo1.00.F #nalog Input Module: Module Ready
4 _01_CHO_ACT B uo1.01.0 #nalog Input Module: CHO Active
5 _01_CHI_ACT ] ~guoT. 0.1 #nalog Input Module: CHY Active
B _01_CHz_ACT B uo1.01.2 #nalog Input Module: CHZ Active
7 _01_CH3_ACT BIT uo.01.3 #nalog Input Module: CHI Active
8 _01_CHO_ |00 BIT uoi.1o0.0 #nalog Input Module: CHO Input Disconnection Flag
3 _01_CHI_IOD BIT uot, o1 #nalog Input Module: CHI Inpat Disconnection Flag
10 |_01_CH2_10D BIT uor.1o.2 #nalog Input Module: CHZ Input Disconnection Flag
1 _01_CH3_Ioo BIT uo1.10.3 #nalog Input Module: CH3 Input Disconnection Flag
12 _01_ERR_CLR BIT ugr.11.2 #ralog Input Module: Error Clear Request
13 |_02_CHO_ERR BIT uoz.0o0.0 #nalog Output Module: CHO Error
14 | _02_CH1_ERR BIT oz, 0o #nalog Output Module: CHI Error
15 |_02_CHZ_ERR BIT uoz.00.2 #nalog Output Module: CHZ Error
16 | _02_CH3_ERR BIT uoz.00.3 #nalog Output Module: CH3 Error E
17 |_02_RO¥ BIT uoz.00.F #nalog Output Module: Module Ready
18 | _02_CHO_ACT BIT uoz.01.0 #nalog Output Module: CHO Active
19 _02_CH1_ACT BIT uoz.01.1 #nalog Output Module: CHI Active
20 |_02_CHz_ACT BIT uoz.01.2 #nalog Output Module: CHZ Active
21 _(02_CH3_ACT BIT uoz.01.3 #nalog Output Module! CH3 Active
22 | _D2_CHO_OUTEW — BIT uoz.0z.0 #nalog Output Module: CHO Output Status Setting
23 | 02 CHI_OUTEM BIT unz, 021 #nalog Output Module! CHI Output Status Setting
24 (12 "H? THTFH RIT |IN7.12 .2 Analna (hitont Modnle: CH? Mitoot Statns Settina LI

(f) For IEC type, as shown below, the variables are registered.

| V| clobal Variable |[D] nirect Varisbie Comment [#] Fiag ]
Variable Kind | Yariable | Type | #ddress ||E“at\ Iuil |Retain| lsed | Comment
1 WAR_GLOBAL _01_ADO_ACT BO0L #UKD.1.16 r r dnalog 10 Module: Input CHO Active
2 YAR_GLOBAL _01_ADD_DATH WORD R r r #nalog 10 Module: Input CHO Data
& W4R_GLOBAL _01_A00_ERR BOOL BUKDLT .24 r r 4nalog |10 Module: Input CHO Error
[ WAR_GLOBAL _01_4D00_100 BOOL BUXD.T.20 r r Analog |10 Module: Input CHO Disconnect jon
5 WAR_GLOBAL _01_ADT_ACT BOOL BUE01 7 r r dnalog 10 Module: Input CHI Active
i WAR_GLOBAL _01_ADT_DATH WORD #0015 r r dnalog 10 Module: Input CHI Data
7 WAR_GLOBAL _01_4D1_ERR BOOL BURD.1.25 r r #nalog 10 Module: Input CHI Error
g W4R_GLOBAL _01_4D01_100 BOOL BUX0.1.21 r r Analog |10 Module: Input CHI Disconnect jon
9 YAR_GLOBAL _01_DAO_ACT BOOL AUX0.1.18 r r Analog |10 Module: Output CHO Active
10 |YA4R_GLOBAL _01_DAD_DATH WORD R r r dnalog 10 Module: Output CHO DATA
11 |YAR_GLOBAL _01_DAO_ERR BOOL BUR0.1.26 r r #nalog 10 Module: Output CHO Error
12 |VR_GLOBAL _01_DAO_OUTEN BOOL #URD.1.96 r r dnalog 10 Module: Output CHO Status Setti
13 |V4R_GLOBAL _01_DA1_ACT BOOL #UKD.1.19 r r dnalog |10 Module: Output CHI Active
14 |VYAR_GLOBAL _01_0AT_DATA WORD AWo.1.8 r r Analog 10 Module: Output CHT DATA
15 |VAR_GLOBAL _01_DAT_ERR BOOL BUKD1.27 r r dnalog 10 Module: Output CHY Error
16 |YAR_GLOBAL _01_0AT_OUTEN BOOL #Uk0.1.97 r r #nalog |10 Module: Output CHI Status Setti
17 |"AR_GLOBAL _O1_ERR BOOL FUX0.1.0 r r #nalog |0 Module: Module Error
18 |VaR_GLOBAL _01_Rov BOOL BUXD1 15 r r 4nalog |10 Module: Module Ready

(2) Save variables
(a) The contents of ‘View Variable’ can be saved as a text file.
(b) Select [Edit] -> [Export to File].
(c) The contents of ‘View variable’ are saved as a text file.
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(3) View variables

The example of XGB ‘S’ type and ‘H’ type is as follows.
(a) The example program of XG5000 is as shown below.

23

Moo MoO10
f 3
MDDIID um}.nlu.F uml.nllﬂ [ nov T2 i ||
UD‘-DID-F UD‘I-DI‘“ [ wov Uo1.03 oot |
e R o e [ mw U0t 04 miz ||
UU‘-UIU-F UD]I'DI]‘S [ v uo1.05 moa |
END
(b) Select [View] -> [Variables]. The devices are changed into variables.
Wooaqo WOOa10
: 5]
Ho00|0 DAY 01 CH0 AT | oy O1CH0BAT - popago L
I 1 I 1 I L
OIRDY 01 e AT | oy OB g L
I 1 I L
DAY 01 pi2 AT | oy BB e L
I 1 I L
N [ wy  DERDAT g L
I 1 I L
END

(c) Select [View] -> [Devices/Variables]. Devices and variables are both displayed.

MO0O0D MODD1D
f [ a—
””””I‘” UD‘}-”?-F ””‘I-”I‘-” [ o ot .02 oooion_ ]|
_OIRDY _O1_CHOACT MRy
R e o [ nov e oooior ||
OIRDY_O1_CHI_ACT oo
“”"”I”'F ””‘I'”I"E WOV T ooz ]|
IRV _O1_CHe_ACT LAy
“”‘-”I“-F ””‘I-”I‘-S Hov uat .05 oooios_ ]|
01ROV _O1_CHA_ACT Ly
END
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(d) Select [View] -> [Device/Comments]. Devices and comments are both displayed.

(e) In case of IEC, you can see variables with diverse option at ‘View’ menu like (b)~(d). The following

is example selecting ‘View Variable/Comment’ at IEC type.

Wooog Moo10
of—/1 53—
MDMID UDC.DID.F UDI‘I.DI1.D Wov U102 Do100 L
Analog Input - Analog Input Analog Input
Module Module Maodule:
Module CHO Active CHO Cutput
Ready
2
UD1.DID.F UDI1.DI1.1 Mo L0103 ootoo l—
I 1T
Analog Input  Anzlog Input Analog Input
Module: Module: Maodule:
Module CH1 Active CH1 Dutput
Ready
UD1.DID.F UDI1.DI1.2 Mo U0 04 Do100 l—
Analog Input  Analog Input Analog Input
Module: Module: Module:
hodule CHZ Active CH2 Cutput
Ready
UD1.DID.F UDI‘I.DI1.D WMo U102 Do100 L
Analog Input - Analog Input Analog Input
hodule: htodule: Maodule:
Module CHO Active CHO Qutput
Ready
unt DP F UD.1 D.1 3 Lo} unt.0a D100 l_
I 1T
Analog Input  Anslog Input Analog Input
Maodule: Module: Maodule:
Module CH32 Active CH3 Dutput
Ready
EMD
28

MoweChanne _01_CHO_&C
Warighle  _01_RDY T MOVE
{ | { | { | EN END
_01_CHO_DA CHOCorwers
Th 4 IH OUT b fontalue
_m _ETHI _AC WOVE
— | EW  EMWO
_0_CH1_DA CHIConwers
Th 1IN OUT L jonValue
_m _ETH2_.I".I3 HOVE
— ——— 4 EN ENO
_01_CHZ_DA CHZConvers
TA 4 IN UT |+ ionvalue
_01_CH3_AC
T

L —
_01_CH3_DA
Th 1

CHaConvers
jona lue
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2.12 Configuration and Function of Internal Memory

A/D conversion module has the internal memory to transmit/receive data to/from PLC CPU.

2.12.1 1/O area of A/D converted data

I/O area of A/D converted data is as displayed in table.

?gylgre “aHs”stlgggd De\l(lﬁzecaf;;ge;]ed Details R/W | Sign direction
0,
Sime |onors e T N e
UXY.01.0 %UXO0.x.16 CHO Run flag
0,
e o cammies | e | wb - cru
UXY.01.3 %UXO0.x.19 CH3 Run flag
UXY.02 %UWO0.x.2 Cho digital output value R
UXY.03 %UWO0.x.3 Ch1 digital output value R A/D — CPU
UXY.04 %UWO0.x.4 Ch2 digital output value R
UXY.05 %UWO0.x.5 Ch3 digital output value R
UXY.11.0 %UXO0.x.176 Flag to request error clear w CPU — A/D

- In the device assigned, X stands for the Base No. and Y for the Slot No. on which module is installed.
- In order to read ‘CH1 digital output value’ of A/D conversion module installed on Base No.0, Slot No.4,

it shall be displayed as U04.03. (in case of IEC type, %UWO0.4.3)

“S” or “H” type

Base No.

Word Sorter

Uo 4

Device Type i

Slot No.

IEC type

Base No

%UWO0.4.3

LW

Device Type

i

v

Word

Slot No.

- In order to read ‘Flag to detect CH4 disconnection’ of A/D conversion module installed on Base No.0,
Slot No.5, it shall be displayed as U05.10.4.

“S” or “H” type IEC type Base No
Base No.
Word Sorter Bit Sorter
4 4 %UXO0.5. 19
uos:!: 10! 4 T i ‘
‘ i ‘ ‘ Device Type Bit
Device Type Word Bit Slot No.

Slot No.
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(1) Module Ready/Error flag (U0x.00, x: slot number)
(a) U0x.00.F: It will be ON when PLC CPU is powered or reset with A/D conversion ready to
process A/D conversion.
(b) U0x.00.0: Itis a flag to display the error status of A/D conversion module.

Bit15 Bitl4 Bitl3 Bit12 Bitll Bitl0 Bit9 Bit8 Bit7 Bit6 Bit5 Bit4 Bit3 Bit2 Bitl Bit0

Apeay
|
|
|
|
|
|
|
|
|
|
|
|
|
|
Joug

(UWO.x.0)

U0x.00

! 4

Module READY Error status
Bit On (1): normal, Bit Off (0): error Bit On (1): error, Bit Off (0): normal

(2) Run channel flag (UXY.01, X: Base No., Y: Slot No.)

The area where Run information of respective channels is saved
* XGB series base number is 0

B15 B14 B13 B12 B1l1 B10 B9 B8 B7 B6 B5 B4 B3 B2 Bl BO

UXY.01 c|cj|c|c

I
|
I
|
I
|
I
|
I
|
I
|
T
I
T
I

(%UWO0.x.1 3|2|1|0

Run channel information
Bit ON (1): During Run, Bit Off (0): Operation Stop

(3) Digital output value (UXY.02 ~ UXY.09, X: Base No., Y: Slot No.)

(a) A/D converted-digital output value will be output to buffer memory addresses UXY.02 ~
UXY.05 (%UWO0.x.2 ~ %UWO0.x.5) for respective channels.

(b) Digital output value will be saved in 16-bit binary.

% XGB PLC’s base number is 0.

B15 B14 B13 B12 Bl11 B10 B9 B8 B7 B6 B5 B4 B3 B2 Bl BO

Channel 0 digital output value (%UWO.x.2)
Channel 1 digital output value (%UN0.x .3
Channel 2 digital output value (%UWO.x.4
Channel 3 digital output value (%UN0.x.5)

ll
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(4) Flag to request error clear (( ) means the case of IEC type, x: slot number)
(a) If a parameters setting error occurs, address No.22’s error code will not be automatically
erased even if parameters are changed correctly. At this time, turn the ‘error clear request’ bit
ON to delete address No.22’s error code and the error displayed in XG5000's [System Monitor].
In addition, RUN LED which blinks will be back to On status.
(b) The ‘flag to request error clear’ shall be used surely together with UXY.00.0 attached thereon

for guaranteed Normal operation.
% XGB PLC base number is 0

B15 B14 B13 B12 Bl11 B10 B9 B8 B7 B6 B5 B4 B3 B2 Bl BO

UXY.11.0 E
—_— - — J— J— J— p— p— J— J— — p— — J— p— C
(%UX0.x.11 R

!

Flag to request error clear (UXY.11.0)
Bit ON (1): Error clear request, Bit Off (0): Error clear standing-by

La uao1.0 ugo.ao.n ugo1.0
{4 {Im R
Errar Clear Errar Flag Errar Clear
= Fequest Reguest
[How to use the flag to request error clear (“S” type or “H” type)]

U¥0.1.178 RUXD1.0 BK0.1.178
| 1 | | R
.ﬂ\nélulg .f'.nlalulg hnalog
Imput [mput Input
Module: Modu le: Module:
Error Module Error
Clear Error Clear
Request Request

[How to use the flag to request error clear (IEC type)]
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2.12.2 Operation parameters setting area

Setting area of A/D conversion module’s Run parameters is as described in Table.

Memory address Details R/W Remark
Hex. Dec.

Oy 0 Channel enable/disable setting R/W PUT
1, 1 Setting ranges of input RIW PUT
voltage/current
2y 2 Output data format setting R/W PUT
3, 3 Filter processing enable/disable RIW PUT
setting

4y 4 CHO filter constant

54 5 CHJ1 filter constant

64 6 CH2 filter constant RIW PUT
" 7 CH3 filter constant

Cy 12 Average processir)g enable/disable RIW

setting

Dy 13 Average processing method setting | R/W

Ey 14 CHQO average value PUT
Fy 15 CH1 average value RIW

104 16 CH?2 average value

11y 17 CHS3 average value

164 22 Error code R/W GET

% R/W is to denote Read/Write if available from PLC program.

(1) Setting operation channels
If the channel to use is not specified, all the channels will be set to Prohibited.

bitl5 bitl4 bitl3 bitl2 bitll bitl0 bit9 bit8 bit7 bit6é bit5 bit4 bit3 bit2 bitl bit0

CH.|CH.|CH. |CH.

Setting channel to use (bit)
Bit On (1): Run, Bit Off (0): Stop
(2) Setting input range
The range of analogue voltage input is DC 0~10V, the range of analogue current input is DC
4~20mA.

Address 1

bitl5 bitl4 bitl3 bitl2 bitll bitl0 bit9 bit8 bit7 bit6 bit5 bit4 bit3 bit2  bitl bit0

—|—|—|—|—|—|—]—]| CH3 CH.2 CH.1 CH.0

Ye

Setting input range (bit)
- 00: 0 ~ 10V(4 ~ 20mA)
- 01: 0 ~ 20mA

- 11: 4 ~ 20mA
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(3) Setting output data type
(a) The range of digital output data for analogue input can be specified for respective channels.
(b) If the output data range is not specified, the range of all the channels will be set to 0 ~ 4000.

Address 2

bitl5 bitl4 bitl3 bitl2 bitll bitl0 bit9 bit8 bit7 bit6é bit5 bit4 bit3 bit2 bitl bit0

—|—|—|—|—|—|—]—]| CH3 CH.2 CH.1 CH.0

Ve

Setting output data type (bit)
- 00: 0 ~ 4000
- 01: -2000 ~ 2000
- 10: 0 ~ 1000(400 ~ 2000/0 ~ 2000)
- 11: 0 ~ 1000
(4) Setting filter process
If the filter process is not specified, the filter process of all channels will not be executed.

bitl5 bitl4 bitl3 bitl2 bitll bitl0 bit9 bit8 bit7 bit6 bit5 bit4 bit3 bit2  bitl bit0

CH.|CH.[CH. |CH.
312|110

\_—_V.—J

Setting filter process (bit)
Bit On (1): used, bit Off (0): not used

(5) Setting filter constant
When using the filter process, specify the filter constant.

bitl5 bitl4 bit13 bitl2 bitll bitl0 bit9 bit8 bit7 bit6 bit5 bit4 bit3 bit2 bitl bit0
Address 4 CH.O0 filter constant
Address 5 CH.1 filter constant

Address 6 CH.2 filter constant

Address 7 CH.3 filter constant

(6) Setting average process
If the average process is not specified, the average process of all channels will not be executed.

Address 12

bitl5 bitl4 bitl3 bitl2 bitll bitl0 bit9 bit8 bit7 bit6 bit5 bit4 bit3 bit2 bitl it0

CH.|CH.|CH. |[CH.
312|110

\_—_V.—J

Setting average process (bit)
Bit On (1): used, Bit Off (0): not used
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(7) Setting average process method
This area is used to specify average processing method, where ‘count average’ and ‘time

average’ are available.

Address 13

bitl5 bitl4 bitl3 bitl2 bitll bitl0 bit9 bit8 bit7 bit6é bit5 bit4 bit3 bit2 bitl bit0

——|—|—|—|—|—]—]| CH3 CH.2 CH.1 CH.0

Vv

Setting average process method (bit)
- 00: count average
- 01: time average

(8) Error code (address 22)

(a) It saves the error code detected from A/D conversion module.
(b) Error type and details is as below.

bitl5 bitl4 bitl3 bitl2 bitll bitl0 bit9 bit8 bit7 bit6 bit5 bit4 bit3 bit2 bitl bit0
Address 22
‘—|—‘—|—‘—|—‘—|—‘ Error code

Error code (Dec.) Details Remark
0 Normal operation RUN LED flickering
50# Exceeding of filter constant setting range
60# Exceeding of time average setting range Flickering RUN LED per
70# Exceeding of Frequency average setting | 1 second
range
80# Setting error of analogue input range

3% # of the error codes stands for the channel with error found.

(c) If 2 or more errors occur, the module sill not save other error codes than the first error code

found.
(d) If an error found is corrected, use the ‘flag to request error clear’, or let power OFF - ON in

order to stop LED blinking and to delete the error code.
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2.13 Example Program

2.13.1 Program to sort A/D converted value in size

(1) System configuration

System information
=@ Base 0 : XGB-MOBA

[l cPuU. ¥GB-XEMS
[Ho siot 0: Intemal Cret
[Hlo Slot 0: XBM_DN325

Assigns Information - Fixed Location

[POODO ~ POO3F]

Comment

Main Base(8 Slots)

Standard CPU Module{l/0: Maxdmum 1,024 Points)
Intemal Cnet Module, RS-232C/RS5-485

DC 24V Input, Transistor Output, 32 Contacts

|Z|I Slot 1: XBF_ADD4A [POD40 ~ POOTF] A/D Voltage Input Type(d Channels)
|Z|2 Slot 2: Empty slot [POO20 ~ PO11F]
|Z|3 Slot 3: Empty slot [P0120 ~ PO15F]
|Z|4 Slot 4: Empty slot [PO160 ~ PO1SF]
|Z|5 Slot 5: Empty slot [PO200 ~ PO23F]
[Hs Slot 6: Empty slot [P0240 ~ PO27F]
[H7 Slot 7: Empty slot [PO280 ~ PO31F]
(2) Initial setting
. Internal memory | The value to write in
s 1 DEELS address internal memory
1 Channel Cho, Ch1, Ch2 0 h0007
2 Input voltage range | 0~ 10V 1 h0000
3 Output data range | 0 ~ 4000 2 h0000
4 Filter process Cho 3 h0001
5 Cho filter constant | 50 4 50
6 Average process | Chl, Ch2 12 h0006
Average process Frequency average: Chl
6 method Time average: Ch2 13 h0100
Frequgncy average value: 15 100
100 (times)
! Average value Time average value:
200 (ms) 16 200

(3) Program
(a) If Ch O’s digital value is less than 3000, Contact No. 0 (P00080) of relay output module

installed on Slot No.2 will be On.

installed on Slot No.2 will be On.

(b) If CH 1’s digital value is greater than 3200, Contact No.2 (P00082) of relay output module

(c) If CH 2’s digital value is greater than or equal to 3000 and less than or equal to 3200, Contact

No.4 (P00086) of relay output module installed on Slot No.2 will be On.

on Slot No.2 will be On.

(d) If CH 2’s digital value is equal to 3200, Contact No.5 (P00085) of relay output module installed
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(4) Program
(a) Program example using [I/O Parameters]
d eS|

Default Slot todule Comment Input Filter Emergency Output Allocation
ENIE
#BF-AD04A (Volt/Curre
¢ XBF-DV044 (Vaoltage, ¢
» Default
! Default
» Default
: Default
» Default

HBF-AD044 [Volt/Current, 4- - - POOD40 ~ POOOTF
HBF-DV044 [Voltage, 4-CH) - - POODB0 ~ POOTIF

o || e o] =

KT [E—

Delete Slot | Delete Base | Base Setting Delete All Details | Brint Vl 0K I Cancel

F-AD044 urrent, 4-CH} 2 x|

#BF-ADD4A (Waolt/Current, 4-CH)

Farameter CHO CHA1 CHZ CH3
[ Channel status Disable Disable Disable Disable
[ Inputrange 010 01 00 010V 010V
Qutput type 0--4000 0--4000 0--4000 0--4000
[" Filter process Enable Disable Disable Disable
Filter constant 1 1 1 1
[T Average sefting Disahle Enable Enable Disahle
[ Average processing|  Count-fyr Caunt-Awr Tirne-fwr Court-Avr
Average value 2 2 a 2

(0] 4 I Cancel

uan.otF Foooo maoad
1] f {P ¥ [y oa—
Mooo1 uotr.01.0 - U102 000 | Foog0
I
Analog Input Analog Input
hodule: odule:
4 CHO Active CHO Cutput
1,011 Poog2
= o1.03 3200 I
Analog Input Analog Input
Module: Module:
CH1 Active CH1 Cutput
uo1.01.2 _ mMOooz
== o1.04 3000 I
Analog Input Analog Input
Module: Module:
CH2 Active CH2 Cutput
= UD1.04 3200 | PO0sE
I
Analog Input
Module: Data no. to read
CH2 Output
Read error code [ oeT 1 7 Dooon p I—
moonz = uo.04 3200 | PODBS
I
A”;'Udg 'lnp“t Slot no. Internal  Device for
odule: :
CHZ Output memory  saving
30 address
EMD
34

[Program in case of “S” type or “H” type]

2-35
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— . e
-—_»_|-__I_ ' B E
_"H_ BE —

2

_|T_£__£

[Program in case of IEC type]
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(b) Program example of PUT/GET instruction used

UO1.ODF  wonoo [ PutP 1 i hooo? |
I 1T
Annilnodgullgpm Channel assignment
(Cho1,2)
Module
Ready
[ Putk 1 1 [ 1 1 mouttme tvaltages
PUTP 1 2 hooao 1 L Output type (0~4000)
[ FUTF 1 3 hoo0T 1 1 Fitter process cnm
PUTP 1 4 50 1 Fitter constant tenm
| PUTP 1 12 hO00g 1 L Average process (Chl, 2
Ch1: Count average
4‘ PUTP ! 13 hoioo ! L Ch2: Time average
[ Purp 1 19 100 1 L Ch1 average value
. PUTP 1 16 200 1 L Ch32 average value
Channel Run signal
uoo.otF POOOO Mooo1
0 f {pt 55—
oot un1.01.0 - o1 02 000 | FO080
I
Analog Input Analag Input
hiodule: hiodule
4 CHDO Active CHO Output
uor.o1 . o103 3200 I PO0g2
Analog Input Analog Input
Module: hodule:
CH1 Active CH1 Output
uot.01.2 _ Mooz
= o104 3000 I —
Analog Input Analog Input
Module: hfodule:
CH2 Active CH2 Output
— FO0BE
= uo1.04 3100 I —
Analag Input
Module:
CHZ Output
[ eET 1 72 D000 |
M0oo2 = uo1 04 200 | Foogs
Analog Input
hodule:
CH2 Cutput
30
EMD
34

[Program in case of “S” type or “H” type]
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TR THSTE T
_01_RDY EMD PUT_WORD FUT _WORD PUT_WORT
|} P} RED DONE REQ ~ DONE RED~ DONE}
0 lBasE sTaT) 0 JeasE sTaT) 0 lpase sTaT)
st 1 st i dstor
0 {MADD 1 Jwamo 2 lwmo
| R R R
7 JDATA 0 J{oata 0 Joata
| INST4 IN3TS INSTS
PLT_WORD FUT_WORD PLT_WORD
RED ™ DONE FED ™ DONE RED ™ DONEL
0 JBASE sTAT) 0 JeasE sTaT) 0 JBasE sTaT)
| Jswor 1 dswor i dsor
3w 4 dmaoo 12 {wadD
| R R R
i lDATA 50 {oaTA 1GRO006  {DATA
| INST? INSTE INSTY
PUT_WORD FUT_WORD PUT_WORD
RET ~ DONE FED ™ DONE RE ™~ DOME|
0 JBASE STAT| 0 Jease sTaT| 0 JBASE STATL
| dswor T T | dstor
13 Imaoo 5 Iwaoo 15 {MaDD
| R A R
160100 {DATA 00 Joata 200 {DATA
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L
—i I h_ I-__I_ = B
—_”_|-_I -
— —{= = —
_| T_ B _-:'
[Program in case of IEC type]
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2.14 Troubleshooting

2.14.1 RUN LED flickers

RUN LED flickers.

4 L

RUN LED flickers every 0.2 sec.

Yes

Ef

RUN LED flickers every 1 sec.

> It seems to be a module defect.

Contact IMO Precision Controls technical support

> It is Run parameters setting error. Check the error code to

Yes
take action against as follows in the table below.
Error code ; f
(Dec.) Error Details Action
50# Filter constant setting Change filter constant setting value within 1 ~ 99.
range exceeded
Time average setting Change time average setting value within 4 ~
60#
range exceeded 16000.
Frequency average Change frequency average setting value within 2
70# .
setting range exceeded | ~ 64000.

[J # indicates channel number.



Chapter 2 Analogue Input Module

2.14.2 RUN LED is off

RUN LED is off.

s

A/D conversion module is installed on the base
correctly?

No > Correctly install A/D conversion module on the base.

ki

I/0 information can be seen at the XG5000.

No > Contact IMO Precision Controls technical support

i

Normally operated if A/D conversion module with
error is changed to another module

Yes > Contact IMO Precision Controls technical support
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2.14.3 A/D conversion value is not normal

A/D conversion value is “0".

-

Channel status is set as Enable.

o

hi

External power (DC 24V) is supplied.

> Check and correct the channel status on the 1/O parameter.

o

A

Wiring of each channel is normal.

Supply external power (DC 24V)

o

i

Input voltage/current of external terminal
block is normal.

Refer to 2.8.2 and wire properly.

(0]

'

Check the status of the external input sensor
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2.14.4 Status check of A/D conversion module throug  h XG5000 system monitor

Module type, module information, OS version and module status of A/D conversion module can be
checked through XG5000 system monitoring function.

1) Execution sequence

Two routes are available for the execution.

(1) [Monitor] -> [System Monitoring] -> And on the module screen, click the right mouse button to
display [Module Information].

(2) [Monitor] -> [System Monitoring] -> And Double-click the module screen.

2) Module information

(1) Module type: shows the information of the module presently installed.

(2) Module information: shows the OS version information of A/D conversion module.
(38) OIS version: shows the OS prepared date of A/D conversion module.

(4) Module status: shows the present error code. (Refer to 7.1 for detailed error codes)

Module Info. - XBF-ADO4A (Volt... EJE|

Dretails Content |
Module Mame | #BF-AD0428 [oltCurrent, 4-
05 Wer Wer, 1.10

05 Update Date | 2008-5-23
Module Statue  [Mommal. [0

Close
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Chapter 3 Analogue Output Module

3.1 Setting Sequence before Operation

Before using the analogue output module, follow steps below.

XBF-DVO4A / XBF-DCO4A

Checking performance specification I—o Specification
®  Operating environment

® Digital input range
® Analogue output range

System configuration and selection ——® System configuration

® Max. No. equip-able
®  Selecting the external power

Wiring I—‘ W|r|ng
®  Wiring (external DC24V)

® Analogue output wiring

Checking analogue output data ———@ Analogue output test
® XG5000 special module monitor
test mode
Setting parameter ———— @ Parameter

® XG5000 I/O parameter

Programming I—. Programming

®  Program for writing digital data
(U device)

If there is error or analogue output
is abnormal, refer to the trouble shooting.




Chapter 3 Analogue Output Module

3.2 Specification

3.2.1 General specifications

Here is the general specification of the analogue output modules.

No. Items Specification Reference
1 Ambient Temp. 0~55°C
2 Storage Temp. -25~+70°C
3 Ambient humidity 5 ~ 95%RH (Non-condensing) -
4 Storage humidity 5 ~ 95%RH (Non-condensing)
Occasional vibration -
Frequency Acceleration Pulse width Times
10 < f < 57Hz - 0.075mm
_ 57 < f < 150Hz 9.8m/s’ (1G) - 10 times
5 Vibration - —
Continuous vibration each
Frequency Acceleration Pulse width direction
IEC61131-2
10 < f < 57Hz - 0.035mm (X,Y and 2)
57 < f < 150Hz 4.9m/s?(0.5G) -
« Peak acceleration : 147 m/s?(15G)
6 Shocks « Duration : 11ms
 Pulse wave type : Half-sine (3 times each direction per each axis)
Square wave
) ) 41,500 V IMO standard
impulse noise
Electrostatic _ IEC61131-2
) Voltage: 4kV (Contact discharge)
discharge IEC61000-4-2
) Radiated
7 Impulse noise ) IEC61131-2,
electromagnetic 27 ~ 500 MHz, 10V/m
) ) IEC61000-4-3
field noise
. Classifi- Power Digital/Analogue Input/Output,
Fast transient . L IEC61131-2
. cation supply Communication Interface
/Burst noise IEC61000-4-4
\oltage 2kV
Operation ) .
8 ) Free from corrosive gases and excessive dust
ambience
9 Altitude Less than 2,000m -
10 Pollution degree Less than 2
ik Cooling method Air-cooling
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3.2.2 Performance specifications

Here describes performance specification of analogue output module.

tem Specification
XBF-DVO0O4A XBF-DCO4A
Type Voltage Current
Analog " ) DC 4 ~ 20mA
ue DC 0~ 10V
Range . DC 0~ 20mA
output (Load resistance: 2kQ or more) .
(Load resistance: 510Q or less)
Type 12-bit binary data
Signed value 0 ~ 4000 0 ~ 4000
Digital
. g Unsigned value -2000 ~ 2000 -2000 ~ 2000
input Range
Precise value 0 ~ 1000 400 ~ 2000/0 ~ 2000
Percentile value 0~ 1000 0~ 1000
Maximum resolution 2.5mvV (1/4000) 5/A (1/4000)
Accuracy +0.5% or less
Maximum conversion speed 1ms/channel
Absolute maximum output DC 15V DC +25mA
Number of maximum channel 4 channels
. Photo-coupler insulation between input terminal and PLC power
Insulation method . .
(no insulation between channels)
Terminal connected 11-point terminal block
I/O points occupied Fixed type: 64 points
Current Internal (DC 5V) 110mA 110mA
oo Exteral 70mA 120mA
tion (DC 21.6 ~26.4V)
Weight 649 709

Offset and gain about analogue output range have been set at the factory and the user can change them.
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3.3 Designations and Functions

Here describes designation and fu

nctions.

XBF-DV0O4A
RUN @

-~
v

XBF-DCO4A
RUN

=
-— =] < ® N
i) | »
" %
=[=
Lles
-
DC24)

XBF—DV0O4A

0O (9}

I

(9}
jusy

PR AR

+

DC:
T

|'|'§

XBF—DCQO4A

¢

=0

No. Description

RUN LED

@ | - on: Normal operation status
- Flickering: Error occurred
- Off: Power off or abnormal status

It displays the operation status of D/A conversion module

of the module

Analogue output terminal (Voltage,
Current)

It is an output terminal to connect an analogue output (Voltage, Current) of
each channel to external machinery and tools.

External power input terminal

® | Itis an external DC 24V input term
output (voltage, current).

inal that supplies power for an analogue
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3.4 Characteristic of I/O Conversion

Characteristic of I/O conversion converts a digital input into an analogue output (voltage, current) and
displays a straight line with the gradient as shown below. The range of digital input is shown with
Unsigned Value, Signed Value, Precise Value, and Percentile Value such as the graph below.

-«———  Digitalinputrange @—»
20mA 20mA 10V
&, Gain T
value
>
3
[y
o]
«Q
o
Analog | 101 1oma sv g
output °
o
3
«Q
(]
OmA 4mA 0V { i
Offset value
Unsigned value | -48 0 2000 4000 4047
Singed value | -2048 -2000 0 2000 2047
Digital 12 0 500 1000 1011
input Precise value | 381400 1200 2000 2018
24 0 1000 2000 2023
Percentile value | -12 0 500 1000 1011
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3.5 Characteristic of Input/Output

The range of a voltage output is DC 0 ~ 10V and a current output is DC 4 ~ 20mA / DC 0 ~ 20mA.

XBF-DVO4A (Voltage, 4-CH) 1 Wl x5F-DCosA (Curent, 4-CH) EAES
~BF-DV044 (Moltage, 4-CH) ¥BF-DC04A [Current, 4-CH)
Paiameter CHO [ cH1 £H2 tHe | Parameter CHO | CH1 £H2 cHa |
[ Chanrel status Disable ¢ Dizable [Diizable Disable [~ Channel status Dizable Disable Dizable Disable
[ Outputrange o~ :J o1 oo 0o [ Output range 4~ 20ma :J 4720ms 1 4720mA | 4720ma
|nput type i 04000 04000 04000 Ihput type: 074000 074000 4000
CH. Output type Former walue | Former walue | Former value : H Fomer value ;

ormer value | Former value

Ok I Canceal | Ok | Cancel
Digital input value toward analogue voltage output is shown below.
Resolution: 2.5mV (1/4000), Accuracy: within £0.5%
The range of Analogue voltage output
digital input under OV ov 25v | sv | 75v | 10v over 10V
Unsigned value
nder O 0 1000 | 2000 | 3000 | 4000 over 4000
(-48 ~ 4047) ! Y
Signed value under -2000 2000 1000 0 1000 | 2000 over 2000
(-2048 ~ 2047)
Precise value under 0 0 250 | 500 | 750 | 1000 | over 1000
(-12 ~ 1011)
Percentile value under 0 0 250 | 500 | 750 | 1000 | over 1000
(-12 ~ 1011)
Digital input value toward analogue current output is shown below.
Resolution: 5pA (1/4000), Accuracy: within £0.5%
Analogue current output
The range of
digital input under 4mA 4mA 8mA 12mA | 16mA | 20mA over 20mA
under OmA OmA 5mA 10mA | 15mA | 20mA over 20mA
Unsigned value under O 0 1000 2000 | 3000 | 4000 over 4000
(-48 ~ 4047)
Signed value
'gned vai under -2000 | -2000 | -1000 | O | 1000 | 2000 | over 2000
(-2048 ~ 2047)
. under 400 400 800 1200 | 1600 | 2000 over 2000
Precise value
(381 ~ 2018, -24 ~ 2023)
under 0 0 500 1000 | 1500 | 2000 over 2000
Percentile value
nder 0 0 250 500 750 1000 over 1000
(-12 ~ 1011) . v
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3.6 Accuracy

Though the range of input is changed, the accuracy for the analogue output values doesn’t change. The
range of accuracy is displayed at the ambient temperature of 25 + 5 C if you select unsigned value as
your range of the digital input. The accuracy is satisfied +0.5%.

20.1mA 1005V ——J—Fo——mm—mmmmmm e
A Y

>

=}

5

S 10mA 5V

o

C

g

g

0.1mA 0.05V -~ -

0.4ma "™ Lo.0sv Y[

0 2000 4000
Digital input

(1) Accuracy in case of 5V output
4000 x 0.5% = 20
So in case of 5V output, accuracy range is (5V - 20x0.0025V) ~ (5V+20x0.0025V) = 1980 ~ 2020.

(2) Accuracy in case of 10V
4000 x 0.5% = 20
So in case of 10V output, accuracy range is (4000-20) ~ (4000+20) = 3980 ~ 4020.
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3.7 Functions of Analogue Output Module

Here describes functions of XBF-DV04A/DC04A module.

Function Details
Operation 1) It sets up Run/Stop of a channel that will operate an analogue output.
channel 2) You can save the time of whole operation by stopping unused channels.

1) It sets up the range of an analogue output.
The range of | 2) Analogue voltage output module offers one range of output (DC 0 ~ 10V)
output and analogue current output module offers two (DC 4 ~ 20mA, DC 0 ~

20mA).

The range of | 1) It sets up the range of a digital input.
input data 2) It offers four ranges of a digital input.
The status of | 1) It sets up the output status of a channel when it switches Run to Stop.
channel output 2) It offers four types of output status.
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3.8 Wiring

3.8.1 Precautions for wiring

(1) Use separate cable of an A.C. power line and an external output signal of an analogue output
module to prevent a surge or inductive noise from the A.C. side.

(2) Select the cable with consideration of an ambient temperature and a permitted current limit. It is
recommended over AWG22 (0.3m),

(3) Don't let the cable at close range to hot devices or materials. And don't bring it into contact with
oil for a long time. These are the factors of a short circuit occurs unusual operation or damages
devices.

(4) Check the polarity before external power is supplied to the terminal.

(5) It may produce inductive hindrance that is a cause of unusual operations or defects if you wire
the cable with a high-voltage line or a power line.

3.8.2 Wiring example
(1) Wiring example for analogue voltage output module

XBF-DV04A Motor driver etc.
CHO+
Over 2kQ
—1 CHO
CH1+
D/A . @®— CHL
Conyer§|on CH2+ Motor driver etc
circuit
®— CH2
CH3+
@— CH3-
ﬂ? v »
DC/DC Hoc +24 |———— DC +24V

g Conversion circuit H bcov ———DC 0V

(2) Wiring example for analogue current output module

XBF-DCO4A Motor driver etc.
- — _I__I -
cHo | I Under
CHo- | ! sta
-
CH1+ L ——J
GND
D/A . p—
Con_ver§|0n CH2+ Motor driver etc.
circult
CH2- - — _I_.I _
R | ! Under
CH3- | 510Q
=
T x |
GND
DC/DC L bc+2av——— DC +24V

g Conversion circuit — pcov —— DC 0V

[11: Use a 2-core twisted shielded wire.
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3.9 Operation Parameter Setting

You can specify operation parameters of the analogue output module through [I/O parameters] menu in
XG5000.

(1) Setting items

For the user’s convenience, XG5000 provides GUI (Graphical User Interface) for parameters setting of
analogue voltage/current output module.
Followings are available through [I/O parameters] on the XG5000 project window.

Iltem Details
[I/O Parameters]

(1) It specifies the following items for the module operation.

— Channel Enable/Disable

Analogue output range
— Input type

- Channel output type
(2) After the parameters that user specified in XG5000 are downloaded,

they will be saved to a flash memory in the CPU unit..

(2) How to use [I/O Parameters] menu

(a) Run XG5000 to create a project. (Refer to XG5000 program manual for details on how to create
the project)

(b) Double-click [I/O Parameters] on the project window.

@ ¥55000 - MewProgram

§Eroject Edit Find/Replace Wiew Online Monitor C

B |4 A dBF e
Est| F3 4 sF1 sk2

| Proect Window

lterns
=-8F Sample =
- NewPLC{XGK-CPUH-OF,., —
29 Variable/Comment
=-[# Parameter
P B

5 _Fa aramete
: i |/0 Parameters

= Scan Program
MewProgram

(c) Click the slot of the base that contains analogue output module in the [I/O Parameter Setting]
window. In the example, the anolog output module is contained in the slot 1.

I/O Parameter Setting - Variable allocation Bed 3

Module [ist

|¥

=7 Base 00 : Default
i g 00 Default
g1 Default
oz 02 1 Detault
oz 03 1 Default
gz 04 Default
= 05 1 Default
oz 06 : Default
gz 07 1 Default
= 08 : Default

Module ‘ Comment | Input Filter | Emergency Dulpul‘ Allocation ‘

oz 09 1 Default

oz 10 Default

ez 111 Default =
{3 Base D1 : Default
7 Base 02 : Default
3 Base 03 : Default =

: =
EFCEEEEEE O

[

=

&
-
+)-

Delete 5ot | Delete Base Baseﬁeﬂing_l Delate all | Details Print YI Q. I Cancel

3-10
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(d) Click the arrow button then you can see the menu to choose the applicable module. Select the

Module list

= Base 00 : Default | st | Module | Comment | IrputFiter | EmergercyOuput | Mosation |

= Default Dimain !
-z O ¢ Default g

! Default & il %
[ Special Module List b i i
ﬁ Analog Input Madule

= 02!
ez 031 Default
= 04 1 Default
ez 081 Default
= 06 ! Default
e U7 1 Default

Diigital Madule List

[Rug H)
" [ EF-DCO44 [Current, 4CH)
@[ Temp. Measuring Module

+1 B, Communication Module List

| [ o fe oo |

Rebe————
Delete Siml e ils Brint ¥ 0K Cancel |

(e) Double-click the applicable slot that is selected for the parameters setting or click [Details].
1/O Parameter Setting 21 x|

Madule list

=0 Base 00 : Default | Slot | Module: Comment Iriput Filker Emergency Dutput Allocation
g 00 Default Dlrmain] i
& 01 =BF-DVD4A (Maoltage, ¢
e 02 ¢ Default
ozp 03 ! Default
ez 04 ¢ Default
‘o 05 ¢ Default
{ozp 06 ! Default
“z 07 ¢ Default

| ——1

Delata Slot | [elete Baze I Base i-ztnngl Delste &l Details Brint ¥ | 818 I Cancel

(f) A screen will be displayed for you to specify parameters for respective channels as shown below.
Click a desired item to display parameters to set for respective items.

/G Parameter Setting 2x]
Module list
=00 Base 00 ¢ Default Slot Module [ Commet Input Filter | Emergancy Duutput Allocation |
= ezp 00 + Default Olmain] H
Ly gé d DXEF-IDVDM iWaltage, ¢ 1 XBF-DVD4& Vollage, #CH] - - FO0010 ~ PODGIF
g 02 Default 2 R - —
- 03  Defaut - VA (Voltage, 4-CH) N, 2l xl
‘e U4 : Default - KBF-DWD44 (Voltage, 4-CH)
gz 05 ¢ Default
-z 06 ¢ Disfault 5 Farameter CH D TH CHZ tH3 |
" 07t Default & T Channel status Disable Disable Disable Disable
7 ™ Output range oY Y RNy 010V
Irput type 04000 04000 04000 04000
™ CH. Dutput type Fommer walue | Fomer valus - Former value | Former walue
S ——1
Delete Slat b K. | Cancel
Cancel
[ |
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3.10 Special Module Monitoring Functi  on

You can start to test the analogue output module connecting by [Online] - [Connect] and then click
[Monitor] = [Special Module Monitoring] menu in XG5000.

Remark

1) If the program is not displayed normally because of insufficient system resource, you may start

XG5000 again after close the program and other applications.

2) /0 parameters those are specified in the state of [Special Module Monitoring] menu are temporarily
set up for the test. They will be disappeared when the [Special Module Monitoring] is finished.

3) Testing of [Special Module Monitoring] is the way to test the analogue output module. It can test the

module without a sequence program.

3.10.1 How to use special module monitoring

Special module monitoring function is described below based on the analogue voltage output module
(XGF-DV04A).

(1) Start of [Special Module Monitoring]
Go through [Online] = [Connect] and [Monitor] = [Special module Monitoring] to start. If the

status is not online, [Special Module Monitoring] menu will not be activated.

[#] Project Edit Find/Replace View Online [Monitor| Debug Jools Window Help

| = @ startfstop Monitoring 2% i@

D=zaEa o [@me

o OEe | &9 | %KD e =S )
== o 12 Pausing Conditions
el A e ][]
| Praject vifindow I'f
lems [iE]
=5 Sample - [Z3] Device Monitoring
=6 MewPLC{XGB-XBMS)-Stap @ Special Module Monitoring .
23 Varlable/Comment {4y Trend Monitoring
- Parameter [ Custom Events

B Basic Parameters =

-G |/0 Parameters & Data Traces
Internal Parameters

Scan Program

“[F] MewPragram

(2) How to use [Special Module Monitoring]

(a) Connecting XG5000 with PLC basic unit, [Special Module List] window will show base/slot
information and types of special module by click [Monitor] > [Special Module Monitoring].
Special Module List wiil display the modules that are installed in PLC now.

Special Module List x|
Base | Slot | Module
@ Base 0 ﬂ_ Internal HSC Module (Open-Collector, 4-CH)
) Base 0 ﬂ Internal Position Module (Open-Collector, 2-CH)
@ Base 0 ﬂ Slot 1 *BF-DW04& (Moltage, 4-CH)
@ Base 0 ﬂ Slot 2 *BF-D%048 (Voltage, 4-CHY
4| |
{MTGdiTE Trito, taonitor Close |
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(b) Select a special module then click [Module Info.] button to display the information as described
below.

ial Module Infornation

2]
[l Displays the informations of special madule,
g e :

Item Information |
Module Hame o BE-DYVDAA Maltage, 4CH)
05 Ver

05 Update Date 2006-5-18
Ennor Status e O ETTOE (0]

(c) Click [Monitor] button in the [Special Module List] window to display the [Special Module
Monitor] window as below
Special Module Monitor ed ]

XBF-DV044 (Valtage, 4-CH)

|tem Setting value Current valug
CHO D /& value:
CH1 D#A value
CHZ D/A value
CH2 D/A value

Itern Settng value Current value
Channels / CHO
Chatinel status

Output range o~10

Input type 0~4000
CH. Output type

Parameter setting for a test

Digital walue:

Output enable
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(d) [Start Monitoring] button will show you digital input data of the operating channel.

Special Module Monitor 21
#BF-DVO44 (Maltage. 4-CH) /\
|tem Setting value y Current value

CHO D& walue:
CH1 D44 walue

CH2 D4 value
CH3 DA walue

Itermn Setting value Current value
CHO

Channelz

Channel status

Output range 010 o~10
Input type 0~4000 04000
CH. Dutput type
Digital value:

Output enable

Stop Monitoring' Test |

Clase

Monitoring screen

Details of channel 0

(e) [Test] is used to change the parameters of the voltage output module. You can change the
parameters when you click the values at the bottom of the screen. It is only available when

XGB CPU unit’s status is in [Stop Monitoring].
ial Module Monitor 2 x|

XBF-DV04A (Valtage, 4-CH)

Item Setting value Current value
CHO DA value: 2000
e
CH2 DA value

CH3 DA value
Itermn Selting value Current value
Channels CHO
Channel status i
Output range
Input tupe 0~4000 0~-4000
EH. Dutput type " Former value Fomer valle
i i
e Dt D
Test |

~48--4047 Close |

(f) [Close] is used to escape from the monitoring/test screen.
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3.11 Register U devices (special module variable)

Register the variables for each module referring to the special module information that is set in the I/O
parameter. The user can modify the variables and comments.

(1) Registration sequence
(a) Select a special module type in [I/O Parameter Setting] window.

1/O Parameter Setting

Madule list

= ﬂ Base 00 : Default | Slot | Module: | Comment Iriput Filker Emergency Dutput Allocation ‘
g 00 Default Dlrmain] i i
& 01 XBF-DVO4A (Woltage. ¢ X ¥ B R
e 02 ¢ Default i
iz 03 1 Default : b
ez 04 ¢ Default
‘o 05 ¢ Default
{ozp 06 ! Default
“z 07 ¢ Default

| ——1

Delata Slot | [elata Easel Base i-mmgl Delste &l | Details | Print ¥ | 818 I Cancel

b) Double-click [Variable/Comment] from the project window.
[Variable/Comment]

ﬁ; Project Edit Find/Replace Wiew Online Monitor Debug Tools Window Help
DadS 8 a6 BE D 20 BREX KLY AAFKL 2 e
GO0 A0 ¢ex 20AGEEAUES OO Puluoy ERETE

EHHE Y ha st aReRs cnEREEEG RD DB @ al 5| &
| Project windows - : -
: otie I l [V wiew variable IE Wiy Device l [ ] ieats Fla ]
=8 Sample - Yariable Twpe | Deviee | Conment:
= @ NewPLCIXGE-#BMS)-Of .. 1

Elﬂ Pararmeter

Basic Parametars
B /0 Parameters

+1- M6 Internal Device
=& Scan Program
MewProgram

(c) Select [Edit] > [Register U Device].
In case of IEC select [Edit] >[Register special module variable]

i, _55.;sr:ggé%xfuﬁ§<,,‘i‘£s<“ MR HSE L ee
SEeaBHEM=EE T Fo g SEamMe

Ctrl+X

CuleC  Mr 8 G G o B B En 20D E &l 7] %
W ; Del [V | ¥iew Variable ],_| Wigtil Device ]Lﬂmew Flai I
5@ Tam §E|ec'f All Ctrl+A Yariable Tvpe Device Conment
g @ I Insert Line Ctrl+L 1

“§ B Deleteline  Ctrl+D
Export to £|Ie...
Register U Device
Internal Device

-
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(d) Click ‘Yes'.

L 65000 - [Variable/Commant]

i3 Project Edit Find/Replace View Online Monitor Debug Toels Window Help

Neads|s|

L EHE D

e - B S
DO |G| FyEy LLACHBEIUEE

HMARWE

B e T A

—+11

10

| & G
" EREOE =

=

| Project Window

- x|

lterns

i =-EF Sample =
E-@P NewPLC{XGB-XBMS)-0f,

29 Wariable/Comment
[ Parameter
E Basic Parameters
- /0 Parameters
@ Internal Device
&) Scan Program

2 MNewProgram

_omment]

' | Wiew ¥ariable: I:E‘ iy Dewice l iﬂil’iéuu Flag ]

Yariable

Comment

Caontinue?

Tupe '| Device |

Automatically register comments in the U Devices according to the special module set in the /O parameter.
The previous comment will be deleted.

(e) As shown below, the variables are registered.

L;a"l Project. Edit Find/Replace View Online Monitor Debug Tools Window Help

DeaoEE s aa BE D Q0 iBR X | SxsY

MWW E S
B 0 OB | B CEAOEHEIUWEE (BO0 T O[W G
andTHYEeasrmaREans nCEEE EG 25 RB| @ afio: = %

1w |
1= |

& =

=ERED®

| Project Window

< x]

lterris

i E@‘

(e
=

Sample =

) MewPLC(XGE-*BMS)-0f..

.29 Wariable/Comment
[# Parameter

: Basic Parameters
B 1/0 Parameters
H Internal Device
Scan Program

; MewProgram

V' | View Variable: l@ iew Device | [ ]biew Flag |
| Yariable Tvpe v| Device | Conment

1 _01_CHO_ERR BIT i ‘hnalog Output Module: CHO Error
2 _0_CH1_ERR BIT ‘hralog Output Module: CHY Error
3 _01_CHZ_ERR BIT “hnalog Qutput Module: CH2 Error
4 _01_CH3_ERR BIT ‘hnalog Output Module: CH3 Error
1) _01_RDY BIT dnalog Output Module: Module Ready
fi _01_CHO_ACT BIT Analog Output Module: CHO Active
i Z01_CHI_ACT BIT “hnalog Qutput Module: CHI Active
8 _01_CHZ_ACT BIT ‘hnalog Output Module: CHZ Active
g _01_CH3_ACT BIT ‘hnalog Output Module: CH3 Active
10 |_M_CHOOUTEN BIT ‘hralog Output Module: CHO Output Status Setting
11 [_O1_CHI_OUTEN BIT ‘hralog Dutput Module: CHY Output Status Setting
12 .0 BIT ‘hralog Output Module: CHZ Output Status Setting
13 | 01 CHI_OUTEM BIT ‘hnalog Output Module: CH3 Output Status Setting
14 | _0_DUTEW WORD ‘hralog Dutput Module: Output Status Setting
15 | 01 _CHO_OATA  WORD “hnalog Qutput Module: CHD Input
16 | 01 CHI_OATA  WORD thnalog Dutput Module: CHI Input
17| 01_CH2_DATA  WORD thnalog ODutput Module: CH2 Input
8| 0 CHo0ATA  UORD dnalog Dutput Module! O oot
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(2) Save variables

(3) View variables in a program

(a) The contents of ‘View Variables’ can be saved as a text file
(b) Click [Edit] > [Export to File].
(c) The contents of ‘View Variable’ are saved as a text file.

(a) The example of XG5000 is shown below.

uot.00.F
o | hv hOOOF uoi.02 ||
Ut .01.0
ey | nov 0 uo.oe ]|
uat.ot.1
| | hov EEE
Ut .01.2
| | nov I
Ut .01.3
| | nov o0 uotos |
END
19
(b) Select [View] - [Variables]. The devices are changed into variables.
01ROy :
o | nov KODDF 01 _OUTEN ||
01_gH0_AC
L | oy 0 _or_ouren ]|
011 A | Hov - _mﬂu_DL
— | .
_01_CH2_AC [ = -mﬂz-DL
_| I 1
> | wov |
— | .
END
19

(c) Select [View] - [Devices/Variables]. Device and variable both are displayed.

unt o0, F
! [ hv OO 1t i
_ni Aoy T
001.01.0 [ Hov 0 uot.o2 ||
| .
_D1_CHO4C 01_0UTE
; I
Uot.0f. [ oy 500w |
_D1_GHI4C _01_CHL
T IATA
unt, .2 o
e [ oy 0 wios |
_01_BH2_4C 0 o
T DATA
i, 0.3
L | nv w0 wioe ||
_D1_CHAAC _01_oH3_
T IATA
END
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(d) Select [View] > [Devices/Comments]. Device and comment both are displayed.

o .oo.F MY hi0oF o1.0z
[ | ]
finalog Ana |og
(utput (ut put
Module: Hodule:
Modu| & Output
Ready Status
Setting
um.or.o Moy 0 a1 .02
—| | H
hria | og
#nalog
Output MDDUJUDHJ .
Module: Tt put'
CHD Active Status
Setting
uat.o1.1 [ wov 500 uoi.03 |
| 1
! Ana log
frialog Ot put
Output Module:
Module: CHO
CHY Active | nput
uot.or.2 [ now 500 uot.os |
I 1
! [ ACE
#nia|og ut put
Output Module:
Module: CHZ
CHZ Active | nput
um.01.3 [ oy w0 wios |
L 1
! hna | og
#nalog Ot put
Output Module:
Module! CH3
CH3 Active | nput
END
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3.12 Internal memory

Describes configuration and function of internal memory

3.12.1 Data l/O area
Describes data I/O area of analogue output module

Address Address

(‘s’, ‘h’ (IEC Description Details Remarks
type) type)

Uox.00 %UWO0.x.0 Module Ready / Error g-(~135l)3|? i(t)g(nl()lz)(::'r\]ﬂ;:nuj; ?;dy avitielggle
Uox.01 %UWO0.x.1 | CH operation information S:: 8;8; gpggzz: gtl:)g

U0x.02 %UWO0.x.2 Output setting S:: 8;8; 83:53: élcl)cr)g\: d R:\fl:”/;/\éjge

U0x.03 %UWO0.x.3 | CHO digital input value

U0x.04 %UWO0.x.4 | CH1 digital input value
Uox.05 %UWO0.x.5 | CH2 digital input value

UOx.06 %UWO0.x.6 | CH3 digital input value

12-bit binary data

[1 In the device assignment, x stands for a slot number that the module is installed

(1) Module Ready/Channel Error information ( () means deice name of IEC type)
(a) U0x.00.F (%UX0.x.15): It will be ON when XGB CPU unit is powered or reset with the condition

that an analogue output module has prepared to convert.

(b) U0x.00.0 ~ U0x.00.3 (%UWO0.x.0~%UWO0.x.3): It is the flags those display error status of each

channel in the analogue output module.

U0x.00

(%UWO0.x.0)

(2) Channel operation information

(%UW0.x.1)

B15 B14 B13 B12 B11 B10 B9 B8 B7 B6 B5 B4 B3 B2 Bl BO
> c|c|c|c
S| —|—|—|—|—|—|—=|—=|—|—=|—|H|H|[H]|H
04 312|110
4 -
Module Ready Error information (bit)
- Bit On (1): Ready - Bit On (1): Error
- Bit Off (0): Not Ready - Bit Off (0): Normal
(a) This area is used to display the channel being used.
B15 B14 B13 B12 B1l1 B10 B9 B8 B7 B6 B5 B4 B3 B2 Bl BO
c|c|cj|c
— === |=|=|=|=]|=|—=|=|—=[H|H|H|H
32|10
-

Run channel information (bit)
-> Bit On (1): During Run
-> Bit Off (0): Operation Stop
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(3) Output setting
(a) Each channel can be specified enable/disable the analogue output.
(b) If the output is not specified, output of all the channels will be disabled.

uox.02

(%UWO0.x.2)

B15 B14 B13 B12 B11 B10 B9 B8 B7 B6 B5 B4 B3 B2 Bl BO

|

I

|

|

|

|

|

|

I

|

I

I
W IO
NI O
=IO
o IO

Output status setting (bit)
- Bit On (1): Allowed
-> Bit Off (0): Forbidden

(4) Digital input
(a) Digital input value can be selected and used within the range of -48~4047, -2048~2047, -
12~1011 (381~2018/-24~2023), and -12~1011 based on input type.
(b) If the digital input value is not specified, it will be set to 0.

B15 B14 Bl3| B12 B11 B10 B9 B8 B7 B6 B5 B4 B3 B2 Bl BO
Digital input Data of CHO (%UW0.x.3)

Digital input Data of CH1 (%UWO0.x.4)

Digital input Data of CH2 (%UWO.x.5)

Digital input Data of CH3 (%UW0.x.6)

% SAdd I-:??;pe) (ﬁ‘_:dg rt?/zsé) Details
U0x.03 %UWO0.x.3 Digital input value of CHO
Uox.04 %UWO.x.4 Digital input value of CH1
U0x.05 %UWO0.x.5 Digital input value of CH2
U0x.06 %UWO.x.6 Digital input value of CH3
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3.12.2 Setting area of operation parameters

XBF-DVO4A
Address —r .
(Dec) Description Details Remarks
Bit On(1): Run
0 Set up the run channel Bit Off(0): Stop
1 Set up the output voltage range | Bit (00): 0 ~ 10V
Bit (00): 0 ~ 4000
. Bit (01): -2000 ~ 2000
2 | Setup the input data type Bit (10): 0 ~ 1000 Read/Write
Bit (11): 0 ~ 1000 available
3 Set up the output type of CHO )
0: outputs the previous value
4 Set up the output type of CH1 | 1: outputs the min. value of output range
5 Set up the output type of CH2 | 2: outputs the mid. value of output range
3: outputs the max. value of output range
6 Set up the output type of CH3
11 CHO setting error
12 CH1 setting error q Read
13 CH2 setting error Error code available
14 CH3 setting error
XBF-DC04A
FORIEES Description Details Remarks
(Dec)
Bit On(1): Run
0 Set up the run channel Bit Off(0): Stop
Bit (00): 4 ~ 20mA
1 Set up the output voltage range Bit (01): 0 ~ 20mA
Bit (00): 0 ~ 4000
. Bit (01): -2000 ~ 2000 )
2 | Setupthe input data type Bit (10): 400 ~ 2000/0 ~ 2000 Read/Write
Bit (11): 0 ~ 1000 available
3 Set up the output type of CHO _
0: outputs the previous value
4 Set up the output type of CH1 | 1: outputs the min. value of output range
5 Set up the output type of CH2 | 2: outputs the mid. value of output range
3: outputs the max. value of output range
6 Set up the output type of CH3
11 CHO setting error
12 CH1 setting error Read
Error code available

13 CH2 setting error

14 CH3 setting error

(1) Setting up the run channel

If the run channel is not specified, all the channels will be set to Stop.

B15 B14 B13 B12 B1l1 B10 B9 B8 B7 B6 B5 B4 B3 B2 Bl BO
c[clcJc

—|=|—=|—=|=|—|H|H|H|H

3l2]1]o0

Run channel (bit)

- 1: Run
3-21 - 0: Stop
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(2) Setting up the output voltage/current range
The range of analogue output voltage is DC 0 ~ 10V and analogue output current is DC 4 ~ 20mA,
DC 0 ~ 20mA.

B15 B14 B13 B12 B11 B10 B9 B8 B7 B6 B5 B4 B3 B2 Bl BO

Address “1” -|—=|—=|—=|—=|—=|—=|—| cH8 | CH2 CH1 CHO

Output range (bit)
- 00: 0 ~ 10V(4 ~ 20mA)
- 01: 0 ~ 20mA

(3) Setting up the input data type
(a) Input type can be specified for respective channels.
(b) If input data type is not specified, all the channels will be set to the range of 0 ~ 4000.

B15 B14 B13 B12 B11 B10 B9 B8 B7 B6 B5 B4 B3 B2 Bl BO

Address “2” - l=l=1=]|=|—=|—=|—1| cHS3 CH2 CH1 CHO

Input data type (bit)

- 00: 0 ~ 4000

- 01: -2000 ~ 2000

- 10: 0 ~ 1000(400 ~ 2000/0 ~ 2000)
- 11: 0 ~ 1000

(4) Setting up the output type
(a) It defines an analogue output status when XGB CPU unit is stopped.
(b) The range is 0 ~3 and used devices are regarded as Words.

B15 B14 B13| B12 B11 B10 B9 B8 B7 B6 B5 B4 B3 B2 Bl BO

Address “3”
- Value
Address “6”
. Input data type (bit)
FRIEEES DEES - 00: Previous value
3 Set up the output type of CHO — 01: Min. value
- 10: Mid. value
4 Set up the output type of CH1 - 11: Max. value
5 Set up the output type of CH2
6 Set up the output type of CH3
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(5) Error code

It displays error codes of each channel.

Address “11”

Address “14”

B15 B14 B12| B11 B11 B10 B9 B8 BY

B6

B5 B4 B3 B2 Bl BO

Error code

Address

Details

11 CHO error

12 CH1 error

13 CH2 error

14 CH3 error

Error code (Decimal)

Sy GUtt Details LED status
(Dec)
- Offset/Gain setting error Blinks every 2 sec.
31# Exceed the range of parameter )
Blinks every lsec.
41# Exceed the range of digital input

% # stands for the channel with error found.
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3.13 Example Program

3.13.1 Analogue output program

(1) Program example using [I/O Parameter Setting].

21x

Module list

=D Base 00 : Default [ st | Module [ Comment [ InputFiter [ Emergency Dutput | Allocation
ez 00 Default mai]

o 01 & Defaut L
— gg ge;au:t 2 - Digital Mocule List
= i Default 3 £l Special Module List
=} o Default 3 i #-f Analog Input Module
vz 0501 Default B Analog Output Module

oz 06 ¢ Default 5 4.TH)

= 07 Default & [ WBFDCD4A [Corent, 4-CH)

7 8 @ Temp. Measuring Madule
-8 Communication Madule List
i I
Delefesiot [ ils Brint 0] Cancel |
/O Parameter Seiting’ 2l
Madule list
S (/oltage £:C 2 - -

S5 Base 00 Defauk ; A (Voltage, 4-CH] 2l Emergency Output | Allocation [
iz 0 : Default XBF-DVI4A (Yoltage, 4-CH) E
LB 01 XBF-DYO4A (Valtage, ¢ PO 0~ POOTF -

== 02 Default Farameter CHO [ cH1 CHZ tH3 | :
e 13 1 Default ¥ Charnel status Enable :

zp 04 1 Default
gz 0B ¢ Default
zg 06 ¢ Default g
oz 07 ¢ Default [ CH. Ouputiype | Former value

[ Dutput range o=1mé

Input type:

Former value | Fommer walue | Formner value |

a1 | LI Cancel I
Delete Slot I [alate | Bace Setting Delete Al Details I Print w I 8] Cancel
Module ready
o
D| Uor.00.F [ wov 3 ot oe l_ Erable all charnels
I
_____ ————=1 N P N
Write a digital input
[ moy ! oo Cooros | e
1 i P i
I oW : o0 1 uol.od l» g{néﬁ]a digital input
] I . . .
| oY : 3000 i uo1.05 l— g{%ﬁf digital input
T
1 . . .
Write a digital input
[ moy |__4o00 R A
CH. Run information Digital input data END
24
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(2) Program example with PUT/GET instruction.

Internal memory

i
L
L
i
i
i
L
i
i
I
i
L

Run channel(D,1,2,3)

The range of output
voltage(0-10V)

Input data type
(0-~4000)

CHO cutput status
{previous value)

CHI output status
(min. value)

CHZ output status
{mid. value)

CH3 output status
(max. value)

Enable run all
channels

Write a dital input
at CHO

Write a dital input
at CHI
Write a dital input
at CHZ

Prite a dital input
at CH3

address Data No. to write
Module ready Slot No. l Data
“udi ﬁﬂ_.F-i ] PUT — ]_ T A | 0 ?|]|_]n|.—_ =1 |_I
I | 0 11 hoooF
& : : : [ = Tt
| | PuT [ TN
! T |: [ L1 :
| [T | 1 1 T hooo | | 1
| | ol ] = !
I [P V0 T3 vt ]
| : | o e
| [ T 1 ! R REHE I
: : [ r [releessy
| Lo 1 L8 o2 11y
| I = 1 oo
: N R
| e e—— | [p—— ey | { ey
Uo1.00.F [ | Er—
il WOv hODoF ot .02
s === I :
101,010,001 T,
) i I | [ wov 1000 ! uot 03
| L0101 WV 200 | U
— I —
| I >
Iunl.nll.z: [ wov T oo U oworos
| |
1 U101, I 4000
R il [ v | om0 | Ua1 .06
CH. Run information Digital input data [ gyp
60

(3) Program example using parameter in case of IEC type

_01_CHOo_od
TEH

_01_ROv
L | 30—
_01_EH1_00
TEN
3

_01_CH2_od
TEM

53—
_01_CH3_00
TEM

_D1_ETHD_AE WIVE _DI_ETHI_AE WIVE
—— ——EN EMO}—o | — BN END
_01_CHO_DA _O1_CH1_DA
1000 4 I OuT b Th 2000 IN - OuT f Th
_D1_ETH2_AE WIVE _DI_ETHS_AE WIVE
L —| ——EN EM0}—ow« | — BN END}
_01_CH2_DA _01_CH3_DA
3000 4 IN 00T Th 4000 IN - OuT f Th

35—
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4) Program example using PUT/GET instruction in case of IEC type

THST THETT THETZ
_01_ROv PUT_WORD PUT_WORD PUT_WORD
} REQ DOWE REQ DOKE RE0  DOME}
0 {BASE STATL i {BASE STATL {BAZE STATE
1 {3L0T 1 {3L0T {3L0T
0 {MDD 1 MDD {M4DD
R R R
TEH000F  {OATA i {DATh {DATh
INST3 INST4 INSTS
PUT_WORD PUT_WORD PUT_WORD
REQ ™ DONE REN ™ DOKE REU ™ DOME}
0 {BASE STATL i {BASE STATL {BASE STATL
1 {3L0T 1 {3L0T {3L0T
3 {M4D0D 4 MDD {MADD
R R R
0 {DATh 1 {DATh {DATh
INSTE
PUT_WORD
REN ™ DOMEL
0 {BASE STATL
1 {3L0T
i {00
R
3 {DATH
_01_CHO_au
_01_ROv TEN
L | 53—
_01_CHI _au
TEN
3
_01_CHz_ou
TEN
33—
_01_CH3_au
TEN
33—
_m _ETHD_AE WOVE _m _ETHI _AC HOVE
— b——E EMf——— —— EN ENO}
_01_CHO_D _01_CH1_DA
oo 4 I OuT Té 2000 IN - ouT b Té
_m _ETH:Z_AE WOVE _m _ETHS_AE HOVE
L — —Ed EMO}|— | —— EN ENO}
_01_CHz_D _01_CH3_DA
oo 4 IN ot Th 4000 IN - ouT b Th
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3.14 Troubleshooting

3.14.1 RUN LED flickers

RUN LED flickers. |

4 L

RUN LED flickers every 0.2 sec.

It seems to be a module defect.
E > Contact the nearest agency or LS branch office.

RUN LED flickers every 1 sec.

Yes > It is Run parameters setting error. Check the error code to
take action against as follows in the table below.

Error Code q f
(Dec.) Error Details Action
31# Parameter range excess error Adjust parameter setting range
214 Digital input value range excess Adjust digital input value range
error

[J # indicates channel number.

3.14.2 RUN LED is off

RUN LED is Off.

-

D/A conversion module is installed on the base
correctly?

> Correctly install D/A conversion module on the base.

il

I/O information can be seen at the XG5000.

No > Contact IMO Precision Controls technical support

A

Normally operated if D/A conversion module with
error is changed to another module.

Yes > Contact IMO Precision Controls technical support
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3.14.3 Analogue output value is not normal.

D/A conversion value is “0".

-

Channel status is set as Enable.

>

o

hi

External power (DC 24V) is supplied.

Check and correct the channel status on the I/O parameter,

o

A

Wiring of each channel is normal.

o

i

Input voltage/current of external terminal
block is normal.

[0]

i

Supply external power (DC 24V)

Refer to 2.8.2 and wire properly.

Set U0x.02 to enable the output referring to p3-19
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3.14.4 Status check of D/A conversion module throug  h XG5000 system monitor

Module type, module information, O/S version and module status of D/A conversion module can be
checked through XG5000 system monitoring function.

(1) Execution sequence

Two routes are available for the execution.

(a) [Monitor] -> [System Monitoring] -> And on the module screen, click the right mouse button to
display [Module Information].

(b) [Monitor] -> [System Monitoring] -> And Double-click the module screen.

(2) Module information

(a) Module type: shows the information of the module presently installed.

(b) Module information: shows the O/S version information of A/D conversion module.
(c) O/S version: shows the O/S prepared date of A/D conversion module.

(d) Module status: shows the present error code. (Refer to 3.23 for detailed error codes)
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Chapter 4 RTD Input Module

4.1 Setting Sequence before Operation

Before using the RTD input module, follow steps below.

XBF-RDO4A / XBF-RDO1A

Checking performance specification I—. Specification
®  Operating environment

® Digital input range

System configuration and selection I—. System configuration
[ ]

Max. No. equip-able
® Selecting the external power

Wiring I—‘ Wiring
®  Wiring (external DC24V)

® RTD input wiring

Reading temperature data I—. RTD input test
® XG5000 special module
monitor test mode

Setting parameter I—. Parameter
® XG5000 I/O parameter

Programming I—. Programming
°

Program for writing digital data
(U device)

abnormal, refer to the trouble shooting

If there is error or RTD input value ij
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4.2 Specification

4.2.1 General Specifications

Here are the general specifications of the RTD input module.

No. Items Specification Reference
1 Ambient Temp. 0~55°C
2 Storage Temp. -25~+70°C
3 Ambient humidity 5 ~ 95%RH (Non-condensing) -
4 Storage humidity 5 ~ 95%RH (Non-condensing)
Occasional vibration -
Frequency Acceleration Pulse width Times
10 < f < 57Hz - 0.075mm
_ 57 < f < 150Hz 9.8m/s’ (1G) - 10 times
5 Vibration - —
Continuous vibration each
Frequency Acceleration Pulse width direction
IEC61131-2
10 < f < 57Hz - 0.035mm (X,Y and 2)
57 < f < 150Hz 4.9m/s?(0.5G) -
« Peak acceleration : 147 m/s?(15G)
6 Shocks « Duration : 11ms
 Pulse wave type : Half-sine (3 times each direction per each axis)
Square wave
) ) 41,500 V IMO standard
impulse noise
Electrostatic _ IEC61131-2
) Voltage: 4kV (Contact discharge)
discharge IEC61000-4-2
) Radiated
7 Impulse noise ) IEC61131-2,
electromagnetic 27 ~ 500 MHz, 10V/m
) ) IEC61000-4-3
field noise
. Classifi- Power Digital/Analogue Input/Output,
Fast transient . L IEC61131-2
. cation supply Communication Interface
/Burst noise IEC61000-4-4
\oltage 2kV
Operation . .
8 ) Free from corrosive gases and excessive dust
ambience
9 Altitude Less than 2,000m -
10 Pollution degree Less than 2
ik Cooling method Air-cooling
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4.2.2 Performance specifications

Here describes general specifications of RTD input module.

Item

Specifications

XBF-RDO4A

XBF-RDO1A

No. of input channel

4 channels

One channel

Input sensor PT100 JIS C1604-1997
type JPT100 JIS C1604-1981 , KS C1603-1991
Temperature PT100 -200 ~ 6001
input range JPT100 -200 ~ 6001
PT100 -2000 ~ 6000
Digital output JPT100 -2000 ~ 6000
Scaling display 0~ 4000

Normal temp.(25(7)
Accuracy

Within +0.3%

Full temp.(0~5577)

Within +0.5%

Conversion speed

40ms / channel

Channel to . .
Non-insulation
Insulati Channel
nsulation -
Terminal to PLC .
Insulation (Photo-Coupler)
Power

Terminal block

15-point terminal block

I/O points occupied

Fixed type: 64 points

Wiring method

3-wire

Max. number of equipment

7 (when using XBM-DxxxS “S"type)

10 (when using XB(E)C-DxxxH “H"type)

Filtering Digital filter (160 ~ 64000ms)
Function
Alarm Disconnection detection
Current Inner DC5V 100mA
consumption external DC24V 100mA
Weight 639
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4.3 Part Names and Functions

Here describes part names and functions.

%
* BF-RDOGA
RUM 4 — \fD
AL
— 0
& ——>
a| 2] N\
CHJEQ D:E
i =N
e =
LH EQ e
N [E] >
=]
“‘2; 2]
=l
a= 2]
CHzg ::
"E =N 7
=] ]
OES4y —
i 5] @
o /E
No. Name Descriptions
» Displays the hardware operation status of XBF-RD04A
On: Normal
@ RUN LED Flickering: Error (0.2s flickering)
Off: power disconnected, hardware error
» Displays the disconnection status of XBF-RDO4A
(Alarm indication LED)
@ ALMLED Flickering: Disconnection is detected (1sec flickering)
Off: normal operation
® Teé;?érllal » Terminal block for connecting external RTD temperature sensor
External
@ power supply | » Terminal for supplying external DC24V
terminal
® Connectgr for » Connection connector for connecting extension module
extension
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4.4 Temperature Conversion Characteristic

Since RTD sensor has non-linear characteristic, RTD input module linearizes the relationship between
input and output in each section.

The graph below is an example to describe the linearization process and is different with graph about
sensor temperature input.

(1) PT100: JIS1604-1997

4
Temperature ('C)
600.0C
4

18.52 0.0C ,’/

/1100 313.71 Measured temperature

A Resistance (Q)

P et — Linearized sensor characteristics
————— Real Sensor characteristics
-200.0C

(2) JPT100: JIS C1604-1981, KS C1603-1991

4

Temperature (C)
600.0C
17.14 0.0C| R
~ 1100 317 .28 Measured temperature
== Resistance (Q)
Linearized sensor characteristics
- T T Real sensor characteristics

Non-linear characteristics: The resistance-temperature characteristics for RTD sensor are presented
with table (JIS C1604-1997). This characteristics table displays resistance value of the sensor to
temperature, namely, the change of the resistance value per increment of 1°C. When the
temperature is changed by 1C, the change of resistance is not in constant width but in different
width per section, which is called the non-linear characteristics.
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4.5 Conversion Speed

The conversion speed of XGF-RD4A is 40 ms per channel and each channel is converted
sequentially, that is, one channel is converted and then the next channel is converted.

(Run/stop can be specified independently for each channel.)
The conversion speed includes the time to convert input temperature (resistance value) to digital
value and to save the converted digital data into the internal memory.

.. Processing time = 40ms X Number of the using channels

[Example] 3 channels are used: Processing time = 40ms X 3 = 120ms

4.6 Accuracy

The accuracy of RTD module is described below.
* When the ambient temperature is 25 + 5C: within £0.3% of available input range

* When the ambient temperature is 0 to 55C: within £0.5% of available input range

Example) PT100 is used and the ambient temperature is normal.
To measure 100°C, the conversion data output range:
100C -[{600 - (-200) } x0.3%] ~ 100 +[{600-(-200)}x0.3%]
Namely, 97.6 ~ 102.4 [TC]

4.7 Temperature Display

(1) The input temperature is converted to digital value down to the one decimal place.

Ex.) If the detected temperature is 123.4C, its converted value to be saved to the internal
memory will be 1234.

(2) Temperature can be converted to Celsius or Fahrenheit scale temperature value as desired.

Ex) If Pt100 sensor is used, the temperature of 100.0C can be converted to 2120 when
Fahrenheit scale is used.

» Conversion C to °F, F = gC +32

« Conversion °F to C, C =g(F —32)

(3) Maximum temperature input range is higher/lower within 10°C than regular temperature input
range. However, the precision will not be guaranteed for any temperature out of regular
temperature input range.

Maximum temperature input ranges of sensor are as follows;
* PT100:-210.0 ~ 610.0C
«JPT100:-210.0 ~610.0TC
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4.8 Scaling Function

It is used to scale and output the range specified by the user other than temperature range.

(Temperaturex10+ 2000
2

* Scaling expression =

Ex.) When scaling is allowed and sensor input is 200°C with PT100 sensor, scaling value is as follows.
(200x10+ 2000
2

= 2000

Scaling value =

The figure below displays the relation between temperature input and scaling value.

A

Scaling
conversion
value

4000

2000

-200.0
200.0 600.0 Temperature
Conversion value
0.0
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4.9 Disconnection Detection Function

(1) As a module used to measure the temperature with the RTD temperature sensor directly
connected, it detects and displays disconnection of the sensor connected. If any disconnection
occurs in the sensor used and extended lead wire, LED (ALM) will flicker in a cycle of 1 second
and produce an error code.

(2) Disconnection can be detected per channel, however, only for the channel specified to run.
LED (ALM) is used in common for all the channels. It will flicker if one or more channels are

disconnected.

(3) The figure below shows the temperature sensor’s appearance of the 3-wired RTD.
(The appearance depends on sensor type)

—
Aterminal A
B terminal 8
b

=

* A disconnection: if disconnected between terminal A and terminal board of the module in the

sensor figure.
* B disconnection: if disconnected between terminal B (two for 3-wired sensor) and terminal

board of the module in the sensor figure, or if A and B lines are all disconnected.

(4) The basic connection between RTD module and RTD Sensor is based on 3-wired RTD sensor.
If 2-wired or 4-wired sensor is used, the connection between the sensor and the module shall be
kept as 3-wired. Disconnection will be detected on the basis of 3-wired wiring.

(5) In case of disconnection, status of ALD LED and operation of disconnection flag are as follows.
- For disconnection flag, refer to 12.3.14 internal memory.

. Channel ALM LED Disconnection
Connection status
status status flag
Run Off Off
Normal
Stop Off Off
Run Flicker (1s) On
A line disconnected or
B line disconnected
Stop Off Off
Run Flicker (1s) o
Any sensor is not n
connected
Stop Off Off
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4.10 Wiring

- 3 types of sensor-connecting methods are available (2, 3 and 4-wired).
- The standard wiring method for XGF-RD4A module is 3-wired wiring.
- Use an identical type of wire (thickness, length, etc.) for each 3 wire when extended lead wire is

used.
- The resistance of each conductor is to be less than 10Q. (If larger than this, it will cause an error.)
- Resistance difference of each conductor is to be less than 1Q. (If larger than this, it will cause an

error.)
- Length of wire is to be as short as possible and it is recommended to connect the wire directly to the

terminal block of module without connection terminal unit. If a connection terminal is to be used,
compensating wire shall be connected as shown below.
4.10.1 If 2-wired sensor is used (connection termin  al unit is used)

Terminal block —
‘ a < A"

g1 12
L

24V
*1 If sensor and compensating wire are shielded, *3

shield line can be connected to FG terminal of

the module. 24G
*2 Let the terminals B and b short on the terminal
block of the module if 2-wired sensor is to be

connected. *1 FG
3 DC 24V external supply terminal to supply the

analogue power to module

4.10.2 If 3-wired sensor is used (connection termin  al unit is used)

J
- L

*1 If sensor and compensating wire are shielded,
shield line can be connected to FG terminal of
the module.

*2 DC 24V external supply terminal to supply the
analogue power to module

24V
*2

®@0®

24G

FG
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4.10.3 If 4-wired sensor is used (connection termin  al unit is used)

Terminal block

e -

Y
k// p 24V

— ]
e

1* If sensor and compensating wire are 24G
shielded, shield line can be connected to FG

terminal of the module. FG
2* DC 24V external supply terminal to supply  *1 ;

the analogue power to module



Chapter 4 RTD Input Module

4.11 Filtering Function

Based on the filter value (time-constant) which defines the temperature-converted value of the specified
channel, it performs and outputs calculation as below.

(Previously filtered temp.x Filter value ) + (Presently input temp.x40 ., X Channels used)

Filtered temperature = -
Filter value ¢ + (40, X Channels used)

A
Temperature([]) )
Filtered Temperature
Actual temperature
100 C
63.2 C
0°¢T
< > Time (ms)
Filtering
Constant (ms)

« Filtering constant setting range = 160 ~ 64000 [ms]
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4.12 Operation Parameter S etting

Operation parameters of RTD module can be specified through [I/O parameters] of XG5000.

4.12.1 Setting items

For the user’s convenience, XG5000 provides GUI (Graphical User Interface) for parameters setting
of RTD module. Setting items available through [I/O parameters] of the XG5000 project window are
described below.

Item Details

(1) Specify the following setting items necessary for the module operation.
- Channel Run/Stop

- Sensor type

[I/O Parameter] - Filter setting
- Scaling setting

(2) The data specified by user through S/W package will be saved on the
flash memory of RTD module when [I/O Parameters] are downloaded.

4.12.2 How to use [I/O Parameter]

(1) Run XG5000 to create a project. (Refer to XG5000 programming manual for details on how to
create the project)

(2) Double-click [I/O Parameter] on the project window.
[ Project Window - x|

ftems I
-2 Example_¥GE
B NewPLCHGE-XBMS)HOfline
-9 Variable/Comment
(&% Parameter
T Basic Parameter
g I
| BT Embedded Parameter
=&l Scan Program

------ Mew Program

(3) If [I/O Parameter Setting] screen appears, click Module part at relevant slot and select relevant

module.
(4) On the ‘I/O parameters setting’ screen, find and click the slot of the base where RTD module is
installed on.
2=
Module list
5l () Base 00 - Defactt [ s ] Module [ Camment [ Input Fiter _[Emergency Ouf Allocation |
-z 00 : Default Ofmain]
=0 hzi & ]
ez 03 : Defautt 3
=z 04 Defautt
= 05 : Defaut 4
=z 06 Defautt 5
=z 07 Defaut 3
7

Delcieiot || DeleieBase | |Beveseii | | DeleteAl | Do | e v | 0K | Caneel

4-12




Chapter 4 RTD Input Module

(5) Click the arrow button on the screen to display the screen where an applicable module can be
selected. Search for the applicable module to select.

2l
i
| Moduls it
| [= @0 Base 00 Defaur I Module [ Comment [ Input Filer _[Emengency Ouf Allocation |
: Default Ofmain]
Defaut . ]
* Defaui 2 [l Digial Moduls List
: Defautt 5 E-fgl. Special Module List
: Defautt H Anslog Input Module
: Default B tnalog Dutput Module
: Defautt &-f Te ing Module
7: Defatt ; -8 ATD, 4-CH]
RTD, 1-CH]

B Communication Module List

Deeiesion | [ B Jtails pint ¥ | ok | Cancel |

(6) After the module selected, click [Details] or double-click relevant slot.
2]

Module list

) i Base 00 : Defaul | Comment

2 00 : Defaul
B0
= 02:
= 03
4
e 05
=
= 07

Sot_ |
O{main]

Module [ [ Input Fitter_[Emeraency Oul Allocation |

XBF-RDO4A (RTD, 4
Default
Default
Default
Default
Default
Default

WBFRD04 (A10, 4 =]

| —

Delte Slot | DeleieBase | Ezvecotig | DeleteMl | Detais |

et ¥ [ [0k |

Cancel |

(7) A screen will be displayed to specify parameters for respective channels as shown below. Click a
~ desired item to display parameters to set for respective items.

| Modde st
[ [© @9 Base 00 Dotk 2 XI[Fl Alocation
00 - Defauit
=
XBF-RDO4A (RTD, 4CH)
B, 01 XBFRDO4AF FO0040 ~ POOTF
a9 02 Defauit Parameter CHO CH1 CH2 CH3
oz 03 Default - :
o et ™ Channel status Discble ]  Disable Disable Disable
=
o 05Dt T Sensor e FTI00 FT100 FT100 FT100
3 06 - Defaul ™ Temp. unit Celsius Celsius Celsius Celsius
= 07 Default Filter constant i i i 0
™ Scaling Disable Disatle Disable Disabls
I Cancel
Delete Slet | Defeteose | Doseteting | Deleteal | Detaie | P ¥ | oK Cancsl

(8) The initial values of respective items are as follows.
(a) Channel status setting screen

XBF-RDD4A (RTD. 4CH)
Farameler [ cHo [ oHi CHZ CH3
[ Chennelststus  |Divable | Disabls Disatle Disable
™ Sensor lype PT100 PT100 FT100
[ Temp unt Enable Celsius Celsius Celsius
Filter constant a 1) 1) 0
™ Scaling Disable Disabls Disable Disabls
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(b) Input sensor type setting screen

XBF-RDO4A (RTD. 4-CH)

Parameter CHO CH1 CH2 CH3
[™ Channel status Digable Disable Dizable Dizable
[ Sensorype  |PTI00 =] PTIO0 PTI00 PT100
™ Temp. unit PT100 Celsiuz Celsiuz Celsius

Filter constant : 1} 1} 1}
™ Sealing Dissble  Disable Disable Disable
OK I Cancel

(c) Temp. unit setting screen
XBF-RDD4A (RTD. 4CH)

Parameter CHO CH1 CH2 CH3

™ Charinel status Disable Disable Disable Dizable

[™ Sensortype FT100 FT100 FT100 FT100

[ Temp. unit Celsivs j Celsius Celsius Celsius
Filter constant E_ 0 0 1}

[C Sealing 'FLWSQEL—E_ Dizable Dizable Dizable

OK I Cancel

(d) Scaling setting screen

XBF-RDO4A (RTD, 4CH)

Farameter CHO CH1 CH?2 CH3
[ Chanrel status Dizable Disable Disable Disable
[ Sensor type PT100 FT100 PT100 PT100
[ Temp. unit Celsivs Celsius Celsiuz Celsius
Filter constant 0 0 0 0
™ Scaling Dizable j Disable Disable Disable

oK | Gancdl |

(9) If necessary setting is complete, press OK.

(10) Check the check box on the parameter menu to select and change setting of a channel then the
setting value of all the channels will be identical to changed setting value. The figure below shows

an example with this function that channel status is changed to ‘Enable’ of all the channels.
21X

XBF-RDO4A (RTD, 4CH)

Parameter CHO CH1 CH2 CH3

[V Channel status Dizable j Disable Disable Dizable

[ Sensor type Diizable FT100 FT100 FT100

™ Temp. unit Celsius Celsiuz Celsiuz
Filter corstant 0 o 1] 1]

[T Scaling Disable Disable Dizable Dizable

0K I Cancsl
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4.13 Special Module Monitoring

Run Special Module Monitoring by selecting [On-Line] -> [Connect] and [Monitor] -> [Special Module
Monitoring]. If the status is not [On-Line], [Special Module Monitoring] menu will not be activated.

Remark

1) If the program is not displayed normally because of insufficient system resource, you may start
XG5000 again after close the program and other applications.

2) I/O parameters those are specified in the state of [Special Module Monitoring] menu are temporarily
set up for the test. They will be disappeared when the [Special Module Monitoring] is finished.

3) Testing of [Special Module Monitoring] is the way to test the analogue output module. It can test the
module without a sequence program.

4.13.1 How to use special module monitoring

(1) Start of [Special Module Monitoring]
Go through [Online] - [Connect] and [Monitor] - [Special module Monitoring] to start. If the
status is not online, [Special Module Monitoring] menu will not be activated.

@ XG5000 - [NewProgram]

Ercject Edit FEind/Replace View Online Monib::rl Debug Tools Window Hel

0 E@ é %@ e [, Start Monitoring
|

o Jlo] Cl{al i BRI ;
4 P 4P dME — | —» % 4p @ Pausing Conditions... :
Est| F3 F4 sFi sF2 F5 F6 sFB sF9 Fd

[Project Window —
| System Monitoring

ftems
=88 Example_XGE * Device Monitoring
E@ NewPLC(XGE-¥BMS)-Stop @ Spedal Module Monitering
o 3 Variable/Comment {4 Trend Monitoring
EI@ Pammet.er [#¥ Custom Events
I Basic Parameter

& Data Traces

E 170 Paramster
. ®-[H Embedded Parameter
B Scan Program

“-[E] NewProgram
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(2) How to use [Special Module Monitoring]
(a) [Special Module List] window will show base/slot information and types of special module by
click [Monitor] > [Special Module Monitoring].In this list box, the modules that are now installed in

PLC system will be displayed.

x
Base | Slat | Module
(i Base 0 E Intemal HSC Module {Open-Collector, 4-CH)
(D Base 0 ﬂ Intemal Position Module {Open-Collector, 2-CH)
fPBase0 [ Sot1 XBF-RDO4A (RTD, 4-CH)
| | 2]
Module Info. I Monitor Close |

(b) Select a special module then click [Module Info.] button to display the information as

described below.

ﬁﬁ Displays the informations of special module.

Item Information
Maodule Name HBF-RDO44 (RTD, 4-CH)
05 Yer Wer 1.0
05 Update Date 2007-2-23
Module Status Mormal. (0]

(c) Select a special module then click [Start Monitoring] button to display the information as
described below.

20

XBF-RDO4A (RTD, 4-CH)

Item CH O CH 1

Temperature value

Scaling valus

Hin. temp value

Ma. temp valus
Item CH 2 CH 2

Temperature valus

Scaling walus

Min. temp wvalus

Ma. temp value

Itern Setting valus Currert value
Channel CHO =
Channel status Disable
Senszor type FT100
Temp. unit Celsius
Filler constant 0
Scaling Disable
Reset max/min valus | Start Monitoring | T |
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(d) [Start Monitoring]: [Start Monitoring] button will show you digital input data of the operating
channel. The figure below is monitoring screen when all channels are Run status.

XBF-RDO4A (RTD, 4CH)

Item CHD P i
Temperature value 1] / 1} \\
Scaling value 1] / 1] \
in. temp value 1] 1]
M. temp value o o [—————— Monitoring screen
Item CH2 CH3
Temperature value 1] 1] J
Scaling value 1] 1] /
Min. temp value 1] 1] /
I ax. temp value 1] \D_/
Item Selting value | Cuusaluglue
Ehenc o « Detail of channel 0
Channel status Dizable Disable
Sensor lype PTion | FT100
Temp. unit Celsius \ Celsiuz
Filter constant 1] ‘\ 1] /
Scaling Disable NLizabls—"

Reset max/min value | Stop Monitoring I Test |
Close |

[Start Monitoring] execution screen

(e) [Test]: [Test] is used to change the parameters of the RTD input module. You can change the
parameters when you click the values at the bottom of the screen. It is only available when
XGB CPU unit’s status is in [Stop].

XBF-RDO4A (RTD. 4CH)
ltem CHO CH 1
Temperature value 1] 1]
Scaling value 1] 1]
Min. temp value 1] 1]
Max. temp value a i}
Item CH2 CH3
Temperature value a i}
Scaling value a i}
Min. temp value a i}
tax. temp value a i}
Item Setting valus Current value
Chaninel CHO
Channel status Disable Disable
Sensar bype PT100 FT100
Temp. unit Celsius Celsiuz
Filter constant 1] ]
Scaling Disable Dizable
Reset max/min value | Stop Monitoring | Test I
Close |

[Test] execution screen

(g) [Close]: [Close] is used to escape from the monitoring/test screen. When the monitoring/test

screen is closed, the max. value, the min. value and the present value will not be saved any
more.

=g [Test] function is only available when XGB CPU unit's status is in [Stop].

4-17
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4.14 Register U devices (Special module variable)

Register the variables for each module referring to the special module information that is set in the 1/O
parameter. The user can modify the variables and comments.

(1) Procedure

(a) Select the special module type in the [I/O Parameter Setting] window.

1/0 Parameter Setting

Module list

2

) (3 Base 00 : Default [ et |

Module

| Comment [ Input Fiter_[Emergeney Ou

Allocation [

00 : DC 24V INPUT/TR C
XBF-RDD4A (RTD.

Ofmain]

Defautt

3 Standard [ms] Default

Defautt

Defautt
Defautt

Defautt

7 : Defautt

~i| e[| e | o B

Bl

Dekete Slot | | DeleicBase | Basedeinn || DeleteMl || Detmls |

et ¥ | oK |

Cancel

(b) Double click ‘Variable/Comment’ from the project window. .

=10l

& XG5000 - [Variable/Comment]

- project Edit EndReplace View Online Monitor Debug Tooks Window Help =lsix]
h=aEEE s LY O aRARWE Ree
b= WG @ B | P B0 O EE 2SR

@0 W E| @ Q[ |

Project Window
- [V] view variable ]E!Vew:em-;e }mhﬁzc_ I
ems -
535 Domple_XGE [ Variable | Twe | Deviee | Comment
2 NewPLC(4GBXBMS)Offine 1 | :
B9 Venable/Comment.
£ [ Parameter
Basic Parameter Ll
& 1/0 Parsmeter
(- [ Embedded Parameter
L -
g Project
[Functon/Fe =
=l et | | o
4 L4
[Function Name |
NewProgram Sy Varsble/Comment

[x] PLC. Type
. B
N |
=
: i
c I
= =
| Kl I I3l |
= (T[S 2 ¥ Monitor 1 AWonitor 2y |2 [T T IMI, Result {TReck Frosran juF1nd 1, F1nd €, Comunication j, Cross Reference Jy ot

[NewpLC [offine [ | iew Variable fove 4

(c) Select [Edit] — [Register U Device].

In case of IEC, select [Edit] — [Register special module variable]

@, XG5000 - [Variable/Comment]

I}"‘%Ercject Edit| Eind/Replace View Online Monitor Debug Tools Window Help

Bl

Expaort Variables to File...

Register U Device

= ﬁg f (D oo s B X
ﬂﬁ(;{,cq Cirl+x L8 ac@Ea
5 L B cony Cri+C b o By R 0 R O S
e F R

Project Windc
ln; K Delete Del [V] view variable IlEl\,rew)aw
ems
_EE’ Exan Select All Cirl+A Variable Ty

E-@ (=8 InsertLine cl+ 1
5@( Delete Line Ctrl+D

| .'I:ijeci
[Function/F& - x|
[Most Recenty Used =1 Edt |
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(d) Click ‘Yes'.
j i X65000 - [Variable/Comment] ~=loix|

Iﬁ Project Edit Find/Replace View Online Monitor Debug Tools Window Help _I_I- =} 5‘
NsaEHsES e as | BmE |2 = JEBEBX|EXLY AT TE N e
WS OEE | &R | FyRe LAAOHBABBE (AL T0/0Q0 (ERS

o= 5 e (EEEE il R e [T

T 5 sF0 o

sFE

“ = ¥ :
: = (V] view variable. |[7]views oevee | [Flvewriss |
ems
=88 Example_XGE | Variable ‘ Type ‘ Device | Comment
EH-ED NewPLCHGE-XBMSHOffine 1 i
-7 Vansble/Comment
S e =
Automatically register comments in the U Devices according to the spedal module setin the 1fO parameter,
() The previous comment will be deleted.

Continue?

B Project

[FunctionfFE

|Most Recerly Ussd e |
Function Name -—
NewProgram by Vanable/Comment.

\ P | Twee |
| [ |

P

* o
ey Monitor 1 GManitor 2 A

| Wariable Monitoring Wir « X

| Message Window

I T4 T»ri] Result fTheck Pragram A Find T, Find 2 Canmunication ), Cross Reference f, Use
[HewpLC [Offiine [ [ Ove

(e) As shown below, the variables are registered.

G5000 - [Variable/Comment] ;Iﬂlﬂ

\,ﬂ_\l Project Edit FndfReplace View Onliine Monitor Debug Took Window Help =18l
PRBX(EKAY ARAERA N ee
AOFEIWEE (IO TOMOY ESRE

e aaEElEE @ =D bR & e

[ Project Window . x| - = :
[V view variable [[0]veucevee | [Flvenrie |
ltems. ”;
-85 Example XGE " Variable Type "| Device | Comment "
B NewPLCXGE-XBMS)}Ofline 1 _01_RDY BIT (J01.00F  Temp. Measuring Module : Module Res
2 | b1 CHo ACT iBIT UD1.010  Temp. Measuring Module - GHO Runnir
3 _01_CH1_ACT BIT u01.011 Temp. Measuring Module - GH1 Runnir
Basic Parameter 4 _01_CHZ_ACT :BIT ug71.01.2 Temp. Measuring Module : CH2 Runnir
% 'émoh:':;a:a’mmm 5 01 _CH3_ACT BT 101013 Temp. Measuring Module . CH3 Runnir.
L Lo 6 _01_CHO_BOUT (BIT Ug1.014 Temp. Measuring Module : CHO Input D
B Project Fi _01_CH1_BOUT :BIT g1.015 Temp. Measuring Module : CH1 Input D
8 _01_CH2_BOUT (BIT UD1016  Temp Measuring Module : GH2 Input D
[ Function/FE ~x||lz _01_CH3_BOUT {BIT Uo1.01.7 Temp. Measuring Meduls - CH3 Input D
Ilvlu;r Fecently Used ;I Edit 10 _01_CHO_TEMP :WORD iUJ01.04 ETemp._ Measuring Module : CHO Temp. ™
4 | »
Function Name e — e e —————)
NewProgram iy VanableComment
= [ PIE [ mee I[P
™ |
=
o
£ H
=z 5
£ £
2 =
2 &
eIk ] |f2
S Ip o] Monitar 1 AWonitor 24 || 2L <] »Ip Result £ Check Proaran A Find 1 A Find 2 } Comiunication A Cross Reference j lse

[NewPLC |offine I [~ View Variable [Ove

(2) Save variables
(a) The contents of ‘View Variable’ can be saved as a text file.
(b) Select [Edit] -> [Export to File].
(c) The contents of ‘View variable’ are saved as a text file.
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(3) View variables

(a) The example program of XG5000 is as shown below.

! UIIIE.DID.F UDZI.DILIJ | MY Uoz.04 00000 [_
LIDZ:.DIH | MY uo2.0s 00001 [_
UDZI-DI1-2 | oy Uoz.05 0002 ||
UD:ZI.UILS | MY uo2.07 00003 [_
EHD
3l
(b) Select [View] -> [Variables]. The devices are changed into variables.
Z_THOAC
2Ry T | Wy _oecwotewe  ooono L
| I UL L
i _02_CHI_AC
T | v oeowtew oo |
U b
1 _02_CH2_t
A | wv woeree wm ||
11 k
1 _02_CHA_AC
T | MOV _02_CH3_TEMP  DODD3 L
| 11 k
. END
(c) Select [View] -> [Devices/Variables]. Devices and variables are both displayed.
uoz.oo.F uoz.o1.0
! = ICHID _ [ ho uoz.04  Doooo |
| -oeRov -t -02.0H0_TE
UDZE'DI]'1 [ hov uoz.os oot |
_02_CHI_AC 02_CH1_TE
| T W
UDZE'DI]'E [ wov Uo2.06  Dooo2 ||
_02_CHZ_AC 02_CH2_TE
| T W
UDZI'DI]'S [ wov voz.o7  Dooos |
_02_CH3_AC _N2_CH3_TE
| T WP
! END
(d) Select [View] -> [Device/Comments]. Devices and comments are both displayed.
U:E:EF U0201.0 [ wov
Temp.

Measuring
Module :
Maodule
Ready

F!l]|1|1i|1g
u02.01.1
|

MoV

Measuring
Module :

Running

Running
uo201.2
- [ wov

Temp Temp
Measuring
Module :
CH2 Temp

Running Value

090 A

He: “; - MOV U207 Doz ||

Temp. Temp.

Measuring
le :
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4.15 Configuration and Function of Internal Memory

Here describes configuration and function of internal memory.

4.15.1 Data I/O area of RTD input module
Data I/0 area of RTD input module is as shown below.

Area Area .
(S, H type) (IEC type) Details Content R/IW
U0x.00.0 %UX0.x.0 Module ERROR flag | 0 Bit On(1): module error
. R
U0x.00.F %UX0.x.15 | Module READY flag | F(15) Bit On(1): module normal
U0x.01.0 %UX0.x.16 CHO Run flag
U0x.01.1 %UX0.x.17 CH1 Run flag Bit On(1): channel run R
U0x.01.2 %UX0.x.18 CH2 Run flag Bit Off(0): channel stop
U0x.01.3 %UX0.x.19 CH3 Run flag
Uox.01.4 %UX0.x.20 | CHO Disconnection flag
U0x.01.5 %UX0.x.21 | CH1 Disconnection flag | Bit On(1): Disconnection R
U0x.01.6 %UX0.x.22 | CH2 Disconnection flag | Bit Off(0): Normal
U0x.01.7 %UX0.x.23 | CH3 Disconnection flag
UOX.04 %UWO.x.4 \?a"l'l?e digital - output Temperature value x10 R
UOX.05 Y UWO.X5 CH1 digital output R
value
UOX.06 YUWO.XE CH2 digital output R
value
UOX.07 YUWO.X.7 CH3 digital output R
value
U0x.08 %UWO0.x.8 CHO scaling value 0 ~ 4000 R
U0x.09 %UWO0.x.9 CH1 scaling value R
U0x.10 %UWO0.x.10 | CH2 scaling value R
U0x.11 %UWO0.x.11 | CHS3 scaling value R

[ In the device assigned, x stands for the slot no. on which module is installed.

(1) Module ready/channel error information ( () means device name of IEC type)
(a) U0x.00.F (%UX0.x.15): It will be ON when PLC CPU is powered or reset with A/D conversion

ready to process A/D conversion.

(b) U0x.00.0 ~ U0x.00.3 (%UWO0.x.0~%UWO0.x.3): It is a flag to display the error status of A/D
conversion module.

u0x.00

(%UW0.x.0)

Bitl5 Bitl4 Bit13 Bit12 Bitll Bitl0 Bit9 Bit8 Bit7 Bit6 Bit5 Bit4 Bit3 Bit2 Bitl Bit0

Y

-3 IS I U [ ISR VU ISR U (NS ISU U IS IS (N I L1
a8 o
S e

Module READY

Bit On (1): normal, Bit Off (0): error

Error status
Bit On (1): error, Bit Off (0): normal
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(2) Channel run/stop information

(a) It displays which channel is being used.

bitl5  bitl4  bit13  bitl2  bitll  bitl0  bit9  bit8  bit7

bit6

bit5

bit4

bit3  bit2 bitl  bitd

U0x.01

(%UWO0.x.1)

I

T

I

I
I
I
I

(3) Temperature value

\

/

Disconnection information (bit)
Bit On (1): Disconnection

Bit Off (0): Normal

V

Run channel information

Bit On (1): Run
Bit Off (0): Stop

It displays current temperature value. Its form is temperature value x10.

bitl5  bitl4  bitl3  bitl2  bitl1  bitl0  bit9 bit8  hit7

bité

bit5

bit4

bit3  bit2 bitl it

Uox.04

CHO temperature conversion value

U0x.05

CH1 temperature conversion value

U0x.06

CH2 temperature conversion value

uox.07

CHS3 temperature conversion value

(%UWO0.x.4)
(%UW0.x.5)
(%UWO0.x.6)
(%UWO0.x.7)
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4.15.2 Operation parameter setting area
Operation parameter setting areas of RTD input module are as follows.

MHeemX.ory addrEe):z Details R/W Remark
On 0 Channel enable/disable setting R/W PUT
1n 1 CHO sensor type setting R/W PUT
2n 2 CH1 sensor type setting R/W PUT
3u 3 CH2 sensor type setting R/W PUT
4y 4 CHS3 sensor type setting R/W PUT
SH 5 Temperature display unit setting R/W PUT
6 6 CHO filter constant setting R/W PUT
Tu 7 CH1 filter constant setting R/W PUT
8h 8 CH2 filter constant setting R/W PUT
O 9 CH3 filter constant setting R/W PUT

An-11n 10~17 Not used - -
12y 18 Scaling setting R/W PUT

134-434 19~67 Not used - -
44y 68 CHO disconnection information (code) R/W GET
45 69 CH?1 disconnection information (code) RIW GET

46H 70 CH2 disconnection information (code) R/W GET
47H 71 CH3 disconnection information (code) R/W GET

(1) Run channel setting
If Run channel is not specified, all channels will be stop status.

bitl5  bitl4  bit13  bit12  bitll  bitl0  bit9  bitd  bit7  bit6  bit5  bit4  bit3  hit2 bitl  bitd

Address 0

@]
@]
@]
@]

Setting channel to use (bit)
] Bit On (1): Run, Bit Off (0): Stop
(2) Sensor type setting

If it is not specified manually, all channels will be specified as Pt100.

bit15  bit14  bit13  bitl2  bitll bitl0  bit9  bit8  bit7 b6 bit5  bit4  bit3  bi2 bt  bitd

Address 1 Cho sensor type setting
Address 2 Ch1 sensor type setting
Address 3 Ch2 sensor type setting
Address 4 Ch3 sensor type setting
Word Desctiption
0 Specified as PT100
1 Specified as JPT100

4-23
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(3) Setting temperature display unit
Unit of temperature conversion value can be specified as Celsius/ Fahrenheit.

bit15  bitl4  Bitl3 bitl2 bitll bitl0  bit9  bit8 bit7  bit6  bit5  bit4  bit3  bit2  bitl  Bit0

Address 5

clc|c |c
—|=l=1=1=|-|-1=|=|—-|=|=|H |H|H|H
3|21 o0

Bit Description
0 Celsius
1 Fahrenheit

(4) Setting filter constant
If filter constant is not specified or specified as “0”, relevant channel is not filtered.

bitl5  bit14  bit13  bitl2  bitll bitl0  bit9  bit8  bit7 b6 bit5  bit4  bit3  bi2 bt bitd

Address 6 Setting Cho filter constant (1~99)

Address 7 Setting Ch1 filter constant (1~99)

Address 8 Setting Ch2 filter constant (1~99)

Address 9 Setting Ch3 filter constant (1~99)

(5) Setting scaling
It specifies whether scaling function is used or not.

bitl5  bitl4  bit13  bit12  bitll  bitl0  bit9  bitd  bit7  bit6  bit5  bit4  bit3  hit2 bitl  bitd

— = |=|=1=|=|=|=|=|—|—=|=|H|H|H|H
32|10
Bit Description
0 Scaling function is not used
1 Scaling function is used

(6) Disconnection information
It outputs disconnection information of each channel.

bitl5  bitl4  bitl3 bitl2 bitll bitl0  bit9  bitg  bit7  bit6  bit5  bit4  bit3  bit2 bitl it

Channel 0 disconnection information

Addr . ) . .
ddress 68 (0: normal,1: sensor A disconnection, 2: sensor B disconnection)
Address 69 Channel 1 disconnection information
(0: normal,1: sensor A disconnection, 2: sensor B disconnection)
Address 70 Channel 2 disconnection information
(0: normal,1: sensor A disconnection, 2: sensor B disconnection)
Address 71 Channel 3 disconnection information

(0: normal, 1: sensor A disconnection, 2: sensor B disconnection)
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4.16 Example Program

- Here describes how to specify the operation condition of RTD input module.

- RTD input module is installed on slot 2.

- Initial setting condition is that with one input, initial setting value is saved in internal memory of
module.

- The following program is an example to read temperature value and disconnection information.

(1) Program example using [I/O Parameter Setting]

Module list
E 0 Base 00 : Default I Slot | Module Comment | Input Filker |Emergancy Olu] Allocation |
00:DC24VINPUT/TRC [ Ojmain) [DC 24V INPUT/TRO ¢ ‘3 Standand [ms]  Defadt  POOOO0 ~ POOAGF
&, 01: TROUTPUT, 32p0in 1 |TROUTRUT - Default
- 02 . XBF-RD04A (RTD, 4 3 | MBF-RDO4A ATD, & - : PO00S0 ~ POOTTF
ey 03 : Default 3
ezg 04 : Default
-z 05 - Defaut 4
-z 06 - Default 5
gy 07 - Defaul 6
7
4 | |
Defete Siot | Deleledese | Baseceting | DecteAl | Detws | e ¥ [[ 0K | Cancel
XBF-RDD4A (RTD. 4CH)
Parameter CHO CHA CHZ CH3
[T Channel status Enable Enable Dizable Disable =
™ Sensor type PT100 FT100 PT100 PT100
[ Temp. unit Celsius Celsiug Celsius Celsiuz
Filker constant 1] 1] 1] 1]
[C Scaling Dizable Dizable Dizable Dizable
ok |  Cancal |
U0200.F 002010 L0204 .
| i Il | MOV 102,04 DO0D0 L Moving channel 0 temp. value to
Temp Temp Temp Temp DO area
Measuring | Measuring ~ Measuring Measuring
Module : Module : Module : Module :
Module CHO CHO Input CHO Temp.
Ready Running  Disconnecti Value
] on
UDZD;J “Dﬁf;j Mo bozes _ own ]| Moving channel 1 temp. value to
Temp Temp Temp D1 area
Measuring  Measuring Measuring
Module : Module : Module :
CH1 CH1 Input CH1 Temp.
Running  Disconnecti Value
on
n | Moving channel 0 disconnection
Z g8 . .
L GET = = Mooo I} information to MO
! GET 2 Mo10 1 l. Moving channel 1 disconnection
b information to M1
i END
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(2) Program example using PUT/GET command

FO0EE 0001
I ]
]_ zCan
[ rute 2 7 l_
| PUTR 2 2 I_
[ Pute 2 ]
[ euTe z :
:\mi- MO D000 l_
H
MOV Ua20s 0001 l_
[ e 2 MO0
[ &= 2 3 M1

(3) Program example using parameter in case of IEC

_01_ROV

Temp,
Measuring
Module :

Modul e

Ready

—

_01_CHO_AC
T

—/—

Tenp,
Measuring
Module :

CHO

Running

_01_CHI_AC
T

Tenp,
Measuring
Module :
CH1

Running

—/—

_01_CHO_BO
i)

Tenp,
Measuring
Module :
CHO Input
Disconnect
an

_01_CHO_TE
WP

Tenp,
Measuring
Hodule @
CHD Temp.

Yalue

HOVE
EN  END

_01_CH1_B0
)

Tenp,
Measuring
Module :
CHT Input
Disconnect
on

_D1_CHI_TE
WP

Temp,
Measuring
Module @
CHT Temp.

Yalue

MOVE
EN  END

INST

B

GET_WORD
RED ™ DONE

BASE  STAT
SLOT DATA

k[0
R

CHOTempDat
a

CHITempDat
a

INST1

GET_WORD
RED ™ DONE

CHODisconn
ectioninfo 1

]

BASE  STAT

CH1Digconn

SLOT DATAL ectioninfo

ka0
R

CH Enable

Sensor type (PT100)
Temperature unit (Celsius)
Filter value

Moving channel 0
temp. value to

Moving channel 1
temp. value to

Moving channel 0 disconnection
information to MO

Moving channel 1 disconnection
information to M
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(4) Program example using PUT/GET function block inn case of IEC

_10H start
|
1 SC&A O
INST IHST1 INST2
PUT_WORD PUT_WORD PUT_WORD
REQ - DOMNE RED - DOME REQ DOMEL
0 JB4SE  STATL 0 {B4SE  STATE 0 {BASE  STATE
1 JsLOT 1 45L0T 1 45L0T
0 JM&00 1 {MA00 5 {MADD
R R R
3 JD4TA ] {DATA i {DATA
IM3T3
PUT_WORD
REQ ~ DOME}
_0M_CHO_AC _01_CHO_BD
start  _OI_ROV T ur HOVE
| | | | |/ EN ENO} i} {BASE STATL
Tenp, Temp, Tenp,
Measuring | Measuring  Measuring
Module Module ! Module
Modu e CHO CHO Input
Ready Running  Disconnect
ion
_01_CHO_TE CHOTempDat
P 1IN OUT} a 1 {5L0T
Temnp,
Merasuring
Module :
CHO Temp.
Walue
i JMADD
R
_D1_ETH1_.-".E _D1_B¥I_BD HIVE
] —/— EN END| i} {0ATA
Temp, Temp,
Measuring  Measuring
Module odule
CH1 1 Input
Runming  Disconnect
ion
_M_CHI_TE
P 1IN Ot
Tenp,
Measuring
Module :
CHT Temp.
Walue
IM3T4 IH3TR
GET_WORD GET_WORD
REL ~ DONE REW DOME L
n JBASE  STATE 0 JBASE STATH
CHOD =conn CHIDi =conn
1 JSLOT DATAL ectioninfo 1 J5SLOT D&TAL ectionlnfo
Ga JHa00 E9 JMA00
R R
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4.17 Trouble Shooting

4.17.1 RUN LED flickers

RUN LED flickers. |

g

RUN LED flickers every 0.2 sec. I

Yes > Contact IMO Precision Controls technical support

4.17.2 RUN LED is off

RUN LED is off.

-

RTD input module is installed on the base correctly?

Correctly install A/D conversion module on the base.

vV

i

1/0 information can be seen at the XG5000.

> Contact IMO Precision Controls technical support

=z

i

Normally operated if RTD input module with error ig
changed to another module

Yes > Contact IMO Precision Controls technical support
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4.17.3 ALM (Alarm) LED flickers

ALM LED flickers.

-

3 wired wiring is normal.

N

i

Wiring to sensor is normal

Wire properly referring to 4.10

[0]

i

Contact the nearest agency or A/S center.

Wire properly referring to 4.10

4.17.4 Temperature conversion value is not normal.

Temperature conversion value is not normal.

-

| External DC 24V input power is normal.

No

T

FG ground is normal.

>

Supply external power (DC 24V)

No

T

Contact the nearest agency or A/S center.

>

Execute FG ground properly referring to 4.10
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4.17.5 Stats check of RTD input module through XG50 00 system monitor

Module type, module information, O/S version and module status of RTD input module can be
checked through XG5000 system monitoring function.

(1) Execution sequence

Two routes are available for the execution.

(a) [Monitor] -> [System Monitoring] -> And on the module screen, click the right mouse button to
display [Module Information].

(b) [Monitor] -> [System Monitoring] -> And Double-click the module screen.

(2) Module information

(a) Module type: shows the information of the module presently installed.
(b) Module information: shows the O/S version information of module.
(c) O/S version: shows the O/S prepared date of module.

(d) Module status: shows the present error code.
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Chapter 5 Thermocouple Input Module

5.1 General

Here describes specification, handling, programming of XGB thermocouple input module (XBF-

TCO04S).
Thermocouple input module is used to convert the temperature data detected from thermocouple to

signed 16 bit data.

5.1.1 Characteristic

(1) Module selection according to purpose
XBF-TCO04S: 4 channel input (Insulation between channels by photo-moth relay)

(2) Four kinds of thermocouple available (K/J/T /I R)
Available to select the different thermocouple according to each channel

(3) Disconnection detection
If thermocouple is disconnected, it is detected and indicated.

(4) Celsius ( C)/ Fahrenheit (°F) type available
Temperature conversion data of Celsius ( C)/ Fahrenheit (°F) is indicated down to one decimal

place

(5) Temperature data scaling function
(Available to use it as additional data than temperature indication)
Scaling conversion of temperature data is available within -32,768~32,767/0~65,535.

(6) Various additional function
Filter process, Average process (time/count/moving), Max./Min. detection process

(7) Parameter setting / Monitoring by GUI (Graphica | user interface) method
It enhanced user-friendly features by changing to /O parameter settings (intensify user

interface) from parameter settings by previous instructions.
By [I/O Parameter], the sequence program can be reduced and by [Special Module Monitoring],

it is easy to monitor the temperature conversion value.

5.1.2 Required version

When making the system, the version below is required.

Basic unit type Classification Required version
XGB basic unit Ver 1.8 or above
'S, 'H' type
XG5000 Ver 2.2 or above
XGB basic unit (IEC type) Ver 1.0 or above
IEC type
XG5000 Ver 3.0 or above
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5.1.3 Setting sequence before operation

Before using the thermocouple input module, follow steps below.

XBF-TCO04S

Checking performance specification I—. Specification

- Operating environment

- Thermocouple sensor type and temperature
range

- Digital output range

System configuration and selection I ® system configuration

- Equip-able number
- External power selection

Wiring I—O Wiring
- Power wiring (External DC24V)
- Thermocouple input wiring

Reading temp. data

—— @ Thermocouple input test
- XG5000 special module monitor

Setting parameter

—— @ Parameter
- XG5000 I/O parameter

Programming I—o Programming

- Program to read analogue data
(U device)

If there is error or thermocouple input data|1
is abnormal, refer to the trouble shooting.
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5.2 Specification

5.2.1 General specification

General specifications are as follows.

e Relat
No. Items Specification elated
standards
1 Operating 0~ 55°C
temp.
p | Storage ~25 ~ +70 °C
temp.
Operating .
5~95%RH (Non-condensin
3 | humidity 6RH ( 9
Storage .
5~95%RH (Non-condensin
| humidity ORH ( 9
For discontinuous vibration -
Frequency Acceleration Amplitude Number
10 < f < 57Hz - 0.075mm
< <
57 15_on2 = 9.8m/s(1G) -
5 Vibration Each 10
For continuous vibration . : IEC61131-2
times in
Frequency Acceleration Amplitude . X,Y?Z
directions
10 < f < 57Hz - 0.035mm
57 < f < )
1501z 4.9m/s“(0.5G)
« Max. impact acceleration : 147 m/s*(15G)
* Authorized time : 11ms
6 Shocks * Pulse wave : Sign half-wave pulse (Each 3 times in X,Y,Z IEC61131-2
directions)
Square wave +1,500 V IMO standard
impulse noise
Electrostatic . . IEC61131-2
discharging Voltage : 4kV(contact discharging) |EC61000-4-2
Radiated
) IEC61131-2,
7 Noise elegtromagnetlc 27 ~ 500 MHz, 10V/m IEC61000-4-3
field noise
P Digital/
T Fast . Class m%vt\ilﬁlre Analogue /0
ransien communication interface IEC61131-2
/bgrst IEC61000-4-4
noise Voltage 2kV 1kV
8 Amplgnt No corrosive gas or dust
conditions
9 Ope.ratlng 2000m or less
height
10 Pollution 2 or less
degree
11 | Cooling type Natural air cooling

5-3




Chapter 5 Thermocouple Input Module

5.2.2 Performance Specification
Performance specifications are as follows

Items

Specification

Number of input channel

4 channels

Type of input sensor

Thermocouple K/ J/ T /R type
JIS C1602-1995

Digital output

K -200.0C ~ 1300.0C
Range of input J -200.0°C ~1200.0°C
temperature T -200.0C ~400.0C
R 0.0TC ~ 1700.0C
Displaying down to one decimal place — notel)
Temp. display

K, J, T type: 0.1C, R type: 0.5C

Scaling display

(user-defined scaling)

Unsigned scaling (0 ~ 65535)

Signed scaling (-32768 ~ 32767)

Insulation pressure

Ambient temperature(25C) Within £0.2% — note 2)
Accuracy Temp. coefficient 5
) +100 ppm/C
(range of operating temp)
Conversion velocity 50ms / channel
) Terminal — inner circuit Photo-coupler insulation
Insulation ] ] ] ]
Terminal — operating power DC/DC converter insulation
method ] ]
) Between channels Photo-moth relay insulation
Insulation

400 V AC, 50/60 Hz, 1min,
leakage current 10mA or below

Insulation resistance

500 V DC, 10 MQ or below

Standard contact
point

compensation

Auto compensation

by RJC sensing (Thermistor)

Compensation amount

+1.0C

Warming-up time

15 min or above —note 3)

Terminal block

11 point terminal

I/O occupied points

64 points

Max. number of equipment

7 (when using XBM-DxxxS “S”")
10 (when using XB(E)C-DxxxH “H")

Additional function

Filter process

Digital filter (200 ~ 64,000ms)

Average process

Time average (400~64,000ms)

Count average (2~64,000 times)

Moving average (2~100)

Alarm

Disconnection detection

Max./Min. display

Display Max./Min.

Scaling function

Signed scaling / Unsigned scaling

Consumption Inner DC5V 100mA
current External DC24V 100mA
Weight 639
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Notel), Note2) For more detail specification, refer to 5.2.6 accuracy/resolution.

Note 3) Warming-up time: for stability of measured temperature, 15 min is necessary after power is on.

5.2.3 Name of part and function

Respective designations of the parts are as described below

B —»

-

KBF-TC045

«— O
«—®

RUN

ALM

CH]

—alt=) ()
— *%’ |
B =]
® e | (°
. E o
py i |
=] = [
ne (o]
NCzay I:‘EI
— 2] ¢ @
KJTR
¥BF-TCO4S
/=
No. Name Description
» Displays the status of thermocouple input module
On: operation normal
) RUN LED Flickering: Error occurs (0.2s flickering)
Off: power Off or module error
P Displays the disconnection status of thermocouple input
module (Alarm indication LED)
@ ALMLED Flickering: Disconnection error occurs (1s flickering)
Off: operation normal
® Terminal » Terminal block for wiring to connect the thermocouple
block (K, J, T, R type)
External
@ | power supply| » Terminal for supply of external DC24V
terminal
® Connectgr for » Connection connector for connecting the extension module
extension
Reference
® junction P Thermistor for reference junction compensation (RJC)
compensator
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5.2.4 Characteristic of thermocouple temperature co  nversion

Thermocouple input module connect 4 kinds of thermocouple directly, input characteristic are as
described below.

(1) Thermocouple K (JIS C1602-1995): -200 C(-5891 4V) ~ 1300 T(52410 W)

Electromotive force

Temperature

(2) Thermocouple J (JIS C1602-1995): -200 C(-7890 V) ~ 1200 T (69553 V)

Electromotive force

Temperature
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(3) Thermocouple T (JIS C1602-1995): -200 C(-5603 V) ~ 400 C(20872 W)

25000

20000 -

16000

10000+

BOOD

Electromotive force

—-400 -300 -200 -100 100 200 300 400 500

5000

—10000—
Temperature

(4) Thermocouple R (JIS C1602-1995): 0 C(0 &) ~ 1700 C(20222 W)

26000

20000

18000 |

10000 |

5000 |

Electromotive force

—200 200 400 G600 800 1000 1200 1400 1600 1800 2000

—5000—
Temperature

Thermocouple characteristics: thermocouple sensor measures temperature by using fine voltage
(electromotive force), which occurs when applying temperature gradient to a junction between two
different metals.

The temperature-electromotive force relation specification of normal thermocouple sensor provides
the electromotive force, which is measured when a sensor’'s measuring point is at OC. On that
account, when measuring temperature by using thermocouple sensor, cold junction compensation
(reference junction compensation, RJC) is used. (built-in function of temperature measuring module).
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(5) Temperature conversion characteristic

Thermocouple input module converts the thermocouple input with non-linear characteristics into A/D
and outputs the temperature conversion that is linearly treated.
Temperature conversion to thermocouple input has non-linear characteristics.

Non-linear characteristics: regarding the relation of temperature(C) and electromotive force(4V) of a
thermocouple sensor, electromotive force is different by sections even though temperature changes
by a certain amount, which is called ‘non-linear characteristics.” As seen in the above graph, it is
shown that the relation of temperature and electromotive force is a curve by temperature sections.
The module processes the non-linear characteristics table as linear.

5.2.5 Temperature display
(1) Temperature is displayed down to one decimal place.
In the XG5000, when monitoring the temperature conversion value, select “Signed decimal”
According to monitor indication type, temperature is monitored like figure below.

Ex.) if displaying -123.0(1 by converting, the value stored in the internal memory would

be -1230.
1230 -1230
| [ hov UD1.04 000D
_01_CHO_TE
HP
Temperature indication value
ndcan (Inner memory) 4
Monitor indication type ndication
contents _123.0C
Unsigned decimal 64306 ! >
! Temperature
. . -1230 ! value
Signed decimal (-123.0C) :
- hFB32 !
Hexadecimal | fFbsce 4 ./ o —1230
As instruction 64306

(2) Temperature display unit
(@) K, J, Ttype: 0.1TC
(b) R type: 0.5TC
(3) Temperature may be displayed by Celsius or Fahrenheit, depending on the settings.

Ex.) if displaying 100 (1 in Fahrenheit, it would be 212F by using the fo llowing formula.

9
(a) From Celsius to Fahrenheit degree F = EC +32

(b) From Fahrenheit to Celsius degree C = g(F —32)
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5.2.6 Accuracy / Resolution

Accuracy / Resolution are as follows according to ambient temperature

Accuracy - notel)
Measurement C Operating
Thermocouple temperature Indication temperature Normal temperature - | resolution
type range temperature
range 250 note2)
() (0C ~ 55C)

-270.0C ~-200.0TC - note3)
K -200.0C ~ -200.0C ~0.0C +3.0C 75T 0.2C
1300.0C 0.0C ~1300.0C +3.0C 75T 0.1C

1300.0C ~ 1372.0C - note3)

. -210.0°C ~-200.0C - note3)
J -200.0C ~ -200.0C ~-100.0TC +2.8C +7.0C 0.2C

1200.0C o e e e e

-100.0C ~1200.0C +2.8C +7.0C 0.1C

T -200.0C ~ -270.0C ~-200.0TC - note3)
400.0C -200.0°C ~ 400.0C +12C |  #30C | 01T

0.0C -50.0C ~0.0C - note3)

. o~ : e e ;

R 1700.0C 0.0C ~17000C +35C |  +85C | 05T

1700.0C ~1768.0C - note3)

Notel) Total accuracy (normal temp.) = accuracy (normal temp.) + cold junction compensation accuracy
= #(full scale X 0.2% + 1.0C)
Cold junction compensation accuracy = +1.0C
Note2) Temp. coefficient: £100 ppm/C
Note3) Measuring the temp. is available, but accuracy and resolution is not guaranteed.

(1) When ambient temp. is normal (25 £ 5C): within the +0.2% range of measurement temp.
(2) When ambient temp. is operating temp. (0 ~ 55°C): within the +0.5% range of measurement temp.

Ex.) When K type thermocouple is used and ambient temperature is normal.
In case of measuring 1000 C temperature, output range of conversion data is
1000°C - [{1300 - (-200)} x 0.2 %] -1 ~ 10007C + [{1300 - (-200)} x 0.2 %] + 1
namely, 996.0 ~ 1004.0 [TC].

(1) For stabilization of measurement temperature, warming-up time more than 15 min. is necessary, after
restart.

(2) If ambient temperature changes rapidly, measurement temperature may change temporally. Keep the
ambient temperature steady for stabilization of measuring temperature.

(3) If wind of the cooling pan contacts with module directly in the panel, accuracy decreases. Do not
contact with wind directly.
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5.2.7 Conversion velocity

(1) Conversion velocity per channel: 50ms/channel

(2) Sequential process method
The next channel is converted after conversion of one channel is completed.
(Run/Stop of the respective channels can be set independently.)

(3) Concept of conversion time

The conversion velocity of XGF-TC4S module is a cycle that the temperature (electromotive
force) entered into terminal strip is converted into digital value and stored in internal memory.

Conversion time increase by a multiple of the no. of used channels

.. Conversion time = 50ms X no. of used channels

Ex.) In case 3 channels is used: conversion time = 50ms X 3 = 150ms

Channel 0 Conversion Conversion
Channel 1 Conversion
Channel 2 Conversion
Channel0 channell channel2 channel0
Conversion Conversion Conversion Conversion
50ms 50ms 50ms
150ms
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5.3 Function

5.3.1 Disconnection detection function

Thermocouple input module has a function to detect the disconnection and display it.

That the module detects and displays disconnection means that the following cabling path would have

partially bad connection, which requires taking measures

(1) Disconnection occurs between a sensor used/compensating cable and module, LED(ALM) flickers

every second and generates error code.

(2) Disconnection can be detected by channels. However, it is available for the only channel(s)
designated for operation. LED (ALM) is commonly used for every channel. It flickers in case even

only one channel is disconnected.

Thermocouple connection Channel ALM LED Disconnection
status run status flag
Run Off Off
Normal
Stop Off Off
Thermocouple Run Flickering (1s) On
disconnection Stop Off Off

(3) In case disconnection occurs, disconnection flag of each channel will be turned on and in case
disconnection is canceled, it will be turned off.

Disconnection flag Contents
U0x.01.4 Ch. 0 disconnection
U0x.01.5 Ch. 1 disconnection
U0x.01.6 Ch. 2 disconnection
U0x.01.7 Ch. 3 disconnection

(4) When disconnection occurs, the min value among range is displayed.

Type Displayed temperature in case of disconnection
K type -270.0°C
J type -210.0C
T type -270.0C
R type -50.0C
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5.3.2 Scaling function

Thermocouple input module has a function to scale value in user-defined range besides temperature
display.

The scope is classified into two types; 16 bits data type, -32768~32767 and 16 bits data type without
mark, 0~65535.

If a user selects one of these two types and sets the range, it displays the temperature through scaling

operation.
Scaling data type Scaling min. value Scaling max. value
Signed value -32768 ~ [Scaling max. value -1] [Scaling min. value+1] ~ 32767
Unsigned value 0 ~ [Scaling max. value-1] [Scaling min. value+1] ~ 65535

The following graph indicates relation between scaled value and temperature input.

. A
Scaling
Conversion
value
Y1l
13000
Y
5000 [@------=o--= :
E
X0 i
-200.0 ! R
500.0 1300.0 Temperature
X X1 value
-2000
YO

Scaling operation: Y = (Y1=Y0) (X=X0)+YO
(X1-X0)

X = Temperature value
X0 = Thermocouple measurement min. temperature value
X1 = Thermocouple measurement max. temperature value
YO = Scaling min. value
Y1 = Scaling max. value
Y = Scaling

Ex.) If scaling with mark is set with -2000 ~ 13000 and the temperature measured K type sensor i
500.011, the value scaled is as follows.

n

» Scaling conversion value = (13000 = (~2000)) (500 - (—200)) + (—200) = 5000
(1300 - (—200))
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5.3.3 Filter function

By means of filter value (time constant 63.2%) setting temperature conversion of a designated
channel, it operates and outputs as follows.

(previously filtered temp. value x fileter value, ) + (presen input temp. value x 50, x No.of channel used)

Filtered temp. value= -
Filter value,, + (50,,, x No.of channelsused)

Filter constant setting range = 200 ~ 64000 [ms]

A

Temperature (1) Temperature chanae after filterina process

Actual temperature chanae

100 C

63.2 C

»
»

< > Time (ms)

< L

Filter constant
(ms)
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5.3.4 Average function

(1) Time average
It accumulates temperature conversion values of a selected channel and displays the average
of the total sum in digital data.

| —— Temperature change after averaging process

Actual temperature change

| )

4—H—M—h4—h4—h4—h4—h4—M—M—M—M—M—h!—h!—h
Channel scan interval

Ll L

Averaging section Averaging section Averaging section

v

Setting range of average time = 400 ~ 64000 [ms]

Frequency of average process for a preset time can be calculated as follows.

Average time
No. of channel used x50,

Average Process Frequency [times] =

(2) Averaged frequency
It accumulates temperature conversion values of a selected channel as many as frequency and
dlsplays the average of the total sum in digital data.

. —— Temperature change after averaging process
' Actual temperature change

al

J I _’_

e ‘
Channel scan |nterval

< b
< L L

Averaging section Averaging section Averaging section

A J

Setting range of average frequency = 2 ~ 64000 [times]
Average process interval of channel used can be calculated as follows

Average process interval[ms] = Average frequency xNo. or channel used x 50f ms]

5-14
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(3) Moving average

It accumulates temperature conversion values of a selected channel as many as set and
displays the average of the total sum in digital data. In case of the moving average, it outputs

average per scan.

Setting range of average number = 2 ~ 100

&
5 {5 2

{1y

-

(D+@+3+) B+ + B+ (B

Average Average

2+ +{(D+(5)
Average

Channel scan interval

(1) time/frequency average characteristically does not output temperature data every conversion time
and instead, it keeps a feature to maintain the previous status until it reaches time/average
frequency.

(2) In case of moving average, it outputs the converted temperature as taking temperature history and
average, which are entered previously, every conversion time, so it can obtain relatively faster data
response than time/frequency average.

(3) Filtering can be processed with one of the foresaid averaging functions simultaneously. If
simultaneous process is selected, filtering would be processed first and it averages and output
temperature value in digital value. At the moment, the digital data output (temperature) is displayed
as the value gained after the final process.

5.3.5 Max./Min. display

It displays maximum/minimum value of temperature conversion value of a selected channel for a
selected section (a section allowed for max./min. search)

Status of command allowing/prohibiting max./min. search

>4 it >
Maintaining previous | Display max./min. value Maintaining previous | Display max./min. value
max./min. value max./min. value
Initializing max./min. value Initializing max./min. value
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5.4 Installation and Wiring

5.4.1 Installation environment

Although the device can be installed with high reliance regardless of installation environment, attention
should be paid to the followings in order to secure the reliance and stability of the system.

(1) Environmental Conditions

(a) Install on a water-proof and dust-proof control board.

(b) Place free of continuous impact or vibration.

(c) Place not directly exposed to direct sunrays.

(d) Place where dew does not form due to rapid temperature change.
(e) Place where ambient temperature is maintained between 0 - 55C.

(2) Installation Construction

(a) In case of screw hole processing or wiring construction, wiring dregs should not go into PLC.
(b) Install on a position easy to access.

(c) Should not install on the same panel which high voltage device is installed on.

(d) It should be 50mm and longer distant from duct and modules.

(e) Should ground in the environment where is not interrupted from noise.

(f) Install not to contact with cooling pan in the panel

(3) Cautions in handling
It describes caution in handling from unpacking module to installation.
(a) Do not fall or apply excessive impact on it.
(b) Never attempt to separate PCB from the case.
(c) Make sure that any impurities including wiring dregs should not go into the upper part of
module during wiring work.
(d) Never attempt to attach or detach the module when it is turned on.

5.4.2 Wiring

(1) Cautions in wiring
(a) Do not place AC power line close to the AUX signal line of the module. To avoid surge or
induced noise occurring from AC, make sure to leave a proper space.
(b) Cable should be selected by considering ambient temperature and allowable current and the
specification of cable should be as follows.

Cable specification
Lower limit Upper limit
0.18mm° (AWG24) 1.5 mm’ (AWG16)

(c) If cable is placed too close to any heating device or materials or if it directly contacts oil and
similar materials for a long time, it may cause short-circuit, resulting in breakdown and
malfunction.

(d) Check the polarities during terminal strip wiring

(e) Wiring with high voltage cable or power line may cause induction problem, causing malfunction
or trouble.

(f) External DC24V power should be same with power of XGB. If external DC24 V power of
thermocouple input module is turned on/off while power of XGB main unit is on, temperature
input value may have an error.

(g) Thermocouple input module may use 4 types of thermocouple sensors. (K/J/T/R)
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(2) Terminal array

Terminal array of thermocouple input module is as follows.

=

XBF-TC045
RUN

ALM

BB o |3 (2

FE A EE

N

0C24y
—

+

1
< [ o

HBF-TCO4S

=

(3) Wiring example

Thermocouple can be connected with module directly. If point where temperature is measured is

KJIR SR | DI P IpI

iig:ﬁ Purpose

%ﬂ%J' Channel 0 thermocouple input

%ﬂlf Channel 1 thermocouple input

%ﬂ22+ Channel 2 thermocouple input

%ﬂ?; Channel 3 thermocouple input
NC Not used

DD%ZZfl\\//Jr For external DC24V power

far from the module, use the compensating cable to connect

(The compensating cables are different according to thermocouple type. For more information

about the compensating cable, contact the producer of thermocouple.)

Terminal block for compensating
cable extension

2+
Sensor

Compensation

Sensor

Module terminal

—

C 1 g

cable 3+

+

\ AN

(/O

|

1) In case sensor and compensating cable are shielded, shield connection is possible to PLC FG terminal.
2) Itis necessary to use extension terminal block of which material is kept at uniform temperature in order

to reduce error.

FG

3) Compensating cable should use the same type of sensor, which was used for measuring.
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5.5 Operation Setting and Monitor

5.5.1 Operation Parameter Setting
Operation parameter of thermocouple input module can be set through [I/O Parameter] of XG5000.

(1) Setting items
For user convenience, parameter setting of thermocouple input module is provided by GUI
(Graphical User Interface) method in the XG5000. The items which can be set through [I/O
Parameter] in the project window are as follows.

Items Content

(a) Sets the following items for operation of module.
1) Channel status (Disable / Enable)
2) Sensor status (K/J/T/R)
3) Filter constant

[I/O Parameter] 4) Average processing (Sampling / Time-Avr. / Count-Avr. / Moving-Avr.)
5) Scaling data type (Bipolar / Unipolar)
6) Scaling min./max. value

(b) The parameter set by the user is saved in the flash memory of XGB main
unit after download.

(2) How to use [I/O Parameter]

(a) Execute the XG5000 and make the project.
(For how to make the project, refer to the XG5000 user manual)

(b) Double-click [I/O Parameter] on the project window.

Project Window x

ltems
= @ Example_X5B
=@ MewPLC{XGE-XBMSHOfline
¥ Variable/Comment
—-[# Parameter
Basic Parameter
ko) /O Parameter
+- T8 Embedded Parameter
= Scan Program
Mew Program

L Project
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(c) If [I/O Parameter Setting] window shows, find slot of base where module is installed and click it.
1/0 Parameter Setting [ r's_(|

t | Slat | I odule | Comment | Inpuit Filker |Emelgency Dut| Allocation |
: Ofrmain)
Sovoes | RS S R
== 02 ! Default 2
e 03 Default 5
= 04 : Default
= 05 ¢ Default 4
== 06 : Default 5
= 07 Default 3
== 08 ! Default 7
e 09 Default 3
= 10 Default g
10
£ | >

(o v) o] (oo

(d) Register the module on a slot where module is installed on as follows.

1

Madule list
= @ Base 00 ; Defautt J Slot | Module | Comment | Input Filter |Emergenc:y Dut| Allacation |
ez 00 : Default Omain) ] ] ] ] i
e Ddak 2 @[] DigtalModueList : : : :
= 03 - Defaut = 5[5, Special Module List
ez 04 : Default —
{em | ﬁ Analog Input Module
oy 05 - Defaut L& |
H : 5 ] ﬂ Analog Output Module
e DE Defautt B ﬁ Temp. Measuring Module
"z 07 : Defautt " XBF-RDO4A [RTD, 4CH)
7 B ®BF-RDO1ARTD, 1-CH)
: P H)
.1@ Caorrmunication Module List
|& s
et ¥ ] [ ok ][ Caneal |

e) Select a module registered and click [Details] or double-click a module

170 Parameter Setting

Module list

= [ Base 00 : Default | Slat | Module | Comment Input Filter [ Emergency Ou Allacation
“zz 00 : Default H 1 g E
B, 01 - XBF-TCD4S (TC, 4C
i 02 - Defauk
-z 03 : Defaut
"z 04 : Default
g 05 : Defaut
-z 06 : Default
g 07 : Defaut

Ofmain]

Gl = A 0 B P N —

< —" s

Jclete Base | | Base Setng | [ DeleteAl | [ Detmis [ eat ¥ ] [_ok | [ Cancel
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(f) Select the required settings in Parameter Settings and click [OK]

Alocation

Module list
" D Base 00 : Default XBF-TCO4S (TC,
- izzp 00 : Default
B 01 XBFTCas () XERTCHMS(TC. 4CH)
17y ez Defend Patameler tHo | o1 tHz | oH3 |
i B Dot [ Charnel Disahl Disath Dissbe ~ Disable
g 04 - Default annel status isablz _Y..I isable isable isable
i 05 Defauk Elicmitegm & o % o & 0 &
-z 06 7 Default ] Temp. unit Celsiuz Celsiuz Celsiuz Celsiuz
azp 07 ; Default Filter constant
[[] Average processing
Average value
[7] Scaling data type Bipolar Bipolar
Scaling min. value
Scaling max. value 32767 32767
£ |
[ Deletcrr |[ Detwis |[ Pt ¥ ] |

(g) The initial values of each item are as figure shown below
1) Channel status (Disable / Enable)

XBF-TCO4S (T

HKBF-TCO45 (TC, 4CH)

Parameter

| cHo

CH1 CH2 CH2
[] Channel status Dizable w Dizable Disable Dizable
[] Sensor status K K K
] Temp. unit Enable Celsius Celsiuz Celsiug
Filter constant 1} 0 1} 1}
[] &verage processing Sampling Sampling Sampling Sampling
Avwerage value 1] 1] 1] 1]
[ Scaling data type Bipalar Bipalar Bipolar Bipalar
Scaling min. value -327E8 32768 -32768 32768
Scaling mar. value 32767 32767 32767 3276V
[ ok ][ cance

2) Sensor status (K/J/T/R)

XBF-TCO4S (TC, 4-CH)

XBF-TCD45 {TC, 4CH)

Parameter CHO CHA CH2 ‘ CH3
[] Channel status Digable Dizable Dizable Dizable
[ Sensor status K v K K K
[ Temp. unit Celsius Celsiug Celsiuz
Filter constant 9[ ] 0 0
[] Awerage processing |/ Sampling Sampling Sampling
Average value o 1] ] o
[] Scaling data type Bipalar Bipalar Bipolar Bipolar
Scaling min. value 32768 -327E8 -32768 32768
Scaling max. value 32767 32767 32767 32767
[ ok ][ cance
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XBF-TC04S (TC, 4-CH)

XBF-TCD4S (TC, 4CH)
Parameter CHO CH1 tHz [ oH3 ]
[] Channel status Disable Dizable Dizable Disable
[1 Sensor status S K K K
] Temp. unit Celsiuz - Celsius Celsiuz Celsiuz
Filter constant 0 i} i}
[ Average processing Fahrenieit Sampling Sampling Sampling
Average value o 0 o o
[ Scaling data type: Bipolar Bipolar Bipolar Bipolar
Scaling min. value 32768 -32768 32768 -327E8
Scaling max, value 32767 32767 32767 32767
[ 0K ] [ Cancel

4) Filter constant (0, 200 ~ 64000

XBF-TCO04S (TC, 4-CH)

XBF-TCO4S (TC. 4CH)
Parameter THO CH 1 tHz | cH3 |
[] Channel status Dizable Dizable Digable Dizable
[] Sensor status K K K K
] Temp. unit Celsius Celziug Celsiug Celsius
Filter constant 0 | 0 0 0
[] #wverage processing Sampling Sampling Sampling Sampling
Auverage value 1] 1] 1] 1]

[] Scaling data type Bipolar Bipolar Bipalar Bipolar
Scaling min. value -3276B 32768 -32768 -3276B
Scaling max. value J27ET J2767 32767 J27ET

0. 200~64000 [ ok [ caea |

5) Average processing (Sampling / Time-Avr / Count-Avr / Moving-Avr)
XBF-TCO4S (TC, 4-CH)

XBF-TC045 (TC, 4CH)
Parameter CHO TH1 tHz | o3 |

[] Channel status Digable Dizable Disable Digable
[] Sensor status K K E 4

] Temp. unit Celsius Celsiug Celsiug Celsius
Filter constant 0 0 0 0

[ Average piocessing | Sampling % | Sampling Sampling Sampling
Average value 1] o o

Tirne-fr f -

F Sc.ahng data type Count-dint Bipolar Bipolar Bipolar
Sealing min. value Moving-dr 32768 -32768 32768
Secaling max. value 32767 32767 32767 32767

[ 0K ] l Cancel

6) Scaling data type (Bipolar / Unipolar)

XBF-TC04S (TC, 4-CH)

XBF-TCD45 (TC. 4CH)
Parameler CHO CH 1 CHz | mH3 |

[] Channel status Disable Disable Disable Disable
[ Sensor status E K K E

] Temp. unit Celsiug Celsiug Celsiuz Celsiug
Filter corstant 0 0 0 0

[] Average processing Sampling Sampling Sampling Sampling
Average value 1] 0 1] 1]

[] Scaling data type | Bipolar v Bipolar Eipolar Eipolar
Scaling min. value -32768 32768 32768
Sealing max, vale | |Snipolsr 7T T27ET 22767

[ OK ] [ Cancel
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7) Scaling min. value/scaling

max. value

XBF-TCO04S (TC, 4-CH)

XBF-TC04S (TC, 4CH)
Parameter CHO CH1 CH2 CH3 |
[ Charnel status Digable Dizable Digable Disable
[] Sensor status K K [ K
] Temp. urit Celsiuz Celsiuz Celzivs Celsius
Filter constant 1} 0 1} 1}
[] Awerage processing Sampling Sampling Sampling Sampling
Lwerage value a 0 a a
[ Scaling data type Bipalar Bipalar Bipalar Bipolar
Scaling min. value -32768 | 32768 -32768 32768
Scaling max. value 32767 32TET 327ET 32767
3276832766 [ ok ] [ cance

Scaling data type

Scaling min value

Scaling max value

With sign

-32768 ~ [scaling max value -1]

[scaling min value+1] ~ 32767

Without sign

0 ~ [scaling max value -1]

[scaling min value+1] ~ 65535

(h) Constant input

1) In case the user inputs numbers directly like filter constant, if the relevant parameter is
selected, available range is displayed in the bottom.

XBF-TCO4S (TC, 4-CH)

XBF-TCD45 (TC. 4CH)
Parameter THO CH1 thz [ tH3 |
[] Channel status Disable [Disable Dizable Disable
[ Sensor status K K K K
] Temp. unit Celsiug Celsiug Celsius Celsius
Filter constant B i} 0 0
[ &wverage processing Sampling Sampling Sampling Sampling
Average value 1] 1] 1} 0
[ Scaling data type Bipalar Bipolar Bipalar Bipalar
Scaling min. value -32768 32768 32768 -32768
Scaling max, value 32TET 327ET I2TET 32TET
I 0K I [ Cancel ]

2) If the number is out of range, error message is displayed.

(If error information shows, it returns to previous status. Set again.)

I —

2x]]

XBF-TCO4S (TC, 4CH)
Parameter
[] Channel status Disable
[1 Sensor status K
Temp. unit siuis Celsius
D 2 L Qut of range. Enter again!
Filter constant . 0
[] Average processing pling Sampling
Average value 0
[ Sealing data type: olar Bipolar
Scaling min. value -32768 -32768 32768 32768
Scaling max. value 32767 32767 32767 32767
R | [ ok ][ Cancad |
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3) If the wrong number is specified, it is displayed with red color.
When Average value or scaling min./max. value is out of range.)
XBF-TC04S (TC, 4-CH)

XBF-TCO4S (TC, 4CH)
Parameter CHO TH1 EE
[[] Charnel status Disable Disable Dizable Dizable
[1 Sensor status K K K K
] Temp. urit Celsiug Celsiug Celsiuz Celsiuz
Filter constant i} i} i} i}
[ &verage processing Time-dwr Sampling Sampling Sampling
Avwerage value “ o o o
[ Scaling data type Elpnlar Bipolar Bipalar Bipalar
Scaling min, value 32768 32768 32768 32768
Scaling max. value 32767 32767 327ET 327ET
5 (=

5.5.2 Special module monitoring function

While XG5000 is connected with PLC, through [Monitor] -> [Special Module Monitoring], the user can
test the operation of the analogue output module.

Remark

1) If system resource is short, the screen may not be displayed properly. In case of this, shut down
other application program and restart the XG5000.

2) On the [Special Module Monitoring] status, I/O parameter is set temporarily to execute the test. So
if [Special Module Monitoring] status ends, /O parameter is not saved.

3) By test function of [Special Module Monitoring], the user can check if analogue module operates
properly or not without any sequence program.

(1) How to use special module monitoring

(a) Start of [Special Module Monitoring]
While XG5000 is connected with PLC, start [Monitor] -> [Special Module Monitoring]. If that is
not online status, [Special Module Monitoring] is not activated.

% XG5000 - [NewProgram]

Eroject Edit Find/Replace View Online iMonitDrl Debug Tools Window Help

O b (8, & - [@] stop Monitering

,@, Pause
ey
@la 0o @ : TR0
e ) & Pausing Conditions... s
SRR 5 B g
[Project Windowe <% {3 Change Current Yalue... =
ftems System Monitoring
= @ Example_¥GB @ Device Manitoring
=[P NewPLC{XGB-XBMS)-Stop @i e ModE Mariorng
- Variable/Comment ; T
= [8, Parameter {4 Trend Monitoring
2 Basic Parameter [ Custom Events
- E 170 Parameter ) Data Traces

.\ @ [ Embedded Parameter
= Scan Program
: NewProgram
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(b) How to use [Special Module Monitoring]

1) Click [Monitor] -> [Special Module Monitoring] while XG5000 is connected with PLC basic
unit. ‘Special Module List’ screen is displayed as shown below and displays information of

base/slot with special module type. On the list dialog box, The modules currently equipped
at the PLC are displayed.

Special Module List

X

Slot Module
ﬁ Intemal HSC Module (Open-Collector, 4-CH)
ﬁ Intemal

Position Module (Open-Collector, 2-CH)
] Slot1 | XBF-TCO4S (TC, 4CH)

<

l Module Info ]l Manitor J

2) Clicking [Module Info.] shows the information of special module.
Special Module Infomation

[m Displays the informations of special module.
Item Information
Module Mame XBF-TCO4S [TC, 4CH)
05 Ver Wer. 1.0
05 Update D ate 2008-2-25
Module Status MNomal. (0

3) Clicking [Monitor] shows the following screen.
Special Module Monitor E‘El

XBF-TCD4S (TC, 4CH)

ltem CHD [ CH1 |
Temperatuie value

Scaling valus

Min temp value

Max. temp valus

Item CH2 CH3

Temperaturs value

Scaling valus

Min temp value

Max. temp valus

FLAG Moritor
ltem Setingvaue | Curentvahe |
Channel CHO ~

Channel status Disable
Sensor type K

Temp. unit Celsius
Filter constant [

Average procsssing Sampiing
Average value i

Sealing data ype Bipalar

Scaling min, value 32768

Scaling ma. value 32767

Close
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channel. The figure below is monitoring
Special Module Monitor

4) [Start Monitoring]: [Start Monitoring] button will show you digital input data of the operating

XBF-TCO4S (TC, 4CH)
Item /  tHo CH1
Temperature value 264 263
Scaling value -22876 -22880
Min. temp value 0 1]
Max. temp walue 0 1]
Item tH2 tH3 Monitoring screen
Temperature value el M
Scaling value 22846 22846
Min. temp value 0 1]
Max. temp walue 0 1]
FLAG Monitar \ FLAG M onitor
Item /Setling value | Current value
Charinel CHO
Chaniel status Dizable Enatle
Senzor type K K
Temp. unit Celsiug Celsiuzs
Fiker constant v v Detail of channel 0
Average processing Sampling Sampling
Average value 0 1]
Scaling data type Bipolar Bipolar
Scaling min. value -32768 32768
Scaling max. value 32767 32TET
Close

[Start Monitoring] execution screen

5) [Test]: [Test] is used to change the parameters of the Thermocouple input module. You can

change the parameters when you click the values at the bottom of the screen. It is only

available when XGB CPU unit’s status is in [Stop].
Special Module Monitor

XBF-TCO4S (TC. 4-CH)

ltem CHO CH1 |
Temperature value 278 0
Scaling value -22815 1}
Min. temp walue 1] 0
Mazx. temp value o 1)
Item CH2 CH3
Temperature value 1] 1}
Scaling value 1] 0
Min. temp value o 1)
Max. temp value a

0
FLAG Manitor FLAG b aritar

Item Setting value | Current value |
Channel CHO
Channel status Enable Enable
Sengor type K K
Temp. unit Celsiug Celsiuz
Filter constant a a
Average processing Sampling Sampling
Average value 1] 0
Scaling data type Bipolar Bipolar
Scaling min. valug -32768 -32768
Scaling max. walue 32767 32767
[ Stop Monitoring ] [ Test I
Close

[Test] execution screen
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6) If [Flag Monitor] is selected on the [Special Module Monitor] window, [Temp. Measuring
Module Command] screen can be monitored.

Special Module Monitor @E|
XBF-TCO4S (TC, 4CH)
ltem CHO | CH1 |
Temperature valug 2 1)
Scaling value 22815 1)
Min. temp valie 0 0
Max temp value U 0 Temp. Measuring Module Command
liem CH2 CH3
Temperaturs valus [ [ XEF-TC045 TG, 4CH)
Scaling value [ [ v
Min temp value [ 0 ltem CHO CH1
HES e o 0 4 Channel status Stop
FLAG Moritor FLAG Monitar
Sensor status Marmal Marmal
Itom Sellingvale | Curentvalus | Item CH2 | CH3 |
o Lo Channel status Stop Stop
Channel status Enable Enable
Senzor status Mormal Normnal
Sensor type 3 K
Temp. unit Celsius Ceksius
= Command CHO | CH 1 \
ilter constant a 1)
Average procesing Sampling Sampling MawdMin active ( DISABLE Il DISABLE J
Bverage vale 0 0 RIC Active [ ENABLE J[ EMAELE ]
Sealing data type Bipolar Eipolar Cemme CH 2 | CH3 ‘
Sca I 32768 32768
AT el Mar/Min active [ DiseBlE  J[ DisBLE ]
Scding mas, value 32767 2767 =
RIC Active [ ENABLE ][ ENABLE i
o= ]

[Temp. Measuring Module Command] execution screen

7) [Temp. Measuring Module Command] screen
monitoring

On the

screen,

Channel

(Normal/Disconnection) can be monitored.

On the flag command screen, Max/Min active (ENABLE/DISABLE) and cold junction

status

compensation (ENABLE/DISABLE) can be specified.

Temp. Measuring Module Command

EIx

(Run/Stop)

and Sensor

status

XBF-TCO4S (TC, 4CH)
[ CHO CH1
Channel status Stop
Sensor status M omal Wormal
Item tH2 | tH3 | Monitoring screen
Channel status Stop Stop
Sensor status Morrmal MNormal /
Command THO | CH1 )\
MaxMin active DISAELE 1 DISAELE )
RC Active EMABLE )il ENAELE ]
Command tHz | H3 | Flag command screen
Man/Min active D|SABLE Jii DISABLE ]
RC Aetive EMABLE ) ENABLE /]

8) [Close]: [Close] is used to escape from the monitoring/test screen. When the
monitoring/test screen is closed, the max. value, the min. value and the present value will
not be saved any more.

[Test] function is only available when XGB CPU unit’s status is in [Stop].
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5.5.3 Register U devices (Special module variable)

Register the variables for each module referring to the special module information that is set in the
1/0 parameter. The user can modify the variables and comments.

(1) Procedure
(a) Select the special module type in the [I/O Parameter Setting] window.

I/0 Parameter Setting

Maodule list
'j@ Base 00 : Default | | Slat | Module Comment Input Filker | Emergency Out Alocation |
&5 00 DC 24V INFUT/TRC, [ Djmain] |DC 2V INFUT/TRO 35tandard [mz]  Defaul PODDDO~ POODZF
RN 01 XBF-TC04S (TC. 4 5 . , :
ez 02 Default 2
ez 03 Default 3
- ezp 04 Default
iz 05 Defaut 4
iz 0B : Default 5
ez 07 : Default E
7
[ ST L2
Delete Slot | | Dclete Base | | Base Seting | [ Deletel | [ Detals | [ Pot ¥ | [ ok ][ Canedl

(b) Double click ‘Variable/Comment’ from the project window.

Eroje:t Edit Find/Replace View Online Monitor Debug Tools Window Help - ||
DEaHEHS 2% BEE P R EY ABWH ALY
; na o & @ ; % i E EmERE
Ak sk HPE dME — | —% 5 4k 44k ASF {RF 4P} AMF AFF - n lag |
F3 F4 SF{ sF2 F3 F6 & 53 F9 Fii SF: oF4 o5 oF5 PO EaEE = =@ D [ Re:
[ Projact Window x| =i
~
ltems g S
= & Bample_XGB
E-FD New?

B Basic Parameter ]
& /0 Parameter
T Embsdded Paramstar —
= [l Scan Program

"[E] NewProgram

v
& 2
B project My Varisble/Commert kS NewPragram
x| | PLC Type |2
a T T 4
=1
=
r -
5 5
£ £
= =
Ik | ¥ ¥
5[4« [P Monitor 1 fMenitor 2, | 2 [W)[M]}, Result {Theck Prosran j,Find 1 jFind @ j Comnunication j\ Cross Reference Jy Us

NewPLC Offiine Raw 0, Column 9 Ove
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(c) Select [Edit] — [Register U Device].
In case of XEC, select [Edit] - [Register special module variable]

riable/Comment]

l}’é} Project |EditL EindReplace View Online Monitor Debug Tools Window Help | | St
=72 Und Ctri+Z v 2 9
OwE— " B2 iz BB X S T i
% cut Cirl4x & I 0= =% B
- By Copy cri+C - IEI = @ 3 [100%
Project Viinde - =
ke % Delete Del E“ﬂ" Variable ]@VEW Dovice m\ =w Flag l
ems =
= BB Exan Select Al Chrl+a Variable | Type v| Device | Comment e
= N 1 i
@ s 04D InsertLine Cirl+L 2
= [Bx Deleteline Ctrl+D 3
—Export Varishles o fle.. {14
| Regster Ubevice IIE
- 5]
=)
7
8
9
an >
< >
Biproject b Vanable/Comment NewProgram
x| [ PLC Type
. ]
=1
;Z
o
2| =
21 g
= £
= 5
=] | 3|8
5 DRI Monitor 1 AMonitor 2 4 | 2|14 ¢ (PP Result fCheck Progran j, Find 1 J, Find 2  Communication f, Cross Reference J, Us
Automatically registers comments in the U Devices according  MewPLC Offine \iew Variable Ove
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(d) Click ‘Yes'. The previous comment will be deleted.

3\ project Edit EindfReplace View Onine Monitor Debug Tools Window Help -8 %
head:dsE ) Bl ER ST [T
BOEI : oo 2&E
E @ G100
Project Window x ~ =
e | [V] view Variable ]iEl‘.’-E\'J}Evc% [ View Fieg ]
ems
|2 HF Example _XGE* ! [ Variable | Type Y] Device | Comment ~
= ) NewPLC(XGB-XBMS}Offline 1
B | 9 Automatcaly register comments in the U Devices according to the special module setin the 1/ parameter,
& ‘-'rj The previous comment wil be deleted,
o8 Sca Continue?
=]
< T =
b | »
B3 Project S Vanable/Comment NewProgram
= | PLC il
M T
£
i
£ E
i £
£ =
5e ] 5 ¥
5|14« [0\ Monitor 1 fHenttor 2, | €1« « [(#)(]\ Result A Theck Proaran j,Find 1 J,Find 2 j Comunicaton f, Cross Reference jUs
NewPLC Offline Ot

(e) As shown below, the variables are registered.

able/Comment]
‘,"%i,ﬁroject Edit FindReplace W¥iew Onfine Monitor Debug Tools Window Help =| 5%
= =~ = %5 BEE P 4 BB X S 8 db B W 0 L8
3 | Bk (2L BOE 0% BwE
. ! El @ & 100
[Project Windowe = | -
|t.. EV“"N‘M'E “E“.few Dewvice @\"EW Flag ]
ems
= E Example_XGB* Variable | Type v| Device | Comment o
& @ NewPLCHGBXEMS)Offine -0 CHO APWE BT OO0, Temn: Meostinng Maddle CHD Ofsoi
; %3 Variable/Comment 2 _01_CH1_ADJE BIT :U01.00.1 ‘Temp. Measuring Module : CHT Offset/t
5 [ Parameter 3 | 01.CH2 ADIE | _ Temp. Measuring Module : CH2 Offsst
B Basc Paameter 4| 01 cH3 ADJE . Temp. Measuring Module : CH3 Offset
[ /0 Parameter 5 _O1_EEPROME Temp. Measuring Module : OffsetiGain
Sean Program 6 Bl farlesn) o e
— 7 ‘emp. Measuring Module : Module Re:
-[&] MewProgram St bl ot sl e e A |
8 o1 L Yemn Meastring Madule’: CHO Runnie
i - CHEACT B . Temp. Measuring Module : CH1 Runnir
O Ut A B 2 lemp Measuting Macklle: CLE-onn
11 _D1_CH3_ACT BIT iU01.01.3 ‘Temp. Measuring Module : CH3 Runnir
12| 01 cHo_BOUT 01014 Temp. Messuring Module : CHO Input €
13 |01 CHLBOUT BIT  UOT0TS  Temp. Measuring Module : CHI InputC
14 |01 CH2 BOUT ot empe Meestring Mock e
15 017 Temp. Measuring Module : CH3 Input
16 L R Mot Muctile: Lhll Seriod
17 D_‘I.DT.Q_ . Measu!'ing quu_le:CH‘I Semng
8 ololA
| <,
i Project = Varizble/Comment New Program
<[ rc e | |*
“ “
=11
=/
2
5 g
=4 ki
= =
3 | 5 ||§
2|« « [0\ Monitor 1 fHenitor 2J |£]< « (B](DYResuit fTheck Prosran Find 1} Find 2 } ComnicatTon J,Crass Reference f, Us

NewPLC

Offiine View Variable Ove
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(2) Save variables
(a) The contents of ‘View Variable’ can be saved as a text file.
(b) Select [Edit] -> [Export to File].
(c) The contents of ‘View variable’ are saved as a text file.

(3) View variables
(a) The example program of XG5000 is as shown below.

B NewProgram

Lo
Ugt.0nF  UD1O1.0 ~
sl —1 a [ nov uoi.os Doooo | g
Lt
o011 [ nov I
‘2
ot 0.2 [ nov s Do |
L3
ot 013 [ nov uior oo |
iq
END
517
L5 b
< | *

(b) Select [View] -> [Variables]. The devices are changed into variables.

£ L
D1_RDY T MlY  _O1_CHO_TEMP 00000 [_ 2
sof— | | | =
% _01_GHI_4c
T | wv  oionee oo ||
| .
i _01_0H2_hc
T IR
| .
i 01034
T | wv  oioeee wm ||
| .
ig
END
517 "
< | 3 ..

B NewProgram

L0 Uot.oo.F o uot.on.o
: " ICHID . [ mow U004 Doooo || 3
_01_GHD_, 01_CHO_TE =
. H 1o
L uot.ot .1
Ml [ nov Uoios  oooo |
_01_CHI_AC _O1_CHITE
T P
i2 UDI.DII.Z [ mow uot.os  Doooo ||
_01_CHZ_AC _01_CHETE
T P
L3 uot.01.3
L [ nov Uo7 oooo ||
_01_CH3_AC _01_CHATE
. T P
END
s17
fE
(_ |
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|"‘

oA
ik
[N

ect [View] -> [Device/Comments]. Devices and comments are both displayed
u ':T: _|-3=- '3=- ! Mo D000 l_
'5::-_':'; .'5:5_5'_:
Maodule Wadule
Madule _':- c
F=ad Funning
e '3=' Mo e con ||
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5.6 Configuration and Function of Internal Memory

It describes the configuration and function of internal memory.

5.6.1 Data I/O area (U device)

(1) Data sent from module to XGB main unit (XGB PLC input area, read only)

pewce Type Comment Content R/W Slgngl
assignment direction
U0x.00.0 BIT CH 0 offset/gain adjustment error R
U0x.00.1 BIT CH 1 offset/gain adjustment error R
U0x.00.2 BIT CH 2 offset/gain adjustment error On: error, Off: R
U0x.00.3 BIT CH 3 offset/gain adjustment error normal R TCoCPU
U0x.00.D BIT Module offset/gain backup error R
U0x.00.E BIT Module H/W error R
UOX.00.F BIT | Module Ready 8][; L?t‘or'ga dy R
U0x.01.0 BIT CH 0 running R
U0x.01.1 BIT CH 1 running Channel running R
U0x.01.2 BIT CH 2 running On: run, Off: stop R
U0x.01.3 BIT CH 3 running R
U0x.01.4 BIT CH 0 disconnection Thermocouple R
Uox.01.5 BIT CH 1 disconnection sensor R
U0x.01.6 BIT CH 2 disconnection On: disconnection, R TC—CPU
U0x.01.7 BIT | CH 3 disconnection Off: normal R
Uox.01.8 BIT | CH 0O setting error . R
UOX.01.9 BIT | CH 1 setting error Parameter setting R
UOx.01.A BIT |[CH2 setting error 8; zgg:zg ﬁ(r)rronr]al R
UOx.01.B BIT CH 3 setting error R
UOx.04 WORD | CH 0 temp. conversion value Temp. conversion R
Uox.05 WORD | CH 1 temp. conversion value value R TC—CPU
Uox.06 WORD | CH 2 temp. conversion value (Measured R
uox.07 WORD | CH 3 temp. conversion value temp.x10) R
UO0x.08 WORD | CH 0 scaling operation value Range with sign: R
Uox.09 WORD | CH 1 scaling operation value -32768~32767 R
- - . . TC—CPU
u0x.10 WORD | CH 2 scaling operation value Range without sign: R
Uox.11 WORD | CH 3 scaling operation value 0~65535 R
U0x.12 WORD | CH 0 min. temp. conversion value R
U0x.13 WORD | CH 0 max. temp. conversion value R
UOx.14 WORD | CH 1 min. temp. conversion value _ R
UOx.15 WORD | CH 1 max. temp. conversion value Te_mp. conversion R
UOx.16 WORD | CH 2 min. temp. conversion value (Tc!::]l.jml?étion R TC—CPU
uox.17 WORD | CH 2 max. temp. conversion value R
U0x.18 WORD | CH 3 min. temp. conversion value R
U0x.19 WORD | CH 3 max. temp. conversion value R

% X’ means slot no. where module is installed.
Ex.) U02.04: no.2 slot channel 0 temp. conversion value (word)
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(2) Command sent from XGB main unit to module (XGB PLC output area, read/write available)

pewce Type Comment Content R/W Slgngl

assignment direction
CH 0 max./min. searching

U0x.29.0 BIT | Enable/Disable RIW

U0X.29.1 BIT CH1 ma>§./m|n. searching Min./max. search R/W
Enable/Disable .

UOX.29.2 BIT CH 2 max./min. searching O?fj gpatt))lle R/W

49 Enable/Disable Off: disable

CH 3 max./min. searching

U0x.29.3 BIT | Enable/Disable RIW CPULTC

- - - o

UOX.29.8 BIT CHO colt_j junction compensation RIW
Enable/Disable
CH 1 cold junction compensation | Cold junction

U0x.29.9 BIT Enable/Disable compensation RIW
CH 2 cold junction compensation | On: enable

UOx.29.A BIT Enable/Disable Off: disable RIW

UOX.29 B BIT CH 3 cqld junction compensation R/W
Enable/Disable

3% ‘X’ means slot no. where module is installed.
Ex.) U03.29.02: no.3 slot, CH 2 max./min. searching Enable/Disable (bit)
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(3) Data sent from module to XGB main unit (IEC type)
(XGB PLC input area, read only)

pewce Type Comment Content R/W Slgngl

assignment direction
%UXO0.x.0 BIT CH 0 offset/gain adjustment error R
%UXO0.x.1 BIT CH 1 offset/gain adjustment error R
%UX0.x.2 BIT CH 2 offset/gain adjustment error On: error R
%UX0.x.3 BIT CH 3 offset/gain adjustment error Off: normal R

TC—CPU
%UX0.x.13 BIT Module offset/gain backup error R
%UX0.x.14 BIT Module H/W error R

On: read
%UX0.x.15 | BIT | Module Ready off. ot ré’a dy R
%UX0.x.16 BIT CH 0 running R
%UX0.x.17 BIT CH 1 running Channel running R
%UX0.x.18 BIT CH 2 running On: run, Off: stop R
%UX0.x.19 BIT CH 3 running R
%UX0.x.20 BIT CH 0 disconnection R
%UX0.x.21 | BIT | CH 1 disconnection Thermocouple sensor ™™g
%UX0.x.22 BIT CH 2 disconnection On: disconnection, R Te—CPU
Off: normal

%UX0.x.23 BIT CH 3 disconnection R
%UX0.x.24 BIT CH 0 setting error ) R
%UX0x.25 | BIT | CH 1 setting error (F;":‘]fasrzzitﬁg Séertrtc')rr‘g R
%UX0.x.26 BIT CH 2 setting error Off: setting normal R
%UX0.x.27 BIT CH 3 setting error R
%UWO0.x.4 WORD | CH 0 temp. conversion value ) R
%UWO0.x.5 WORD | CH 1 temp. conversion value \-I/—S;EE' conversion R TCCPU
%UWO0.x.6 WORD | CH 2 temp. conversion value (Measured temp.x10) R
%UWO0.x.7 WORD | CH 3 temp. conversion value R
%UWO0.x.8 WORD | CH 0 scaling operation value Range with sign: R
%UWO0.x.9 WORD | CH 1 scaling operation value -32768~32767 . R TCoCPU
%UWO0.x.10 | WORD | CH 2 scaling operation value Range without sign: R
%UWO0.x.11 | WORD | CH 3 scaling operation value 0~65535 R
%UWO0.x.12 | WORD | CH 0 min. temp. conversion value R
%UWO0.x.13 | WORD | CH 0 max. temp. conversion value R
%UWO0.x.14 | WORD | CH 1 min. temp. conversion value ) R
%UWO0.x.15 | WORD | CH 1 max. temp. conversion value 'Ir;ﬁnm/prh;?(nversmn R TCoCPU
%UWO0.x.16 | WORD | CH 2 min. temp. conversion value accumulation R
%UWO0.x.17 | WORD | CH 2 max. temp. conversion value R
%UWO0.x.18 | WORD | CH 3 min. temp. conversion value R
%UWO0.x.19 | WORD | CH 3 max. temp. conversion value R

¥ ‘X’ means slot no. where module is installed.
Ex.) %UWO0.2.4: no.2 slot channel O temp. conversion value (word)
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(4) Command sent from XGB main unit (IEC type) to module
(XGB PLC output area, read/write available)

pewce Type Comment Content R/W Slgngl
assignment direction
CH 0 max./min. searching
0,
06U X0.x.464 BIT Enable/Disable R/W
%UX0.x.465 BIT CH 1 max./min. searching Min./max. search R/W
Enable/Disable .
%UXO0 X466 BIT CH 2 max./min. searching 82 Spalglle R/W
DUV Enable/Disable - disable
CH 3 max./min. searching
0,
0%UX0.x.467 BIT Enable/Disable R/W
CH 0 cold junction CPU=TC
0,
BUX0.x.472 BIT compensation Enable/Disable RIW
CH 1 cold junction Cold junction
0 .
»UX0.x473 | BIT compensation Enable/Disable compensation RIW
CH 2 cold junction On: enable
0, .
#UX0x474 1 BIT compensation Enable/Disable Off: disable RIW
CH 3 cold junction
0,
UX0.X.475 BIT compensation Enable/Disable RIW

¥ ‘X’ means slot no. where module is installed.
Ex.) %UX0.3.466: no.3 slot, CH 2 max./min. searching Enable/Disable (bit)

5.6.2 How to set operation parameter
Operation parameter of thermocouple input module can be set by two methods.

(1) Setting operation parameters through [I/O parameter setting] window.

XBF-TCO4S (TC, 4-CH)

KBF-TCD4S (TC, 4-CH)

Parameter CHO | CHY tHz | oH3 |
PR I * [ Channel status Enable ~|  Enatle Enable Enable
ltems [] Sensor status K K K K
= @ Example_¥GB [ Temp. unit Celsiuz Celsiuz Celsiuz Celsiuz
=@ NewPLCXGB-¥BMS)-Offline Filter constant 0 0 0 0
%3 Varable/Comment [ Average processing Sampling Sampling Sampling Sampling
= E Parameter Average value 1] 1] 1] i}
[] Scaling data type Bipalar Bipalar Bipalar Bipalar
Scaling min. walue -32768 -327E8 -327E8 -32768

T Embedded Parameter Soaling max. vaue w2767 32767 30767 32767
=] Scan Program
. OK ] [ Cancel

Mew Program
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(2) Writing operation parameters through program (PUT instruction is used.)

| o
o om0 1] 15003 &1 v
h 2 unning
h0004: Ch3 running
MDD?1 ! PUT 1 1 l_}JI chanrels stop
MDD?Z | PUT 1 F 1 I_EJI channges run
MDD? ! PUT 1 1 1 I_Ch[ K type sensor
MDD[IM | PUT 1 5 1 I_'Celeius
e | puT 1 1 1 1 || Enable Chtime - Avr
MDD?E | PUT 1 14 < 1 l_ Time-Avr value: 400ms
MDD[IL [ruT T 12 i Y Eectar
MDD?a ! PUT 1 15 1 I_Ch[scaling min, value
MDD?E | PUT 1 2 1 l_Ch.CscaIing max. value
END
Remark
How to use PUT instruction
COMMAMD
PUT _|_|_I || l—1 [ [s1]s2]n
COMMAND
PUTP L || [—r[s [s1]s2]n
[___] indicates PUT instruction.
[Area setting]
Operand Description Data size
sl Slot no. where special module is mounted WORD
S1 Internal memory address of special module WORD
S2 Device to save in special module WORD
N The number of data WORD
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(3) Writing operation parameters at setting area of thermocouple input module through program

(IEC type, PUT function block is used)

&1 1Charne|
AWND.1.15  sStop HIVE
— | |} EN  END
| ooy
& 11Channe
sRun MOYE OperationT
— | EN  ENO 0 IN - our vpE
CHORUR HOYE Operat ionT
}—— EN  ENO 1BRO00f INouT ype
OperationT
1680001 N ouT YpE
CHIRun MOVE
— EN  END
CHZRun HOYE OperationT
! EN ~ ENO 16#0002 IN- T vpE
CH3Run HOYE Operat ionT
j—— EN ENO L 1680004 INouT ype
OperationT
1BRO00G IN - OuT b
IN3TE IN3T? IN3TS
PUT_IORD PUT_IORD PUT_IORD
REQ ™ DONE REQ ~ DOKE REQ ™ DOME L
0 {BASE STATL 0 {BASE STAT} 0 {BASE STATL
1 {5007 1 {5007 1 {5LaT
0 JHA00 1 JHA00 5 JM400
R R R
OperationT
vpE JDATA 0 JDATA 0 {DATA
IN3TY INSTI0 INST11
PUT_IORD PUT_IORD PUT_IORD
REQ ™ DONE REQ ~ DOKE REQ ™ DOMEE
0 {BASE STATL 0 {BASE STAT} 0 {BASE STATL
1 45007 1 45007 1 {5LaT
1a JMA00 14 JMA00 18 JMA00
R R R
1 JDATA 400 JDATA 0 {DATA
| IN3T1Z IN3T13
PUT_IORD PUT_IORD
REQ ™ DONE REQ ™ DOMEE
0 {BASE STATL 0 {BASE STATL
1 45007 1 {5LaT
19 JMA00 20 JMA00
] R R
0 JDATA 0 {DATA
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5.6.3 Operation parameter setting area

It describes operation parameter setting area of thermocouple input module.

Memory
address Description Setting value R/W Instruction
Hex. Dec.
Designate a channel to |
00n 0 bit0:bit3, 0: stop, 1: run R/W
use
01y 1 Set sensor type of CH 0
024 2 Set sensor type of CH 1
K:0,J:1, T:2, R:3 R/W
034 3 Set sensor type of CH 2
044 4 Set sensor type of CH 3
Designate temperature | iio-pi . : .
05, 5 g p bit0:bit3,  0:  Celsius,  1: RIW
metric system Fahrenheit
064 6 Set CH O filter value
074 7 Set CH 1 filter value W
- 0 or 200 ~ 64000 R
084 8 Set CH 2 filter value o
094 9 Set CH 3 filter value
Set averaging method
OAH 10
of CHO
Set averaging method )
OBy 11 0: sampling
of CH1 1: time average RIW
Set averaging method | 2: count average
0Cy 12 of CH 2 3: moving average
Set averaging method
0D 13
of CH3 PUT
GET
OE 4 14 Set mean value of CH 0
OF 4 15 Set mean value of CH 1 | Time average: 400~60000 ms
Set I fCH 2 Count average: 2~64000 times R/W
10w 16 et mean value o Moving average: 2~100
11y 17 Set mean value of CH 3
12 18 Designate scaling type | bit0O:bit3, RIW
H 0: signed, 1: unsigned
Set min. value of CH 0
134 19 .
scaling range
Set max. value of CH 0
14y 20 .
scaling range
Set min. value of CH 1|
154 21 . Min. value
scaling range signed: -32768~[max.-1]
Set max. value of CH 1 | unsigned: O~[max.-1]
164 22 l R/W
Scaling range Max. value
Set min. value of CH 2 | signed: [Min.+1]~32767
17w 23 scaling range Unsigned: [Min.+1]~655535
Set max. value of CH 2
184 24 .
scaling range
Set min. value of CH 3
194 25 .
scaling range
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Memory
address Description Setting value R/W Instruction
Hex. Dec.
Set max. value of CH 3
1AH 26 .
scaling range
1By 27 Set error inf. Of CHO.
1CH 28 Set error inf. Of CH1 _ _ )
10, 25 Set error inf. Of CH2 Setting error information (Flag) R GET
1E 4 30 Set error inf. Of CH3
Cold junction
1F 4 31 compensation temp. of
CHO.
Cold junction
201 32 compensation temp. of
CH1. Measured value of cold junction
- - . R GET
Cold junction compensation temp.
214 33 compensation temp. of
CH2.
Cold junction
224 34 compensation temp. of
CH3.
234 35 System area . . . i
~37, 55 (Offset gain storage area) Read/Write unavailable unavailable
/\ Caution
(1) If input value of memory address 004~1An(0~26) is out of range of setting value,
U0x.01.8~U0x.01.B (setting error representation flag, in case of IEC type,
%UX0.x.24~%UX0.x.27) are on and it acts as default setting
value. Error information is displayed in 1By~1Fu(27~30) area.
(2) System area (Offset gain storage area) is area where Read/Write is unavailable.
If this area changes, malfunction or breakdown may occur.
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(1) Designating Channel (Address 0)
(a) Temperature conversion module Enable/Disable can be set to each channel.
(b) By prohibiting a channel not to use from conversion, conversion interval by channels can be
shortened.
(c) If channel to use is not designated, every channel can not be used.
(d) In case of using PUT instruction,temperature conversion module Enable/Disable are as follows.

B15 B14 B13 B12 Bl11 B10 B9 B8 B7 B6 B5 B4 B3 B2 Bl BO

clc|c
Address “0” — === =]|=]=|=|=|=|=]|H|H|H
3|2 0

BIT Description
0 Stop
1 Operate

(e) Vales set in B4 ~ B15 are ignored.
() This area shows the same results with operation channel designation in I/O parameter setting

window.
XBF-TCO4S (TC, 4-CH) PIx
XBF-TCO4S (TC, 4CH)
Parameter CcHo | oWt | oHz | cH3 |
[] Channel status Enable v Enahle Erable Enahle
[] Sensor status K K 4
] Temp. unit Enabls Celsius Celziuz Celsiuz
Filter constant 0 0 0 1]
[] Average processing Sampling Sampling Sampling Sampling
Awerage value 0 1] 1] a
[] Scaling data type Bipolar Bipolar Bipolar Bipolar
Scaling min. value -32768 32768 32768 -32768
Scaling max. value 32767 32767 32767 32767
OK ] [ Cancsl

(2) Sensor Type Setting Area (Address 1~4)
(a) Thermocouple sensor type can be set per channel.
(b) In case of using PUT instruction, Sensor Type Setting Area is as follows.

B15 B14 B13 B12 Btll B10 B9 B8 B7 B6 B5 B4 B3 B2 B1 BO

Address “1” CHO sensor type setting
Address “2” CH1 sensor type setting

Address “3” CH2 sensor type setting

Address “4” CH3 sensor type setting

Word Description
0 K type
1 J type
2 T type
3 R type

(c) When input value is larger than 4, 0 (K type) is selected by force.
But, U0x.01.8~ UOx.01.B (setting error representation, in case of IEC type, %UX0.x.24
~ %UXO0.x.27) are on, error information is displayed at bit O of address 27~30.

5-40
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(d) This area shows the same results with sensor type designation in I/O parameter setting window.
XBF-TC04S (TC, 4-CH) FIx

XBF-TCD4S (TC, 4CH)
Parameter tHo | oH1 [ tHz [ oH3 |

[] Channel status Disable Enable Enable Enable
[ Sensor status K v K K S

[ Temp. unit Celsiuz Celsiuz Celsiuz
Filter constant JT 1} 1} 1}

[ Average processing |R Sampling Sampling Sampling
Average value 1] 1] u] 1]

[ Sealing data type Bipolar Bipolar Bipolar Bipolar
Scaling min. value -327E8 -32768 -327E8 -32768
Scaling max. value 32767 32767 32767 32767

[ OK 1 [ Cancsl

(3) Temp. unit setting area (Address 5)
(a) Temp. unit (Celsius/ Fahrenheit) of thermocouple input module can be set per channel.
(b) In case of PUT instruction, Temp. unit setting area is as follows.

B15 Bl4 B13 B2 B1l BI10 B9 B8  B7 B6 B5 B4 B3 B2 Bl BO

Address “5” clc c |lc

— == |=|=|=|=|=|—-|=|=|—|H|H|H|H
312|110
[
Bit Description
0 Celsius
1 Fahrenheit

(c) Vales set in B4 ~ B15 are ignored.
(d) This area shows the same results with temp. unit setting in I/O parameter setting window.

XBF-TC04S (TC, 4-CH) Px

XBF-TCO45 (TC, 4CH)

Parameter cHo | oHr [ oMz | W3
[ Chanrel status Dizable Enable Enable Enable
[ Sensor status K K K K
] Temp. unit Celsiuz “ Celsiug Celsiug Celsiuz
Filter congtant 0 o 0

Fahrenheit

[] Average processing Sampling Sampling Sampling
Awerage value 1] 1] u] 1]

[] Scaling data type Bipalar Bipalar Bipolar Bipalar
Scaling min. value -327E8 -32768 32768 -22TER
Scaling max. value 32767 32767 32TET 32TET

[ OK ] [ Cancel

(4) Filter constant setting area (Address 6~9)

(a) Filter constant can be set per channel.

(b) Filter constant ranges 0 or 200 ~ 64000.

(c) If filter constant is set as 0, filtering process is not executed.

(d) When input is 1~199 or larger than 6400, O (filter disable) is selected by force.
But, UOx.01.8~ UO0x.01.B (setting error representation, in case of IEC type, %UXO0.x.24
~ %UXO0.x.27) are on, error information is displayed at bit 1 of address 27~30.

(e) In case of PUT instruction, filter constant setting address is as follows.
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B15 B14 B13 B12 B11 B10 B9 B8 B7 B6 B5 B4 B3 B2 Bl BO
Address “6” CHO filter constant setting (0, 200~64000)
Address “7” CHL1 filter constant setting (0, 200~64000)
Address “8” CH2 filter constant setting (0, 200~64000)
Address “9” CHa3 filter constant setting (0, 200~64000)

(f) This area shows the same results with filter constant setting in I/O parameter setting window.
XBF-TCO4S (TC, 4-CH) Rx

XBF-TCO45 (TC, 4CH)
Parameter tHo | cH1 [ ocHz | cH3

[] Channel status Dizable Enable Enable Enable
[] sensar status K K K K.

1 Temp. unit Celsius Celsiuz Celsius Celsius
Filter constant o | 0 1} 1}

[[] Awverage processing Sampling Sampling Sampling Sampling
Average value 1] 0 1] 1]

[ Scaling data type Bipolar Bipolar Bipolar Bipalar
Sealing min. value -327E8 32768 -327E8 32768
Scaling max, valus 32767 32TET 32767 32767

0. 200~64000 ok ] [ cance

(5) Average processing setting area (Address 10~13)
(a) Average processing method can be set per channel.
(b) Average processing method (Sampling: 0 / time-avr.: 1 / count-avr.: 2 / moving-avr.: 3)
(c) When input is larger than 4, 0 (sampling) is set by force.
But, UO0x.01.8~ UOx.01.B (setting error representation, in case of IEC
type, %UX0.x.24~%UX0.x.27) are on, error information is displayed at bit 2 of address 27~30.
(d) In case of PUT instruction, average processing setting method is as follows.

B15 B14 B13 B12 Bl BI10 B9 B8 B7 B6 B5 B4 B3 B2 B1 BO

Address “10” CH# average processing method setting
Address “11” 0: Sampling
1: Time-average
Address "12” 2: Count-average
Address “13” 3: Moving-average

(e) This area shows the same results with average processing method setting in I/O parameter
setting window.

XBF-TCO4S (TC, 4-CH) RIx)

XBF-TCO4S5 (TC, 4CH)
Parameter cHo | oW1 [ cHz | cH3 |
[] Channel status Disable Enable Enable Enable
[] Sensor status 4 K S 4
] Temp. unit Celsiuz Celziug Celsiuz Celsiuz
Filter constant i 0 0 0
[ Average processing | Sampling v | Sampling Sampling Sampling
Average value o o ]
i Timne-Aur i i
[F Scahng.dala tppe Count Bipolar Bipalar Bipolar
Scaling min. value Moving-Ayr -32768 32768 -32768
Scaling max. value J27ET 32767 32767 3Z7ET
OK 1 [ Cancel
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(6) Average value setting area (Address 14~17)
(a) Average value can be set per channel.
(b) In case average processing method is sampling, values of this area are ignored.
(c) In case of using PUT instruction, average value setting address is as follows.

B15 Bl4 B13 B12 B1l BI10 B9 B8 B7 B6 B5 B4 B3 B2 Bl BO

Address 14 CH# average value setting
Address “15” Time-average: 400 ~ 64000[ms]

Address “16” Count-average: 2 ~ 64000[times]

Address “17” Moving-average: 2 ~ 100

(d) When input is out of range, the min. value of each address is selected by force.

But, U0x.01.8~ UOx.01.B (setting error representation, in case of IEC type, %UXO0.x.24

~ %UXO0.x.27) are on, error information is displayed at bit 3~5 of address 27~30.
(Bit 3: time-average, bit 4: count-average, bit 5: moving-average)

Ex.) When selecting the Time-average and setting average value as 200, 400ms is selected in

address “14" by force.

(e) This area shows the same results with average value setting in I/0O parameter setting window.
In the I/O parameter setting window, prohibition function is provided not to set value that is out
of range. (In case of setting value that is out of range, that values are displayed with red color

and error message is displayed.)

1) Time-Avr.
XBF-TC04S (TC, 4-CH) 2Ix
XBF-TCO4S (TC, 4CH)
Parameter o | oW1 [ eHz [ cHs ]
7 Channel status Disable Enable Enable Enable
[ Sensor status K K K 3
[ Temp. unit Celsius Celsius Celsius Celsius
Filter constant o o o 0
] Average processing Time-dut Sampling Sampling Sampling
Awerage valug 500 o o i}

[ Scaling data type Bipolar Bipolar Bipalar Bipolar
Scaling min. value 32768 32768 32768 32768
Scaling max. value 32767 32767 32767 32767

2) Count-Avr.
XBF-TCO4S (TC, 4-CH) 3]
XBF-TCO45 (TC, 4-CH)
Parameter cHo [ oW1 | W2 [ oH3 |
[] Channel status Disable Enable Enable Enable
[ Sensor status K K K K
[ Temp, unit Celsius Celsius Celsius Ceksius
Fier constant 0 0 0 0
[ Average processing | Counthwi  Samping Samping  Sampling
Average value 500 | 0 i i

[] Scaling data type Bipolar Bipolar Bipolar Bipolar
Scaling min, walue 32768 32768 -32768 32768
Scaling max. valug 32767 32767 32767 32767

500
3) Moving-Avr.
XBF-TCO4S (TC, 4-CH) 3
XBF-TCD45 (TC, 4CH)
Parameter tHo [ eH1r [ oHz | cH3 ]
[ Channel status Disable Enable Enable Enable
] Sensor status K K K 3
] Temp. unit Celsius Celsius Celsius Celsius
Filter constant o o o 0
[ &werage processing | Mowing-dwr Sampling Sampling Sampling
Average value 50 [t} o o

[ Sealing data type Bipolar Bipalar Bipolar Bipolar
5caling min. value 32768 32768 32768 -32768
Scaling max. value 32767 32767 32767 32767

100
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(7) Scaling data type setting area (address 18)
(a) Scaling data type can set per channel.
(b) There are two type of scaling operation output, unsigned 16 bit (0~65535) or signed 16 bit (-
32768~32768).
(c) In case of using PUT instruction, scaling data type setting address is as follows.

B15 B14 B13 B2 B1l BI10 B9 B8  B7 B6 B5 B4 B3 B2 Bl BO

— === |—|—|—|—|—|—|—|—|H|H |H|H
32|10
-
Bit Description
0 Signed integer
1 Unsigned integer

(d) Values set in B4~15 are ignored.
(e) This area shows the same results with Scaling data type setting in I/O parameter setting

window.
XBF-TCO4S (TC, 4-CH) 72X
XBF-TCO4S (TC, 4CH)
Parameter cho | et [ cH2 | 3
[ Channel status Disable Enable Enable Erable
[[] Sensor status K K K K
[ Temp. unit Ceksius Ceksius Ceksius Celsius
Filter constant i i i ]
[] Aveiage processing | Movingwr  Sampling Sampling Sampling
Avverage value 50 0 i 0
[] Scaling datatype | Bipdlar v | Bipolar Bipolar Bipalar
Scaling min. value -32768 32768 32768
Scaling max, value 32767 32767 32767

(8) Scaling min./max. value setting area (Address 19~26)
(a) Scaling min./max. value can be set per channel.
(b) There are two type of scaling operation output, unsigned 16 bit (0~65535) or signed 16 bit
(-32768~32767).
(c) In case of using PUT instruction, scaling min./max. value setting address is as follows.

B15 B14 B13 B12 B11 B10 B9 B8 B7 B6 B5 B4 B3 B2 B1 B0

CH2: min. address 23 / max. address 24

Address "25 CH3: min. address 25 / max. address 26

Address “19”
P CH# scaling min./max. value

Address "20 1) with sign Min.: -32768 ~ [Scaling max. value-1]

Address “21” Max.: [Scaling min. value+1]~32767
woon 2) without sign Min.: 0 ~ [Scaling max. value-1]

Add 22 . 4

Max.: [Scaling min.value+1]~65535
Address 23 CHO: min. address 19 / max. address 20
Address “24” CH1: min. address 21 / max. address 22

Address “26”

(d) If input is out of range, it keeps previous value.
But, UOx.01.8~ UOx.01.B (setting error representation, in case of IEC
type, %UXO0.x.24~%UX0.x.27) are on, error information is displayed at bit 6 of address 27~30.
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(e) This area shows the same results with Scaling min./max. value setting in I/O parameter setting

window.
XBF-TCO4S (TC, 4-CH) R
XBF-TCO4S (TC, 4CH)
Parameter cHo [ o1 [ cH2 | cHa |
[1 Channel status Dizable Enable Enable Enable
[] Sensor status K K K K
1 Temp. unit Celsius Celsius Celsius Celsius
Filter constant 1] 1] ] ]
[] Average processing Maving-dur Sampling Sampling Sampling
Auwerage value A0 a 0 0
[ Scaling data type Bipolar Bipolar Bipolar Bipolar
Scaling min. value -32768 -32768 -32768 -32768
Scaling max. value 32767 32767 32767 32767
3276832765 [ ok ][ camea |
Scaling data type Scaling min. value Scaling max. value
Signed -32768 ~ [Scaling max. value -1] [Scaling min. value+1] ~ 32767
Unsigned 0 ~ [Scaling max. value-1] [Scaling min. value+1] ~ 65535

(9) Setting error information area (address 27~30)
(a) If there is error when setting parameter (address 1~26), error information is displayed at
address 27~30 per channel.
(b) In case of GET instruction, setting error information address is as follows.

B15 B14 B13 B12 Bi11 B10 B9 B8 B7 B6 B5 B4 B3 B2 B1
Address “27” CHO setting error information
Address “28” CH1 setting error information

Address “29” CH2 setting error information

Address “30” CH3 setting error information

Related memory
Bit Description address

Hex. Dec.
Bit0 Sensor type (Off: normal, On: error) 011~044 1~4
Bit1l Filter constant (Off: normal, On: error) 061~09y 6~9

. Average processing method

Bit2 (Off: n%rn?al, on: e?ror) OA~0Dx 10-13
Bit3 Time-average value (Off: normal, On: error)
Bit4 Count-average value (Off: normal, On: error)) OEn~11y 14~17
Bit5 Moving-average value (Off: normal, On: error)
Bit6 Scaling range (Off: normal, On: error) 13~1A4 19~26

(c) In case there is error, setting error representation flag (U0x.01.8 ~ U0x.01.B, in case of IEC
type, %UXO0.x.24 ~ %UX0.x.27) will be on, it acts as default value.
If setting error representation flag (UOx.01.8 ~ U0x.01.B) is on, check error information 1By ~
1Fy (27~30) area and solve the error.
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(10) Cold junction compensation temp. area (Address 31~34)
(a) Cold junction compensation temp. can be seen per channel.
(b) In case of GET instruction, cold junction compensation temp. area is as follows.

B15 B14 B13 B12 Bl1 B10 B9 B8 B7 B6 B5 B4 B3 B2 Bl BO

CHO cold junction compensation temp.
CH1 cold junction compensation temp.
CH2 cold junction compensation temp.
CH3 cold junction compensation temp.

(11) System area (offset gain storage area: address 35~55)
(a) In the system area, Read/Write is unavailable.

. If the user changes this area, it may cause malfunction or breakdown.
ﬁcaunon So do not handle this area.
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5.7 Example Program

(1) It describes how to set operation parameter in the internal memory of thermocouple module.
(2) Regarding the initial condition, the initial settings are saved in the internal memory of thermocouple
module if saved once.

(3) The following is program example that reads the temp. value of thermocouple input module of slot
1 and check whether disconnection occurs or not.

5.7.1 Example using [I/O Parameter]

(1) /O parameter setting window

170 Parameter Setting @@
Modulz fist
[ 9 Base 00: Defaut [ [t ] Module [ Comment [ input Fiter_| Emergency 0uf Allocalion |
A5 00:DC 24V INPUT/TRC 3Standard [ms]  Default PO0000 ~ POOO3F
i & 01: XBF-TCD45 (TC. 4C| i B - 0071
= 12 : Defautt 5
oz 013 : Defaut -
- 04 Defauk
= 05 Defaut 4
=z 06 : Defauk 5
= 17 Defat 5
%
< .
Delete Siot | | Dl : [ Deetear | [ petals | [ Pt w ] [ ok ][ cancel
XBF-TCO4S (TC, 4-CH) 33
XBF-TC045 (TC. 4CH)
Parameter cHo | cH1 [ tHe [ tH3 ]
[] Chanrel status Enable Dizable Disable Disable
[] Sensor status K K K K
[ Temp. urit Celsius Celsius Celsius Celsius
Filter constant 1} 1} 0 o
[ Average processing Sampling Sampling Sampling Sampling
Average value [t} [t} 0 0
[ Scaling data typs Bipolar Bipolar Bipolar Bipolar
Scaling min, walue 32768 32768 32768 32768
Sealing max. valug 32767 32767 32767 32767

2) Program example

UOI.0OF U000 WiME Wlono  Uioe HOODO
I 15T 15T 1T 15T
on poy O1CHDAD O1WOTER 01 _CHOLAC 01 _CHO SE
1 JERR R T TERR
oo [ o ugi.o4  Doooo ||
01 CHO_TE
HP
ugt .14 HODD!
—— 3
01 _CHO BO
(T
END

(a) If module is under normal operation, M0O0OQO is on.
U01.00.F(module Ready) = On
U01.00.0(CHO offset/gain adjustment error) = Off
U01.00.E(module H/W error) = Off
U01.00.E(CHO running) = On
(b) If MOOOO is on, temp. conversion value (U01.04) of CHO moves to DO00O.
(c) If disconnection error occurs at CHO, U01.01.4 (CHO disconnection) is on and MO0OL1 bit is set.
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(3) Program example (in case of IEC type)

RUKDTI5 0 BUMOLTLO BUXDLO114 0 BUMDL1 16 BUMOL1.24 start
— | 1/ 1/ { | 1/ —
Tenp, Tenp, Temp, Tenp, Tenp,
Measuring  Measuring  Measuring  Measuring  Measuring
Module Module Module © Module @ Module
Module CHI  Module HA CHO CHO
Ready 0Of f set G Error Running Setting
n Error Error

start MOYE
—{ —— EN EWOL

CHOTempDat
F i

AMo.1.4 q INo0T

Tenp,
Measuring
Module
CHO Temp,

Yalue

CHODi=conn
ect ionErro
#0120 r
— | 35—
Temp,
Measuring
Module @
CHO Imput
Disconnect
jon

1

(a) If module is running normally, operation start bit is on
%UXO0.1.15 (Module Ready) = On
%UXO0.1.0 (CH 0 offset/gain adjustment error) = Off
%UX0.1.14 (Module H/W error) = Off
%UX0.1.16 (CH 0 running) = On
%UXO0.1.24 (Setting error) = Off
(b) If operation start bit is on, it moves CH 0 temp. conversion value (%UWO0.1.4) into CH 0 temp.
data
(c) If CH 0 disconnection error occurs, %UX0.1.20 (CHO disconnection) is on and CH 0
disconnection error bit is set
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5.7.2 Program example using PUT/GET instruction

1) Program example

FO0SE [ 1 0 hooo1 |
i
UOl.OOF  UD.00.0  UDI.OD.E  UOL.O1.O 01018 MO0
L] {H} 1] il (At
01 poy DI.CHOAD _O01_WOT_ER _01_CHOAC _01_CHO SE
- JERR R T TERR
— 278 218
T | oy Uoi.04 00000 ||
_01_CHO_TE
WP
Uot.01.4 MOO0!
| 53—
_01_CHO_BO
g
MO000 -
I | e ! 21 00001 L
END

(a) It writes h0001 at address 0 of slot 1 in order to enable CHO.
(b) If module is under normal operation, MO0OOO is on.
U01.00.F(module Ready) = On
U01.00.0(CHO offset/gain adjustment error) = Off
U01.00.E(module H/W error) = Off
U01.00.E(CHO running) = On
(c) If MOOOO is on, temp. conversion value of CHO moves to D0O00O.
Current temp. conversion value, 278(27.8C2) is saving in U01.04.
(d) If disconnection error occurs at CHO, U01.01.4 (CHO disconnection) is on and M0O001 bit is set.
(e) If MOOOO is on, setting error (address 27) of CHO moves to DO001. Since setting error (address
27) of CHO is 0, there is no setting error.
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(2) Program example (in case of IEC type)

THSTTd
FFR1EE PUT _WORD
} REQ DOME}
| 1 scan DM
INSTIS
start GET_WORD
| |—— REU DOWEL 0 JB4SE  STATL
0 JBASE  STATE 1 J5L0T
CHOErrorIn
1 JSLOT DATAL fo 0 -M%?D
27 -M#?D 1 J0&TA
| 0116 EURDL0 BUKDO114 BURDIE S BURDLTL 24 start
— | /1 1/ {1 /1 —
Temp, Temp, Temp, Temp, Tenp,
Measuring  Measuring  Measuring  Measuring  Measuring
Module Module Module : Module odule
Module CHO Module HAN CHO CHO
Ready Of fset/Gai Error Running Setting
N n Errar Errar
start MOYE
—— |—— EW EMOD}
CHOTempDat
w04 1IN OUT } a
Tenp,
Merasuring
Module
CHO Tenp,
Walue
] CHODi =conn
ectionErro
FUKD. 1,20 r
— | 33—
Tenp,
Measuring
Module
CHO Input
Disconnect

lon

(a) Writes 1 at address 0 of slot 1 and operates CH 0 by using PUT_WORD function block.
(b) If operation start bit is on, reads CH 0 setting error (address 27) and movies it into DO001.
(c) If module is running normally, operation start bit is on.

%UX0.1.15 (module Ready) = On

%UXO0.1.0 (CH 0 offset/gain adjustment error) = Off

%UXO0.1.14 (Module H/W error) = Off

%UX0.1.16 (CH 0 running) = On
%UXO0.1.24 (setting error) = Off

(d) Operation start bit is on, moves CH 0 temp. conversion value (%UWO0.1.4) into CH 0 temp.
data
(e) Disconnection error occurs at CH 0, %UX0.1.20 (CH 0 disconnection) is on and CH 0
disconnection error bit is set.
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5.7.3 Example when error occurs

1) Program example

FosE B 1 0 hoDD 1 ]
i
Uol.00F 01000 UDTLODE  UDL.O1.O 01,018 MO000
—H {H} 1] {l} 1 —
01 poy DI.CHOAD _O01_WOT_ER _01_CHOAC _01_CHO SE
S JERR R T TERR
- -2700 2700
T | oy .04 Do0o0 |
_01_CHO_TE
HP
uot.01.4 Mooa1
[ ]
_01_CHO_BO
it
MOo00 -
B B 1 27 00001 |
END

(a) If disconnection error occurs at CHO, U01.01.4 (CHO disconnection) is on and M0O001 bit is set.
(b) If disconnection error occurs at CHO, min. value within the range of K type temperature senor
is displayed at U01.04.
(c) It is monitored as follows according to monitor display type.
When monitoring the temp. conversion value, select “Unsigned Decimal’.

Monitor display type Display content
Unsigned Decimal 62836
Signed Decimal -2700 (-270.0C)
Hexadecimal hF574
As Instruction 62836
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5.8 Troubleshooting

The chapter describes diagnostics and measures in case any trouble occurs during use of thermocouple

input module.

5.8.1 LED Indication by Errors

Thermocouple input module has two LEDs and it is possible to check whether it had any error with the

indication of RUN LED and ALM LED.

Abnormal module
Item Normal Disconnection
H/W (error)
Flicker every 0.2
RUN LED ON ON
second
ALM LED OFF Flicker every second OFF
; Normal operation Every function works Module function
Operation ] ) o
Every function works | Min. temp. is displayed stops
Management - Checking sensor wiring Customer service

5.8.2 Stats check of module through XG5000 system m

Module type, module information, O/S version and module status of thermocouple input module can

be checked through XG5000 system monitoring function.

(1) Execution sequence
Two routes are available for the execution.

(a) [Monitor] -> [System Monitoring] -> And on the module screen, click the right mouse button to

display [Module Information].
(b) [Monitor] -> [System Monitoring] -> And Double-click the module screen.

(2) Module information

(a) Module type: shows the information of the module presently installed.
(b) Module information: shows the O/S version information of module.
(c) O/S version: shows the O/S prepared date of module.

onitor
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5.8.3 Troubleshooting

(1) RUN LED flickers.

RUN LED flickers. |

:

RUN LED flickers every 0.2 sec. I

Yes > Contact IMO Precision Controls technical support

(2) RUN LED i off.

RUN LED is off.

1

Thermocouple input module is installed correctly?

n >| Correctly install this module.

ik

1/0 information can be seen at the XG5000.

No >

hi

Normally operated if thermocouple input module withy
error is changed to another module

Contact IMO Precision Controls technical support

Yes >

Contact IMO Precision Controls technical support
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(3) ALM LED flickers.

ALM LED flickers.

oy

Sensor wiring is normal.

> Wire properly referring to wiring method of user manual.

Z

hil§

Contact the nearest agency or LS branch office.

(4) Temperature conversion value is not normal.

Temperature conversion value is not normal.

-

External DC 24V input power is normal.

> Supply external power (DC 24V)

P

AL

FG ground is normal.

> Execute FG ground properly referring to user
manual

o

U

Parameter setting is normal.
(Channel status, sensor type)

> Set parameter properly referring to user manual.

ki

| Contact the nearest agency or LS branch office. I
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5.8.4 Error code and measure

(1) Measure when error flag of data I/O area (U device) occurs.

Device Device
assignment assignment Description Content Measure
('S, 'H'type) | (IEC type)
U0X.00.0 %UX0.X.0 CHO offset/gain adjustment
error
CH1 offset/gain adjustment .
Uox001 | %UXox1 | gain ady If repeated when restarting
- - the power, contact custom
UOx00.2 | %Uxox2 | CH2 offsetigain adjustment service center
error
U0X.00.3 %UX0.x.3 CH3 offset/gain adjustment Onf error
error Off: normal
If repeated when restarting
U0x.00.D %UX0.x.13 | Module offset/gain backup error the power, contact custom
service center
If repeated when restarting
U0x.00.E %UX0.x.14 | Module H/W error the power, contact custom
service center
U0x.01.8 %UX0.x.24 | CHO setting error Parameter setting | Check the parameter setting
Uox.01.9 %UX0.x.25 | CH1 setting error On: setting error | area (address 27~30) by GET
UOx.01.A %UX0.x.26 | CH2 setting error Off: setting instruction, solve the setting
UOx.01.B %UXO0.x.27 | CH3 setting error normal error contents.

(2) Checking error information area (address 27~30) of operation parameter area

(a) Setting error information area (address 27~30)

Related memory
Bit Description address

Hex. Dec.
Bit0 Sensor type setting (Off: normal, On: error) 014~04n 1~4
Bitl Filter constant setting (Off: normal, On: error) 061~094 6~9

. Average processing method settin

Bit2 (Off: n%rngal, On: e?ror) ) OA~0Dn 10-13
Bit3 Time average value (Off: normal, On: error)
Bit4 Count average value (Off: normal, On: error) OEx~11y 14~17
Bit5 Moving average value (Off: normal, On: error)
Bit6 Scaling range (Off: normal, On: error) 134~1An 19~26

(b) Checking setting error information
Check the setting error information (address 27~30) area by GET instruction.
Ex.1) In case thermocouple input module is mounted at slot 1.

i G 1 27 00000 1
i 1 28 00001 ]
|6 1 2 onno? |
| 6T 1 a0 003 1
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Ex.2) In case thermocouple input module is mounted at slot 1. (In case of IEC)

[HSTTE [HSTTY
ReadError GET_WORD GET_WORD
| | REQ  DOWE RED  DOMWE
n JBASE STATLH 0 JBASE STATEH
1 JaL0T  DATAL  CHOError 1 JaL0T DAT&E CH1Error
27 JMALD 28 JM400
_ R R
] [H3T18 [H3T19
GET_WORD GET_WORD
REQ OOKE REL  DOMWE -
n 1BASE STATL 0 1BASE STATL
1 J5LO0T DATAE CHZ2Error 1 J5LOT DATAE CH3Error
29 JMa00 30 JMa00
_ R R

(c) In case setting error occurs, setting error representation flag (U0x.01.8~ UOx.01.B, in case of
IEC type %UXO0.x.24 ~ %UXO0.x.27) will be on and it will act as default value. If setting error
representation flag (U0x.01.8~ U0x.01.B, in case of IEC type, %UXO0.x.24 ~ %UX0.x.27) is on,
check above setting error information 1By ~ 1Fy (address 27~30) area, check related memory
address 01y ~ 1A, (address 1~26) and cancel error.
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Chapter 6 Analogue Combo Module

6.1 Pre-operation Setting Procedure

Please proceed as follows before operating analogue combo module.

XBF-AHO4A

Check Performance Specifications I—o Specification (6.2 Performance
Specifications)

Operating Environment
I/O Type and Range
Digital Output Range
Analogue Output Range

Wiring I—O Wiring
®  Power supply (ext. DC24V)

® Analogue I/O wiring

Eternal Voltage/Current S/W Setting I ® Switch Setting
® V/AI/O Type Setting

Analogue /O Data Read/Write I—. Analogue I/O Test
® XG5000 Special Module
Monitor Test Mode
Parameter Setting I—. Parameter
® XG5000 I/O Parameter

Programming I—O Programming
°

Analogue Data Read/Write Program
(U Device)

In case of error or abnormal analogue inpuf]
or digital output, see Diagnosis.
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6.2 Specification

6.2.1 General Specification

This section describes general specifications of the analogue mix module.

e Applicable
No. Item Specification Standard
1 Working 0~ 55°C
Temperature
p | Storage 25~ +70°C
Temperature
3 Worl.<njg 5 ~ 95%RH, no condensate
Humidity
4 Stor:.ig.e 5 ~ 95%RH, no condensate
Humidity
Intermittent Vibration -
Frequency Acceleration Amplitude Cycle
10 < f < 57Hz - 0.075mm
57 < f < 2
5 Vibration 150Hz 9.8m/s"(1G)
Resistance Continuous Vibration 10 cycles IEC61131-2
for X, Y, Z
Frequency Acceleration Amplitude each
10 < f < 57Hz - 0.035mm
57 < f < 2
1501z 4.9m/s“(0.5G)
Impact - Max. impact acceleration: 147 m/s*(15G)
6 .p « Duration: 11ms IEC61131-2
Resistance . . .
» Pulse Shape: sinusoidal half-wave pulse (3 cycles in X, Y, Z)
Rectangular IMO Self Test
+
Impulse Noise *1,500V Standard
Static Electricity ) . IEC61131-2
Discharge Voltage: 4kV (contact discharge) IEC61000-4-2
. Radiation
Noise . IEC61131-2,
7 Resistance Elegtromagnetlc 27 ~ 500 MHz, 10V/m |EC61000-4-3
Field Noise
Classific Power Digital/Analogue I/O,
Past Transient ation Module Communication Interface IEC61131-2
/Burst Noi IEC61000-4-4
UrstNOISe 1 voltage 2kV 1kv
8 Environment No corrosive gas or dust
9 Altitude 2,000m max.
10 Contaminati 2 or less
on
11 Cooling Natural air cooling
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6.2.2 Performance Specification
This section specified the performance of analogue mix module.

(1) Input Performance Specification

Classification Input Performance Specification
No. input channels 2 channels
Type Voltage Current
DC 1~5V DC 4 ~ 20mA
Analogue DC 0~ 5V DC 0 ~ 20mA
Input DC 0~ 10V (Input resistance 250 Q)
Range
Range (Input resistance: 1 MQ min.)

Input range shall be specified in user program or I/O parameters

by channel, and selected with external voltage/current switches.

Type 12-bit binary data
Unsigned 0 ~ 4000
Signed -2000 ~ 2000
Digital 100 ~ 500 (DC 1 ~ 5V) 400 ~ 2000 (DC 4 ~ 20mA)
Value | Precise
Output 0~ 500 (DC 0 ~5V) 0~ 2000 (DC 0 ~ 20mA)
Range | Value
0~ 1000 (DC 0 ~ 10V)

Percentile
0~ 1000
Value
1/4000
Max. Resolution 1.25nV (DC 1~5V, 0~5V) 5/A (DC4~20mA, 0~20mA)
2.5mV (DC 0~10V)
Precision +0.5% max.
Max. Conversion Rate 1ms/channel
Max. Absolute Input DC +15V DC +25mA
Filtration Digital filter (4 ~ 64,000ms)
Time average (4~16,000ms)
Additional
Averaging Cycle average (2~64,000 cycles)
Functions
Moving average (2~100 values)
Alarm Open line detection (DC 1~5V, DC4~20mA)
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(2) Output Performance Specification

Classification

Output Performance Specification

No. of output channels 2 channels
Type Voltage Current
DC1-~5V DC 4 ~ 20mA
DC 0 ~ 5V DC 0 ~ 20mA
Analogue
DC 0~ 10V (Load resistance: 510 Q max.)
Output
Range (Load resistance: 2kQ min.)
Range
Output range shall be specified in user program or /O
parameters by channel, and selected with external
voltage/current switches.
Type 12-bit binary data
Unsigned 0 ~ 4000
Signed -2000 ~ 2000
Digital 100 ~ 500 (DC 1 ~ 5V) 400 ~ 2000 (DC 4 ~ 20mA)
Value Precise
Input 0~ 500 (DC 0~ 5V) 0 ~ 2000 (DC 0 ~ 20mA)
Range Value
0~ 1000 (DC 0 ~ 10V)
Percentile
0~ 1000
Value
1/4000

Max. Resolution

1.250 (DC 1~5V, 0~5V) 5uA (DC4~20MA, 0~20MA)

2,51V (DC 0~10V)

Precision +0.5% max.
Max. Conversion Rate 1ms/channel
Max. Absolute Output DC 15V DC 25mA

Additional Functions

Channel output status setting function (selectable from previous,

min., mean, max. value outputs)

(3) I/O Common Performance S

ecification

Classification

I/0 Common Performance Specification

Insulation Type

Photo-coupler isolation between 1/O terminal and PLC power

source (no insulation between channels)

I/O Terminals

11 point terminal block

1/0 Points

Fixed type: 64 points

Max. No. of Installation

7 units (XBM-DxxxS “S” type)
10 units (XB(E)C-DxxxH “H” type)

Internal (DC 5V) 120mA
Current
External (DC 24V) | 130mA
Weight 739
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6.3 Major Components

Major components are as follows;

=
XBF—AHO4A
INPUT - (D
OUTPUT - (2
®O—»
Vel
2 —
=] | fe—o
= —
2] | fe—o
[ =T
e | o
L=
K=
2 -]
9 ] O
-H =]
ne | (o]
[=7]
DC24V -—
A=) \J
XBF—AHO4A
Ny =
No. Name Description
P Indicate operation of input part
On: normal operation
© |INPUT LED Flashing: in error (1 sec. flashing)
Off: power off or module failure
P Indicate operation of output part
On: normal operation
@ | OUTPUTLED Flashing: in error (1 sec. flashing)
Off: power off or module failure
©) Input  Volt/Current| » Switch for selecting voltage/current input of analogue
Select Switch input Ch 0 and Ch 1
@ Output Volt/Current| » Switch for selecting voltage/current output of analogue
Select Switch outputCh0and Ch 1
® Input Terminal » Terminal block for analogue input wiring with external
Block devices
® Output Terminal » Terminal block for analogue output wiring with external
Block devices
Ext. Power
) Connector P Connector for DC24V external power supply
Ext. Connector » Connector for extension modules
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6.4 Conversion Characteristics by I/O Range

The input/output ranges of voltage and current can be set up per channel with user program or
I/O parameters. The 1/O types of digital data are defined as follows.

(1) Unsigned Value

(2) Signed Value

(3) Precise Value

(4) Percentile Value

6.4.1 Input Characteristics
The graph below shows the data conversion characteristics by input range.

r«—  Practical analog input range——————»|

1011 | 2047 | 4047
1000 | 2000 | 4000
J\f Gain
value
750 | 1000 | 3000
Digital | 50, 0 | 2000
output
250 | -1000 | 1000
0 -2000 0
-12 -2048 -48 L Offset value
DC 4 ~ 20 mA 4 mA 12 mA 20 mA
DC 0 ~20 mA 0mA 10 mA 20 mA
Analog DC1~5V 1V 3V 5V
input DCO~5V oV 25V 5V
\ DCO~10V oV 5V 10V

1) DC 4 ~ 20mA Range Input

Digital Analogue Input Current (mA)

Output Range 381 4 8 12 16 20 | 2018
tg‘fi%gg)va'”e 48 0 1000 | 2000 | 3000 | 4000 | 4047
ﬁgggngggo) 2048 | -2000 |  -1000 0 1000 2000 2047
gggifez\égg')e 381 400 800 1200 | 1600 | 2000 | 2018
Czlrl‘jg(”(;"f 1000) 12 0 250 500 750 1000 | 1011
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2) DC 0 ~ 20mA Range Input

Digital Analogue Input Current (mA)

Output Range -0.24 0 5 10 15 20 20.23
Unsigned Value
(0 ~ 4000) -48 0 1000 2000 3000 4000 4047
Signed Value
(-2000 ~ 2000) -2048 -2000 -1000 0 1000 2000 2047
Precise Value
(0 ~ 2000) -24 0 500 1000 1500 2000 2023
Percentile
Value(0 ~ 1000) -12 0 250 500 750 1000 1011

3) DC 1 ~ 5V Range Input
Digital Analogue Input Voltage (V)

Output Range 0.96 1 2 3 4 ) 5.04
Unsigned Value
(0 ~ 4000) -48 0 1000 2000 3000 4000 4047
Signed Value
(-2000 ~ 2000) -2048 -2000 -1000 0 1000 2000 2047
Precise Value
(100 ~ 500) 96 100 200 300 400 500 504
Percentile
Value(0 ~ 1000) -12 0 250 500 750 1000 1011

4) DC 0 ~ 5V Range Input
Digital Analogue Input Voltage (V)

Output Range -0.06 0 1.25 2.5 3.75 5 5.05
Unsigned Value .48 0 1000 2000 3000 4000 4047
(0 ~ 4000)

Signed Value 2048 | -2000 |  -1000 0 1000 2000 2047
(-2000 ~ 2000)

Precise Value 6 0 125 250 375 500 505
(0 ~ 500)

Percentile 12 0 250 500 750 1000 1011
Value(0 ~ 1000)

5) DC 0 ~ 10V Range Input

Digital Analogue Input Voltage (V)

Output Range -0.12 0 25 5 75 10 10.11
Unsigned Value -48 0 1000 2000 3000 4000 4047
(0 ~ 4000)

Signed Value -2048 -2000 -1000 0 1000 2000 2047
(-2000 ~ 2000)

Precise Value 12 0 250 500 750 1000 1011
(0 ~ 1000)

Percentile 12 0 250 500 750 1000 1011
Value(0 ~ 1000)
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6.4.2 Output Characteristics
The graph below shows the data conversion characteristics by output range.

Practical analog output
range
1011 2047 | 4047
1000 2000 4000
/\7 Gain
value
750 1000 3000
Digital
input 500 0 2000
250 -1000 1000
0 -2000 0
-12 | -2048 | -48 * Offset
value
DC 4 ~20 mA 4 mA 12 mA 20 mA
Analog DC 0 ~20 mA 0mA 10 mA 20 mA
output DC1~5V 1V 3V 5V
DCO~5V oV 25V 5V
\ DCO~10V ov 5V 10V
1) DC 4 ~ 20mA Range Output
Digital Input Analogue Output Current (mA)
Range 4mA less 4 8 12 16 20 | 20mA over
Unsigned Value
(0 ~ 4000) 0 less 1000 2000 3000 4000 | 4000 over
Signed Value -
(-2000 ~ 2000) -2000 less 2000 -1000 0 1000 2000 | 2000 over
Precise Value
(400 ~ 2000) 400 less 400 800 1200 1600 2000 | 2000 over
Percentile
Value(0 ~ 1000) 0 less 0 250 500 750 1000 | 1000 over
2) DC 0 ~ 20mA Range Output
Digital Input Analogue Output Current (mA)
Range OmA less 0 5 10 15 20 [20mA over
Unsigned Value
(0 ~ 4000) 0 less 0 1000 2000 3000 4000 | 4000 over
Signed Value
(-2000 ~ 2000) -2000 less|  -2000 -1000 0 1000 2000 | 2000 over
Precise Value
0 less 0 500 1000 1500 2000 | 2000 over
(0 ~ 2000)
Percentile
0 less 1000 over
Value(0 ~ 1000) 0 250 500 750 1000
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3) DC 1 ~ 5V Range Output

Digital Input Analogue Output Voltage (V)

Range 1V less 1 2 3 4 5 5V over
tg‘fi%gg)va'”e 0 less 0 1000 | 2000 | 3000 | 4000 |4000 over
f_ggggY;ggo) -2000less|  -2000 |  -1000 0 1000 | 2000 2000 over
flrggif‘eS\ég')“e 100less | 100 200 300 400 500 | 500 over
52[52?5"3 1000) | Oless 0 250 500 750 1000 | 1000 over

4) DC 0 ~ 5V Range Output

Digital Input Analogue Output Voltage (V)

Range 0V less 0 1.25 25 3.75 5 5V over
Unsigned Value | oo 0 1000 2000 3000 4000 | 4000 over
(0 ~ 4000)

Signed value 2000 less|  -2000 -1000 0 1000 2000 | 2000 over

(-2000 ~ 2000)

Precise Value
(0 ~500)

0 less 0 125 250 375 500 500 over

Percentile
Value(0 ~ 1000)

0 less 0 250 500 750 1000 | 1000 over

5) DC 0 ~ 10V Range Output

Digital Input Analogue Output Voltage (V)

Range 0oV less 0 25 5 7.5 10 10V over
Unsigned Value 0 less 0 1000 2000 3000 4000 | 4000 over
(0 ~ 4000)

Signed value | 5500 jess| 2000 | -1000 0 1000 | 2000 | 2000 over
(-2000 ~ 2000)

Precise Value 0 less 0 250 500 750 1000 | 1000 over
(0 ~ 1000)

Percentile 0 less 0 250 500 750 1000 | 1000 over

Value(0 ~ 1000)
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6.5 Precision

6.5.1 Input Precision

The precision of digital output is not dependent upon the input range.

The graph below shows the variation of precision when the analogue input range is 0 ~ 10 V for
unsigned value for digital output.

The input precision of the XBF-AHO4A is £0.5%.

2000

anjeA ndino |enbiq

ov 5V 10V

Analog input voltage

(1) Precision at 5V input;
4000 x 0.5% = 20
Therefore, precision range at 5V input is; (2000-20) ~ (2000+20) = 1980 ~ 2020.

(2) Precision at 10V input;
4000 x 0.5% = 20
Therefore, precision range at 10V input is;(4000-20) ~ (4000+20) = 3980 ~ 4020.
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6.5.2 Output Precision

The precision of analogue output is not dependent upon the output range.

The graph below shows the variation of precision when the analogue output range is 0 ~ 10 V for
unsigned value for digital output.

The output precision of the XBF-AHO04A is £0.5%

20.1mA 00V - J1-F-—————————— - ——————————__
2 oV

19.0mAZOMA g g5y 1Y I oot ——————————=
>

>

)

o

@  1o0mA 5V

o

C

£

3

0.1mA 0.05V -~

“0.4mA ™A 05y &Y_[2

0 2000 4000
Digital input

(1) Precision at 5V output;
4000 x 0.5% = 20, therefore,
precision range at 5V output is; (5V - 20x0.0025V) ~ (5V+20x0.0025V) = 4.95 ~ 5.05V .

(2) Precision at 10V output;
4000 x 0.5% = 20, therefore,
precision range at 10V output is; (10V-20x0.0025V) ~ (5V+20x0.0025V) = 9.95 ~ 10.05V.



Chap. 6 Analogue Combo Module

6.6 Functions of Analogue Combo Module

The functions of XBF-AHO4A Module are as follows.

Function Description
Channel « Specify operation/stop of the channel which will perform A/D and D/A conversion.
operation/stop setting | . Specifying unused channels as Stop can shorted overall operation time.

« Specify desired range of analogue I/O.

I/O Voltage /current | « Select voltage/current with external switch, and set up range with parameter.

range setting . Analogue Mix Module provides 2 ranges(4~20mA, 0~20mA) of current I/O and 3
ranges (1~5V, 0~5V, 0~10V) of voltage /0.

. Specify digital /O types.
1/0O data type setting . This module provides 4 output data types (Unsigned, Signed, Precision, and
Percentile Values)
« Sampling Process
- If A/D conversion method has not been specified, the module processes sampling.
A/D input conversion | . Filter process
method - Filters rapid changes in input value by external noise.
« Averaging process
- Outputs A/D converted value averaged by time, cycle, and moving.
D/A  output status | «Sets up channel output state at transition from run to stop.
setting « Provides 4 output selections (Previous, Minimum, Mean, Maximum Values)

6.6.1 Sampling Process
In popular A/D conversion process, analogue input signals are collected at constant time
intervals and A/D converted. The time elapsed for the analogue signals converted into digital
signals and saved in memory device depends upon the number of channels used.

(Process Time) = (No. of Channels Used) x (Conversi  on Rate)

(Ex.) Process time when using 3 of 4 I/0 channels;
3x1 ms =3.0 ms

The term ‘sampling’ means taking analogue signal values at certain time intervals.
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6.6.2 Filtering Function

The input value of the designated channel is calculated with previously filtered input value using
preset filter constant (time constant 63.2%) by the formula below;

Pr esentlyFilteredinput = (Pr eviouslyFilteredinput x Filter Constant) + (Pr esentlnput x Imsx No.ofChannel Used)

FilterConstant + (Imsx No.ofChannel dUsed)

Filter Constant setting range = 4 ~ 64000 [ms]

A
Input —— |nput after filtration
Actual input

1000
632
0

—> . g

Filter Constant Time (ms)
(ms)

In the above graph, if the input value changes rapidly from 0 to 100, the input value is filtered.
Filter (time) constant is the time required for input values to vary by 63.2% of the actual input
value.



Chap. 6 Analogue Combo Module

6.6.3 Averaging Function

() Average by Time
The input values of the designated channel are accumulated for the preset time, and the
average value of the total sum is outputted in digital data.

Averaged input value |
== « = Actual input value :

DR DO ORISR

Channel Scanning Intervals (1ms/Ch. Used)
= Averaging % Averaging L Sampling 4
Section Section Section

Setting Range = 4 ~ 16000 [ms]
For time averaging, No. of averaging cycles are calculated with the No. of channels used
as below;

AverageTime
No.ofChannelsUsed x1ms

No. Averaging Cycles =

(2) Average by Cycles
The input values of the designated channel are accumulated for the preset cycles, and the
average value of the total sum is outputted in digital data.

|
I = Averaged input value |
: - Actual input value :

. . ) “
’ 4 4
. \ I .

Channel Scanning Intervals (1ms/Ch. Used)

v

N Averaging > Averaging > Sampling
Section Section Section

Setting Range = 2 ~ 64000 [Cycle]

For cycle averaging, averaging interval is calculated with the No. of channels used.

Averaginginterval [ms] = AveragingG/clex NoofChannel4Jsed x1ms
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(3) Moving Average

The inputs into the designated channel are accumulated for the presser number, and its
average is calculated and outputted in digital data. However, in moving average method,

each scan provides its average value.

L4}

L+ {2+ 3+ (33 + () + {5+ (8)

Averaging No. Averaging No.

(254 (3 + )+ (5
Averaging No.
Channel Scanning Intervals (1 ms/Ch, Used)

(1) In case of time/cycle averages. The input value is not outputted at every conversion, but the
previous value is maintained until the average time or cycle is reached.

(2) In case of moving averages, the converted input is averaged with the previously entered
value and the result is outputted at every conversion. Therefore, data response is faster than
time/cycle averaging methods.

(3) The three averaging methods can be processed simultaneously with the filter function
described earlier. In such case, the filter function is executed first, and averaging function is
processed to output the average value in digital data, which is expressed with the finally-
processed value.
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6.6.4 Line Open Detection Function

The analogue mix module has a diagnostic function which can detect and indicate open input line,
when voltage input range of DC 1~5V or current input range of DC 4~20mA is selected as its
analogue input range. If the module indicates open input line, check the wiring.

(2) If the wiring to the module is open, the Input LED flashes at 1 second intervals and the respective
error code is generated.

(2) Line open detection is available for each channel. However, open indication is provided only for
the channel selected for the operation. The Input LED is common for the input channels 0 and 1,

and flashes if 1 or more channels are open.

Input Connection Channel Input LED Open Line
P Operation State Flag
Working on Off
Normal
Stopped on Off
Input wire open or Working Flash (1s) On
disconnected Stopped on o

(3) At line open, the line open flag of the channel turns On, and turns Off at correction.

Open Flag Description
U0x.01.4 Ch 0 open
U0x.01.5 Ch 1 open

(4) At line open, the least of all input values is indicated.



Chap. 6 Analogue Combo Module

6.6.5 Channel Output Status Setting Function
This function sets up the output in response to PLC shutdown or failure.

(1) Function

This function is used to obtain preset output value of the analogue mix module when the PLC
system is transferred from run to stop.

(2) Type
Channel output can be one of the followings;
(a) Previous value: maintains the last output from normal operation.
(b) Minimum: outputs the least values of the respective output ranges.
(c) Median: outputs the median values of the respective output ranges.
(d) Maximum: outputs the largest values of the respective output ranges.

(3) Example
Assume that the output channel range is set to 4 ~ 20mA and the output level is 10mA. If the
PLC system is switched from run to stop status, the output will be one of followings according to
the setting;
(a) Previous value: maintains 10mA which is the previous normal operation value.
(b) Minimum: outputs 4mA which is the minimum of the output range setting.
(c) Median: outputs 12mA which is the median of the output range setting.
(d) Maximum: outputs 20mA which is the maximum of the output range setting.
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6.7 Wiring

6.7.1 Precautions for Wiring

(1) Keep the 1/0 signal lines of the analogue mix module away from AC power line. Otherwise, the
surge or induction noise of the AC line may affect the module.

(2) The cable should be selected taking ambient temperature and allowable current into
consideration. Recommended cable is AWG22 (0.3mm) or higher grade.

(3) Keep the cables away from heat source or oil. Otherwise, short-circuit, damage, or malfunction
of the module may occur.

(4) Check polarity at terminal block connection.

(5) Keep the cables away from high voltage line or power line to avoid malfunction or failure of the
module by induction.

6.7.2 Exemplary Analogue Input Wiring

(2) Input resistance of the current input circuit is 250 Q (typ.).

(2) Input resistance of the voltage input circuit is 1 MQ (min.).

(3) Set only the channels to be used up for operation.

(4) Analogue mix module does not provide power supply to external input device. Use external

power supply.

(5) Exemplary analogue input wiring
Same wiring scheme is applied to voltage and current inputs, except that voltage/current
setting switch must be set up accordingly.

=
XBF—AHO4A
INPUT
QUTPUT
Voltage/Current
r Selection
Switch
+[> .E CHo e - Vel
ol _+ —
S 2l B
“leHm [T =
s[cHo|| cixill) I
— 5[cHol | T
= ~L &|cH1 (|
+ ~ CHI—]+ ~<3
o CHo+ | [ g5
- . - CHO- S—I:Ej
/J7 CHi+ | Eom =
CH1 f[
g [
“E (=)
z-H[
£
3 [ =
|-HE
e |[23]
DC power Supply DC24V+ S (o
(for analog device) DC24V— [
XBF—AHO4A
[ ==

q
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(6) Exemplary Wiring for Analogue Input 2-Wire Sensor/Transmission
Same wiring scheme is applied to voltage and current inputs, except that voltage/current setting
switch must be set up accordingly.

BH
XBF—AHO4A
INPUT
ouTPUT
Voltage/Current
selection switch
- i V <l
+ - -
DC Trsn\évr:i?ter | : vel _+ 7 e
-T—F /J7 L 2|cvo| |2 ; cHol|——
ZlcH1 || =
s[cHo|| cH || 1
— E[cHo| |
] - ~L (B ||
+ -! CH1 + ~ 2
T 2Wire Fa w2 —H— <3
DC Transmitter | {——f-r-eni- I CHo+ | [¢© o
- cHo— |- L{Eg
,J; CH1+ zg"il:E:]
“ CHI- LEHO [
(+[ =)
ey [
<3 +|: :
|_, oY
e |[23]
DC power supply DC24V+ (o
(For analog device) DC24v— | 2% oY
XBF—AHO4A
=

(7) Exemplary Wiring for Analogue Input 4-Wire Sensor/Transmission
Same wiring scheme is applied to voltage and current inputs, except that voltage/current setting
switch must be set up accordingly.

=
XBF—AHO4A
INPUT
OUTPUT
Voltage/Current
selection switch
V |
oL | 4wire vel _ 77 e
= Transmitter § p— 2lcHoll—
= Zlow ||
= =[cro| | T
= ~L E cH1 ||
+ ~
4-Wire + cHO ~[©
DC_ Transmitter CHO |—+ =]
cho- 1= _[ {59
CHi+ | 2o =
CH1- L_[ [=d
CHO
e
€ g |2
3 +|: =]
[-HE=
ne (2]
DC power supply DC24V+ (o
" DC24V
(For analog device) DC24V— i (a2
XBF—AHO4A
=




Chap. 6 Analogue Combo Module

(8) Relation between voltage input precision and cable length

In voltage input system, the cable length between the module and transmitter or sensor
influences on the converted digital value of the module. The value is as follows.

_______________________

>

nalogue input (Voltage)

Where,
Rc: line resistance of the wire,
Rs: internal resistance of the transmitter or sensor,
Ri: internal resistance of voltage input module (1 MR)
Vin: voltage applied to the analogue input
% Vi: error in the converted value caused by source and cable length in voltage

input(%)
, Ri xVs
Vin =
[Rs+(2x Rc) + Ri
%V = (1—@) x100%
S
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6.7.3 Exemplary Analogue Output Wir

(1) Exemplary analogue voltage output wir

Same wiring scheme is applied to voltage

ing

ing

setting switch must be set up accordingly.

D pawar
supply
(Far analag
device)

CHO+

CH1+
CH1-

DO24Y+

DC24V—

(2) Exemplary analogue current output wiring
Same wiring scheme is applied to voltage and current outputs, except that voltage/current

setting switch must be set up accordin

gly.

CHO+

CHO- |«

and current outputs, except that voltage/current

. B
¥EF = AHO4A
NPT
QUTPUT
Voltage/current
selection switch
-— U ‘_’I
Vol g - .
e = g | cHo| | ]
= mCl) =
;‘—;;-4- | - '5 CHO
— = BlcH ||
[ omo H‘“‘ E
=
g =3
e 1
vy 152
'[ =3
e [
2 il (=]
L-—L=d
w [
=]
=4

=

MEF—AHDAA

[N Sy =
Rl

XBF—AHO4A
INPUT

OUTPUT

CHO—

CH1+

CH1-

DC24V+

DC power supply
(For analog

DC24V—

device)

<
!

INPUT
“
Bl
=3

ijili

OUTPUT
n

E-

=5

e 2
Ak

15[

+o ! +§| +Q 1+

— OUTPUT ———— INPUT —

LI

DC24v
—

+|
z
S

XBF—Al

I
S

4A

d

Voltage/current
selection switch

V <]

CHO
CH1

INPUT

CHO
CH1

0aoo

OUTPUT
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6.8 Operation Parameter Setting

The operation parameters of analogue mix module can be set up with XG5000 [I/O Parameter].

(1) Setting Items
For user convenience, XG5000 provides GUI (graphic user interface) for analogue mix module
parameter setting. The items which can be set up in the [I/O Parameter] in the XG5000 project
window are as follows.

Item Description

(a) Input parameter setting
Sets up following items required for module operation.
1) Operation channel (Stop/Run)
2) Input voltage (current) range
3) Output data type
4) Filter constant
5) averaging process
[I1O 6) Average value
Parameter] (b) Output parameter setting
Sets up following items required for module operation.
1) Operation channel (Stop/Run)
2) Output voltage (current) range
3) Input data type
4) Channel output status
(c) The parameters set up in XG5000, when downloaded, are stored in the flash
memory of the XGB base unit.

(2) Usage of [I/O Parameter]

(a) Create a project with XG5000. See XG5000 Program Manual for project creation.
(b) In the Project window, double-click [I/O Parameter].

ltermns
S EE AH
=i MewPLC{XGE-XBCH)-0Offline
3 Varahle/Comment
= Parameter
Basic Parameter
H /0 Parameter
+ - Embedded F‘aran'%ter
= Scan Program
MewFrogram

L Project
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(c) In the [I/O Parameter Setting] window, find out the slot of the base where the analogue mix module is installed, and
click it.

I/0 Parameter Setting

All Base | sst8as |

= @ Base 00 : Default | Slat | Maodule | Corrnent | Ittt Filter |Emergency Dull Allacation ‘
== 00 Default Ofmain)
= 01 Defaul - S S S
== 02 Default A
= 03 : Default
= 04 : Default
== 05 Default
= U6 : Default
=z U7 ¢ Default
=z 080 Default
== 09 Default
== 10 Default

oo |~ ||| e

o

(o v) (o] [coes

(d) In the above window, click the arrow button to call the window where the module can be selected. Find out the module
and select it.

g 2]

All Base ] Set Base ]
= 3 Base 00 : Default | Slat | Module | Comment ‘ Irput Filter |Emergency Dut‘ Allocation

= 10 : Default 0Ofmain]
o 01 : Default 'H_
o= U2 : Default Digital Madule List

. 2 a]
= gi ge;au:t k] = @, Special Module List
= 5 Default 1 ﬂ Analog Input Module
= 6 . Default 5 ﬂ Analog Dutput Module
= 07 sz:ﬁli 5 ﬂ Temp. Measuring Moduls
= e &nalog 10 Modul
o 08 : Default 7 © B Ancloo 10 Modue
09t Default
= H C tion Module List
= 10 : Default = B Communication Module Lis
10

pit ¥ | [ ok ][ Caneal

(e) To set up parameter, double click with the respective slot being selected, or click [Detail] button.
I/0 Parameter. Setting

All Base | saiase |

= @ Base 00 : Default | Slat | Module | Comment Input Filker | Emergency Out] Allacation |
= 00 : Default {main)
A 01 HEF-AH04A (1)
== U2 ¢ Default
== 03 Default
= 04 : Default
= 05 : Default
= 06 : Default
= 07 : Default
== 08 ! Default
== 09 Default
= 10 Default

w oo |~ ||| ||k

=

A

Delete Al | [ Detae | [ Pt ¥ ] [0k ][ Cancel
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(f) The window below where parameters can be set up by channel appears. Click the item to set up. The parameters
which can be set up appear by item.

XBF-AHODA4A (170, 2/2 CH)

HBF-AHOD4A (10, 2/2 CH)
Input Parameter CHO | CH1 |
[] Channel status Dizable ﬂ Dizable
[ Input range 4~ 20ma, 4~20ma,
Output bype 0~4000 0~4000
Filter constart 1} 1}
[ Awerage proceszing Sampling Sampling
Average value ] ]
Output Parameter Channel 0 Channel 1
[] Channel status Dizable Dizable
[ Dutput range 4 20me, 4 20me,
Input type 0~4000 0~4000
[] CH. Output bype Farmer walue Farmer value
0K ] [ Cancel

6.9 Special Module Monitor Function

The functions of the special module monitor are as follows.
(1) Start-up of [Special Module Monitor]
Select [Online] -> [Connect], and [Monitor] -> [Special Module Monitor] to start up. [Special
Module Monitor] menu is enabled only in the [Online] condition.

& AA - XG5000 - [NewProgram [Program]]

7] Broject Edit Find/Replace Miew QOnline Monitor] Debug Tools Window Help
Neags ® @ :@ Stop Monitoring

|, Pauge
[@% Por ar !
2, Pausing Conditions, .,
Project Window 3 Change Current ¥alue,,, —
Iterns System Monitaring -
=8B AA Device Monitoring
=@ NewPLC{XGE-XECH)-Run/Warning @ Special Madule Monitoring
% Global/Direct Variables {4 Trend Monitorin
=-[¢% Parameter - d
Basic Parameter
[ 1/0 Parameter [ Custom Events

+-[H Embedded Parameter
= Scan Program
MewProgram
User Function/Function Block
S Lser Data Type

& Data Traces

|

(BIE =

1) The screen may not function properly if the system resources are not sufficient. In this case, close
the screen, exit other applications, and rerun XG5000.

2) The I/O parameters set up in [Special Module Monitor] condition are temporarily set up for testing
purpose. Therefore, these I/O parameters are deleted after exit from [Special Module Monitor].

3) the test function of the [Special Module Monitor] enables testing analogue mix modules without
sequence programming.
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(2) Usage of [Special Module Monitor]
(a) With the XG5000 in connection (online) with the base unit of PLC, select [Monitor] ->
[Special Module Monitor]. The Select Special Module window shown below will appear
showing the type of the special modules and base/slot information. In the list dialog, the

modules present in the PLC system are displayed.

Base
il Baze 0
) Base 0

ell

<

Slat

ﬂ Internal

Internal
Slot 1

[[ todule [nfa. ]I Monitar ]]

Module

High Speed Counter Module[Open-Collector, 8-CH)
Paosition Madule [OpenCallector, 2-CH)
#BF-5HO44 140 H]

Close

>

(b) In the above window, select the special module and click [Module Info.] to see the
information window below.

Special Module Infomation E|E‘

Displays the infomations of special madule.

ltem Information |
Hodule Name #EBF-AH048 /0, 2/2 CH)
05 Ver Ve 4
05 Updatz Date 2009323
Modue Status Nomal. (0]

(c) Click the [Monitor] button in the “Special Module” window. The “Special Module Monitor’

window will appear as shown below.
Special Module Monitar @‘g|

XBF-AHO44 (140, 2/2 CH)

Input ltem MaeMinvalue | Curentwalie |
CHOA/D value
CH1 A/D valus
Oulput tem Seingvalie | Cunentvave |
CHO Digital valuz
CH1 Digitdl value:
rput et Setting Value Curent Value |
Channel CHO ~
Channel status Disable
Input range 4-20m4
Duiput iype 04000
Filter constant 0
Average processing Sampling
Average value 0
Oulput tem Setting Value Curtent Valug
Channels CHO
Charnel status Disatle
Olutput range 4-20m4
Input type; 0~4000
CH. Output type Fomer vahue
D/ Digtal value 0
Oulput enable Disable
Resetmax/minvalue | [ Start Montoing |
Closs
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(d) [Start Monitoring]: click [Start Monitoring] to look up the digital input data of the channel
currently in operation. The screen shot below is a monitoring window when all the
channels are in operation status.

Special Module Monitor

*BF-AHO44 [1/0, 2/2 CH)
Input Item MaxMin value | Current value ‘
CHO A/D value 040 0 |nput Monitoring
CH1 A/D value /0 0
Output itern be\nﬂue | Lurrent walue
CHO Digital value 0 B H
CH1 Digital value 0 OUtDUt Monltorlng
Input Item Setting Value Current Value
Channel CHO
Chatinel statuz Disable Dizable
Input range: 4~ 20méd, 47 20ma,
Dutput bpe 0~4000 04000 Detail information
Filter constant 0 0 of input CHO
Auerage pocessing Sampling Sampling
Avwerage value 1] 0
Output Item Setting Value Current Value
Charnels CHO
Channel status Dizable Disable
Outpul rsnge 20, 20, Detail information
Input type 0~4000 0~4000 of output CHO
CH. Output type Farmer value Former value
D4 Digital value 1] 0
Output enable Disable Diizable
[ Feset man/min value I | Stop Moritaring |
Clase

The screen executing [Start Monitoring]

(e) [Test]: this function is used to change the current parameter settings of the analogue mix
module. Click the settings in the fields in the bottom screen to change the parameters.
Test] can be set up only when the operation status of the XGB base unit is STOP.

Special Module Monitor

XBF-AHO44 [1/0, 2/2 CH)
InpLit Item b 2 /bin walue | Current value |
CHO &/D value 0/0 1]
CH1 &/D value 0/0 1]
Output item Setting value | Current value |
CHO Digital value 1]
CH1 Digital valus 1]
Input Ikem Setting Value Curent Value
Channel CHO
Channel status Enable Enable
Input range 4720, 47 20ma,
Output type 0~4000 0~4000
Filter constant 1} 1}
Luerage processing Sampling Sampling
Awerage value 1] 1]
Output ltem Setting Yalue Current Y alue
Charinels CHO
Channel status Enable Enable
Output range 4720, 47 20ma,
InpLt type 0~4000 0~4000
CH. Output type: Former value Former value
D4 Digital value o 1]
Output enable Dizable Diizable
[ Fieset mar/min value ] [ Stop Monitaring ] i Test i
Close

The screen executing [Test]
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(f) Minimum/Maximum Value Monitoring
The minimum and maximum values of the input channels in operation can be monitored.
However, the Max/Min values in the window are based on the current value. Therefore,
the Max/Min values are not saved when exiting from the [Monitoring/Testing Screen].

HBF-4HO44 (140, 2/2 CH)

Input Item Max/Min value Current value ‘ . .
THOA/D valie /0 2 > Monitors Max/Min value
CH1 A/D value 0/0 0

Output ikem Setting walue Current walue

CHO Digital value 0
CH1 Digital value 0
Input Item Setting Walue Current Value
Charinel CHO
Charnel status Disable Disable

Input range 4~20md, 47 20ma,

Output type: 0~4000 0~4000
Filter corstant 0 ]

Average processing Sampling Sampling
Average value 1] 0

Output Item Setting Walue Current Value

Channels CHO
Charinel status Disable Disable

Output range 4~20mad, 47 20md,

Input type 0~4000 0~4000
CH. Dutput type: Former value Former value
D/ Digital value 1] 0

Output enable Dizable Digable
[ Besetmaninin value )| —f—StoPororme—} » Resets Max/Min value
Cloze

The screen executing [Max/Min Value Monitoring]

(g9) Close
[Close] button is for ending/closing the monitoring/testing screen. Maximum,
minimum, and current values are not saved at exit.
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6.10 Auto-registration of U-Device (Special Module  Variable)

The variables for each module are automatically registered by referring to the information of the
special modules set up in the [I/O Parameter]. User can modify variables and descriptions.

(1) Registration Procedure
(a) In [I/O Parameter], set up special module in slot.
/0 Parameter Setting E‘E|

All Base | sctBase |

= @0 Base 00 : Default T Module | Comment | Input Fiter | Emengency 0u] Allocation |
== 00 : Default Ofmain]
A, 01 : XBF-AH04A (I 1
== 02 ! Default
== 13 Default
== 04 : Default
== 5! Default
== 06 Default
== 07 Default
== 08 Default
= 19 Default
== 10 Default

w|oo|~afm|o|e|w|r

=]

Dekte Al | [ Detale | [ Pamt ¥ ] [_ok ][ Cancel

b) Double click [Variables/Comment].
¥ AH - XG5000 - [Variable/Comment]

';é; Project Edit Find/Replace Miew Online Monitor Debug Tools Window Help

iDEaEs © aa BEO P | b BB X | E K LYLY A
B i
[l =

Project Window x

ltemns [V] View Variable l:E‘Vew Devics | [] view Fiag ]
E-ES AH « [ variable Twpe | Dewice | Used |
= MewPLC(XGE-XBCH)-Offline 1] r

3 Variable/Comment
=-[# Parameter
Basic Parameter
B 1/0 Parameter
E Embedded Parameter
= Scan Praogram
MNewPragram

c) In the ‘Edit’ menu, select ‘U-Device Auto Registration’ (special module variable auto registration).
@ AH - XG5000 - [Variable/Comment]

';é; Project |Edit| Find/Replace Miew Online Monitor Debug Tools Window Help

D= D i $BE X 2K D60 0A B W A L
: % cut Ctisx & RE!
i Copy Cirl+C El &
Project Windo x .

ltems . Delete Del [V] view variatle l@\"ew)evoe [¥F] view Fisg l

=-2E AH Select All i+ | Yariable Tvpe | Device | lzed |

=D Mg insert Line CirlaL . L.
[z 8¢ Delete Line Ctrl+D

Export Variables to File...

E| Register U Device |
=
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(d) Click ‘Yes.’

= Automatically register comments in the U Devices according to the special module st in the /0 parameter
"-:.-) The previous commuent will b deleted
Contimue?

X

(e) Variables are registered as shown below.

|V | view Variable l?\.rewjeuoe [¥] view Fiag l
Yariable | Type A| Device | lsed | Comment
1 _01_ERR BIT o1.00.0 r Analos 10 Module: Module Error
2 _M_RDY BIT ot.o0.F r dnalog 10 Module: Module Ready
3 _01_ADO_ACT BIT uor.o.a r dnalog 10 Module: Input CHO Active
] _01_AD1_ACT BIT uat.of .1 r Analog 10 Module: Input CHI Active
5 _01_OA0_ACT BIT uor.o.2 r Analog 10 Module: Output CHO Active
i _01_Oi1_ACT BIT uo.o.3 r dnalog 10 Module: Output CHY Active
7 _01_ADO_100 BIT uot.o1.4 r dnalog 10 Module: Input CHO Disconnection Flag
8 _01_AD1_100 BIT uor.om.5 r dnalog 10 Module: Input CH1 Disconnection Flag
g _01_ADO_ERR BIT uot.o1.8 r dnalog 10 Module: Input CHO Error
10 |_01_AD1_ERR BIT uo.o.9 r dnalog 10 Module: Input CH1 Error
11 _01_DA0_ERR BIT uot. 01,4 r dralog 10 Module: Output CHO Error
12 |_01_Da1_ERR BIT Uo.o1.e r Analog |0 Module: Output CH1 Error
13 |_M_DA0_OUTEM  BIT o1.05.0 r dnalog 10 Module: Output CHO Status Setting
14 |_M_O41_OJUTEN  BIT uat.os.1 r dnalog 10 Module: Output CHI Status Setting
15 |_M_ADO_DATH WORD lo1.04 r Analog 10 Module: Input CHO Data
16 [_01_401_DATA WORD o1, 05 r dralog 10 Module: Input CHY Data
17 |01 _DAD_DATH WORD lo1.ov r drialog 10 Module: Output CHO DATH
18 | _01_DA1_DATH WORD o1, 08 r drialog 10 Module: Output CH1 DATA

(f) In IEC types, the variables are registered as shown below.

|| Global Variable lT Direct Variable Comment ¥ riag l
Yariable Kind | Yariable | Type | Address ||'I7I'tl'a| |Retain| Uzed | Comment
2 YaR_GLOBAL _01_ADO_DATA WORD Ao, 1.4 r r 4nalog 10 Module: Input CHO Data
3 WAR_GLOBAL _01_400_ERR BOOL 260,124 r r #nalog 10 Module: Input CHO Error
4 ViR_GLOBAL _01_400_100 BOOL Bx0.1,20 r r #4nalog 10 Module: Input CHO Disconnection
5 ViR_GLOBAL _01_A01_ACT BOOL B0 17 r r #nalog 10 Module: Input CHI Active
[ ViR_GLOBAL _01_A01_DATA ] Ao, 1.5 r r dnalog 10 Module: Input CHI Data
7 ViR_GLOBAL _01_401_ERR BOOL 260,17, 25 r r #nalog 10 Module: Input CHI Error
] VAR_GLOBAL _01_4D1_1D0 BOOL BUR0.T.21 r r 4nalog 10 Module: Input CHI Disconnection
] VAR_GLOBAL _01_DAO_ACT BOOL 280,118 r r 4nalog 10 Module: Output CHO Active
10 |V4R_GLOBAL _01_DAD_DATA WIORD o, 1,7 r r dnalog 10 Module: Output CHO DATA
11 |VAR_GLOBAL _01_DAD_ERR BOOL Ak0.1.26 r r hnalog 10 Module: Output CHO Error
12 |VAR_GLOBAL _01_DAD_OUTEN BOOL 260,171,965 r r dnalog 10 Module: Output CHO Status Setti
13 |VAR_GLOBAL _01_DA1_ACT BOOL Ax0.1.19 r r dnalog 10 Module: Output CH1 Active
14 |VR_GLOBAL _01_DA1_DATA ] Fa.1.8 r r dnalog 10 Module: Output CHI DATA
15 |VAR_GLOBAL _01_DA1_ERR BOOL Bx0..27 r r #nalog 10 Module: Output CHI Error
16 |VAR_GLOBAL _01_DA1_OUTEN BOOL #x0.1.97 r r dnalog 10 Module: Output CH1 Status Setti
17 |VR_GLOBAL _01_ERR BOOL Fx0.1.0 r r #nalog 10 Module: Module Error
18 |VéR_GLOBAL _01_ROY BOOL 3X0.1,15 r r #nalog 10 Module: Module Ready
13 i | r r

(2) Saving Variables
(a) The contents in the ‘View Variables’ tab can be saved in a text file.
(b) In the ‘Edit’ menu, select ‘Save as Text File.’
(c) The contents in the ‘View Variables’ tab are saved in a text file.
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(3) Viewing Variables in Program

The figures below present examples of use in XGB “S” and “H” types.

(a) Below is an exemplary program for XG5000.

e

Lt

L2

£3

g

L5

L
331

Lo

£

£3

g

L5

ig

30

iLf

s

i2

i

s20

LA

LEF

WIOOOD U100 U01.00.0
o | " I | nv uai.o4  pooton ||
um.o0.F . U001 [ v uat.05 o101 ||
I LI
Mool UQl.00.F  Uan.oi.z ut.06.0
s I I —
uot.oocF o uot.ot.3 uat.06. 1
— | I —
Mooz Ual.00.F  Uan.oi.z
wol— | I I [ ov Do0200  u01.07 |
wj.@F . ot [Wv womoi wis ||
ENDI
(b) In the ‘View' menu, click ‘View Variables.’ The devices are changed into variables.
_01_AD0_4C
Miooon 01ROy T Wy D00 0A g L
o I I | L
_01_4D1_4C
_O1_RDY T | Wy D00 L
— | I L
01 _DA0_AC _01_Dan_au
| _1_ADY T TEN
st I I —
01 _DW1_4C _01_DA1_a0
_01_RDy T TEN
— | {1 —
Wadao2 01_Roy o DT#“MD | 01 _0A0_0
01 My oogzon -1 L
wop— | { {1 - ATA
01_rov . DTm e | 01_0A1_D
01 My oogeor -1 L
— | {1 - ATA
END
S|
(€) In the ‘View' menu, click ‘View Device/Variables’ to look up the devices and variables at the same time.
MOODOD  UDI.D0.F L1010
. O I [ v U01.04 000100 |
_OTRDY _O1_ADO_AC _O7_ADO_DA
T Th
””"DID'F ”ml'“ﬂ" | nv uot .05 oot ||
_OIRDY  _01_AD1_AC _OT_ADT DA
T Th
HOOODI  U1.00.F U012 Uat.06.0
I I} o —
_OIADY_01_DAOAC _01_D0_ou
T TEN
uot.o0oF  ugn.ot.3 uat.06.1
— | . —
_OTRDY _01_DAT_AC _01_DAT 00
T TEN
Mooz UO1.00.F  U0r.on.z
ey I I [ now 000200 UD1.07 |
1R m_m.n AL _m_%u_m
uat.on.F um.m.a
I I [ o Dooz0l u0i.08 ||
_DIRDY  _01_DAILAC _O7_DAT_D&
T Th
END
1
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(d) In the ‘View' menu, click ‘View Device/Description’ to look up the devices and descriptions at the same time.

MOnono uot.o0.F - uo.ot.o
My u N [ v Uot.04 000100 ||
bralog 10 Analog [0 dnalog 10
Module: Module: Module:
Module Input CHO Input CHO
Ready bt iwe Data
UD]'DID'F UD]I'DJ'] [ MOV 1o1.05 poatot l_
dnalog 10 Analog [0 Aralog 10
Module: Module: Module:
Hodule Input CHI Input CHI
Ready hot ive Data
Moot uot.oo.F o Uot.ot.2 1Jo1.06.0
— | { | { |
dmalog 10 Analog 10 dnalog 10
Hodule: Madule: Module:
Module Output CHO Output CHO
Ready hotive gt%ELIIS
etting
uot.oo.F o Uo.o1.3 101,061
! | |
fnalos 10 Analog 1D Analoa 10
Hodule: Madule: Module:
Module Output CHI Output CH1
Ready hot ive gt%ELIIS
etting
Mononz uot.ooF o Uo.ot.2
ey " ' [ wov 000200 UO1.07 ]
dmalog 10 Analog 10 dnalog 10
Hodule: Madule: Module:
Module Output CHO Output CHO
Ready hot ive DATH
”U"”F'F ”mI'UI"S [ wv Doeoi U010 ||
bralog 10 Analog 10 #nalog 10
Module: Module: Module:
Module  Output CHI Output CHI
Ready bt iwe DATA
EHD
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(e) For IEC type also, as shown in Fig. (a) ~ (d), you can look up variables with
diversified options in the ‘View’ menu. The figure below is the case of an IEC type

with which the ‘View Variables/Descriptions’ option.

_01_ADO_AC
M0 _01_RDY T MOVE
— | {1 I EW  EWDF
drglog 10 Analog 10
Modu 1 e: Module:
Module Input CHO
| Ready het jve
_O1_ADT_AC
_01_RDY T HOVE _01_401_D4 CHIConvers
EW  END | Té 4 IN 0T L forValue
dralog 10 Analog [0 dnalog 10
Modu 1 e: Module: Module:
Module Input CHI Input CH
| Ready Active Data
_01_ADO_Dé CHO I nput Ya
Té 4N DUT lue
dnalog 10
Module:
Input CHO
| Data
] _01_DA0_AC _01_DA0_0U
Ehi1 _01_RDY T TEH
— | | | | |
drglog 10 Analog 10 dnalog 10
Modu 1 e: Module: Module:
Module Output CHO Output CHO
Ready bt jve Status
Setting
1 _01_D&1_AC _01_D&T_0U
T TEN
| |
hralog 10 Analog 10
Modu 1 e: Module: Module:
Module  Output CHI Output CHI
Ready Aot jve Status
Setting
_01_DAD_AC
M2 _01_RDY T HOYE
| |} || EW  EWO L
dralog 10 dnalog 10
Module: Module:
Modu | e Output CHO
| Ready Aot ive
_01_DAT_AC
01RO T MOVE CHIDutputy _01_Di1_D
EW  END | alue IN 0Tt Th
dralog 10 dnalog 10 bnalog 10
Module: Module: Module:
Module Output CHI Output CHI1
| Ready htive DATA
CHOOutputy _01_DAD_DA
alue { IN OUTL Th
dnalog 10
Module:
Output CHO
| DATA
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6.11 Constitution and Function of Internal Memory

An analogue mix module has internal memory for data communication with XGB base unit.

6.11.1Analogue Data I/O Area
The table below presents the analogue data I/O area.

Device Allocation 4 |
i v g A Rea Signal
Variable Type S” or “H IEC Type Description Write Direction
Type

_Oy_ERR BIT U0y.00.0 %UXO0.y.0 Module error Read AHO4A -
_Oy_RDY BIT UOy.00.F | %UX0.y.15 | Module ready CPU
_Oy_ADO_ACT BIT U0y.01.0 %UX0.y.16 | Input Ch O operating Read
_Oy_AD1 ACT BIT U0Oy.01.1 %UX0.y.17 | Input Ch 1 operating AHO4A N
_Oy _DAO_ACT BIT U0y.01.2 %UXO0.y.18 | Output Ch 0 operating CPU
Oy DAl ACT BIT U0y.01.3 %UX0.y.19 | Output Ch 1 operating

Input Ch 0 open wire
_Oy_ADO_IDD BIT UOy.0L4 | %UX0y.20 | (oo o Read | AHO4A

Input Ch 1 open wire CPU

0,

_Oy_AD1_IDD BIT U0y.01.5 %UX0.y.21 detected
_Oy_ADO_ERR BIT U0y.01.8 %UXO0.y.24 | Input Ch O error Read
_Oy_AD1_ERR BIT U0y.01.9 %UXO0.y.25 | Input Ch 1 error AHO4A N
_0Oy_DAO_ERR BIT UOy.01.A %UXO0.y.26 | Output Ch O error CPU
_0Oy_DAl ERR BIT UOy.01.B %UXO0.y.27 | Output Ch 1 error

Input Ch 0 converted AHO4A —
_Oy_ADO_DATA WORD | U0y.04 %UWO0.y.4 value Read | cpy

Input Ch 1 converted AHO4A —
_Oy_AD1 _DATA WORD | U0y.05 %UWO0.y.5 value Read | cpy
_Oy_DAO_OUTEN | BIT U0y.06.0 %UX0.y.96 | Ch 0 output state setting Write AHO4A PN
_Oy_DA1 OUTEN | BIT U0y.06.1 %UX0.y.97 | Ch 1 output state setting CPU
_Oy_DAO_DATA WORD | UO0y.07 %UWO0.y.7 Output Ch 0 input value Write é';?fm <
0y DAL DATA | WORD | U0y.08 %UWO.y.8 | Output Ch Linputvalue | write é';ffA i

- In the device allocation, the small letter 'y’ is the No. of the slot where the module is installed.
- For example, to read the ‘Input Ch 1 Converted Value’ of the analogue mix module installed in
the 4" slot, write in U04.05. (%0UWO0.4.5 for IEC types)

Word classifier Base No
uo4 ! 05 %UWO0.4.5
DeviciType i Wfrd Device Type i Word
Slot No. Slot No.
[“S” or “H" type] [IEC type]

- To read the ‘Output Ch 1 Output Status Setting’ of the analogue mix module installed in the 5"

slot, write in U05.06.1 (%UX0.5.97 for IEC types)

Word classifier  Bit classifier Base No
Uob5 ? 0 6 ? 1 % UXO0.5.97
oy o

Device TypeSIOt o, Word Shot No.
[“S” or “H” type] [IEC type]
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(1) Module Ready/Error Flag ( () is for IEC types, x: slot No.)

(a) U0x.00.F(%UX0.x.15): at power on or reset of PLC CPU, turns on when the analogue I/O conversion is ready,
and analogue conversion is performed.

(b) UOx.00.0(%UXO0.x.0): the flag indicating the error status of A/D conversion module.

bit15 bit14 bit13 bit12 bit11 bit10 bit9 bit8 bit7 bit6 bit5 bit4 bit3

bit2 bit1 bit0
U0x.00
(%UWO0.x.0) e -
2 =
Sl - - 1-1-1-|-1-1-1-|/-1-1-153
<
Module READY Ili;gor:n oacticctlr:rence
Bit On (1): Normal . :
Bit Off (0): error Bit On (1): error

Bit Off (0): Normal

(2) Operation channel information/ open-wire detection information/ channel error information flags
(()is for IEC types, x: slot No.)

This is the area for storing the operation information, input wire open detection,

and channel error information by channel.

[1 The base No. of the XGB PLC is 0.

Bit15 Bit14 Bit13 Bit12 Bit11 Bit10 Bit9 Bit8 Bit7 Bit6 Bit5 Bit4 Bit3 Bit2 Bit1 Bit0
U0ox.01
o o = = = = o o — —
(%UWO0.x.1) S| 5|3 |3 3|3 |5 |&5|28|=2
- - _ _ 2 2 =4 =4 =4 S |2 2 =4 =4
sl sl ol of B olol|l 3|l &3l el o
e x|z T 28|
R S e i I N =T e
\ \
' '
Channel Error Info. Open-wire detection info. Operation Ch, Info.
Bit On (1): error Bit On (1): open-wire Bit On (1): in operation
Bit Off (0): normal Bit Off (0): normal Bit Off (0): Stop operation
(3) Digital Output Values ( () is for IEC types, x: slot No.)
(a) A/D converted digital values are outputted to buffer memory address U0x.04 ~ U0x.05 (%UWO0.x.4
~ %UWO0.x.5) by channel-basis.
(b) Digital output values are saved in 16-bit binary figures.
[1 The base No. of the XGB PLC is 0.
Bit15 Bit14 Bit13 Bit12 Bit11 Bit10 Bit9 Bit8 Bit7 Bit6 Bit5 Bit4 Bit3 Bit2 Bit1 Bit0
(%ll:JJ(\)/i/((.)(.):(lA) Input channel 0 converted value
(%ll:JJ(\)/i/((.)(.)f.S) Input channel 1 converted value
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(4) Output Permit Setting ( () is for IEC types, x: slot No.)
(a) Output permit/prohibit can be set up for each channel.
(b) The default setting is ‘Output Prohibited.’
[1 The base No. of the XGB PLC is 0.

Bit15 Bit14 Bit13 Bit12 Bit11 Bit10 Bit9 Bit8 Bit7 Bit6 Bit5 Bit4 Bit3 Bit2

@
@
3

UOx.06

(%UWO0.x.6)

|

|

|

|

|

|

|

|
L'HO Indino
0'HO IdinQ

Output status setting
BitOn (1): Output permitted
BitOff (0): Output prohibited

(5) Digital Input Values ( () is for IEC types, x: slot No.)
(a) Digital inputs can be set up as unsigned (-48~4047), signed (-2048~2047), precision, or percentile (-12~1011) values.
(b) When digital input value is not set up, they are processed as zero.
[1 The base No. of the XGB PLC is 0.

Bit15 Bit14 Bit13 Bit12 Bit11 Bit10 Bit9 Bit8 Bit7 Bit6 BitS Bit4 Bit3 Bit2 Bit1 Bit0

(tyl[JJ(\)/\)/((SOZ 7) Output channel 0 input value

(‘ytd(\),\)/((')of 8) Output channel 1 input value
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6.11.2 Operation Parameter Setting Area
The operation parameter setting area of the analogue mix module is as follows.

Memory
Add.

0 Appoint operating channel Bit Off (0): stop, Bit ON (1): run R/W
I/0O range setting (4 bit per Ch.)
0:4~20 mA
1:0~20 mA
2.1~5V
3:0~5V
4:0~10V
I/O data type setting (4 bit per Ch.)
0: 0 ~ 4000
1: -2000 ~ 2000
2: Precision value
3:0~ 1000
2 /0 data type setting - for precision values; R/W
4 ~20 mA: 400 ~ 2000
0~ 20 mA: 0 ~ 2000
1~5V:100 ~ 500

R/W

Description Setting R/W | Command

1 1/0 range setting R/W

Input Ch 0 filter value
setting
Input Ch 1 filter value
setting

0 or 4 ~ 64000

R/W

Averaging method setting (4 bit per Ch.)
0: Sampling

5 Averaging method setting 1: Time average R/W
2: Cycle average
3: Moving average

Time average: 4 ~ 16000 [ms] R/W
Cycle average: 2 ~ 64000 [cycles]
Moving average: 2 ~ 100 [samples] R/W

Input Ch 0 average value
setting
Input Ch 1 average value
setting

0: previous value

Channel  output  status | 1: min. value

setting 2: median

3: max.

10#: Input Ch range setting error

20#: Input Ch data type setting error
30#: Input Ch filter value setting error
40#: Input Ch averaging setting error
50#: Input Ch average value setting error
60#: Output Ch range setting error R GET
70#: Output Ch data type setting error
80#: Ch output status setting error

90#: Output Ch input value range-over
error

(#: channel number)

R/W

Set-up error information
output area

Note
(1) If the memory address 0~8 area is entered with values different from the setting.
U0x.01.8~U0x.01.B (setting error representative flag, for IEC
type, %UX0.x.24~%UX0.x.27) is ON and runs with default values. The error
information is displayed in the setting error information are (No. 9).

A CAUTION (2) System areas (after No. 10) are read/write protected.
Changing these areas may cause malfunction or failure of the product.
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(1) Operating Channel Setting
The default setting for operating channel is ‘Stop.’

Bit15 Bit14 Bit13 Bit12 Bit11 Bit10 Bit9 Bit8 Bit7 Bit6 Bit5 Bit4 Bit3 Bit2 Bit1 Bit0
Address0 °olo|l=s|=
_8 _8 © ©
S I I I R e = =T = -
o o
Q Q T T
| T | = | :
N =) ©
=
g

Appoint Using CH. bit
Bit On (1): Operate
Bit Off (0): Stop

(2) /0 Range Setting

(a) The analogue /O voltage range is DC 1~5V, DC 0~5V, DC 0~10V, and analogue current /O
range is DC 4~20mA, DC 0~20mA.

(b) Default range is DC 4~20mA.

Bit15 Bit14 Bit13 Bit12 Bit11 Bit10 Bit9 Bit8 Bit7 Bit6 BitS Bit4

Bit3 Bit2 Bit1 Bit0
Address1
Output CH.1 Output CH.0 Input CH.1 Input CH.0
Input ch. Set-up 1/0 range(by ch. 4bit)
0:4~20mA
1:0~20mA
2:1~5V
3:0~5V
4:0~10V
(3) I/0 Data Type Setting
(a) I/O data type can be set up for each channel.
(b) If the 1/O data type is not set up, all the channels are processed in 0~4000 range.
bit15 bit14 bit13 bit12 bit11 bit10 bit9 bit8 bit7 bite bits bit4 bit3 bit2 bit1 bit0
Address2
Output CH. 1 Output CH. 0 Input CH. 1 Input CH. 0

Set-up I/0 data type (by Ch.4bit) - For precision values

0:0~4000 4 ~ 20 mA: 400 ~ 2000

1:-2000 ~ 2000 0~ 20 mA; 0 ~ 2000

2 : Precision value 1~5V:100 ~ 500

3:0~1000 0~5V:0~500

0~10V:0~1000
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(4) Filter Constant Setting
(a) If set to 0, no filtration is processed.
(b) Default setting is 0 — no filtration process.

Bit15 Bit14 Bit13 Bit12 Bit11 Bit10 Bit9 Bit8 Bit7 Bit6 Bit5 Bit4 Bit3 Bit2 Bit1 Bit0
Address3 Input channel 0 filter constant (0 or 4 ~ 64000 ms)
Address4 Input channel 1 filter constant (0 or 4 ~ 64000 ms)

(5) Averaging Method Setting
(a) Averaging method can be one of; time average, cycle average, moving average.
(b) Default setting is no averaging throughout the channels.

Bit15 Bit14 Bit13 Bit12 Bit11 Bit10 Bit9 Bit8 Bit7 Bit6 BitS Bit4 Bit3 Bit2 Bit1 Bit0

Addressb5
- - - - - - - - Input CH.1 Input CH.0

Set-up averaging method (4bit per Ch)
0 : Sampling

1: Time average

2 : Cycle average

3 : Moving average

(6) Average Value Setting
(a) Set up average values in accordance with the setting area of the averaging
method.
(b) If the average value is out of setting range, averaging is not applied.

HIE15 HIE14 HIE13 HIE12 HE1N HE1W HIE9 HIE8 HIE7 HIE6 HIES5 HIE4 HIE3 HIE2 HIE1 HIE0
Addressb Input channel 0 average value
Address7 Input channel 1 average value

Input channel# average value setting
Time average : 4 ~ 16000 [ms]
Cycle average : 2 ~ 64000 [Cycle]
Moving average : 2 ~ 100 [samples]
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(7) Output Status Setting
(a) This sets up the analogue output status when the XGB base unit is changed from run

to stop.

(b) Default setting is the Previous Value output.

Bit15

Bit14 Bit13

Bit12 Bit11 Bit10 Bit9 Bit8 Bit7 Bit6 Bit5

Bit4

Bit2 Bit1 Bit0

Address8

- - - - - Output Ch.1

Output Ch.0

(8) Error Code (Address 9)

(a) Saves the error code detected by the analogue mix module.
(b) The types and descriptions of the error are as follows.

Output channel status setting (4 bit per Ch)

0 : Previous value output

1 : Min. value output
2 : Median value output
3 : Max. value output

Bit15 Bit14 Bit13 Bit12 Bit11 Bit10 Bit9 Bit8 Bit7 Bit6 Bit5 Bit4 Bit2 Bit1 Bit0
Address9 Set-up error information
Error _ Priority
Type ol LED Lamp Description Il Remark
10# Input Ch range setting error 2
out 20# | INPUT Input Ch data type setting error 3
Er?or 30# | LED Input Ch filter cons. Setting error 4
404 | lsflash Input Ch averaging setting error 5 # Ch No.
50# Input Ch average value setting error 6 Input Ch. 0,1
60# Output Ch range setting error 7 Output Ch. 0,1
704 | OUTPUT | output ch d i 8
Output LED utput ata type setting error
Error 80# | 15 flash Output Ch status setting error 9
90# Output Ch input value range-over error 1

(c) In case of plural errors, the code with higher priority order will be saved.

(9) System Area (after Address 10)
(a) System area (after address 10) is read/write protected.

A Caution

Modifying this area can cause malfunction of failure of product.
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6.12 Example Program

(1) This sample program sets up operating parameters of analogue mix module.
(2) Initial settings are saved in the internal memory of the module by input by once.

(3) The sample program below controls the 1/O data of the analogue mix module at slot #1 and check
open wire.

6.12. 1 Example of [I/O Parameter] Usage

(1) /O Parameter Setting Window

/0 Parameter Setling

AIIBane}Se’.Ea;e ]

= @ Base 00 : Default Comment Input Filker | Emergency Oul Allocation
85 00: DC 24¥ INPUT, [T ol CC 24 [NPUT/RELS dard[ms]  Default
&5 01 : XBF-AH04A (1) XEF-AHD4A (10, 242 -
== 02 Default
== 03 Detault
== 04 Default
= 05! Default
== 06 : Default
== 07 : Default
== 08 : Default
= 09 Detault
== 10 Default

[2=0 F=-3 S oY 3, B IS Y Y

=

[(Deetedi | [ Detas | [ et ¥ ] [ ok ][ Cancel

XBF-AHD4A (I/0, 2/2 CH)

*BF-AHO44 (170, 2/2 CH)

Input Parameter CHO CH1 |
[] Chanrel statuz Enable Dizable
[ Input range 4~ 20md, o1
Output type 0~4000 0~4000
Filter constant 0 0

[ werage processing Sampling Sampling

Average value 1] 1]

Output Parameter Channel 0 Channel 1
[] Chanrel statuz Enable Dizable
[ Output range 420 1oy
Input type 0~4000 0~4000
] CH. Output type Farmer walue Farmer value

ok ] [ Concel |

(a) Input Channel O is set to operating channel and input range is set to 4~20mA.
(b) Output Channel 0 is set to operating channel and output range is set to 4~20mA.




Chap. 6 Analogue Combo Module

(2) Sample Input Program
Input CHO program

it T LR S 1 O 1 I I WHOD0OD
—/1 | | | | 1/} € >—
orEm  _ob R ..m_:.Tm__m 1 _ADO_ER
3l R
L2 MOG000
Mt | o w0000 ||
_O1_AD_0A
b TA
L3 .00 .4 WO
— | 53—
JD1_AD0_ 10
| ]
£
BN

(a) When the module is in normal operation, MO0QO is turned On.
U01.00.0(Module Error) = Off
U01.00.F(Module Ready) = On
U01.01.0(Input Channel 0 in-operation) = On
U01.01.8(Input Channel 0 Error) = Off
(b) When M000OQ is ON, Input Channel 0 Converted Value(U01.04) is moved to DO0100.
(c) If open-wire error occurs in channel 0, U01.01.4(channel 0 open-wire) is ON, and M0001 bit is
set.

(3) Sample Output Program
Output CHO program

Lr UL 000 WIL0OF  LOLOIZ  DI.00.A WOODID
—4/1 1 | | 1/ < 3
01 B8R JBRDY 01 _DADLAC  _D1_DAO_ER
3l T R
@ HOD010 1#01.06.0
_| ! PR
01 DAD_0U
% TEN
L3
s [ oem  wow |
' O AITh
oe:] Ta
L
BN

(a) When the module is in normal operation, MO0010 is turned ON.
U01.00.0(Module Error) = Off
U01.00.F(Module Ready) = On
U01.01.2(Output Channel 0 in-operation) = On
U01.01.A(Output Channel 0 Error) = Off

(b) When M00010 is On, channel 0 output status setting (U01.06.0) is turned ON and output is
permitted.

(c) When M00010 is On, the data in D00200 is transmitted to Output Channel 0 input value
(U01.07) and outputted.
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(4) Sample Input Program (for IEC type)

#K0.1.0 xuxn 1.15 xuxn 1 16 xuxu 1 L 0
I/I I I E
_OT_ERR  _D1_FDY _m_aTDn_Ac _EII_ARDD_ER
Lt
0 MIVE
|| EW  EHD
JE]
gmo.1.4 { I ot} CHOInput
_01_4D0_DA Value
] TA
£3
L4 #0.1.20 1
{ 52—
_DI_ADDEI_ID
(a) When the module is in normal opérétion', %MXO0 is turned ON.
%UXO0.1.0(Module Error) = Off
%UX0.1.15(Module Ready) = On
%UX0.1.16(Input Channel 0 in-operation) = On
%UX0.1.24(Input Channel O Error) = Off
(b) When %MXO0 is ON, Input Channel 0 Converted Value(%UWO0.1.4) is transferred to “Channel
Olnput” variable.
(c) If open-wire error occurs at Channel 0, %UXO0.1.20(ChannelOopen) turns ON and %MX1 bit is
set.
(5) Sample Output Program (for IEC type)
M0 1.0 3ED.1.15 %an 1 18 xuxu 1 2 10
1/ | | 1
0TERR 01ROV _IJI_IJT#.IJ_HE _m_DR.ﬂ\u_EH .
Lf 10 K0, 1.96
| ]
_01_Dh0_ou
TEN
L2
EMA10 WOVE
| | EW EMD
JE!
CHOOutput { v OUT | smw0.1.7
Value _01_DAD_D:
TA
7]

(a) When the module is in normal operation, %MX10 is turned ON.
%UX0.1.0(Module Error) = Off
%UX0.1.15(Module Ready) = On
%UX0.1.18(Output Channel 0 in-operation) = On
%UX0.1.26(Output Channel 0 Error) = Off

(b) When %MX10 is ON, ChannelO output status setting (%UX0.1.96) is turned ON and output is
permitted

(c) When %MX10 is ON, the data of the ‘Channel Ooutput’ variable is transferred to Output
Channel 0 Input Value (%UWO0.1.7) and outputted.
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6.12. 2 Exemplary Usage of PUT/GET Command

(1) Sample Input Program
Input CHO Program

Iy FOO0 - — —
| | T i ] |_
5] i ]
[y
[ 1
i3 WI.000  WLBOF  L0I.0LE  U01.00E MO0
—1/} { | - = 1/} { —
OIERM  DLROY _DLADOAC _D1_ADOER
10 T R
£
o [Mwv  wie  poowo |
1Ak
§15 i
iy o104 Cn)|
w—{ ! ..('S',u—-
1A ID
= i
il
END
=0 |

(a) Using PUT command to write h0005 in the address 0, slot 1 to operate Input Channel 0 and
Output Channel 0.

(b) Using PUT command to write h0O000 in the address 1, slot 1 to set the input range of Input
Channel 0 to DC 4 ~ 20mA and the output range of the Output Channel 0 to DC 4 ~ 20mA.

(c) When the module is in normal operation, MO0OQO is turned ON.
U01.00.0(Module Error) = Off, U01.00.F(Module Ready) = On
U01.01.0(Input Channel 0 in-operation) = ON,  U01.01.8(Input Channel 0 Error) = Off

(d) When M000O is ON, Input Channel 0 Converted Value(U01.04) is transferred to D00100.

(e) If open-wire error occurs at Channel 0, U01.01.4(ChannelOopen) is ON, and M00O01 bit is set.

(2) Sample Output Program
Output CHO Program

Fa] FoOrE
- | P b
g
I,
[ 1]
La unl.one  WiOhF  W1.0EZ  ubl0lA L]
L/} | } J—y ¢ —1|
olem ol 0 moA 0150
a1
& i 00,060
ki 01_DAD_00
315 B WEBLL
i
_"f”f“ [ e WL ||
01RO A
517 T
i
B
o [e0 |}

(a) Using PUT command to write h0005 in the address 0, slot 1 to operate Input Channel 0 and
Output Channel 0.

(b) Using PUT command to write h0O000 in the address 1, slot 1 to set the input range of Input
Channel 0 to DC 4 ~ 20mA and the output range of the Output Channel 0 to DC 4 ~ 20mA.

(c) When the module is in normal operation, M00010 is turned ON.
U01.00.0(Module Error) = Off, U01.00.F(Module Ready) = On
U01.01.2(Output Channel 0 in-operation) = ON, U01.01.A(Output Channel 0 Error) = Off

(d) When M00010 is ON, Channel 0 Output Status setting (U01.06.0) is turned ON and output is
permitted.

(e) When M00010 is ON, data of D00200 is transferred to Output Channel O Input Value (U01.07)
and outputted.
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(3) Sample Input Program (for IEC type)

STATI

M0

MK
33—

10 M5 IMa 11
3155 FUT_IOR FIIT_I0RD
| A0 DOE REQ ~ DOREL
1o
it
0 lpasE sl stamo 0 lease smatl
L2
T T
14
0 qwaoo i woo
B B
L
IG#0005 JDATA 1640000 {DATA
)
i8 BH0.1.0 YKO.0.05 SUN0.1L06 BUND.T.24
—/1 { | | { |
OLER 0L O1ANAC 01 A0 R
L7
£ WO
e e e
18
1.4 | our | CHOINput
_01_ADD_DA Value
T
a8
L1 3140.1.20
I
01 400_10

(a) Using PUT command to write h0005 in the address 0, slot 1 to operate Input Channel 0 and

Output Channel 0.

(b) Using PUT command to write h0O000 in the address 1, slot 1 to set the input range of Input
Channel 0 to DC 4 ~ 20mA and the output range of the Output Channel 0 to DC 4 ~ 20mA.

(c) When the module is in normal operation, %MXO is turned on.
%UXO0.1.0(Module Error) = Off
%UXO0.1.15(Module Ready) = On
%UXO0.1.16(Input Channel 0 in-operation) = On

%UXO0.1.24(Input Channel 0 Error) = Off
(d) When %MXO0 is on, Input Channel 0 Converted Value (%UWO0.1.4) is transferred to “Channel

Olnput” variable.

(e) If open-wire error occurs at Channel 0, %UX0.1.20(ChannelOopen) is turned on and %MX1 bit

is set.
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(4) Sample Output Program (for IEC type)

] IHST IN3T1
AF 155 PUT_WORD PUT_WORD
|| RED ™ OOME REQ™ OOKE}
_10M
Lf
0 {BASE STATE  STATO 0 JB43E  STATE  STAT1
L2
1 45007 1 J5L0T7
JE]
0 JM&00 1 JM400
N R R
{4
1640005 {OATH 1640000 JO&TH
L5
L8 BUXDLT.00 BURDOTS O RUXDOY1E BUXD.1.26 M0
1/l | | { | { | —
_01_ERR _01_ROY _DI_DTAIJ_AC _EII_DRAIJ_ER
L7 AMx10 SUX0.1.96
[ | —
_n_0&n_ou
TEH
L8
AMx10 MOVE
|} EN  EMD
£g
CHOOutnput | v ouT | zm0.1.7
Value _01_DAD_DA
] Th
L10
U

(a) Using PUT command to write hO0O5 in the address 0, slot 1 to operate Input Channel 0 and
Output Channel 0.

(b) Using PUT command to write h0O000 in the address 1, slot 1 to set the input range of Input
Channel 0 to DC 4 ~ 20mA and the output range of the Output Channel 0 to DC 4 ~ 20mA.

(c) When the module is in normal operation, %MX10 is turned on.
%UX0.1.0(Module Error) = Off
%UXO0.1.15(Module Ready) = On
%UX0.1.18(Output Channel 0 in-operation) = On
%UX0.1.26(Output Channel 0 Error) = Off

(d) When %MX10 is on, Channel 0 Output Status setting (%UXO0.1.96) is turned on and output is
permitted.

(e) When %MX10 is on, data of the ‘Channel Ooutput’ variable is transferred to Output Channel 0
Input Value (%UWO0.1.7) and outputted.
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6.13 Troubleshooting

This section describes methods for identifying the troubles which may occur during the
operation of analogue mix module, and their solutions.

6.13.1

LED Indication for Error

An analogue mix module has INPUT LED and OUTPUT LED to indicate error status of the module.

Module H/W
Normal Channel Open Parameter Setting
Classification Failure
State (Input) Error
(Serious Failure)
Flash at 1s intervals
Flash at 0.2s
INPUT LED On Flash at 1s intervals (input parameter setting
intervals
error)
Flash at 1s intervals
Flash at 0.2s
OUTPUT LED | On N/A (output parameter setting
intervals
error)
All  functions are
Module All functions All  functions work at | Module cannot
performed. Indicates
Behavior are normal default parameter setting | function
min. input value
Action - Check input wire Check parameter setting | Request for A/S

6.13.2 Checking Module Condition

XG5000's system monitor enables verification of the analogue mix module conditions (module type,
module information, OS version).

(1) Procedure

The verification can be done in 2 ways;
(a) [Monitor] -> [System Monitor] -> mouse right click on module icon -> [Module Information]
(b) [Monitor] -> [System Monitor] -> double click module icon.

(2) Module Information

(a) Module type: shows the information on the present module.
(b) Module information: shows the OS version of the module.
(c) OS version: shows release date of Module OS.
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6.13.3 Troubleshooting

(1) INPUT LED or OUTPUT LED is off.

INPUT LED or OUTPUT LED is off..

:

Analog combo module is correctly
installed.

No | Install the module correctly

i

XG5000 software shows I/O information

No —

Contact IMO Precision Controls technical support

o

System resumes normal function if the
module is replaced.

Yes —

Contact IMO Precision Controls technical support

(2) INPUT LED flashes.

INPUT LED flashes

:

INPUT LED flashes at 0.2s intervals.

Yes i

Contact IMO Precision Controls technical support

i

INPUT LED flashes at 1s intervals

:

Input wire is correct.

g

Parameter setting is normal
(Check with PUT command)

No T

¥

Correct wiring according to user manual

No —| (Check line open)

Operation parameter setting error
Correct the error according to user manual
(Check error code)
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(3) OUTPUT LED flashes.

OUTPUT LED flashes

:

OUTPUT LED flashes at 0.2s intervals

i

Yes ——

Contact IMO Precision Controls technical support

OUTPUT LED flashes at 1s intervals

:

Output channel input exceeds data
range

i

Parameter setting is normal
(Check with PUT command)

¥

No —

(4) Analogue /O value is abnormal.

Analog 1/0 value is abnormal.

:

External DC24V input power is OK.

No —

i

FG ground is OK

No i

I

Parameter setting is OK
(Operation channel permit, 1/0 range
setting

:

No i

External voltage/current selector switch
setting is correct

oy

i

Enter correctly according to the output range
in the user manual

Operation parameter setting error
Correct the error according to user manual
(Check error code)

Supply DC 24 power

Correct FG grounding according to the wiring
in the user manual

Set up the parameters correctly according to
the user manual

Set the switch according to the user manual

Contact IMO Precision Controls technical support
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7.1.2 Features
The built-in PID control functions of XGB series feature as follows.

(1) Since operations are executed within CPU part, it can be controlled by PID parameters and PLC
program without PID module.

(2) A variety of controls can be selected
= That is, a user can easily select P operation, Pl operation and PID operation.

(3) Precise control operation
= It can make precise PID control operations possible through floating point operations.

(4) PWM (Pulse Width Modulation) output available.
= It outputs control operation results to the output contact point designated by a user through PWM.

(5) Improving convenience of control settings and monitoring
= Through parameter setting method and K area flag, it maximizes control parameter settings
during operation and convenience of monitoring

(6) Freely selectable operation direction
= Forward, reverse and mixed forward/reverse operations are available

(7) Cascade operation realizing quick and precise PID control
= It can increase quickness of response to disturbance through cascade loop.

(8) Various additional functions
= PID control can be achieved by various methods a user wishes because set value ramp, the
present value follow-up, limiting change of values and types of alarm functions are provided.
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7.2 PID Control

7.2.1 Basic theory of PID control
Here describes basic theory of PID control and how to configure PID control.

(1) Terms
Terms used in this user manual are as follows.

= PV: status of plant detected by sensor (Process value)

= SV: Target value (Set Value) to control plant, if control is done normally, PV should follow the SV.
= E: error between SV and PV. It can be expressed as (SV-PV).

= Kp: proportional coefficient

= Ti: Integral time constant. Sometimes called integral time

= Td: Derivative time constant. Sometimes called derivative time

= MV: Control input or control device output. The input to plant to make PV follow the V

= Ts: Sampling time, a cycle of operation to execute PID control

(2)PID operation expression
Basic PID operation expressions are as follows.

E=SV-PV (7.2.1)
_Ke

U jEdtdE (7.2.3)

MV, = KT, (7.2.4)

MV = MVp + MV, + MV, (7.2.5)

PID control operation expressions of XGB series are more complicate than expression (7.2.1) ~
(7.2.5) mathematically but those are base on the above expression. The followings describe the
characteristics of control process with an example that controls the output temperature of heating
system in figure 7.1. At this example, the system and PID parameters imaginary to help the
comprehension and those may be different with real heating system. If the heating system in
figure 7.1 is expressed as second order system with transfer function like expression (7.2.6) in
frequency domain, it is expressed as differential equation like expression (7.2.6) in the time
domain.

32 (7.2.6)
(2s+1)(3s+5))

idzy(t)JrEdy(t)
32 (t? 32 dt

That is, x(t) is Manipulated value and y(t) is Process value.

Transfer function =

+5y(t) = x(t) (7.2.7)
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At this system, we assume that the PID parameter is specified as shown below to describe the PID
control operation.

Items Value Iltems Value
Output temperature of 0% Proportional coefficient 5
heating system (PV) (Kp)
Target temperature . .
50C Integral time (T;) 3s
(Sv)
Cycle of operation 0.01s Derivative time (Tq) 0.19s

<Table 7.1 example of control of heating system>

At this system, if we assume that target value of output temperature is 50°C and initial value of
output temperature is 0°C, SV and PV becomes 50 and O respectively. In case of this, PID
controller acts as follows.

(3) Proportional control (P control)
In the proportional control, the controller yields output that is proportional to error.
Manipulated value of controller by Proportional control is as follows.

(a) If P control starts, output of controller by initial P operation is as follows.
MV, =50x4 =200

If P control is executed for 10 seconds, output temperature will be as table 7.2.
If this is expressed with graph, it will be as figure 7.2.

Time Target temp. nggfc;ir(t:iioeg?l Output temp. Error
0 50 5 0 50
1 50 5 44.98 5.02
2 50 5 53.08 -3.08
3 50 5 50.15 -0.15
4 50 5 48.42 1.58
5 50 5 48.28 1.72
6 50 5 48.44 1.56
7 50 5 48.49 1.51
8 50 5 48.49 1.51
9 50 5 48.49 1.51

< Table 7.2 example of Proportional control >
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Temp. (°C) Example of P control
80

M ax- overshoeft— — — — — — —
B0 — -~ - — - Offset _ __ __ _|

n 4

4" "" " "—""—"———— — Quiput temp N

10 _— 0 — — — — — | — Sgttemp.

Time (s)

1 2 J 4 ]
< Figure 7.2 simulation of proportional control >

(b) Concerning the result of simulation, it has the maximum overshoot of about 23.4°C at 0.62s
and after 7s, it converges at 48.49°C with offset of 1.51C (about 3%).

(c) Offset is an unavoidable error when only P control is executed. Offset decreases proportional
to P coefficient but overshoot increases proportional to P coefficient. Table 6.3 and figure 6.3 is
simulation of offset and overshoot according to P coefficient.

Time temT;‘;?aetture Kp=5 Kp =25 Kp=1
0 50 0 0 0
1 50 45.02 63.46 46.67
2 50 53.11 42.52 46.77
3 50 50.15 47.93 41.38
4 50 50.22 47.25 41.60
5 50 48.27 46.96 43.30
6 50 48.35 46.92 43.25
7 50 48.44 46.90 43.21
8 50 48.53 46.90 43.18
9 50 48.53 46.90 43.18

<Table 7.3 Temperature- time table according to P coefficient>
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Temp. (°C)
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< Figure 7.3 Temperature- time graph according to P coefficient >

(c) Considering table 7.3, as P coefficient decreases, offset increases but overshoot decreases.

(d) Generally, offset can’t be solved with only P control. In order to remove the offset, P control
and | control is used together.

(4) Proportional Integral Control (Pl Control)

In | control, it yields the output proportional to error accumulated according to time. And the
expression is as follows.

wv, =Kz [t (7.2.9)
Ti

(a) In the expression 7.2.9, Ti means the time takes for MV, output by | control, to be added into
real output.

(b) Generally, | control is used with P control. So the expression of Pl control is as follows.

MV=MVP+Mvi=ExKP+%jEdt (7.2.10)
i

(c) In the above heating system, the simulation results are as shown in the table 6.4 when
proportional coefficient is 2.5 and integral time is 1.5s.

Time I:;?;F Péngc;ir(t:iizgtal In,:i?ﬁ];al P Control PI Control
0 50 25 1.5 0 0
1 50 25 1.5 63.46 74.41
2 50 25 1.5 42.52 40.63
3 50 25 1.5 47.93 52.99
4 50 25 1.5 47.05 49.67
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Time IZ;?SF Péggf?iréiizg?l Intti?ﬁ;al P Control PI Control
5 50 25 1.5 46.96 49.70
6 50 25 1.5 47.12 50.38
7 50 2.5 1.5 47.03 49.76
8 50 25 1.5 47.07 50.14
9 50 25 1.5 47.06 49.94
10 50 25 1.5 47.06 50.02
11 50 25 1.5 47.06 49.99
12 50 25 1.5 47.06 50.00
13 50 25 1.5 47.06 50.00
14 50 2.5 1.5 47.06 50.00
15 50 25 1.5 47.06 50.00

< Table 7.4 Temp.- time table >

(d) Considering table 7.4 and figure 7.4, if P and | control is used together, offset is removed and

temp. converges at 50C, target temp. after 12s

(e) But in this case, convergence time is longer than that of P control and overshoot is larger.
Generally, as integral time increases, overshoot decrease. About this, refer to the figure 7.5.

Temp. (°C) Comparison of P control and Pl control

a0

aa

a

=

50

40

30

1 LR R PP PP PR PR PP PR EPEEPEE

— Pl contral

P control

1 2 3 4 5 il 7

< Figure 7.4 Temp.- time graph >

a Time (s)
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Temp. (°C) Response according to Ti

1 7 3 4 5 g Time (s)
< Figure 7.5 overshoot according to integral time >

(f) Like this, if | control is used, overshoot is larger. According to system, large overshoot can be
problem. In order to solve this, PID control is used.

(5) Proportional integral derivative control (PID control)
In D control, when status of system changes rapidly, D control yields the output to reduce the
error. Namely, D control yields the output proportional to change velocity of current status. So if
D control is used, response speed of controller about status change of system increases, and
overshoot decreases. Output of controller by D control is as shown in expression 7.2.11.

dE
MV, ZKPTdE (7.2.11)

(a) In the expression 7.2.11, Td means the time takes for MV4output by | control, to be added into
real output.

(b) Generally, D control is not used solely but with PD control. So PID control is expressed as
expression 7.2.12.

MV = MVp, + MV; + MV, :ExKP+%IEdt+KpTd‘Z_'tE (7.2.12)
i

(c) The figure 7.6 is simulation result when PID control is applied to above heating system.
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Time Target Propo_rti.onal Int_egral Deri_vative Pl PID
temp. coefficient time time Control Control
0 50 25 1.5 0.3 0 0
1 50 25 1.5 0.3 74.41 55.50
2 50 25 1.5 0.3 40.63 56.33
3 50 25 1.5 0.3 52.99 52.50
4 50 25 1.5 0.3 49.67 50.92
5 50 25 1.5 0.3 49.70 50.34
6 50 25 1.5 0.3 50.38 50.12
7 50 25 1.5 0.3 49.76 50.05
8 50 25 1.5 0.3 50.14 50.02
9 50 25 1.5 0.3 49.94 50.01
10 50 25 1.5 0.3 50.02 50.00
1 50 25 1.5 0.3 49.99 50.00
12 50 25 1.5 0.3 50.00 50.00
13 50 25 1.5 0.3 50.00 50.00
< Table 7.5 comparison of Pl control and PID control >
Temp. (") Comparisan of Pl control and PID control
a0

—— Pl control

— PID control

5 Time (s)

< Figure 7.6 comparison of Pl control and PID control >

(d) Considering table 7.5, in case PID control is used, max. overshoot decreases from 16.5C to
8.5°C. At this time, P coefficient, integral time, derivative time are not optimal values, just one of
the examples. Actually, P coefficient, integral time, derivative time values vary according to PID
control system.
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7.2.2 Functional specifications of PID control
(1) Functional Specifications

The performance specifications of the built-in PID control function in XGB series are summarized
in the below table.

Item Specifications
No. of loops 16 Loop
Proportional 5
SCOp_e of constant(P) Real number (0 ~ 3.40282347e+38)
sc—.;;[;:r)mg Integral constant(l) Real number (0 ~ 3.40282347e+38), unit: second
constants Differential Real number (0 ~ 3.40282347e+38), unit: second
constant(D)

Scope of set value

INT (-32,768 ~ 32,767)

Scope of present value

INT (-32,768 ~ 32,767)

Scope of maneuver value

INT (-32,768 ~ 32,767)

Scope of manual maneuver value

INT (-32,768 ~ 32,767)

Indication

Operation: PID RUN Flag On (by loops)

RUN/STOP Stop: PID RUN Flag Off (by loops)
Normal: PID Error Flag Off (by loops)
Error Error: PID Error Flag On,
Error code occurrence (by loops)
Normal: PID Warning Flag Off (by loops)
Warning Error: PID Warning Flag On,

Warnig code occurrence (by loops)

Control operation

Control of P,PI,PD and PID, control of forward/reverse
operation

Control interval

10.0ms ~ 6,553.6ms (0.1msUnit)

Additional
functions

PWM output Supportable
Mixed forward/reverse Supportable
output

Limiting change of
present value

INT (-32,768 ~ 32,767)

Limiting change of
maneuver value

INT (-32,768 ~ 32,767)

Equally dividing set
value

0 ~ 65,536 (frequency of control cycle time)

Present value follow-
up

0 ~ 65,536 (frequency of control cycle time)

Cascade control

Supportable.

Min./max. present
value

-32,768 ~ 32,767

Differential filter

0.01 ~ 655.35 (x 100 Scaled Up)

Dead band setting 0 ~ 65,535
Prevention of dual
. : Supportable
integral accumulation
PID operation pause | Supportable

< Table 7.6 built-in PID control performance specification >
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7.2.3 PID control parameter setting

To use the built-in PID control function of XGB series, it is necessary to set PID control parameters by

loops in the parameter window and operate it though the commands. Here, it explains parameters to
use PID control functions and how to set them.

(1) PID parameter settings
Follow the steps below to set the PID control function parameters of XGB series.

(a) If selecting the built-in parameters in Parameter of the project window, it shows the built-in
parameter setting window as in below figure.

Project Wiindow

Items |

=-2F PID_SETTING *
B MewPLCEGE-=BMS-0fine

-9 Variable/Comment
=% Parameter

Basic Parameters
- 140 Parameters

EH Internal Pararneters

= PID
& 0: PIDE Loop)

&1 Scan Program
L[] MewProgram

1 - Praject

< Figure 7.7 Parameters setting window >

(b) If selecting PID Control, it shows the PID control parameter setting window as in below figure.

x|
Embedded FID[1E Loop]
Parameter LOOP 0 LOOP 1 LOar 2 LOO
Operational tMode Auta Opr Ao Opr Auto Dpr Auto

Operational Direction
Secondary Anti windup
Derivative term Cal. Method
Enable Fw/M Output
SetValue
Scan Period

Proportional Gain

Integral Time

Derivative Time
Delta P4 Limit
Delta MY Lirnit
Max. My
Min. MY
M anual MY
[eadBand Setting Y alue
Set filtering coefficient
P/ Contact
Pt Output Period
Set 5V Ramp
Set PV Tracking
Min P
Max P

K I— 2

(]9 I Cancel |

[ Figure 7.8 Built-in PID function parameters setting window ]

7-1
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(c) Input items

The items to set in the built-in PID function parameter window and the available scope
of them are summarized in below table.

Items Description Scope
RUN mode Set the operation mode of PID control. Auto/mapual
operation
RUN direction Set the operation direction of PID control. Forward/reverse
. Prevention of dugl Set whether to allow dual integral accumulation. Disabled/enabled
integral accumulation
PWM output Set whether to allow PWM output of maneuver Disabled/enabled
value.
Operation cycle time Set the operation cycle time of PID control 100 ~ 65535

cycle.

Set value

Set target control value.

-32,768 ~ 32,767

Proportional gain

Set proportional gain.

Real number

Integral time

Set integral time.

Real number

Differential time

Set differential time.

Real number

Limiting change of
present value

Set the limited change of present value per
operation cycle.

-32,768 ~ 32,767

Limiting change of
maneuver value

Set the limited change of maneuver value per
operation cycle.

-32,768 ~ 32,767

Max. maneuver value

Set the max. maneuver value for control.

-32,768 ~ 32,767

Min. maneuver value

Set the min. maneuver value for control.

-32,768 ~ 32,767

Manual maneuver

Set the manual maneuver value for control.

-32,768 ~ 32,767

value
DeadBand setting Set the deadband width of the set value. 0~ 65,535
Differential filter value | Set the filter coefficient of differential operation. 0 ~ 65,535
PWM junction Set the junction to which PWM output is out. (%Qx:(f.%;A?;o.o.M)
PWM output cycle Set the output cycle of PWM output. 100 ~ 65,535
Set value ramp Set the frequency of set value ramp. 0~ 65,535
Present value follow- | Set the follow-up frequency of the present value 0 ~ 65,535

up

follow-up function.

Min. present value

Set the min. value of the input present value.

-32,768 ~ 32,767

Max. present value

Set the max. value of input present value.

-32,768 ~ 32,767

< Table 7.7 PID function parameter setting items >
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(2) Description of Setting of PID Parameters

(a) Operation mode
It is the mode to set the operation for PID control of a loop in question.
The available scope is automatic operation or manual operation.
If automatic operation is selected, it outputs the PID control result internally operated by the
input PID control parameter as the maneuver value while if manual operation is selected, it
outputs the value input to the manual maneuver value parameter without PID operation
modified. The default is automatic operation.

(b) Operation direction
It is designed to set the operation direction for PID control of a loop in question. The available
scope is forward or reverse direction. At the moment, forward direction means increase of PV
when MV increases; reverse direction means decrease PV when MV increases. For instance, a
heater is a kind of forward direction system because PV(temperature) increases when
output(heating) increases. A refrigerator is a kind of reverse direction system in which
PV(temperature) decreases when output increases.

(c) Prevention of dual integral accumulation

It makes dual integral accumulation function enabled/disabled. To understand integral
accumulation prevention function, it is necessary to explain the phenomenon of integral
accumulation first of all. Every drive has a limit. That is, a motor is limited to the speed and a
valve can become status overcoming the complete open/close. If it happens that MV output from
a control is beyond the output limit of a drive, its output is maintained as saturated, which may
deteriorate the control performance of a system and shorten the life of a drive. Formula (7.2.3)
shows that the integral control among PID control output components accumulates errors as time
goes on, from which it may take more time to return the normal status after the actuator is
saturated in a system of which response characteristically is slow. It is so called integral
accumulation phenomenon as illustrated in Fig. 7.9, which shows that if the initial error is very
large, the error is continuously accumulated by integral control. Accordingly, a drive is saturated
within its output upper limit while the control signal is getting larger, keeping being saturated for a
long while until the drift becomes negative and the integral term turns small enough. Due to the
operation, the PV may have a large over-shoot as seen in the figure. Such a wind-up
phenomenon may occur if the initial drift is large or by a large disturbance or due to malfunction of
a device.

The PID function of XGB series is basically with the integral accumulation prevention function,
cutting off any integral accumulation phenomenon. In addition, it can detect a time when SV is
suddenly decreased, providing a more strong dual integral accumulation prevention function.

A
Drive saturation

< > PV Upper limit of drive output

T

1
Target '
value

I

l. \ 3 " * N LI
I

1

Integral accumulation phenomenon

Time
< Figure 7.9 Integral accumulation phenomenon >
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(d) PWM Output Enabled
PWM output means an output method to turn a junction on — off with a duty proportional to control
output calculated by a uniform output cycle. If PWM output is enabled, it realizes PWM output in
accordance with PWM output cycle set in the parameter of PWM output junction(P20 ~ P3F)
designated in the parameter. At the moment, the PWM output cycle follows the PWM output cycle
separately set in PID operation cycle. figure shows the relation between PID control output and
PWM output.

i.e.) if PWM output cycle: 1 second, PWM output junction: P20, max. output: 10000, min. output: 0

Time Output P40 junction operation

0 sec 5000 0.5 sec On, 0.5 sec Off

1 sec 3000 0.3 sec On, 0.7 sec Off
MV = 5000 MV = 7000

0.5sec 0.5sec §0.3sec§ 0.7sec

P20 output : : : :

(%QX0.0.0
output)

. Time

A

Output cycle = 1sec i Output cycle = 1sec

»
Ll ».

[ Figure 7.10 Relation between PWM output cycle and MV ]

(e) Set value
It sets the target of a loop in question, that is, the target status a user wishes to control. In case of
the PID control built in XGB, physical values (temperature, flow rate, pressure and etc) of an
object to control is not meaningful and instead, it should use the physical amount of an object to
control after converting them into numerals. For instance, in order to control a system using a
sensor that the output is OV when its heating device temperature is 0°C while it is 10V when the
temperature is 100°C as much as 50C, it is necessary to set SV as 2000 (as long as it uses AD
input module XBE-ADO4A).

(f) Operation cycle
It sets the cycle to yield control output by executing the built-in PID operation. The setting cycle is
0.1ms and available between 10ms ~ 6553.5ms (setting value: 100 ~ 65,535) while it is set at a
unit of integer per 0.1ms. For instance, to set PID operation per 100ms, set the operation cycle as
1000.

(g) Proportional gain
Itis intended to set the proportional coefficient of a PID loop in question (Kp). As larger Kp, the
proportional control operation is getting stronger. The scope is real number.

(h) Integral time
It sets the integral time of PID loop in question (Ti). As larger the integral time, the integral
operation is getting weaker. The scope is real number at the unit of second.
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(i) Differential time
It sets the differential time of PID loop in question (Td). As larger the differential time, the
differential operation is getting stronger. The scope is real number at the unit of second.

(j) Limiting change of present value
It sets the limit of change in present value of PID loop in question. If PV suddenly changes due to
signal components such as sensor’s malfunction, noise or disturbance during control of PID, it
may cause sudden change of PID control output. To prevent the phenomenon, a user can set the
max. limit of change in present value that is allowed per PID operation cycle. If the change of
present value is limited accordingly, it may calculate the present value as much as the limit
although the present value is changed more than the limit once the limit of change in present
value is set. If using the PV change limit function, it may prevent against sudden change of
control output owing to noise or etc. If it is, however, set too small, it may reduce the response
speed to the PV change of an actual system, not to sudden change by noise or etc, so it is
necessary to set the value appropriately according to the environment of a system to control in
order that the PV toward the set value does not take a longer time. The available scope is
between -32,768 ~ 32,767. If setting the PV change limit as 0, the function is not available.

(k) Limiting change of MV (AMV function)

It limits the max. size that control output, which is output by PID operation is changed at a time.
The output MV in this operation cycle is not changed more than the max. change limit set in the
previous operation cycle. The function has an effect to prevent a drive from operating excessively
due to sudden change of output by preventing sudden change of output resulting from
instantaneous change of set value. If it is, however, set too small, it may cause taking a longer
time until PV reaches to its target, so it is necessary to adjust it appropriately. The available
scope is between -32,768 ~ 32,767. If setting it as 0, the function does not work.

() Max. MV
It sets the max. value of control output that may be output by the result of PID operation. The
available scope is between -32,768 ~ 32,767. if it exceeds the max. output designated by PID
operation result, it outputs the set max. output and alerts the max. output excess warning. For
the types and description of warnings, refer to Error/Warning Codes.

(m) Min. MV
It sets the min. value of control output that may be output by the result of PID operation. The
available scope is between -32,768 ~ 32,767. If it is smaller than the min. output value designated
by PID operation result, it outputs the set min. MV and alerts the min. output shortage warning.
For the types and description of warnings, refer to Error/Warning Codes.

(n) Manual MV
It sets the output when the operation mode is manual. The available scope is between -32,768 ~
32,767.

(o) DeadBand setting
It sets the deadband between set value and present value. Although it may be important to
reduce normal status reply of PV for its set value even when MV fluctuates heavily, depending on
control system, it may be more important to reduce the frequent change of MV although the
normal status reply is somewhat getting larger. DeadBand may be useful in the case.
Below figure shows an example of DeadBand setting.
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A

DeadBand

v

[ Figure 7.11 Example of DeadBand setting ]

If setting deadband as in the figure, the PID control built in XGB may regard the error between PV
and set value as 0 as long as PV is within the available scope of deadband from set value.

That is, in this case, the change of MV is reduced. The available scope of setting is between 0 ~
65,535 and if it is set as 0, it does not work.

(p) Differential Filter Value Setting

It sets the coefficient of differential filter. Since differential control outputs in proportion to gradient
of error and gradient of PV change, it may suddenly change MV as it generates a large response
to instantaneous noise or disturbance. To prevent it, XGB series uses a value to which PV is
filtered mathematically for differential control. Differential filter value is the coefficient to determine
the filter degree for differential control. As smaller differential value set, as stronger differential
operation is. The available scope is between 0 ~ 65,535 and if it is set as 0, the differential filter
does not work.

(q) Setting set value ramp

Since the drift is suddenly large if SV is heavily changed during PID control, MV is also changed
heavily to correct it. Such an operation may cause excessive operation of a system to control and
a drive. To prevent it, SV ramp is used, changing SV gradually step by step when modifying SV
during operation. If using the function, SV is gradually changed by SV ramp when SV is changed
during PID control. At the moment, SV ramp setting represents the frequency of PID operation
cycle taken from when SV starts changing to when it reaches to the final SV. For instance, if SV
is to be changed from 1000 to 2000 during operation as PID operation cycle is 10ms and its SV
ramp is 500, SV may reach to 2000 after 500X10ms = 5 seconds, that is, as it increases each 2
per operation cycle and after the 500th operation scans. The available scope of setting is
between 0 ~65,535 and it is set as 0, it does not work.

/ If SV Ramp is not used

Modified SV :
./

| —

If SV Ramp is used

Existing SV / SV * operation cycle

3 . Time

[ Figure 7.12 SV Ramp function ]
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(r) PV Follow-up setting

It is intended to prevent any excessive operation of a drive resulting from sudden change of
output at the initial control and changes SV gradually from PV at the time when PID operation
starts, not directly to SV in case control just turns from stop to operation mode or it changes from
manual to automatic operation. At the moment, SV represents the frequency of PID operation
cycles taken from when control starts to when it reaches to the set SV (other operations are same
as SV ramp function). The available scope is between 0 ~ 65,535. If SV is changed again while
PV follow-up is in operation, the SV would be also changed according to SV ramp.

(s) Min./max. PV
It sets the min./max. value entered as the present value of PID control. The available scope is

between -32,768 ~ 32,767.
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7.2.4 PID flag
The parameter set by the XGB series built-in PID control function is saved into the flash memory of
the basic unit. Such parameters are moved to K area for the built-in PID function as soon as PLC
turns from STOP to RUN mode. PID control operation by PID control command is executed through K
area data for PID functions. Therefore, if a user changes the value in the trend monitor window or
variable monitor window during operation, PID operation is executed by the changed value. At the
moment, if PLC is changed to RUN again after being changed to STOP, it loads the parameters in
flash memory to K area, so the data changed in K area is lost. Thus, to keep applying the parameters
adjusted in K area, it is necessary to write the parameter set in K area to flash memory by using WRT
command. (In case of IEC, APM_WRT)

(1) PID Flag Configuration
K area flags for XGB series built-in PID control function are summarized in the below table.

Loop K area IEC type Symbol Ig/?)t: Default Description
K12000~F %KX19200~15 _PID_MAN Bit Auto | TP output designation(0:auto,
1:manual)
K12010~F %KX19216~31 _PID_PAUSE Bit RUN | PID pause (0:RUN, 1:pause)
K12020~F %KX19232~47 | _PID_REV Bit | Forward ?‘::\t/’:r's‘i'; i‘s;';iz;oxitril
K12030~F %KX19248~63 _PID_AW2D Bit | Disabled Er‘;i:::s)ir(%'::g:‘t‘)gz"a;i:‘;’i’sable 0
K12040~F %KX19264~79 _PID_REM_RUN Bit | Disabled T:'En;ir:gf operation(0:disabled,
Common |\ 1905-K1207 | %KW1205~%KW1207 | Reserved WORD - Reserved area
K12080~F %KX19328~43 _PID_PWM_EN Bit | Disabled | - WM outputenable(0:disabled,
1:enabled)
K12090~F %KX 19344~59 _PID_STD Bit - ':,'Ejr:’)pera“o” indication(0:stop,
K12100~F %KX19360~75 _PID_ALARM Bit - PID warning(0:normal, 1:warning)
K12110~F %KX19376~91 _PID_ERROR Bit - PID error(0:normal, 1:error)
K1212~K1215 | %KW1212~%KW1215 | Reserved WORD - Reserved

K1216 %KW1216 _PID00_SV INT 0 PID SV

K1217 %KW1217 _PID00_T s WORD | 100 | PID operation cycle[0.1ms]

K1218 %KD609 _PIDO0_K_p REAL 1 PID proportional constant

K1220 %KD610 _PID00_T i REAL 0 PID integral time[sec]

K1222 %KD611 _PID00_T _d REAL 0 PID differential time[sec]

Loop 0 K1224 %KW1224 _PID00_d_PV_max | WORD 0 PID PV change limit

K1225 %KW1225 _PID00_d_MV_max | WORD 0 PID MV change limit

K1226 %KW1226 _PIDO0_MV_max INT 4000 | PID MV max. value limit

K1227 %KW1227 _PIDO0_MV_min INT 0 PID MV min. value limit

K1228 %KW1228 _PID0O0_MV_man INT 0 PID manual output

K1229 %KW1229 _PID00_PV INT - PID PV

< Table 7.8 K area flags for PID control >
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Loop K area IEC type Symbol It:;it: Default Description
K1230 %KW1230 _PID00_PV_old INT - PID PV of previous cycle
K1231 %KW1231 _PID0O0_MV INT 0 PID MV
K1232 %KD616 _PID0O0_ERR DINT - PID control error
K1234 %KD617 _PIDO0_MV_p REAL 0 Z')?ng"o\;é’r:‘t’pmi"“a' value
K1236 %KD618 _PIDO0_Mv_j REAL 0 E;?npong/r']\t/ integral control
K1238 %KD619 _PIDO0_MV_d REAL 0 Cpc')?ng"o\;:ri]ftfere”tia' control
K1240 %KW1240 _PID0O0_DB_W WORD 0 PID deadband setting
K1241 %KW1241 _PID00_Td_lag WORD 0 PID differential filter coefficient
Loop 0 K1242 %KW1242 _PID0O0_PWM WORD H'20 PID PWM junction setting
K1243 %KW1243 _PID00_PWM_Prd WORD 100 | PID PWM output cycle
K1244 %KW1244 _PID00_SV_RAMP WORD 0 PID SV Ramp value
K1245 %KW1245 _PID0O0_PV_Track WORD 0 PID PV follow-up setting
K1246 %KW1246 _PID0O0_PV_MIN INT 0 PID PV min. value limit
K1247 %KW1247 _PID00_PV_MAX INT 4000 PID PV max. value limit
K1248 %KW1248 _PIDO0_ALM_CODE Word 0 PID warning code
K1249 %KW1249 _PIDO0_ERR_CODE Word 0 PID error code
K1250 %KW1250 _PID0O0_CUR_SV INT 0 PID SV of current cycle
K1251-1255 %KW1251-1255 Reserved WORD - Reserved area
Loop 1 | K1256~K1295" | %KW1256~%KW1295 | - - - PID Loop1 control parameter
Loop16 | K1816~K1855 | %KW1816~%KW1855 | - | - ‘ - | PID Loop16 control parameter

PID control.

< Table 7.8 K area flags for PID control (continued) >

K1200 ~ K1211 areas are the common bit areas of PID loops while each bit represents the status of
each PID control loop. Therefore, each 16 bits, the max number of loops of XGB PID control
represents loop status and setting respectively. K1216 ~ K1255 areas are K areas for PID control
loop 0 and save the loop 0 setting and status. It also contains parameters such as SV, operation
cycle, proportional coefficient, integral time and differential time set in the built-in parameter window
and the XGB built-in PID function executes PID control by each device value in question. In addition,
the output data such as MV calculated and output while PID control is executed is also saved into
the K areas. By changing the values in K areas, control setting may be changed any time during

1) PID control flag expression : _PID[n]_xxx

i.e.)

=> [n] : loop number
= xxx : flag function

PID10 K p : means K _p of loop 10.

By changing value of area, you can change control setting whenever you want
during the PID control

! Occupies 40 words per loop.
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2) PID flag function
Each function of K area flags for XGB series built-in PID control function is summarized as follows.

(a) Common bit area
The area is a flag collecting operation setting and information consisting of bits to each 16 loop.

Each bit of each word device represents the information of each loop. That is, ‘n’ th bit represents
the information about PID loop n.

1) _PID_MAN (PID RUN mode setting)

IEC type , ,
Flag name address address Unit Setting
_PID_MAN o )
(PID RUN mode setting) K1200n | %KX19200+n | BIT Available

t determines whether to operate the PID control of n loop automatically or manually. For more
information about RUN mode, refer to 6.2.3 PID control parameter setting. If the bit is off, it
operates automatically; if on, it runs manually.

2) _PID_PAUSE (PID Pause setting)

IEC type . .
Flag name Address address Unit Setting
_PID_PAUSE (PID pause setting) | K1201n | %KX19216 + n BIT Available

It changes PID control of n loop to pause status. If PID control is paused, the control MV is
fixed as the output at the time of pause. At the moment, PID operation is continued internally
with output fixed. If changing pause status to operation status again, it resumes control, so it
may take a longer time until the PV is going to SV once system status is largely changed during
pause. If the bit is off, it cancels pause; if on, it operates as paused.

3) _PID_REV (PID RUN direction setting)

IEC type . .
Flag name Address address Unit Setting
_PID_REV o .
(PID RUN direction setting) K1202n | %KX19232 + n BIT Available

t sets the RUN direction of PID control of ‘n’th loop. For more information about run direction,
refer to 7.2.3 PID control parameter setting. If the bit is off, it operates normally; if on, it
operates reversely.

4) _PID_AW2D (Dual Integral accumulation prevention setting)

Flag name Address IaE d%rtggse Unit Setting
_PID_AW2D
(dual integral accumulation K1203n | %KX19248 + n BIT Available
prevention setting)

t sets enable/disable of dual integral accumulation prevention of ‘n’th loop. For more
information about dual integral accumulation prevention, refer to 7.2.3 PID control parameter
setting. If the bit is off, it is enabled; if on, it is disabled.
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5) _PID_REM_RUN (PID remote operation setting)

(PID remote run setting)

IEC type . .
Flag name Address address Unit Setting
_PID_REM_RUN K1204n | %KX19264 +n BIT Available

A

GB series built-in PID function can be started by both run from command’s start junction and
remote run bit setting. That is, XGB starts PID control if PIDRUN command’s start junction is on
or remote run setting bit is on. Namely, if one of them is on, it executed PID control.

6) _PID_PWM_EN (PWM output enable)

Flag name

Address

IEC type
address

Unit

Setting

_PID_PWM_EN
(PWM output enable)

K1208n

%KX19328 + n

BIT

Available

t determines whether to output the MV of PID control of ‘n’th loop as PWM output. For more
information about PWM output, refer to 7.2.3 PID control parameter setting. If the bit is off, it is

disabled; if on, it is enabled.

7) _PID_STD (PID RUN status indication)

IEC type . .
Flag name Address address Unit Setting
_PID_STD o .
(PID RUN status indication) K1209n | %KX19344 +n | BIT Unavailable

t indicates the PID control RUN status of ‘n’ th loop. If a loop is running or paused, it is on while
if it stops or has an error during RUN, it is off. In the area as monitoring area, it is changed to

the current run status by PLC although a user enters any value temporarily.

8) _PID_ALARM (PID Warning occurrence)

(PID Warning occurrence)

IEC type . .
Flag name Address address Unit Setting
_PID_ALARM K1210n | %KX19360 + n BIT Unavailable

t indicates warning if any warning occurs during PID control of ‘n’th loop. Once a warning

occurs during PID control operation of a loop, it is on while if it is normal, it is off. At the moment,
despite of warning, PID control continues without interruption, but it is desirable to check
warning information and take a proper measure. Once a warning occurs, the warning code is
also indicated in warning code area of a loop. For more information about the types of warning
codes and measures, refer to 7.5. In the area as monitoring area, it is changed to the current
run status by PLC although a user enters any value temporarily.

9) _PID_ERROR (PID Error occurrence)

(PID error occurrence)

IEC type . .
Flag name Address address Unit Setting
_PID_ERROR K1211n | %KX19376 + n BIT Unavailable

f an error that discontinues running during PID control of ‘n’ th loop occurs, it indicates the
error’s occurrence. If an error generates warning, it is on; if normal, it is off. When an error
occurs, PID control stops and MV is output as the min. output set in parameter. Also, if an error
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occurs, the error code is indicated in the error code area of a loop. For more information about
type of error codes and measures, refer to 7.5. In the area as monitoring area, it is changed to
the current run status by PLC although a user enters any value temporarily.

(b) PID Flag area by loops
PID flag areas by loops are allocated between K1216 ~ K1855 and for totally 16 loops, each 40
words is allocated per loop. Therefore, the individual data areas of ‘n’ th loop are between K
(1216+16*n) ~ K (1255+16*n). Every setting of the PID flag areas by loops may be changed
during PID control operation. Once the settings are changed, they are applied from the next PID
control cycle.

1) _PIDxx_SV (PID xx Loop SV setting)

Flag name Address IEC type address Unit Scope

_PIDxx_SV

*. 0, * - ~
(PID xx Loop SV setting) K1216+16*xx | %KW1216+16*xx INT 32,768 ~ 32,767

It sets/indicates the SV of PID control of ‘xx’ th loop. For more information about SV, refer to
7.2.3 PID control parameter setting. The available scope is between -32,768 ~ 32,767.

2) _PIDxx_T_s (PID xx Loop operation cycle)

Flag name Address IEC type address Unit Scope

_PIDxx_T_s
(PID xx Loop operation cycle)

K1217+16*xx | %KW1217+16*xx | WORD 100 ~ 65,535

It sets/indicates the operation cycle of PID control of ‘xx’ th loop. For more information about
operation cycle, refer to 7.2.3 PID control parameter setting. The available scope is between
100 ~ 65,535.

3) _PIDxx_K_p (PID xx Loop proportional constant)

Flag name Address IEC type address Unit Scope
_PIDxx K p K1218+16"xx | %KD609+20*xx | REAL |  Real number
(PID xx Loop proportional constant)

It sets/indicates the proportional constant of PID control of ‘xx’ th loop. For more information
about proportional constant, refer to 7.2.3 PID Control Parameter Setting. The available scope
is real number (-3.40282347e+38 ~ -1.17549435e-38 , 0, 1.17549435e-38 ~ 3.40282347e+38).
If it is, however, set as 0 and lower, the PID control of a loop generates an error and does not
work.

4) _PIDxx_T_i (PID xx Loop Integral time)

Flag name Address IEC type address | Unit Scope
PIDCT K1220+16*xx | %KD610+ 20+xx | REAL |  Real number
(PID xx Loop integral time)

It sets/indicates integral time of PID control of ‘xx’ th loop. The available scope is real number. If
it is set as 0 and lower, it does not execute integral control.
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5) _PIDxx_T_d (PID xx Loop differential time)

Flag name Address IEC type address Unit Scope
_PIDxx_T_d * 0 *
(PID xx Loop differential time) K1222+16*xx | %KD611+20*xx | REAL Real number

It sets/indicates differential time of PID control of ‘xx’ th loop. The available scope is real
number. If it is set as 0 and lower, it does not execute differential control.

6) _PIDxx_d_PV_max (PV change limit)

Flag name Address IEC type address Unit Scope

_PIDxx_d_PV_max

- K1224+16*xx | %KD612+20*xx | WORD 0 ~ 65,535
(PV change limit)

It sets the PV change limit of “xx’ th loop.
For more information about PV change limit, refer to 7.2.3 PID control parameter setting. If it is
set as 0, the PV change limit function does not work.

7) _PIDxx_d_MV_max (MV change limit)

Flag name Address IEC type address Unit Scope

_PIDxx_d_MV_max

* 0, * -
(MV change limit) K1225+16*xx | %KD610+20*xx | WORD 0~ 65,535

It sets the MV change limit of ‘xx’th loop. For more information about MV change limit, refer to
7.2.3 PID control parameter setting. If it is set as 0, the MV change limit function does not work.

8) PIDxx_MV_max, PIDxx_MV_min, PIDxx_MV_man (max. MV, min. MV, manual MV)

Flag name Address IEC type address Unit Scope
_PIDxx_MV_max (max. MV) K1226+16*xx | %KW1226+16*xx
_PIDxx_MV_min (min. MV) K1227+16*xx | %KW K1227+16*xx INT -32,768 ~ 32,767
_PIDxx_MV_man (manual MV) K1228+16*xx | %KW K1228+16*xx

It sets the max. MV, min. MV and manual MV of ‘xx’ th loop. For more information about max.
MV, min. MV and manual MV, refer to 7.2.3 PID control parameter setting. If the max. MV is set
lower than the min. MV, the PID control loop generates an error and does not work.

9) PIDxx_PV (prevent value)

Flag name Address IEC type address Unit Scope

_PIDxx_PV
(present value)

K1229+16*xx | %KW1229+16*xx INT -32,768 ~ 32,767

It is the area that receives the present value of ‘xx’ th PID control loop. PV is the present status
of the system to control and is normally saved into U device via input devices such as A/D input
module if it is entered from a sensor. The value is used to execute PID operation by moving to
_PIDxx_PV by means of commands like MOV.

10) _PIDxx_PV_OLD (PV of previous control cycle)

Flag name Address IEC type address Unit Scope
_PIDxx_PV_OLD K1230+16%xx | %KW1230+16*xx | INT Unavailable
(PV of previous control cycle)

The area indicates the PV just before the xx th PID control loop. The flag, as a dedicated
monitoring flag, would be updated by PLC although a user directly enters it.
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11) _PIDxx_MV (Control MV)

Flag name Address IEC type address Unit Scope

_PIDxx_MV (control MV) K1231+16"xx | %KW1231+16"xx INT Unavailable

The area shows the MV of ‘xx’ th PID control loop. As the area in which XGB built-in PID
operation result is output every PID control cycle, it delivers the value in the area to U device

every scanning by using commands like MOV in the program and outputs to D/A output module,
operating a drive.

12) _PIDO0_ERR (Present error)

Flag name Address IEC type address Unit Scope

_PID00_ERR
—+ (present error)

K1232+16*xx | %KW1232+16*xx | DINT Unavailable

he areas shows the current error of ‘xx’ th PID control loop. It is also used as an indicator about
how much gap the present status has with a desired status and if an error is 0, it means the
control system reaches a desired status exactly. Therefore, if control starts, error is quickly
reduced at transient state and it reaches normal state, maintaining remaining drift as 0, it could

be an ideal control system. The flag, as a dedicated monitoring, is updated although a user
directly enters it.

13) _PIDxx_MV_p, PIDxx_MV_i, PIDxx_MV_d (P/I/D control components of MV)

Flag name Address IEC type address Unit Scope
_PIDxx_MV_p N o "
(MV proportional control component) K1234+16%x | %KD616+20xx
_ _PIDxx_MV_i K1236+16"xx | %KD617+20*xx | REAL Unavailable
(MV integral control component)
_PIDxx_MV_d

K1238+16"xx | %KD618+20*xx

(MV differential control component)

It indicates ‘n’ th loop MV by classifying proportional control MV, integral control max. MV and
differential control MV. The entire MV consists of the sum of these three components. The flag,
as a dedicated monitoring, is updated although a user directly enters it.

14) _PIDxx_DB_W (DeadBand setting)

Flag name Address IEC type address Unit Scope
_PIDxx_DB_W K1240+16*xx | %KW1232+16*xx | WORD 0 ~ 65,535
(DeadBand setting)

It sets the deadband of ‘xx’ th loop. For more information about Deadband function, refer to
7.2.3 PID control parameter setting. If it is set as 0, the function does not work.

15) _PIDxx_Td_lag (Differential filter coefficient)

Flag name Address IEC type address Unit Scope
_PIDxx_Td_lag N o . 5
(differential filter coefficient) K1241+16*xx | %KW1241+16*xx | WORD 0~ 65,535

It sets the differential filter coefficient of ‘xx’ th loop. For more information about differential filter
coefficient, refer to 7.2.3 PID control parameter setting. If it is set as 0, the function does not
work.
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16) _PIDxx_PWM (PWM output junction setting)

Flag name Address IEC type address Unit Scope
_PID0O0_PWM N 0 * 90 ~ H’
(PWM output junction setting) K1242+16*xx | %KW1242+16*xx | WORD H'20 ~ H'3F

It sets the junction to which PWM output of ‘xx’ th loop is output. PWM output junction is valid
only between H'20 ~ H'3F. If any other value is entered, PWM output does not work.

17) _PIDxx_PWM_Prd (PWM Output cycle setting)

Flag name Address IEC type address Unit Scope
_PIDxx_PWM_Prd N 0 N -
(PWM output cycle setting) K1243+16*xx | %KW1243+16*xx | WORD 100 ~ 65,535

It sets the PWM output cycle of ‘xx’ th loop. The available scope is between 100 ~ 65,535 at the

unit of 0.1ms.

18) _PIDxx_SV_RAMP (SV ramp setting)

Flag name Address IEC type address Unit Scope
_PIDxx_SV_RAMP K1244+16"xx | %KW1244+16*xx | WORD 0 ~ 65,535
(SV ramp setting)

It sets the SV ramp value of ‘xx’ th loop. For more information about SV ramp of PV, refer to

7.2.3 PID control parameter setting. If it is set as 0, the function does not work.

19) _PIDxx_PV_Track (PV follow-up setting)

Flag name Address IEC type address Unit Scope
_PIDxx_PV_Track K1245+16*xx | %KW1245+16*xx | WORD 0~ 65,535
(PV follow-up setting)

It sets the PV follow-up SV of ‘xx’ th loop. For more information about PV follow-up, refer to

7.2.3 PID control parameter setting. If it is set as 0, the function does not work.

20) _PIDxx_PV_MIN, _PIDxx_PV_MAX(Min. PV input, Max. PV input)

Flag name Address IEC type address | Unit Scope
(MV proporﬁsgrzathi_liomponent) K1246+16%x | %KW1246+16%xx
PIDoC MY | INT | -32,768 ~ 32,767
XXV K1247+16*xx | %KW1247+16*xx
(MV integral control component)
It sets the min./max. PV of ‘xx’ th loop.
21) _PIDxx_ALM_CODE (Warning code)
Flag name Address IEC type address Unit Scope
_PIDxx_ALM_CODE K1248+16*xx | %KW1248+16%x | WORD Unavailable
(Warning code)

It indicates warning code if a warning occurs during ‘xx’ th loop run. The flag, as a dedicated
monitoring, is updated although a user directly enters it. For more information about warning

code, refer to 7.5.
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22) PIDxx_ERR_CODE (Error code)

Flag name

Address

IEC type address

Unit

Scope

_PIDxx_ERR_CODE
(error code)

K1249+16*xx

%KW1249+16*xx

WORD

Unavailable

It indicates error code if an error occurs during ‘xx’ th loop run. The flag, as a dedicated
monitoring, is updated although a user directly enters it. For more information about warning

code, refer to 7.5.

23) _PIDxx_CUR_SV (SV of the present cycle)

Flag name

Address

IEC type address

Unit

Scope

_PIDxx_CUR_S8SV
(SV of the present cycle)

K1250+16*xx

%KW1250+16*xx

INT

Unavailable

It indicates SV currently running of ‘xx’ th loop. If SV is changing due to SV ramp or PV follow-
up function, it shows the currently changing PV. The flag, as a dedicated monitoring, is updated
although a user directly enters it.
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7.3 PID Instructions

It describes PID control commands used in XGB series. The command type of PID control used in
XGB series built-in PID control is 4.

(1) PIDRUN
PIDRUN is used to execute PID control by loops.

Start Signa [ PIDRN s |

- Operand S means the loop no. to execute PID control and avaiable only for constant(0~15).
- If start signal is on, the PID control of a loop starts.

- In case of IEC type, PID control is conducted by PIDRUN function block.

- In case of XGB IEC type, inputs ‘0’ at BLOCK

TRET
Start PTORON
| —— RED  DOWE}
0 JBoc PID_L Pio_sTAT
i K STAT
s JLooe

- PID_STAT, only supported on IEC type, indicates status of PID operation. For meaning of
inidcation data, refer to indication contents of PID STATE.
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Indication contents of PID STATE

Item Indicatio Flag name Contents
n
1640001 PV_MIN_MAX_ALM \C/I:lzrsnt value exceeds range of maximum, minimum
16#0002 “PAID—SCANTIME—AL Operation cycle is too short.
1640003 PID dPV WARN Variation of currgnt' val_ue_ of this PID cycle exceeds the
- - current value variation limit.
ALARM Variati f ipulated val f this PID I d
1640004 PID dMV WARN ariation of manipulated value of this cycle exceeds
— - the manipulated value variation limit.
PID_MV_MAX_WAR | Manipulated value of this PID cycle exceeds maximum
16#0005 ;
N manipulated value.
1640006 PID MV MIN WARN Mgmpulated Yalue of this PID cycle is smaller than
- == minimum manipulated value.
1640100 MV MIN MAX ERR Mg)_(lmum mampulated value is set to be smaller than
- - — minimum manipulated value.
1640200 PV MIN MAX ERR Max[mum current value is set to be smaller than current
- - — manipulated value.
16#0300 PWM_PERIOD_ERR | PWM output cycle is set to be smaller than 100(10ms).
In case of forward operation, set value at start of auto-
1640400 SV_RANGE_ERR tun|ng_|s smaller than current value. In_ case of reverse
operation, set value at start of auto-tuning is larger than
current value.
16£0500 PWM_ADDRESS E | PWM output is set as contact point other
RR than %QX0.0.0~0.0.31.
ERROR 16#0600 P _GAIN SET ERR Proportional constant is set to be smaller than 0.
16#0700 | TIME SET ERR Integral constant is set to be smaller than 0
16#0800 D TIME SET ERR Differential constant is set to be smaller than 0
1640900 ggNTROL—MODE—E Control mode is other than P, P1, PD and PID.
16#0B00 PID_PERIOD ERR; PIC operation cycle is set to be smaller than 100(10ms)
In combined operation, directional parameter of forward
164#0C00 HBD WRONG DIR operation loop is set as reverse operghon or directional
- - parameter of reverse operation loop is set as forward
operation
16#0D00 (I—:IED_SV_NOT_MAT In combined operation, set values of two loops are different
16#0E00 LOOP_EXCEED PID LOOP number is larger 15
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(2) PIDCAS
PIDCAS is a command to execute CASCADE control.

Start Signal | PIDCAS M s L

- Operand M and S mean master loop and slave loop respecively and available only for
constant(0~15).

- If start junction is on, cascade control is executed through master loop and slave loop.

- In case of IEC type, PIDCAS function block is used for cascade control.

(M1

Start PIOCAS
| —{FEQ DOME}

0 {BLOC MST_b MST_STAT

] K STAT

M {LOOP  SLY_F SLY_STAT
] _M3T  STAT

3 {LO0p
-] _aLY

Cascade control is called a control method which is intended to increase control stability through
quick removal of disturbance by connecting two PID control loops in series and is structured as

follows.
hot water hot waterl | -,
outlet
Ut | | sV (5]
= i) PV
pIEY
) kaster Loop
Fonls) Master Loop| |0t yyater Tl 5)
hot water Controller inlet L
inlet —
] e ]
Slave Loop
by Caels) Contraoller
X R
distiller, Steam Yalve distiller, Steam Valve

[Figure 7.13 Comparison of single loop control and cascade control]

Looking at the figure, it is found that cascade control contains slave loop control within external
control loop. That is, the control output of external loop PID control is entered as SV of the
internal loop control. Therefore, if steam valve suffers from disturbance in the figure, single loop
PID control may not be modified until PV, y(s) appears while cascade control is structured to
remove any disturbance by the internal PID loop control before any disturbance that occurs in
its internal loop affects the PV, y(s), so it can early remove the influence from disturbance.

XGB internal PID control connects two PID control loops each other, making cascade control
possible. At the moment, MV of external loop is automatically entered as the SV of internal loop,
so it is not necessary to enter it through program.
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(3) PIDHBD
PIDHBD is a command to execute the mixed forward/reverse E control.

Start signal
| | PioeD F R

- Operand F and R represent forward operation loop and reverse operation loop and available
only for constant(0~15).

- If start junction is on, it starts the mixed forward/reverse operation from the designated
forward/reverse loops.

- In case of IEC type, combined operation is executed by using PIDHBD function block

e
Start PIDHED
| ——RED OONE|
0 feLoc Fwo_l Fwp_sTaT
| K STAT
Foo foor mev L mev_sTaT
| R0 STAT
R Lo
| _REY

The mixed forward/reverse control is called a control method to control forward operation control
output and reverse operation control operation alternatively to a single control process. The XGB
built-in PID control enables the mixed forward/reverse control by connecting two PID control loops
set as forward/reverse operations. At the moment, it uses PIDHBD command. For more information
about the command, refer to 7.2.5. The mixed forward/reverse run is executed as follows in the
XGB built-in PID control.

(a) Commencement of mixed run
If PIDHBC command starts first, it starts reverse run when PV is higher than SV; it starts
forward run if PV is lower than SV.

(b) Conversion of RUN direction
The conversion of run direction is executed according to the following principles. In case of
forward operation run, it keeps running by converting to reverse operation once PV is over SV
+ DeadBand value. At the moment, the DeadBand setting value uses the deadband of a loop
set for forward operation. If PV is below SV — DeadBand value during reverse operation, it also
keeps running by converting to forward operation. In the case, the DeadBand setting uses the
deadband of a loop set for reverse loop. It may be illustrated as 7.14.
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F
100%:
Pl
E q Dead
T Band
an Heverse
l:l .
| L
=N

[Figure 7.14 Conversion of RUN direction in the mixed forward/reverse control]

(c) Atthe moment, every control parameter uses the parameter of a loop set for forward operation
while MV is output to MV output area of a loop of forward operation. Reversely, every control
parameter uses the parameter of a loop set for reverse operation during reverse operation run
while MV is also output to MV output area of reverse operation loop.

(d) WRT
WRT is a command to save K area flags changed during operation to the internal flash memory of
PLC.

MF"JDID | W 0 0 0

- Once start juction is on, it writes K area values to flash memory.
- Each operand description is summarized as follows.

Operand desli’::;ergte d Available device Remark
OP1 Slot Constant Designating basic uit as 0
OP2 N/A PMLKD.ZR, Not used
constant
0 : positioning X axis
1 : positioning Y axis
OP3 Parameter type | P,M,L,K,D,Z,R,constant | 2 : HS counter
3 : PID parameter
4 : PID auto-tuning parameter
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- In case of IEC type, APM_WRT funcion block is used.
[N5T3

Start APML_IRT
|| RED  DOME}

0 {BASE  STATL
SLO0T 45007

Notlsed {4X13

ParameterT

YRR+
- h

==
—_33
[}
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7.4 PID Auto-tuning

7.4.1 Basic theory of PID auto-tuning
It describes the function of PID auto-tuning.

The performance of PID controller is very different according to P, I, D coefficient. Generally, It is very
difficult and takes long time to predict the system and set P, |, D coefficient because of non-periodical
disturbance, interference of other control loop, dynamic characteristic of control system though the
engineer is good at handling the PID controller. So auto-tuning that sets the PID coefficient
automatically is very useful. Generally, there are many methods in setting the PID coefficient. Here, it
will describe Relay Auto-tuning.
(1) PID coefficient setting by Relay auto-tuning

It makes critical oscillation by force and uses the width and period of oscillation to specify the PID

coefficient. It applies max. output and min. output to control system for auto-tuning. Then,

oscillation with steady period and steady width occurs around the Set value like figure 6.15, and it

can calculate the boundary gain by using it like expression (7.3.1).

Max. output
M FPerod
//_H-\\ ................ E— —
Set value = ! T —
Widtl
Min. output -
< Figure 7.15 Relay auto-tuning >
K, = 4 x (Max.output — Min.output) (7.3.1)

7 x width

At this time, oscillation period is called boundary period. If boundary gain and period is specified,
use table 7.9, Ziegler & Nichols tuning table to specify the PID coefficient. This Relay tuning is
relatively simple to configure and easy to know the boundary gain and period so it is used
frequently and XGB built-in PID auto-tuning uses this method.

Controller Proportional gain Integral time(Ti) Dinerentia|
(Kp) time(Td)
P 0.5K, - i
Pl 0.45K, P, /1.2 -
PID 0.6K, P /2 P, /8

< Table 7.9 Ziegler & Nichols tuning table >
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7.4.2 PID Auto-Tuning function specifications
The specifications of the XGB series built-in PID auto-tuning function are summarized as in Table.

Iltem Specifications
Scope of SV INT (-32,768 ~ 32,767)
Scope of PV INT (-32,768 ~ 32,767)
Scope of MV INT (-32,768 ~ 32,767)

Normal: error flag off

Error indication
Error: error flag off, error code occurs

AT direction setting Forward/reverse
Control cycle 100 ~ 65,536 (0.1msUnit)
Additional PWM output Supportable
function Hysterisis Supportable

[Table 7.10 Spec. of built-in PID auto-tuning function]

7.4.3 Auto-tuning parameter setting

To use the XGB series auto-tuning function, it is necessary to start it by using a command after
setting auto-tuning parameters by loops in the parameter window. It explains the parameters to
use auto-tuning function and how to set them.

(1) Auto-tuning parameter setting
To set the parameters of XGB series auto-tuning function, follow the steps.

(a) If selecting parameter in project window and the built-in parameter, it shows the built-in
parameter setting window as seen in below figure.

Project wiindow - x .

[terms
=& PID_SETTING *

E@ MewPLC[GE - =BM5]-Offline
(. %3 Y ariable/Comment

EI@ Parameter

----- Basic Parameters

T 140 Parameters

EH Internal Parameters
i8] High Speed Counter

----- E Position

=& PID

~[E 0:PID[16 Loop)]

B Project

< Figure 7.16 Built-in parameter setting window >
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(b) If selecting auto-tuning, it shows the parameter setting window as seen in figure 7.17.

x|
Embedded PID Auta Tuning(16 Loop)

Parameter LOOF 0 LOopP 1 Loop 2 Loa
Operational Direction Forward i Fonward i Farnward ] Fana
Enable P Output Disable Dizable ; Dizable : Dise

Scan Period 100 100 100 : 10

ban, b 4000 4000 : 4000 : 400

P/ Contact P20 P20 i P20 : Pz

PWM OupuPeiod | 100 w0 e
HyoreBard | o

KN i

] i Cancel |

<Figure 7.17 Built-in auto-tuning function parameter setting window>

(c) Input items
Table shows the items to set in auto-tuning parameter window and the available scopes.

Iltems Description Scope
RUN direction Set the run direction of auto-tuning. Forward/reverse
PWM output enable Sr?;bl\;vg/ztizggleﬁ set PWM output of MV Disable/enable
S\ Set SV. -32,768 ~ 32,767
Operation time Set auto-tuning operation time. 100 ~ 65535
Max. MV Set the max. MV in control. -32,768 ~ 32,767
Min. mV Set the min. MV in control. -32,768 ~ 32,767
PWM junction Designate the junction to which PWM output is
designation output. P20 ~ P3F
PWM output cycle Set the output cycle of PWM output. 100 ~ 65,535
Hysterisis setting Set the hysteris of auto-tuning MV. 0~ 65,535

< Table 7.11 Auto-tuning function parameter setting items>
(2) Description of auto-tuning parameters and how to set them

(a) RUN direction
RUN direction is to set the direction of auto-tuning run of a loop. The available option is forward
or reverse. The former (forward) means that PV increase when MV increases while the latter
(reverse) means PV decreases when MV increases. For instance, a heater is a kind of forward
direction system because PV (temperature) increases when output (heating) increases. A
refrigerator is a kind of reverse direction system in which PV (temperature) decreases when
output increases.

(b) PWM output enable
PWM output means an output method to turn a junction on — off with a duty proportional to control
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output calculated by a uniform output cycle. If PWM output is enabled, it realizes PWM output in
accordance with PWM output cycle set in the parameter of PWM output junction (P20 ~ P3F, in
case of IEC type, %QX0.0.0~%QX0.0.15) designated in the parameter. At the moment, the PWM
output cycle follows the PWM output cycle separately set in auto-tuning operation cycle.

(c) SV
It sets the auto-tuning SV of a loop in question. Similar to PID control, physical values
(temperature, flow rate, pressure and etc) of an object to control is not meaningful and instead, it
should use the physical amount of an object to control after converting them into numerals. For
instance, in order to control a system using a sensor that the output is OV when its heating device
temperature is 0'C while it is 10V when the temperature is 100 °C as much as 50T, it is
necessary to set SV as 2000(as long as it uses AD input module XBE-ADO4A).

(d) Operation time
It sets the cycle to execute operation for auto-tuning. The setting cycle is 0.1ms and available
between 10ms ~ 6553.5ms (setting value: 100 ~ 65,535) while it is set at a unit of integer per
0.1ms.

(e) Max./min. MV
It sets the max./min. value of output for auto-tuning. The available scope is between -32,768 ~
32,767. If the max. MV is set lower than min. MV, the auto-tuning function of a loop generates an
error and does not work.

(f) Hysterisis setting

Looking at relay tuning in figure 7.15, it shows it outputs the max. MV as auto-tuning starts but it
converts to min. output as PV is over SV and then, it converts to the max. output as PV is lower
than SV. However, if input PV contains noise components or reply components, auto-tuning
ends by a slight vibration of PV around SV, yielding incorrect tuning result. To prevent it,
hysterisis may be set. XGB auto-tuning converts output at SV + Hysterisis when PV increases or
at SV — Hysterisis when it decreases once hysterisis is set. With it, it may prevent incorrect
tuning by a slight vibration around SV.

A

SV

Hysteresis

SV+Hysteresis

SV- Hysteresis

v

[Figure 7.16 Example of Hysterisis setting ]
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7.4.4 Auto-tuning flag

The parameters set in the XGB series auto-tuning function are saved to the flash memory of basic unit.
Such parameters are moved to K area for auto-tuning function as soon as PLC enters to RUN mode
from STOP. Auto-tuning operation using auto-tuning command is achieved by data in K area. At the
moment, if PLC is changed to RUN again after being changed to STOP, it takes the parameters in
flash memory to K area, so the data changed in K area is lost. Therefore, to continuously apply the
parameters adjusted in K area, it is necessary to write the parameters set in K area into flash memory
by using WRT command. (In case of IEC type, APM_WRT function block)

(1) Auto-tuning flag configuration
The K area flags of XGB series auto-tuning function are summarized in Table 7.12.

Loops K area IEC type Symbol Data type | Default Description
%KX29696 . Auto-tuning  direction(0:forward,
K18560~F ~KX29711 _AT_REV Bit Forward T-reverse)
s 1
K18570~F /(?KX29712 _AT_PWM_EN Bit Disable PWM output enable(0:disable,
Common ~%KX29727 1:enable)
%KX29728 . Auto-tuning
K18580~F ~%KX29743 AT_ERROR Bit j error(0:normal, 1:error)
K1859 %KW1859 Reserved WORD - Reserved area
K1860 %KW1860 AT00 SV INT 0 AT SV —loop 00
AT operation cycle
K1861 %KW1861 WORD 100
ATO0 T s (T_s)[0.1msec]
K1862 %KW1862 | AT00 MV_max INT 4000 | AT MV max. value limit
K1863 %KW1863 AT00_MV_min INT 0 AT MV min. value limit
K1864 %KW1864 _AT00_PWM WORD 0 AT PWM junction setting
K1865 %KW1865 _AT00_PWM_Prd WORD 0 AT PWM output cycle
K1866 %KW 1866 _AT00_HYS_val WORD 0 AT hysterisis setting
Loop0 K1867 %KW1867 | AT00 STATUS WORD 0 AT auto-tuning status indication
K1868 %KW1868 _AT00_ERR_CODE | WORD 0 AT error code
K1869 %KD _AT00 K p REAL 0 AT result proportional coefficient
K1871 _ATO0 T i REAL 0 AT result integral time
K1873 ~AT00 T d REAL 0 AT result differential time
K1875 AT00 PV INT 0 AT PV
K1876 AT00 MV INT 0 AT MV
%KW1877
K1877~1879 Reserved Word 0 Reserved area
~%KW1879

[Table 7.12 K area flags for auto-tuning]
K1856 ~ K1859 areas (In case of IEC type, %KW1856~%KW1859) are the common bit areas for
auto-tuning and each bit represents auto-tuning loop status respectively. K1860~K1879 areas save
the setting and status of loop 0 as the K area for auto-tuning loop 0. In the area, the parameters
such as PV, operation cycle and etc set in the built-in parameter window are saved and the XGB
built-in auto-tuning function executes auto-tuning by the device values and saves the results into the
K areas.
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(2) Auto-tuning flag function
Each function of K area flags for XGB series auto-tuning is summarized as follows.

A) Common bit area
The area is a flag collecting operation setting and information consisting of bits to each 16 loop.
Each bit of each word device represents the information of each loop.

1) _AT_REV (auto-tuning run direction setting)

Flag name Address | IEC type address | Unit Setting
_AT_REV 0 .
(PID RUN direction setting) K1856n %KX29696 + n BIT Available

It determines the run direction of auto-tuning of ‘n’ th loop. If the bit is off, it is forward operation;
if on, it is reverse operation.

2) _AT_PWM_EN (PWM output enable)

Flag name Address | IEC type address Unit Setting
(PVV/:\/ITEEt\gJI\tAEE:bIe) K857n %KX29713 + n BIT Available

It sets whether to output the auto-tuning MV of ‘n’ th loop as PWM output. If the bit is off, it is
disabled; if on, it is enabled.

3) _AT_ERROR (Auto-tuning error occurrence)

Flag name Address | |IEC type address | Unit Setting
(PlD_grlgFESclﬁ?rSnce) K1858n | %KX29728+n | BIT |  Unavailable

It indicates the error in case an error that discontinues operation during auto-tuning of ‘n’th loop
occurs. If an error occurs, it is on; if normal, it is off. Once an error occurs, auto-tuning stops
and the MV is output as the min. output set in the parameter. Also, if an error occurs, it
indicates the error code in the error code area of a loop. For more information about error code
types and measures, refer to 7.5. The area, as a dedicated monitor area, is updated although a
user directly enters it.

B) Auto-tuning flag area by loops
The auto-tuning flag areas by loops are K1860 ~ K2179 and each 20 words per loop are
allocated to totally 16 loops. Therefore, individual data area of ‘n’ th loop is between K
(1860+16*n) ~ K (1879+16*n).

1) _ATxx_SV (auto-tuning xx Loop SV setting)

Flag name Address IEC type address Unit Scope

_ATxx_SV

* 0, * - ~
(AT xx Loop SV setting) K1860+16*xx | %KW1860+16*xx INT 32,768 ~ 32,767

It sets/indicates the auto-tuning SV of ‘xx’th loop.
The available scope is between -32,768 ~ 32,767.
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2) _ATxx_T_s (Auto-tuning xx Loop operation cycle)

Flag name Address IEC type address Unit Scope

_PIDxx_T_s

. . K1861+16*xx | %KW1861+16*xx | WORD 100 ~ 65,535
(Auto-tuning xx Loop operation cycle)

It sets/indicates the operation cycle of ‘xx’ th loop auto-tuning. The available scope is 100 ~
65,535.

3) _ATxx_MV_max, _ATxx_MV_min(max. MV, min. MV)

Flag name Address IEC type address Unit Scope
_PIDxx_MV_max (Max. MV) K1862+16*xx | %KW1862+16*xx
INT -32,768 ~ 32,767
_PIDxx_MV_min (Min. MV) K1863+16*xx | %KW1863+16*xx

It sets max. MV and min. MV of ‘xx’ th loop respectively. If the max. MV is set lower than min.
MV, the auto-tuning loop generates an error and does not work.

4) _ATxx_PWM (AT output junction setting)

Flag name Address IEC type address Unit Scope

~ATO0_PWM

* 0, * ’ ~ ’
(AT output junction setting) K1864+16*xx | %KW1864+16*xx | WORD H'20 ~ H’3F

It sets the junction that PWM output of ‘xx’th loop is output. The PWM output junction is valid
only between H'20 ~ H’3F (hex). If any other value is entered, PWM output does not work.

5) _ATxx_PWM_Prd (PWM output cycle setting)

Flag name Address IEC type address Unit Scope

_ATxx_PWM_Prd

*. ) * ~
(PWM output cycle setting) K1865+16*xx | %KW1865+16*xx | WORD 100 ~ 65,535

It sets the PWM output cycle of ‘xx’ th loop. The available scope is between 100 ~ 65,535 at the
unit of 0.1ms.

6) _ATxx_HYS_val (Hysterisis setting)

Flag name Address IEC type address Unit Scope

_ATxx_HYS_val (Hysterisis setting) | K1866+16*xx | %KW1866+16*xx | WORD 0~ 65,535

It sets the hysterisis of xx’ th loop. For more information about hysterisis function, refer to 6.3.3
Auto-Tuning Parameter Setting. If it is set as 0, it does not work.

7) _ATxx_STATUS (Auto-tuning status)

Flag name Address IEC type address Unit Scope

_ATxx_STATUS

) K1867+16*xx | %KW1867+16*xx | WORD Unavailable
(Auto-tuning status)

It indicates the auto-tuning status of ‘xx’ th loop. If auto-tuning is in operation, it is 1; if
completed, it is 128. In any other cases, it shows 0.
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8) _ATxx_ERR_CODE (Error code)

Flag name Address IEC type address Unit Scope
ATXx_ERR_CODE K1868+16"xx | %KW1868+16*xx | WORD |  Unavailable
(Error code)

It indicates error code in case an error occurs during the auto-tuning of ‘xx’th loop. The flag, as
a dedicated monitor, is updated although a user directly enters it. For more information about

error code, refer to 7.5.

9) _ATxx K p, ATxx_T_i, ATxx_T_d (AT result proportional coefficient, integral time, differential
time)

Flag name Address IEC type address Unit Scope

(propoﬁﬂ]";‘l—c’gﬁﬁciem) K1869+16%xx | %KD934+20*xx

AT T K1871+16*xx | %KD1004+20*xx
(integral time)

Real Unavailable

_ATxx_T_d K1873+16*xx | %K1005+20%xx
(differential time)

The area indicates proportional coefficient, integral time and differential time calculated after
the auto-tuning of ‘xx’ th loop is normally completed. The flag, as a dedicated monitoring,
updated although a user directly enters it.

10) _ATxx_PV (PV)

Flag name Address IEC type address Unit Scope

_ATxx_PV (PV) K1875+16*xx | %KW1875+16*xx INT -32,768 ~ 32,767

It is the area to receive PV of ‘xx’ th auto-tuning loop. PV is the present status of a system to
control and in case of PID control, the entry from a sensor is saved into U device through input
devices such as A/D input module and it moves the value to _ATxx_PV by using commands
such as MOV every scanning, executing auto-tuning.

11) _ATxx_MV (Auto-tuning MV)

Flag name Address IEC type address Unit Scope

_ATxx_MV (auto-tuning MV) K1876+16"xx | %KW1876+16*xx INT Unavailable

It is the area to output MV of ‘xx’ th auto-tuning loop. Every auto-tuning cycle, it saves XGB
auto-tuning and it delivers the value in the area by using commands like MOV in a program and

operates a drive every scanning.
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7.4.5 Auto-tuning instructions
The commands used in XGB series auto-tuning are as follows.

1) PIDAT
PIDAT is a command to execute auto-tuning by loops.

Start signal | PioaT 3

- Operand S means the loop no. to execute auto-tuning and avaiable only for constant(0~15).
- If start junction is on, the PID control of a loop starts.

- In case of IEC type, the following PIDAT function block is used for start of auto-tuning

[HaTd

PIOAT
| ——{RED DONE}

0 {BLOC AT 3t AT_STAT
-] K ThT

3 JLO0p
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7.5 Example Programs

The paragraph explains example programs regarding the directions of XGB built-in PID function. The
example programs are explained with water level system as illustrated in 7.17.

Water /]
level sensor

O
Tank

Pump

‘ 0~10V

A

Tank

> | XGB| D/A | AID

s-2a2e

XG5000 0~10V

[ Figure 7.17 Example of water level control system ]

7.5.1 System structure

The example system in figure is an example of a system to control a pail’s water level to a desired
level. The pail’'s water level is sensed by a water level sensor and entered to A/D input module while
PID control operation result, MV is output to a pump through D/A output module, controlling a pump’s
rotation velocity, regulating the water amount flowing into a pail and regulating the water level as
desired. Each mechanism is explained as follows.

(1) XGB basic unit
The XGB basic unit operates by PID control operating PID control operation. It receives PV from
A/D input module (XBF-AD0O4A), executes the built-in PID control operation, output the MV to D/A
(XBF-DV04A) and executes PID control.

(2) A/D input module (XBF-ADO04A)
It functions as receiving PV of an object to control from a water level sensor and delivering it to
basic unit. XBF-ADO4A is a 4CH analog input module and settings of analog input types and
scopes can be changed in the I/O parameter setting window appeared when selecting 1/0
parameter in the parameter item of project window. For more information, refer to Analog 1/0
Module.

(3) D/A output module (XBF-DV04A)

It functions as delivering control MV from basic unit to a drive (pump). XBF-DV04A is a 4CH
analog voltage output module and ranges 0 ~ 10V. For detail setting, refer to Analog 1/0 Module.
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(4) Water Level Sensor

A water level sensor plays a role to deliver the PV of an object to control to XGB by measuring the
water level of a pail and outputting it within 0 ~ 10V. Since the types and output scope of water
level sensors varies, the output scope of a sensor should be identical with that of A/D input
module’s input scope. The example uses a water level sensor outputting between 0 ~ 10V.

(5) Drive (pump)

A drive uses a pump that receives control output of XGF-DVO04A and of which rotation velocity is
variable. For accurate PID control, the output scope of XBF-DV04A (0~10V) should be same with
that of a pump’s control input. The example uses a pump that receives its control input between 0 ~

10V.

7.5.2. Example of PID Auto-tuning

Here, with examples, it explains how to calculate proportional constant, integral time and differential
time by using PID auto-tuning function

(1) PID auto-tuning parameter setting

(a) If double-clicking Parameter — Built-in Parameter — PID — Auto-tuning parameter in the
project window, it opens up the auto-tuning parameter setting window as illustrated in
figure 6.18.

x|
Embedded PID Auta Tuningl1E Loop]
Parameter LOOR 0 LOOP 1 LOOF 2 | Loo
Operational Direction Forward ! Forward i Farward i
o T o) S P R R L R
SetValue B R Tto S
—— i - e
Man. MY B B S 1 1
PuwiM Contact B = < A S =i E B
T S g S S S
T T Sy e e

[Figure 7.18 Auto-tuning parameter setting window]

(b) Set each parameter and click OK.
In the example, Loop 0 is set as follows.

¢ RUN direction: forward
- Since in the system, water level is going up as MV increases and pump’s rotation
velocity increases, it should be set as forward operation.

¢ PWM output: disabled
- In the example, auto-tuning using PWM is not executed. Therefore, PWM output is set

as disabled.

« SV: 1000(2.5V)

- It shows an example in which XBF-ADO4A is set as the voltage input of 0~10V.
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e Max. MV: 4000
- Max. MV is set as 4000. If MV is 4000, XBF-DV04A outputs 10V.

e Min. MV: 0
- Min. MV is set as 0. If MV is 0, XBF-DVO04A outputs 0V.

¢ PWM junction, PWM output cycle
- It is not necessary to set it because the example does not use PWM output.

o Hysterisis setting: 10
(2) A/D input module parameter setting

(a) If double-clicking Parameter — 1/0 parameter, it opens up the setting window as illustrated

2=

todule list

=3 Base 00: Default Slat todule Comment Input Filter | Emergency Outpu Allocation
ey 00 Default
‘g 01 : Default
g 02 Default
g 03 : Default
g 04 : Default
g 05 : Default
g 06 : Default
‘ez 07 : Default

|| | =

Drelefe Slot I Belete E:asei Base 5-3[{::@' Delete Al I Details | Frint ¥ I ok Cancel

[ Figure 7.19 1/0O parameter setting window ]

(b) If selecting A/D module for a slot in A/D input module, it opens up the setting window as
illustrated in figure 7.20.
etting

1/0 =r Setting 21X
Module list
= Base 00: Default Slot Module | Comment Input Filter  [Emergency Dutpu!{ Allocation |
iy 00 Default frmain] i ]
- 01 HBF-ADO4A Malt/Cu 1 “WEF-AD 0 e B h0040 ~ PODOTF -
iz 02 Default .. z
- 2 ! 7] %
oz 03: Default - ks R EL
za 04: Default 7 HBF-A0044 [Wolt/Current, 4-CH)
ozp 05 Default
iz 06 : Default 5 Parameter CHO CH1 CH2 CH3 |
iz 07 : Default E [~ Channel status Disahle Disahle Disakle Disakle
7 [ Inputrange
Cutput type 0 0 0=
[T Filter process Disable Disahle Disahle
Filter canstant
[ Average setting Disahle Dizable
™ Awerage processing|  Countdwr Count-Avr Count-Avr Count-Avr
1] I Average value 2 2 2 2 :
Delete Slat | Delete Base l Bas oK Cancel

[ Figure 7.20 A/D input mode setting window ]
(c) Check A/D Module operation parameter and click OK. The example is set as follows.

¢ RUN CH: CHO RUN
- The example receives the water level sensor input as CHO.
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¢ Input scope: 0 ~ 10V
- Set XBF-ADO4A input scope as 0 ~ 10V so that it should be identical with the output
scope of water level sensor.

¢ Output data type: 0 ~ 4000
- It converts the input 0 ~ 10V to digital value from 0 ~ 4000 and delivers it to basic unit.
- In the case, the resolving power of digital value 1 is 10/4000 = 2.5mV

o Filter process, averaging: disabled
- The example sets the input values in order that filter process and averaging are not
available.
- For more information about each function, refer to 12 Analog I/O Module.

(3) D/A Output Module Parameter setting

(a) Set the parameter of D/A output module(XBF-DV04A) that output MV to a drive.
How to set them is as same as A/D input module. In the example, it is set as follows.

21X
#BF-DY044 Moltage, 4-CH)
Farameter CHO CH1 CH 2 CH 3
[T Channel status Dizable Dizable Disable Disable
[T Output range 0-10% Q-1 0-~10% 0-~10%
Input type 0-~4000 0~4000 0~4000 0~-4000
[T CH. Outputtype | Formervalue Formervalue | Former value Fnrmervalueé

¢ RUN CH: CHO RUN

Ok

Cancel

- In the example, MV is output as CHO of D/A output module.

e Output scope : 0 ~ 10V

e Input data type: 0 ~ 4000
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4) Example of PID Auto-tuning program
The example of PID auto-tuning program is illustrated as figure 7.21.

comment [Enables ChO of D/ conversion module and A/d Conwersion module

FO039
|y

FoDag uo1.01.0
| |
i oW _O1_PH_acT
UoE.02.0
"

_DZ_DHNDiDUTE

cornment [Move current input value of A0 conversion module to PY Device area of AT Loop O

oY uo1.0z2 K187

1 DNI

5

_OT_CHO_DATA _ATOO_PY

cormment |Executes auto tuning of AT loop O during MO bit is ON

14

Moooo Mooo1
PIDAT i
o — | /1 ]
comment [Move current MY value of AT loop O to 044 conversion module 0
FPDS? oY K1876 02,03
; UNI _ATOO_MY _0Z_CHO_DATA

comment [Move mininum MY value of AT loop 0 to D4 conversion module 0O when auto tuning has been finished
successful Iy or error has been occured

K 18550 MOoo 1
| | 5
1a| _ATOD_ERROR
‘I = K1867 hioaa
_ATOO_STATUS
END

00

(a) Devices used

< Figure 7.21 Auto-tuning example program >

Device Data type Application

F0099 BIT It is always on, so it readily operates once PLC is RUN.
u01.01.0 BIT It starts operation of CHO of Slot 1 A/D input module.
u02.02.0 BIT It starts operation of CHO of Slot 2 D/A output module.
uo01.02 INT PV entered to A/D input module.

U02.03 INT MV entered to D/A output module.

K1875 INT Device to which PV is entered for LOOP 0 auto-tuning

K1876 INT Device to which auto-tuning MV of LOOP 0 is output.
K18677 BIT Junction that is on once auto-tuning is complete.
K18580 BIT Junction that is on once auto-tuning has an error.

K1863 INT Min. MV of auto-tuning designated in parameter.

(b) Program explanation

1) Since FO099(always on) is ON if PLC is converted form STOP to RUN, CHO of A/D and D/A
starts operating.
2) At the moment, PV entered to CHO is moved to K1875, the input device of PV and saved

accordingly.

3) Once M0000 junction is on, the auto-tuning of loop 0 starts.
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4) The auto-tuning MV of loop 0 that is output by PIDAT command is output to D/A output
module by line 14 MOV command.

5) If auto-tuning is complete or there is any error during auto-tuning, M0001 junction is set,
blocking operation of PIDAT command and it outputs min. MV set in parameter to D/A
output module.

(c) Monitoring and changing PID control variables using K area
In XGB series built-in auto-tuning, it can monitor and change RUN status of auto-tuning by
using K area allocated as fixed area by loops.

1) Variable registration

If selecting “Register in Variable/Description” by right clicking in the variable monitor
window, “Variable/Device Selection” window appears. Select “ltem” as PID, deselect
“View All” and enter 0(means loop number) in “Parameter No”, K area device list to save
every setting and status of loop 0 appears as shown figure 7.22. Then, if selecting a
variable to monitor and clicking “OK”, a selected device is registered to variable monitor
window as illustrated in figure 7.23. Through the monitor window, a user can monitor
auto-tuning run status or change the settings.

2l x|
Wariable/Device: | List: IVariabIa/CorrLI I 4l Parameter number: I1 Block index: IIZ!
Wariable Type | Device | Comment =
i _M_CHO_ACT (Jo.o1.0 ‘Analog Input Module: CHO Active
2
3 Flag
4 -
5 i i i3 :
E _01_CH1_IDD T HEUT TR gAnaIng Input Module: CHY Input Dizconnection Flag
7 _01_CHZ_ACT T ‘U010z ‘Analog Input Module: CH2 Active
g8 _D1_CH2 DATA, ORD ;um 04 ‘Analag lnput Module: CH2 Dutput
g _D1_CHZ_IDD T Jo10z tAnalog Input Module: CH2 Input Disconnection Flag
10 | i ATy Wy el “Analog Input Module: CH3 Active
11
2|
13 ]
I S e b SEE R g AR RPN iy Sl Lo R Wlip st AL ot et oo b e A A v R P P S SR
15 e e e e e e T e Ko N s e L b R e e e e e e e e o
16 T e L R S bl PR SERECE R ot yiod s AR et et A M i Pty b e £ AR RE R EECE PECECEE DL L L L DS LE DECECECE e
17 e e NS S L RSN 24 00 ARG stk Ayt b 8 i ey Pt it SO R D S PSR P RS S S I Pe P O L oY o
18 |
13 i
Z0 i
21 e C T o B e b ST R N e M S
22 sl 2 p
23 _ _OUTE uoz2.02.1 halog Output Module: CH1 Dutput Status Setting
24 _02 CH2_ACT BIT uoz01.2 iAnalog Output Module: CH2 Active -
oL A (0T in2icaBiieLt Monde, BH2 S : _}H
Ok | Cancel I
v
[Figure 7.22 Variable registration window]
X PLC Type Device W alue Y ariable Comment &
: PID Output 5e
1 MewPLT BIT k12000 _PIDO0_MAN [D:Auta, 1:Man
- Loopdd
FID PAUSE
2 MNewPLC BIT k12010 _PID00_PAUSE |[:5TOF ar RL
1:Pauze] - Loo
FID Operate
Direction
z|3 MNewPLC BIT k12020 _FID00_REY [0:Forward,
3 1:Reverse] -
= LoopO0
i FID Anti
& ind-up2
e MNewPLC BIT k12030 _PID00_&w320 | [Enable,
= 1:Dizable] - =
o i v
=K | 3
Z L2 2P Monitor 1A Monitor 2 4 Manitor 3 A Monitar 4 7

[Figure 7.23 Auto-tuning variables registered]
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(d) In case of IEC type, example program
In case of IEC type, the following program is used.

Comment |Operates &0 input module of slot 1 and CHO of 0% output module of slot 2
Lf BF¥153 #0116
[ | —
_OM _m _ETHD_.l'-'.E
L2 ax0.2.32
}_
_02_CHO_ou
TEM
Moves present walue(PV) coming from &/0 module to Auto-tuning Loopd current walue
Conment input devie
ig
SFR153
| |
"o
ia
o 1.2 4 FKW1ET
_01_CHO_DA _ATOO_PY
Th
ia
Comment [If Auto-tuning bit is on, auto-tuning of Loop 0 starts
i8 [H3TS
TuningErro
dutoTuning r PIDAT
| |/ REQ  DOME}
Lig
i JBLOC AT 5L AT_STAT
K TaT
L1
0 JLOap
Lir
Comment [Moves output of auto-tuning to digital input walue of 0/ module Chi
L2
2FR153 MOYE
| | EN EHD
_ON
iL1g
AEINETe [N 00T | ogwn.2.3
_ATOO_KY
LiA
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(5) Observing RUN status by using trend monitor function
Since it is possible to monitor the operation status of XGB series built-in auto-tuning
graphically, it is useful to monitor the operation status of auto-tuning clearly.

(a) If selecting Monitor — Trend monitor menu, it shows the trend monitor widow as illustrated in
figure 7.24.

# e

-0l x|

[ Figure 7.24 Trend Monitor window ]

(b) If right-clicking trend setting, a user can select a variable to monitor as illustrated in figure
7.25.

Monitor 5 2lx

— Sample zetting

bl ax. zample to dizplay: 1000 Sample, Time: 1000 zec,
Max. sample to keep: 1000 Sample, Time: 1000 sec,

Freguency: ]1EIEIEI - | ms

— Device setting

Bit Graph l Trend Graph ]

Device Warnable Mame

Apply k. Cancel

[ Figure 7.25 window to register trend monitor variable ]

(c) For more information about trend monitor, refer to “XG5000 Use’s Manual.”
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7.5.3. Stand-along operation after PID Auto-Tuning
Here, with example, it explains how to execute PID control followed by PID auto-tuning.
(1) PID auto-tuning parameter setting

= PID auto-tuning parameters are set as same as examples of 7.4.2 Example of PID Auto-
tuning.

(2) Setting parameters of A/D input module and D/A output module

= Set the parameters of A/D input module and D/A output module as same as the example in
7.4.2 Example of PID Auto-tuning.

(3) PID parameter setting

(a) If double-clicking Parameter — Built-in Parameter — PID — PID Parameter, it shows the
built-in PID parameter setting window as seen in figure 7.26.

x|
Embedded FID[1E Loop]

Pararmeter LOOR 0O LOOR 1 LOOR 2 LOo
Operational Made Auto Opr i Auto Opr Auto Opr : At
Operational Direction " Fowad ° " Forward ‘ T Fowad T Fare
Secondary Anti windup Dizable Dizable : Dizable Dise
e R T N s
Enable Piw/M Output " Disable " Disable " Diss
o 5 DE
Scan Perind 100 100 e 1
et B S e el
Integral Time o "
Derivative Time o s
Delta P Limit 1] C
Deelta MY Lirnit o T
Max. My 4000 401
Min, MY/ T 't
Pl aral by a i
DeadBand Setting Yalue o o
Set filkering coefficient o r
Pt Contact == Pz
Fradtd Output Period : 100 C
e R R R =
v o T ]
s P R R S I T S A
| I—| i
Ok | Cancel |

[ Figure 7.26 Auto-tuning parameter setting window ]

(b) Set each parameter and click OK.
In the example, Loop 0 is set as follows.

¢ RUN mode: automatic

- Set as automatic in order that PID control is executed as the built-in PID operation
outputs MV.

e RUN direction: forward

- Since in the system, water level is going up as MV increases and pump’s rotation
velocity increases, it should be set as forward operation.

7-50



Chapter 7 PID Function (Built-in function)

o PWM Output: disabled
- In the example, auto-tuning using PWM is not executed. Therefore, PWM output is set
as disabled.

e SV: 1000(2.5V)
- It shows an example in which XBF-ADO4A is set as the voltage input of 0~10V

¢ Operation cycle: 1000
- In the example, it is set that PID control is executed every 100ms.

¢ Proportional gain, integral time and differential time
- It should be initially set as 1,0,0 because PID auto-tuning results is used with PID
constant.

e Max. MV: 4000
- Max. MV is set as 4000. If MV is 4000, XBF-DV04A outputs 10V.

e DeadBand: 0
- Itis set as 0 because the example does not use DeadBand function.

o Differential filter setting: 0
- it is also set as 0 because the example does not use differential filter.

e Min. MV: 0
- Min. MV is set as 0. If MV is 0, XBF-DV04A outputs 0V.

e PWM junction, PWM output cycle
- It is not necessary to set them because the example does not use PWM output.

e SV ramp, PV follow-up: 0
- It is not necessary to set SV ramp and PV follow-up because the example does not
use them.

e Min. PV, Max. PV: 0
- Set them as 0 and 4000 respectively so that it could be identical with A/D input
module’s input scope.
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(c) Example of PID control program after PID auto-tuning
The program example for PID auto-tuning is illustrated as figure 7.27.

Foogg uo 01,0
I i
o 1o _01_CHO_AC
uoz, 02,0
_0Z_CHO_0U
TEN
Fooss +O00O MO ot oz K1675
T AT EN _01_CHO_DA  _ATOO_PY
. Th
MOoo0 HOOCH
PIDAT o
— | /1 - ;
7| _aT_EN
Fo0sg OO0 [ wov K1576 uoz, 03 [_
1T T L
O _AT_EN _ATOO_MY — _OZ_CHO_DA
11 ™
k18877 [ oy k1869 k1215
1T 1
15| _AT_DONE _ATOO_K_p  _PIDO0_K_p
[ Rwov K1571 K1zz0
_ATOO_T_i  _PIDOO_T_i
[ ROy K1573 K1zzz
_ATOO_T_d  _PIDO0_T_d
MOO0
83—
MOO0
PI0RUN o
ag[— | ' i
Fooss oo [ mov ot oz K1zzg
I 1T
_ON _01_CHI_DA  _PIDOO_FY
o Th
Fooss oo [ mov k1231 oz, o3 [_
T b _PI000_MY  _OZ_CHO_DA
- Th
END
54

1) Devices used

[Figure 7.27 Example program of PID control after auto-tuning]

Device | Datatype Application

F0099 BIT It is always on, so it readily operates once PLC is RUN.
u01.01.0 BIT It starts operation of CHO of Slot 1 A/D input module.
u02.02.0 BIT It starts operation of CHO of Slot 2 D/A output module.
uo01.02 INT PV entered to A/D input module.

u02.03 INT MV entered to D/A output module.

K1875 INT Device to which PV is entered for LOOP 0 auto-tuning

K1876 INT Device to which auto-tuning MV of LOOP 0 is output.
K18677 BIT Junction that is on once auto-tuning is complete.
K18580 BIT Junction that is on once auto-tuning has an error.

K1863 INT Min. MV of auto-tuning designated in parameter.

K1229 INT Device to which PV is entered for Loop 0 PID control

K1876 INT Device to which MV of loop 0 PID control is output.
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2) Program explanation

a) Since F0099 (always on) is ON if PLC is converted form STOP to RUN, CHO of A/D and
D/A starts operating.
b) Once M00QO junction is on, the auto-tuning of loop 0 starts. At the moment, PV entered to
CHO is moved to K1875, the PV input device of loop 0 and saved accordingly.
¢) The auto-tuning MV of Loop 0 output by PIDAT command is output to D/A output module
by line 11, MOV command.
d) Once auto-tuning is complete, it moves P, |, D coefficients generated from auto-tuning to
the input devices of P, | and D, K1218,K1220 and K1222, sets M001 and starts the
operation of PID loop 0.

3) In case of IEC type, program example is as shown below.

FFX153 X016
I }_
-0 1.g0.A¢
#UKD.2.32
)_
_02_CHO_ou
TEN
HFE153 WOYE
— | EN  EWD
| o
INSTE
TuningComp
dutaTuning leted PIDAT
p——A /—— REQ DOKEL wa.1.2 1N ot #Nas
_01_CHO_DA _ATOO_PY
Th
0 JBLOC AT St AT_STAT
Ko TAT
0 JL0oP
FKX29879 MOYE
— ENEND
MOYE
EN  ENO gye?s 4 IN OUT |ozuwo.2.3
_ATOO_MY _02_CHO_D&
Th
MOVE
EN  ENO 0934 4 INOUT #KDB09
_ATOO_K_p _PID0O_K_p
MOVE
EN  ENO #K0935 4 IN 0T #KDB10
_ATOO_T_i _PID0O_T_i
#KD936 4 INOUT #KDE11
_ATO0_T_d _PID00_T_d
TuningComp
leted
33—
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7.6 Error/Warning Codes

It describes error codes and warning codes of the XGB built-in PID function. The error codes and
warning codes that may occur during use of the XGB built-in PID function are summarized as table. If

any error or warning occurs, remove potential causes of the error by referring to the tables.

7.6.1. Error codes

Sy Indications Measures
codes
H'0001 MV MIN MAX ERR It occurs when max. MV is set onver than min. MV. Make
- = - sure to set max. MV larger than min. MV.
H'0002 PV MIN MAX ERR It occurs when max. PV is set lower min. Pv. Make sure to
- - — set max. PV larger than min. PV.
It occurs when the period of auto tuning or PID operation
H'0003 PWM_PERIOD_ERR | loop is set under 100(10ms). Make sure to set output
period more than 100.
It occurs when SV is larger than PV at the start time of
; auto-tuning if auto-tuning is forward or when SV is larger
H'0004 SV_RANGE_ERR than PV at the start time of auto-tuning if auto-tuning is
reverse.
; It occurs when the junction designated as PWM output
H'0005 | PWM_ADDRESS_ERR junction is beyond between P20 ~ P3F.
H’0006 P_GAIN_SET _ERR It occurs when proportional constant is set lower than 0.
H0007 |_TIME_SET_ERR It occurs when integral time is set lower than 0.
H'0008 D _TIME_SET _ERR It occurs when differential time is set lower than 0.
H’0009 | CONTROL_MODE_ERR | It occurs when control mode is not P, PI, PD or PID.
It occurs when operation direction is changed during auto-
H'000A | TUNE_DIR_CHG_ERR | tuning. Never attempt to change operation direction during
auto-tuning.
It occurs when period of operation is smaller than 100
HO00B PID_PERIOD_ERR (10ms) at Auto-tuning or PID operation.
Make sure to set period of operation larger than 100.
In mixed operation, It occurs when the direction parameter
of forward operation set to reverse operation or the
HO00C HBD_WRONG_DIR direction parameter of reverse operation set to forward
operation. Make sure set to appropriate direction each
loop.
In mixed operation, it occurs when the Set value of each
HOOOD | HBD_SV_NOT_MATCH | loop is not concurrent. Make sure set to Set value
concurrently.

[Table 7.13 : PID error codes]
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7.6.2. Warning codes

Sy Indications Measures
codes
H0001 PV_MIN_MAX_ALM | It occurs when the set PV is beyond the min./max. PV.
It occurs when PID operation cycle is too short. It is
H0002 | PID_SCANTIME_ALM | desirable to set PID operation cycle longer than PLC scan
time.
H’0003 PID dPV WARN It occurs V\_/hen the PV change of PID cycle exceeds PV
- = change limit.
H'0004 PID dMV WARN It occurs \{vhen the PV cycle MV change exceeds MV
- - change limit.
H'0005 | PID_MV_MAX_WARN :;g)(zcm\s/ when the calculated MV of PID cycle exceeds the
H'0006 | PID MV MIN WARN It occurs V\_/hen the calculated MV of PID cycle is smaller
- = = than the min. MV

[Table 7.14 : PID error codes]
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Appendix 1 Standard Resistor of Pt RTD

Pt100Q

-200 18.52
-100 60.26 56.19 52.11 48.00 43.88 39.72 35.54 31.34 27.10 22.83

0 100.00 96.09 92.55 88.22 84.27 80.31 76.33 72.33 68.33 64.30

Temp.(C) 0 10 20 30 40 50 60 70 80 90

0 100.00 103.90 107.79 111.67 115.54 119.40 123.24 127.08 130.90 134.71
100 138.51 142.29 146.07 149.83 153.58 157.33 161.05 164.77 168.48 172.17
200 175.86 179.53 183.19 186.84 190.47 194.10 197.71 201.31 204.90 208.48
300 212.05 215.61 219.86 222.68 226.21 229.72 233.21 236.70 240.18 243.64
400 247.09 250.53 253.96 257.38 260.78 264.18 267.56 270.93 274.29 277.64
500 280.98 284.30 287.62 290.92 294.21 297.49 300.75 304.01 307.25 310.49
600 313.71

JPt100Q

-200 17.14
-100 59.57 55.44 51.29 47.11 42.91 38.68 34.42 30.12 25.80 21.46

0 100.00 96.02 92.02 88.01 83.99 79.96 75.91 71.85 67.77 63.68

Temp.(C) 0 10 20 30 40 50 60 70 80 90

0 100.00 103.97 107.93 111.88 115.81 119.73 123.64 127.54 131.42 135.3
100 139.16 143.01 146.85 150.67 154.49 158.29 162.08 165.86 169.63 173.38
200 177.13 180.86 184.58 188.29 191.99 195.67 199.35 203.01 206.66 210.3
300 213.93 217.51 221.15 224.74 228.32 231.89 235.45 238.99 242.53 246.05
400 249.56 253.06 256.55 260.02 263.49 266.94 270.38 273.8 277.22 280.63
500 284.02 287.4 290.77 294.12 297.47 300.8 304.12 307.43 310.72 314.01
600 317.28
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Appendix 2 Thermo Electromotive Force and Compensating Cable

2.1 Table of Thermo Electromotive Force

» Type K unit: pv
-200 | -100| -0 | &M HT(Q?? 0 | 100 | 200 | 300 | 400 | 500 | 600 | 700 | 800 | 900 | 1000|1100 | 1200
5801 |-35531 -0 | -0 || O | O | 4095 | 8137 | 12207 | 16395 | 20640 | 24902 | 29128 | 33277 | 37325 | 41269 | 45108 | 48828
-3852 | -392 | -10 || 10 | 307 | 4508 | 8537 | 12623 | 16818 | 21066 | 25327 | 29547 | 33686 { 37724 | 41657 | 45486
-4138 | -777 | -20 20 798 | 4919 | 8938 | 13039 | 17241 | 21493 | 25751 | 29965 | 34095 | 38122 | 42045 | 45863
4410 | 1156 | =30 || 30 | 1203 | 5327 | 9341 | 13456 | 17664 | 21919 | 26176 | 30383 | 34502 | 38519 | 42432 | 46238
-4669 | -1527 | -40 || 40 | 1611 | 5733 | 9745 | 13874 { 18088 | 22346 | 26599 | 30799 | 34909 | 38915 | 42817 | 46612
-4912 | -1889 | =50 || 50 | 2022 | 6137 | 10151 | 14292 | 18513 | 22772 | 27022 | 31214 | 35314 | 30310 | 43202 | 46985
5141|2243 | -60 || 60 | 2436 | 6539 | 10560 | 14712 | 18938 | 23198 | 27445 | 31629 | 35718 | 30703 | 43585 | 47356
5354 | -2586 | -70 || 70 | 2850 | 6939 | 10969 | 15132 | 19363 | 23624 | 27867 | 32042 | 36121 | 40096 | 43968 | 47726
-5550 | -2920 | -80 80 | 3266 | 7338 | 11381 | 15552 | 19788 | 24050 | 28288 | 32455 | 36524 | 40488 | 44349 | 48095
5730 | -3242 | -90 [| 90 | 3681 | 7737 | 11793 | 15074 | 20214 | 24476 | 28709 | 32866 | 36925 | 40879 | 44729 | 48462
» Typel unit: pLv
200 | -100 | -0 | &Pl E™| o | 100 | 200 | 300 | 400 | 500 | 600 | 700 | 800
-7890 | -4632 0 -0 0 0 5268 | 10777 | 16325 | 21846 | 27388 | 33096 | 39130 | 45498
-5036 | -501 | -10 10 | 507 | 5812 | 11332 | 16879 | 22397 | 27949 | 33683 | 39754
-5426 | -995 | -20 || 20 | 1019 | 6359 | 11887 | 17432 | 22949 | 28511 | 34273 | 40382
-5801 | -1481 | =30 || 30 | 1536 | 6907 | 12442 | 17984 | 23501 | 29075 | 34867 | 41013
-6159 | -1960 | -40 40 2058 | 7457 | 12998 | 18537 | 24054 | 29642 | 35464 | 41647
-6499 | -2431 -50 50 2585 | 8008 | 13553 | 19089 | 24607 | 30210 | 36066 | 42283
-6821 | -2892 | -60 60 3115 | 8560 | 14108 | 19640 | 25161 | 30782 | 36671 | 42922
-7122 | -3344 | -70 70 3649 | 9113 | 14663 | 20192 | 25716 | 31356 | 37280 | 43563
-7402 | -3785 | -80 80 4186 | 9667 | 15217 { 20743 | 26272 | 31933 | 37893 | 44207
-7659 | -4215 | -90 90 4725 | 10222 | 15771 | 21295 | 26829 | 32513 | 38510 | 44852
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» Type T
unit: pv
-200 -100 -0 () “ () 0 100 200 300 400
-5603 -3378 0 -0 0 0 4277 9286 14860 20869
-3656 -383 -10 10 391 4749 9820 15443
-3923 757 -20 20 789 5227 10360 16030
-4177 -1121 ~-30 30 1196 5712 10905 16621
-4419 -1475 ~40 40 1611 6204 11456 17217
-4648 -1819 -50 50 2035 6702 12011 17816
-4865 -2152 -60 60 2467 7207 12572 18420
-5069 -2475 -70 70 2908 7718 13137 19027
~-5261 -2788 -80 80 3357 8235 13707 19638
-5439 -3089 -90 90 3813 8757 14281 20252
» Type R
unit: v

(C){| 0 | 100 | 200 | 300 | 400 I 500 I 600 l 700 ‘ 800 | 900 1000'1100 1200!1300 1400!1500] 1600| 1700

0 |} 0 | 647 | 1468 | 2400 | 3407 | 4471 | 55682 | 6741 | 7949 | 9203 | 10503 | 11846 | 13224 | 14624 | 16035 | 17445 | 18842 | 20215

10 || 54 | 723 | 1557 | 2498 | 3511 | 4580 | 5696 | 6860 | 8072 | 9331 | 10636 | 11983 | 13363 | 14765 [ 16176 | 17565 | 18981 20350

20 ||111] 800 | 1647 | 2596 | 3616 | 4689 | 56810 | 6979 | 8196 | 9460 | 10768 | 1211913502 | 14906 | 16317 | 17726 { 19119 | 20483

30 (1711 879 | 1738 | 2695 | 3721 | 4799 | 5925 | 7098 | 8320 | 9589 | 10902 | 12257 | 13642 | 15047 | 16458 | 17866 | 19257 | 20616

40 {2321 959 | 1830 | 2795 | 3826 | 4910 | 6040 | 7218 | 8445 | 9718 | 11035 | 12394 | 13782 | 15188 | 16599 | 18006 | 19395 | 20748

50 (296 | 1041 | 1923 | 2896 | 3933 | 5021 | 6155 | 7339 | 8570 | 9848 | 1117012632 | 13922 | 15329 | 16741 18146 | 19533 [ 20878

60 |(363| 1124 | 2017 | 2097 | 4039 | 5132 | 6272 | 7460 | 8696 | 9978 | 11304 | 12669 | 14062 | 15470 | 16882 { 18286 | 19670 | 21006

70 |{431] 1208 | 2111 | 3009 | 4146 | 5244 | 6388 | 7562 | 8822 | 10109 | 11439 | 12808 | 14202 | 15611 | 17022 | 18425 | 19807

B0 |[501 1294 | 2207 | 3201 | 4254 | 5356 | 6505 | 7704 | 8949 | 10240 | 11574 | 12946 | 14343 | 15752 | 17163 | 18564 | 19944

90 |{573 | 1380 | 2303 | 3304 | 4362 | 5469 | 6623 | 7826 | 9076 | 10371 | 11710} 13085 | 14483 | 15893 | 17304 | 18703 | 20080
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2.2 Thermocouple

2.2.1 Common limit and overheat limit

. Former symbols Nominal diameter Common limit (1) Overheat limit (2)
Symbol of materials () (mm) ¢ °C
0.65 650 850
1.00 750 950
K CA 1.60 850 1050
2.30 900 1100
3.20 1000 1200
0.65 400 500
1.00 450 550
J IC 1.60 500 650
2.30 550 750
3.20 600 750
0.32 200 250
0.65 200 250
T CC
1.00 250 300
1.60 300 300
R 0.50 1400 1600

(1): common limit refers to the temperature limit that continuously use in the air.

(2): overheat limit refers to the temperature limit that may inevitably use for a short time.
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2.2.2 Allowance by temperature

Symbol of materils | Formersymbols (cf Temperature Grade Allowance

0°C ~ lowerthan 1000°C | 0.4 | +£1.5°C or £0.4% of temperature measured

K CA 0°C ~ lower than 1200°C | 0.75 | £2.5°C or £0.75% of temperature measured

-200°C~ lower than 0°C 1.5 | £2.5°C or £1.5% of temperature measured

0°C~ lower than 750°C 0.4 | +1.5°C or £0.4% of temperature measured

’ ¢ 0°C~ lower than 750°C 0.75 | +2.5°C or +£0.75% of temperature measured
0°C~ lower than 350°C 0.4 | +0.5°C or £0.4% of temperature measured

T CcC 0°C~ lower than 350°C 0.75 | £1°C or £0.75% of temperature measured
-200°C~ lower than 0°C 1.5 | £1°C or £ 1.5% of temperature measured

R - 0°C ~ lowerthan 1600°C | 0.25 | £1.5 °C or +£0.25% of temperature measured

Allowance refers to the allowable max. limit subtracting the actual temperature of junction from the converted temperature,
based on thermo electromotive force table. In addition, the allowance will be bigger one of °C or %.
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2.3 Compensating Cable

2.3.1 Type and specifications of compensating cable

2 Type of 3 .
m?nﬂggs:dl compensating type LEEE Temp. Eleptnc Electric Qoecebsoder
ple . resistan A
. . Operating of resistan
Sectional ratio by tem themo. e ceof | Sheath
— _ application and P " | compen Remarks
S S range and : retum | colors
k] 2 allowance o L sating
35 € 3 % . . (°C) junction —r cable
% g % g +point - point (°C) QP () -+ -
£
S £
kxG | weag | Commonfor 25
general us -20-90 "
kxGs | woags | Common for +
i i general use Alloy of Alloy of 15
Common for nickel and nickel 15
KX-H | WCA-H heat-resistance chrome +25
KxHS | wcang | | Common for R Rt +15
K CA heat-resistance - Blue Red | Whie
wx | woag | Common for Aloyof | -20-90
Cgommon Tor Iron copper +3.0 0.5
WX-H | WCA-H heat-resistance and nickel 0~150
Alloy of
VX-G | WCAG Coerzggmgr Copper | copper | -20~90 -20~100 0.8
g and nickel
Common for +2.5
JX-G | WIC-G general us Alloy of -20~90 .
J IC Common for Iron copper 0.8 Yelow | Red | Whie
JX-H WIC-H heat-resistance and nickel 0~150
™G | WCC-C C°mm°? for 2.0
TX-GS general use Alloy of +1.0 .
T CcC Common for Copper copper 0.8 Brown | Red | White
TXH | WCC-H : and nickel +2.0
heat-resistance 0-150
Precise for
TXHS heat-resistance 1.0
Common for
. N (1)
RxG i general us Alloy of 0-90 + )
R - c f Copper copper 0~150 0.1 Black | Red | White
g ommon for and nickel - )
RXH heat-resistance 0~150 7

(1): The thermocouple electromotive force of thermocouple R and S is non-linear, so it does not indicate the actual
temperature measurement error.
(2): applicable to nominal cross-sectional area of 1.25mm2and more.
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| Appendix 3 Dimension

1) Dimension of XBF-ADO4A

Unit: mm
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2) Dimension of XBF-DVO04A

Unit: mm
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Unit: mm
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3) Dimension of XBF-DCO4A
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4) Dimension of XBF-RD0O4A
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5) Dimension of XBF-TC04S
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Warranty

1. Warranty Period
The product you purchased will be guaranteed for 36 months from the date of purchase.

2. Scope of Warranty

Any trouble or defect occurring for the above-mentioned period will be partially replaced or repaired. However,
please note the following cases will be excluded from the scope of warranty.

(1) Any trouble attributable to unreasonable condition, environment or handling otherwise specified in the
manual,

(2) Any trouble attributable to others’ products,

(3) Ifthe product is modified or repaired in any other place not designated by the company,

(4) Due to unintended purposes

(5) Owing to the reasons unexpected at the level of the contemporary science and technology when delivered.

(6) Not attributable to the company; for instance, natural disasters or fire

3. Since the above warranty is limited to PLC unit only, make sure to use the product considering the safety for
system configuration or applications.

Environmental Policy

IMO Precision Controls Ltd supports environmental policy according to the details on the website.



IMO Precision Controls Limited
1000 North Circular Road
Staples Corner

London NW2 7JP

United Kingdom

Tel:  +44 (0)20 8452 6444
Fax:  +44 (0)20 8450 2274
Email: imo@imopc.com
Web: www.imopc.com

IMO Jeambrun Automation SAS
Centre D’ Affaires Rocroy

30, Rue de Rocroy

94100 Saint-Maur-Des-Fosses
France

Tel:  +8000 452 6444
Fax:  +8000 452 6445
Email: info@imope.fr
Web: www.imopc.fr

IMO Automazione
Viale A. Volta 127/a
50131 Firenze
[talia

Tel:  +39 800 783281
Fax: +39 800 783282
Email: info@imopc.it
Web: www.imopc.it

IMO Canada

Unit 10, 1 Whitmore Road
Woodbridge

Ontario L4L 8G4

Canada

Tel:  +1905 265 9844

Fax: +1905 265 1749
Email: imocanada@imopc.com
Web: www.imopc.com

IMO
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